Customer Support:

Instantel is represented by a network of qualified dealers throughout the United States, Canada, and Internationally. For further information, including product literature and the location of the dealer nearest you, contact Instantel.

- Extensive dealer network.
- Comprehensive application support.
- In-depth user documentation.
- Technical support, 1–613–592–4642 or e-mail service@instantel.com

Instantel License Agreement:

This is a legal agreement between you (either an individual or an entity) and Instantel, a division of Xmark. By opening the sealed CD package you are agreeing to be bound by the terms of this agreement. If you do not agree with the terms of this agreement, promptly return the unopened CD package and the accompanying items (including user manuals and other written materials) to the location where you obtained them.

The software which accompanies this license agreement (the “Software”) is warranted against defects in materials and workmanship and shall perform substantially in accordance with the accompanying written materials for a period of one year. Should a product fail within this period it shall be repaired or replaced free of charge. Instantel does not warrant that the operation of the Software will be uninterrupted or error free. Instantel does not represent that any product will prevent bodily injury or damage to property. This warranty is void if the product has been dismantled, altered or abused in any way. EXCEPT FOR THE WARRANTIES SPECIFIED IN THIS AGREEMENT, THERE ARE NO WARRANTIES OR CONDITIONS, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND THOSE ARISING BY STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE IN TRADE. USE OF THE SOFTWARE IS ENTIRELY AT YOUR SOLE RISK.

INSTANTEL WILL NOT BE LIABLE FOR: (A) HARM TO OR LOSS OF YOUR RECORDS OR DATA; (B) ANY CLAIMS AGAINST YOU BY THIRD PARTIES; OR (C) ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOST PROFITS, LOST BUSINESS REVENUE, OR FAILURE TO REALIZE ON SAVINGS, EVEN IF INSTANTEL HAS BEEN ADVISED OF THE POSSIBILITY OF THESE DAMAGES. THIS LIMITATION APPLIES TO ALL CLAIMS BY YOU IRRESPECTIVE OF THE CAUSE OF ACTION UNDERLYING THE CLAIM BUT NOT LIMITED TO BREACH OF CONTRACT INCLUDING FUNDAMENTAL BREACH, TORT INCLUDING NEGLIGENCE AND MISREPRESENTATION; AND BREACH OF STATUTORY DUTY. IN NO EVENT SHALL THE LIABILITY OF INSTANTEL EXCEED THE COST OF THE SOFTWARE.

This agreement allows you to use the Software on one computer and make one copy of the software solely for backup purposes. You must reproduce on any such copy all copyright notices and any other proprietary legends on the original copy of the Software. You may not decompile, reverse engineer, disassemble, or otherwise reduce the Software to a human conceivable form. This agreement gives you limited rights to use the Software. Although you own the CD on which the Software is recorded, you do not become the owner of, and Instantel retains title to, the Software, and all copies thereof. All rights not specifically granted in this agreement are specifically reserved by Instantel.

Instantel may terminate your license if you breach any term of this agreement and do not remedy the breach within 10 days written notice of the breach. Upon termination you will immediately delete the Software from the computer in which it is installed and return all copies of the Software to Instantel.

This agreement constitutes the entire agreement of the parties with respect to the subject matter and supersedes all prior agreements, understandings, negotiations and discussions, whether oral or written, between the parties. This agreement will be governed by the laws of the Province of Ontario excluding the law of conflicts and excluding the United Nations Convention of Contracts for the Sale of Goods. You agree to attorn to the exclusive jurisdiction of the courts of the Province of Ontario which will have exclusive jurisdiction over matters in respect of this agreement.

© 2015 Xmark Corporation. Instantel, the Instantel logo, Auto Call Home, Blastware, Blastmate, Histogram Combo, InstaLink, Micromate, Minimate, Minimate Plus, Minimate Pro4, and Minimate Pro6 are trademarks of Stanley Black & Decker, Inc., or its affiliates.

Microsoft and Windows are registered trademarks of Microsoft Corporation.
IBM is a registered trademark of International Business Machines, Inc.
U.S. Robotics is a registered trademark of U.S. Robotics Corporation.
CutePDF is a registered trademark of Acro Software Inc.
Printed in Canada, September 2015. 714U0301 Rev 22
# Table of Contents

1. **Before You Begin** ........................................................................................................... 1–1
   1.1 Complete and Return Your Registration Card ......................................................... 1–1
   1.2 What You Need to Run Blastware ....................................................................... 1–1
   1.3 Microsoft Windows® End of Support Lifecycle .................................................... 1–1
   1.4 Hardware Key Connection (Advanced Module Only) ............................................. 1–2
   1.5 Installing Blastware on Your Computer .............................................................. 1–2
   1.6 Starting Blastware ................................................................................................. 1–6
   1.7 Conventions Used Throughout This Manual ....................................................... 1–6

2. **Introduction** .................................................................................................................. 2–1
   2.1 Blastware® Software Modules ............................................................................. 2–1
   2.2 How to Obtain the Advanced Software Module .................................................... 2–1
   2.3 Blastware Features and Benefits ........................................................................ 2–1

3. **Basic Tutorial** ............................................................................................................... 3–1

4. **Blastware Compliance Module** .................................................................................. 4–1
   4.1 File Menu .............................................................................................................. 4–1
      4.1.1 Event Manager – Compliance Module ............................................................. 4–1
      4.1.2 Report Options ............................................................................................. 4–2
      4.1.3 Close ............................................................................................................. 4–11
      4.1.4 Print .............................................................................................................. 4–11
      4.1.5 Print Preview ............................................................................................... 4–11
      4.1.6 Print Setup ................................................................................................... 4–11
      4.1.7 Copy Report to Clipboard .......................................................................... 4–12
      4.1.8 Exit ............................................................................................................... 4–12
   4.2 Unit Menu ............................................................................................................... 4–12
      4.2.1 Communications Setup ................................................................................ 4–12
      4.2.2 Compliance Setup – Series II, Series III and Micromate ............................... 4–18
      4.2.3 Compliance Setup – Series IV ..................................................................... 4–37
      4.2.4 Status .......................................................................................................... 4–58
      4.2.5 Sensor Check ............................................................................................... 4–58
      4.2.6 Date/Time ..................................................................................................... 4–59
      4.2.7 Monitor ........................................................................................................ 4–61
      4.2.8 Monitor Log .................................................................................................. 4–64
      4.2.9 Reload Operating System ........................................................................... 4–65
      4.2.10 Select Unit Type ......................................................................................... 4–67
   4.3 Tools Menu .............................................................................................................. 4–68
      4.3.1 Scaled Distance ............................................................................................ 4–68
      4.3.2 Scaled Distance - Technical Description ....................................................... 4–77
      4.3.3 Post Event Notes ......................................................................................... 4–78
      4.3.4 ASCII Conversion ...................................................................................... 4–79
   4.4 Remote Access ...................................................................................................... 4–83
      4.4.1 Auto Call Home™ Overview ....................................................................... 4–83
      4.4.2 Steps for a Successful Auto Call Home Configuration ............................... 4–83
      4.4.3 Description of Commands .......................................................................... 4–84
      4.4.4 Communications Configuration Options ...................................................... 4–93
      4.4.5 Configure TCP/IP Communications ............................................................. 4–96
      4.4.6 Configure Auto Call Home UDP/IP Communications .................................. 4–98
      4.4.7 Configure Internet UDP/IP Communications ............................................... 4–107
      4.4.8 Configure Auto Call Home™ Serial Communications .................................. 4–113
   4.5 Blastware Mail ....................................................................................................... 4–120
      4.5.1 Starting Blastware Mail ............................................................................... 4–121
Table of Contents

4.5.2 Editing Mail Delivery ................................................................. 4–126
4.5.3 Blastware Mail Example Setup .................................................. 4–127
4.5.4 Sending E-mail from the Event Manager .................................... 4–128

4.6 Windows Menu .................................................................................. 4–129

4.7 Help Menu .......................................................................................... 4–130
4.7.1 Help .............................................................................................. 4–130
4.7.2 System Info .................................................................................... 4–130

4.8 Blastware Main Menu Icon Toolbar .................................................. 4–130

4.8.1 Event Manager ................................................................................ 4–131

4.8.2 Event Report .................................................................................. 4–131

4.8.3 FFT Report .................................................................................... 4–131

4.8.4 Print ............................................................................................... 4–131

4.8.5 Report Options ............................................................................... 4–131

4.8.6 Compliance Setup ......................................................................... 4–132

4.9 Event Manager Icon Toolbar ............................................................. 4–132

4.9.1 Copy/Print ..................................................................................... 4–132

4.9.2 Print ............................................................................................... 4–132

4.9.3 Open ............................................................................................... 4–133

4.9.4 Copy ............................................................................................... 4–134

4.9.5 Delete ............................................................................................. 4–135

4.9.6 New Folder .................................................................................... 4–135

4.9.7 Notes ............................................................................................. 4–136
5. Series II Menus ........................................................................... 5–1
   5.1 Connecting Series II Monitors to Your Computer .................. 5–1
   5.2 Selecting a Serial Port .......................................................... 5–2
   5.3 Series II Event Manager ....................................................... 5–2
   5.4 Series II Unit Menu ............................................................... 5–5
       5.4.1 Compliance Setup ....................................................... 5–5
       5.4.2 Notes .................................................................. 5–8
       5.4.3 Timer Mode Setup .................................................... 5–9
       5.4.4 Status ................................................................ 5–10
       5.4.5 Sensor Check ........................................................... 5–11
       5.4.6 Date/Time ................................................................. 5–12
       5.4.7 Monitor Mode ......................................................... 5–13
       5.4.8 Monitor Log ............................................................ 5–13
       5.4.9 Reload Operating System .......................................... 5–13

6. Blastware Advanced Module (optional) ...................................... 6–1
   6.1 Event Manager – Advanced Module ...................................... 6–1
       6.2 Analysis Window ............................................................ 6–2
           6.2.1 Waveform Window ............................................... 6–2
           6.2.2 Waveform Scale Control ....................................... 6–3
           6.2.3 Time Scale Control .............................................. 6–3
           6.2.4 Waveform Checkboxes ........................................ 6–4
           6.2.5 Zoom Data Plot Command .................................... 6–4
       6.3 Advanced Setup (Series III and Series IV) .......................... 6–8
       6.4 Sound Level Microphone Setup (Series IV only) [Optional] 6–15
       6.5 Flex™ Setup (Series III only) .......................................... 6–17
   6.6 File Menu .......................................................................... 6–21
       6.6.1 File .................................................................. 6–21
   6.7 Unit Menu ....................................................................... 6–24
### Table of Contents

6.8 Analysis Menu ........................................................................................................ 6-24
  6.8.1 Post Event Notes ......................................................................................... 6-24
  6.8.2 Edit Timeline .............................................................................................. 6-24

6.9 Process Menu ........................................................................................................ 6-24
  6.9.1 View History ............................................................................................... 6-25
  6.9.2 Add .............................................................................................................. 6-25
  6.9.3 Subtract ...................................................................................................... 6-25
  6.9.4 Shift ............................................................................................................ 6-26
  6.9.5 Truncate ...................................................................................................... 6-26
  6.9.6 Vector Sum ................................................................................................. 6-26
  6.9.7 Integrate ...................................................................................................... 6-27
  6.9.8 Differentiate ............................................................................................... 6-27
  6.9.9 Filter ............................................................................................................ 6-28
  6.9.10 Scale .......................................................................................................... 6-32
  6.9.11 Remove Offset .......................................................................................... 6-32
  6.9.12 FFT Analysis ............................................................................................. 6-33
  6.9.13 Test Wave ................................................................................................. 6-34
  6.9.14 Peak Hold ................................................................................................. 6-34
  6.9.15 Smooth ...................................................................................................... 6-35
  6.9.16 Third Octave ............................................................................................. 6-35
  6.9.17 Sound Monitoring ..................................................................................... 6-36

6.10 Tools Menu .......................................................................................................... 6-38
  6.10.1 Scaled Distance ......................................................................................... 6-38
  6.10.2 Post Event Notes ....................................................................................... 6-39
  6.10.3 ASCII Conversion ...................................................................................... 6-39
  6.10.4 Human Exposure Report .......................................................................... 6-39
  6.10.5 Frequency Filter Report ............................................................................ 6-42
  6.10.6 Compliance Graph Editor .......................................................................... 6-45
  6.10.7 Edit Timeline ............................................................................................. 6-49
  6.10.8 Scale Graphs (Available with Advanced Event Open) ......................... 6-52
  6.10.9 Remove Channel ....................................................................................... 6-53
  6.10.10 Ponderation ............................................................................................. 6-53
  6.10.11 Human Exposure ..................................................................................... 6-53
  6.10.12 Transfer Function .................................................................................... 6-55
  6.10.13 Export Data ............................................................................................. 6-57

6.11 Blast Design Simulation ...................................................................................... 6-58
  6.11.1 Interval Analysis ....................................................................................... 6-58
  6.11.2 Linear Superposition ................................................................................ 6-61
  6.11.3 Signature Hole Analysis ............................................................................ 6-62

6.12 View Menu ............................................................................................................ 6-73

6.13 Window ................................................................................................................ 6-75
  6.13.1 Auto Open ................................................................................................. 6-75

6.14 Help ....................................................................................................................... 6-75
  6.14.1 System Info ............................................................................................... 6-75

### 7. Modem Operation ........................................................................................................ 7-1

7.1 Using a Telephone and Modem .......................................................................... 7-1
  7.1.1 Materials Required ..................................................................................... 7-2
  7.1.2 Configuring the Modems ........................................................................... 7-3
  7.1.3 Modem Settings .......................................................................................... 7-3
  7.1.4 Connecting a Modem to a Computer ......................................................... 7-3
  7.1.5 Connecting a Modem to a Remote Monitor .............................................. 7-3
  7.1.6 How to Connect to a Remote Monitor Using Modems ......................... 7-4
  7.1.7 Communications Setup .............................................................................. 7-4

7.2 Setting Up a Cellular Telephone and Modem ...................................................... 7-10
  7.2.1 Modem Script File ....................................................................................... 7-10
<table>
<thead>
<tr>
<th>7.2.2</th>
<th>Example Modem Script File</th>
<th>................................................................. 7–12</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Index</strong></td>
<td>.................................................................</td>
<td>................................................................... I-1</td>
</tr>
</tbody>
</table>
Thank You . . .

Thank you for purchasing Instantel’s Blastware software program. Blastware combines the ease-of-use of the Microsoft® Windows® operating system with the power and control of the two Blastware software modules: Compliance and Advanced. The Compliance module copies, views, prints reports, and deletes Events. It also sets up and programs the Series II, Series III, or Series IV monitor. The Advanced module, available separately, performs advanced functions, and has customizable setups.

1. BEFORE YOU BEGIN

1.1 Complete and Return Your Registration Card

Instantel offers the most comprehensive Product Support Program available. You receive a one year warranty on the Blastware software and free software upgrades for the first year. All you have to do is complete the registration card included with your software and return it to Instantel by mail or facsimile within thirty (30) days of purchasing your new software, or by completing the online registration form at the website, www.instantel.com.

1.2 What You Need to Run Blastware

Note: Instantel provides limited support for Windows® 2000, XP. Review the next section that details Microsoft’s End of Support program.

Blastware software can run on any IBM-compatible PC with the Windows® 7 or Vista Operating System with the following requirements:

(1) CD-ROM drive
(2) Mouse or Touchpad for Navigation
(3) SVGA or higher screen resolution
(4) A free RS232 Serial, USB or Ethernet Port depending on the model of seismograph you have purchased
(5) A free USB port for the Advanced Software hardware dongle
(6) Printer (optional)
(7) Modem (optional) – Contact Instantel for the modem supported by your unit
(8) Latest version of Acrobat® Reader®

1.3 Microsoft Windows® End of Support Lifecycle

Microsoft implements an ‘End of Support Lifecycle’ for their product releases. A detailed description of these support timelines can be reviewed at; support.microsoft.com/common/international.aspx

<table>
<thead>
<tr>
<th>Desktop operating systems</th>
<th>Latest service pack</th>
<th>End of mainstream support</th>
<th>End of extended support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP</td>
<td>Service Pack 3</td>
<td>April 14, 2009</td>
<td>April 8, 2014</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>Service Pack 2</td>
<td>April 10, 2012</td>
<td>April 11, 2017</td>
</tr>
<tr>
<td>Windows 7</td>
<td>Service Pack 1</td>
<td>January 13, 2015</td>
<td>January 14, 2020</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Not yet available</td>
<td>January 9, 2018</td>
<td>January 10, 2023</td>
</tr>
</tbody>
</table>
1.4 Hardware Key Connection (Advanced Module Only)

The Hardware Key, supplied with the Advanced Module software, plugs into your computer’s USB port. Do not plug in the Hardware Key until after you have installed the Blastware software. The Hardware Key accesses the Blastware advanced features in the advanced module. The Hardware Key can be used on any computer with a USB port and can be changed from one computer to another.

After you have connected the Hardware Key, start the Blastware program. The Event Manager appears and displays the Analysis icon indicating you have access to the Blastware Advanced Module software.

**NOTE:** Users of Windows 2000, XP, or Vista must be logged on with Administrator privileges in order to install the drivers required by the Hardware Key. Please see Installing Blastware on Your Computer below for details.

**NOTE:** New Blastware software installations may not run using hardlock devices from previous versions.

1.5 Installing Blastware on Your Computer

Blastware installs onto your hard disk creating its own directory and copying all the necessary Blastware program files into the directory. If you are installing the Advanced Module, do not plug in the Hardware Key until after you have installed the Blastware software.

To install the Blastware Software Program:

1. Insert the Blastware CD-ROM into the CD/DVD-ROM drive on your PC. The Blastware welcome screen appears. (If auto run is disabled on your computer, the screen will not appear. Open the Blastware CD-ROM and double click on the startup.exe icon.)
2. From the welcome screen, select “Install the Blastware [Version No.] software”. You then have the option to select and Save manuals from the CD to your hard drive. Additionally, you can select View for any of these manuals and they will open after being saved. Or, you may choose to View or Save them independently.

3. Accept the destination directory for the manuals, or choose a new one.
   **Note:** If you have purchased the Advanced Module, do not insert the USB stick until after the installation.

4. The message below appears. Select the **Proceed** button to continue with the Blastware Installation. **Exit** cancels the installation:

5. An “Installing Dongle” message flashes on the installation window indicating that the Dongle software is being installed.

6. After the Dongle software is installed, the Blastware installation process begins, indicated by a flashing “Installing Blastware” message:

7. The InstallShield Wizard appears. Proceed with the installation by selecting the **Next** button. You may stop the installation at any time by selecting **Cancel**.
8. The “Welcome to the InstallShield Wizard for Blastware [Version]” appears. Select Next to proceed with the installation of Blastware.

9. The Instantel License Agreement is displayed. Read the License Agreement and then select the “I accept the terms in the license agreement” radio button. Select Next to proceed with the installation.

10. Review the Readme Notes. These are important updates about the features and software fixes that are included in the Blastware version currently being installed. Select Next to continue with the installation.
11. Accept the default directory destination for the software installation, by clicking Next, or use the Change button to create a new location.

12. Now you must decide on who will be allowed access to the software. Select “Anyone who uses this computer (all users)” or “Only for me” with the name of your computer beside the message. Select Install to start the software installation.

13. The Blastware installation begins, displaying a status bar of the progress. When this process has been completed, select Next to continue with the installation.
14. Select **Finish** to complete the installation.

![InstallShield Wizard Completed](image)

15. You are now ready to begin using Blastware. A series of icons related to the Blastware program was added to your Windows, Start, Program list, and a Blastware icon was added to your Desktop. Start Blastware by selecting the icon at either location.

**NOTE:** If Available, we recommend that you install an update of Blastware available at [www.instantel.com](http://www.instantel.com). This update will include a new version of the monitors operating system.

After downloading the update, ensure that you have selected the proper unit type prior to trying to communicate with it using the **Reload Operating System** option. Select **Reload Operating System** from the **Unit Menu**.

1.6 **Starting Blastware**

If you have the USB Hardware Key for the Advanced Module, insert it into your USB port. To start Blastware, place the mouse pointer on the Blastware program icon, located on your Windows Desktop or within your Windows, Programs listing. A welcome screen appears followed by the Blastware Event Manager.

1.7 **Conventions Used Throughout This Manual**

The following typographical conventions appear throughout this manual.

**Bold type** Press the indicated key.

**Italic type** Information that you enter. For example, *filename* asks you to enter a filename of your choice.
2. **INTRODUCTION**

The Blastware program combines the ease-of-use of a Microsoft Windows based program with the power and control of a user-friendly menu structure. Using the program, you can view and print Event waveforms and program, control, and customize the operation of your Minimate Blaster, Series II, Series III or Series IV monitor.

### 2.1 Blastware® Software Modules

The Blastware software program has two modules. The first is the **Compliance Module** and comes standard with each Blastmate III, Minimate Plus, or Minimate Blaster, or Series IV monitor. This module includes all the commands to control your monitors basic compliance features. You can also use it to transfer your recorded Events to a personal computer where you can view them, format user-definable Event and FFT Reports that can be produced by your printer, or produce a PDF file format that can be emailed.

The second module, the **Advanced Module**, provides advanced features to analyze recorded Events. You can edit National Frequency Standards, perform FFT and timeline analysis. You can also integrate, differentiate, invert, add, linear superposition, filter, and truncate waveforms. Blastmate III and Minimate Plus users can customize the monitor LCD windows to match particular applications or display another language. Using this module, you can also change sample rates, and program the Blastmate III, Minimate Plus, or Series IV to use additional sensors.

The Advanced Module will only operate on a computer equipped with a Hardware Key that is provided with the purchase of the Advanced Module.

### 2.2 How to Obtain the Advanced Software Module

You can order the Advanced Software module from any authorized Instantel Dealer. The module includes an installation CD, a Hardware Key to access the programs, and an Operator Manual.

### 2.3 Blastware Features and Benefits

The following table provides a sample of the Blastware features and benefits. The Compliance Module is supplied at no cost with every monitor. The Advanced Module is available separately.

<table>
<thead>
<tr>
<th>Functions and Features</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Compliance</td>
</tr>
<tr>
<td>Program monitor</td>
<td>•</td>
</tr>
<tr>
<td>Upload and Display Events, store on disk, and print via RS–232</td>
<td>•</td>
</tr>
<tr>
<td>Modem communications</td>
<td>•</td>
</tr>
<tr>
<td>Remote Monitoring</td>
<td>•</td>
</tr>
<tr>
<td>Auto Call Home</td>
<td>•</td>
</tr>
<tr>
<td>Post Event Notes to multiple events</td>
<td>•</td>
</tr>
<tr>
<td>Sample rates programmable (1 to 4 KHz)</td>
<td>•</td>
</tr>
<tr>
<td>Single batch command for copy and print</td>
<td>•</td>
</tr>
<tr>
<td>Change units of measurement</td>
<td>•</td>
</tr>
<tr>
<td>Read Blastmate II files – convert to Blastmate III</td>
<td>•</td>
</tr>
<tr>
<td>Feature</td>
<td>Series II</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Select national frequency analysis</td>
<td>•</td>
</tr>
<tr>
<td>ASCII output for third party analysis packages</td>
<td>•</td>
</tr>
<tr>
<td>Series II Blastmate and Minimate Support</td>
<td>•</td>
</tr>
<tr>
<td>Scaled Distance Analysis</td>
<td>•</td>
</tr>
<tr>
<td>Histogram mode for standard sensors</td>
<td>•</td>
</tr>
<tr>
<td>Customized Event Reports</td>
<td>•</td>
</tr>
<tr>
<td>Customized FFT Reports</td>
<td>•</td>
</tr>
<tr>
<td>Histogram Combo mode for standard sensors</td>
<td>•</td>
</tr>
<tr>
<td>Customized Signature Hole Analysis Reports</td>
<td>•</td>
</tr>
<tr>
<td>Fast Fourier Transform (FFT) analysis</td>
<td>•</td>
</tr>
<tr>
<td>Time line display</td>
<td>•</td>
</tr>
<tr>
<td>Change sample rates (512 Hz to 65 KHz*)</td>
<td>•</td>
</tr>
<tr>
<td>Program monitor for custom sensors</td>
<td>•</td>
</tr>
<tr>
<td>Support for custom sensors</td>
<td>•</td>
</tr>
<tr>
<td>Integrate and Differentiate (i.e. velocity displacement/acceleration)</td>
<td>•</td>
</tr>
<tr>
<td>Truncate waveform</td>
<td>•</td>
</tr>
<tr>
<td>Add waveforms</td>
<td>•</td>
</tr>
<tr>
<td>Shift waveform</td>
<td>•</td>
</tr>
<tr>
<td>Filter to eliminate unwanted frequencies</td>
<td>•</td>
</tr>
<tr>
<td>Compliance Graph Editor</td>
<td>•</td>
</tr>
<tr>
<td>User defined printout and LCD headings</td>
<td>•</td>
</tr>
<tr>
<td>Waveform and Blast Simulation using Interval Analysis, Linear Superposition, and Signature Hole Analysis Tools</td>
<td>•</td>
</tr>
<tr>
<td>Language Editor to change existing language or translate to another language (Series III and IV)</td>
<td>•</td>
</tr>
<tr>
<td>Remove offsets when using custom sensors</td>
<td>•</td>
</tr>
<tr>
<td>Transfer Function</td>
<td>•</td>
</tr>
<tr>
<td>Human Exposure</td>
<td>•</td>
</tr>
<tr>
<td>PDF Output</td>
<td>•</td>
</tr>
<tr>
<td>Ethernet Communications</td>
<td>•</td>
</tr>
<tr>
<td>Frequency Filter Report</td>
<td>•</td>
</tr>
<tr>
<td>1/3 Octave Report</td>
<td>•</td>
</tr>
<tr>
<td>Export Data to Windows Clipboard</td>
<td>•</td>
</tr>
<tr>
<td>Zoom Data</td>
<td>•</td>
</tr>
<tr>
<td><strong>Series IV Only</strong></td>
<td></td>
</tr>
<tr>
<td>Vibration Dose Value (VDV) at 512 Hz sample rate and Event Reports</td>
<td>•</td>
</tr>
<tr>
<td>Feature</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>View Histogram data in real-time</td>
<td></td>
</tr>
<tr>
<td>Monitor Scheduler (24 hour and Week with Repeat Option)</td>
<td>•</td>
</tr>
<tr>
<td>Sound Level Monitoring and Analysis</td>
<td>•</td>
</tr>
</tbody>
</table>

* Sample rates up to 65 KHz available on one channel for Series III monitors. Four channel monitors manufactured before 1998 require modifications to minimize noise. Sample rates up to 65 KHz available on all channels for Series IV monitors. Contact Instantel for more information.
3. Basic Tutorial

In this tutorial, we set up your computer and the Blastware program to work together. We then transfer Event files from your Series III or Series IV unit to the computer. Once we have completed this, we view and print each Events Event Summary Report.

Step 1: Connect the Monitor to Your Computer

Series III Monitor Connection

Turn off the power to the unit. Connect the Blastmate III or Minimate Plus to your computer with the Blastmate III PC cable provided (Part No. 712A2301). Attach the Blastmate III PC connecting cable to a serial port on your computer. Use the 9 – 25 Pin Adapter (Part No. 312-0007) if required. If you are using the optional USB to Serial Adaptor Kit (Part No. 714A7001), follow the supplied instruction sheet. Connect the opposite end of the cable to the AUX connector (or cable, if you are using the USB cable) located on the front of the Blastmate III or on the side of the Minimate Plus. Do not force the connectors, possible damage may result.

Series IV Monitor Connection

Connect the Minimate Pro Series IV unit to your computer using the Ethernet Communication Cable, Minimate Pro to PC (Part No. 720A4101). Attach the Series IV PC connecting cable to the Ethernet port on your computer. Connect the other end of the cable to the Auxiliary connector located on the right of the unit. For more information, refer to Section 4.2.1b. These are quarter-turn connectors – do not force the connectors, possible damage may result.

Micromate Monitor Connection

Connect the Micromate unit to your computer using the PC to USB connecting cable. Attach the connecting cable to a free USB port on your computer. Connect the other end of the cable to the connector labeled PC on the unit.

Step 2: Start the Blastware Program

Turn on your computer. Click on the Windows Start button in the lower left of the screen, select Programs, and then Blastware. Click on the Blastware icon to start the Blastware program.

Step 3: Set up Communications

Communication between an Instantel monitor and your computer is configured using the Communications Setup dialog box located under the Unit Menu. Open the Unit Menu and choose Communications:
For the tutorial, we will use an Automatic IP Address. Check the **Automatic IP Address** check box. The other menus; **Baud Rate**, **Retries**, and **Modem Type** should have the same settings as the dialog box pictured above.

**NOTE:** If you have attached a Micromate monitor to the PC, the name of the unit and associated port will be automatically populated in the **Port** dropdown window.

When the Automatic IP address option is selected, the Minimate Pro is automatically set to use an IP address in the same domain as the IP address used on your computer.

Click on the **Test Communications** button. To test your successful connection to the monitor, Blastware will communicate with the unit, and indicate if your selection is correct. Click on the **Close** button to save your setting and exit the Communications Setup dialog box. The remaining buttons including **Dial**, **Hang up**, **Initialize PC Modem**, and **Initialize Remote Modem** control modem communications. See Chapter 7 for further information about these communication options.

**Step 4: Check the Unit Status**

To check the status of the Blastmate III, Minimate Plus, Series IV or Micromate from your computer, position the mouse pointer on the **Unit** Menu and click the mouse button. Click on the **Status** command to display Status dialog box.

This dialog box informs you of important information about the monitor including its operating software version, when it was calibrated and by who, the currently set date and time, the current
mode the monitor is in, its battery level and the amount of total memory installed in the monitor and the amount the memory available. Press the Refresh button to update the information.

**Step 5: Report Options**

Blastware creates an Event Summary Report for each recorded Event. Blastware offers you a wide degree of flexibility to define the contents of these reports. In this step, we enter a new report title, choose a Compliance Report, and choose the reports measurement units.

1. Open the Report Options Menu by clicking on the icon, or access it from the File Menu.

![Report Options Menu](image)

2. Change the **Report Title**.
   
   You can change the Report Title to a title of your choice. Position the mouse pointer in the Report Title text box. Press the Backspace key to delete the existing title. Enter a new title up to a maximum of forty nine characters.

3. Choose a **Compliance Graph**.
   
   Blastware supports numerous Compliance Reports. To choose a Compliance Report, position the mouse pointer over the Compliance Graph drop-down menu and click the left mouse button. A list of supported Compliance Reports appears. Scroll through the list and choose a report by clicking the left mouse button. If you have two geophones attached, then repeat this step for the second geophone.

4. Press the **OK** button to close the dialog box and save your changes.

**Step 6 Open the Event Manager**

The Event Manager organizes the Event files stored on your computer similar to the Windows File Manager. The Event Manager allows you to copy, delete, print, and view Events by simply selecting an Event and pressing the appropriate command button. If the Event Manager is not
Basic Tutorial

open, click the mouse pointer on the File Menu then click on the Event Manager command. The Event Manager dialog box appears.

Step 7 Copy All the Events to Your Computer

To copy Events from the Blastmate III, Minimate Plus, Series IV or Micromate to your computer, press the Copy/Print icon. If you are using a Series IV monitor, ensure that you select the unit icon in the Event Manager. The Copy and Print All Events dialog box appears. Press the Yes button to copy all the Events on the unit, and display them in the Events List Box. Click on the Print checkbox to print the Events on your computers default printer at the same time.

Step 8 View an Event Report

You can view an Event or FFT Report by selecting the event and clicking on the Event Report or FFT Report icons provided in the toolbar. These reports can also be accessed by pre-selecting them under the Window menu, then Auto Open – select the reports you would like to view automatically by highlighting them with a check mark. The default is both reports. To automatically view reports using the Auto Open selections, double click your left mouse button on the desired event, and the reports will be created in a new window based on the settings you have defined within the File menu, Report Options dialog.

1. The settings of your PC monitor (i.e. 800 x 600) will determine the extent of the Event Report you will be able to view without scrolling. Scroll through the Event.
   Click on the scroll bars (Arrows) to scroll through the Event Report.
2. View the Entire Event.
   Click on the File Menu and choose the Print Preview command. The entire Event Report appears on your display.
3. Add Post Event Notes.
   Click on the Tools Menu and click on the Post Event Notes command. Enter your comments and press the Apply to Event button.
4. **Print the Event.**

To print an Event, click on **File** Menu and click on the **Print** command, or use the **Print** icon available in the toolbar. If required, adjust the settings in the Printer dialog box and press **OK** or **Yes** to send the print job to your local default printer.

Below is an example of a **Series IV Event Report** using the **Waveform Record Mode**:

![Event Report Example](image-url)
4. **BLASTWARE COMPLIANCE MODULE**

This chapter provides instructions to use the Blastware Compliance Module. It provides instructions to transfer, list, copy, delete, print, and view Events. It also includes procedures to set up your Series III, Minimate Blaster, Series IV or Micromate and customize the Event Summary Report. The Main Window contains the Blastware Main Menu, an Icon Toolbar, and other standard Windows controls. You access all Blastware commands from the main window.

The Blastware Main Menu contains several commands to program the unit. After you have changed the setups, Blastware can transfer the changes to the monitor. In order for Blastware to complete this successfully, a unit must be connected to the computer using the communication cable that was provided with it. Before you enter this menu and attempt to change the setups, connect a monitor to your computer.

### 4.1 File Menu

File Menu contains several commands; **Event Manager**, **Report Options**, **Close**, **Print**, **Print Preview**, **Print Setup**, and **Exit**. The **Close**, **Print**, **Print Preview**, and **Print Setup** commands are only available if you have a **Report** open.

#### 4.1.1 Event Manager – Compliance Module

If you have a Report open, you can access the Event Manager by clicking on the **Event Manager** command in the File Menu. This will bring the Event Manager to the forefront. Or, if you have closed the Event Manager, clicking on this menu selection will reopen the Event Manager window.
4.1.2 Report Options

The Report Options command defines the contents of the Event Report created by Blastware which can then be printed using your computer's printer. This report is not the same report as the one printed by the Blastmate III printer or the Minimate Plus using a printer. The setups of this report can be different from the monitor report. You can define which Event information to include or exclude in the report.

To change these settings, select the File Menu and choose Report Options. The Report Options dialog box appears. This dialog has several tabs, with each tab containing options that control the printed results of the Event Report – these tabs are Data Display, Units and Channel, Compliance Scaling, and FFT Report Options.

To accept any changes that you make within Report Options, click on Apply. Any changes that you have made will be automatically updated and the Report Options dialog will remain open. If you make changes, but decide not to accept them, click on Cancel. Clicking on OK will apply the changes and exit from the Report Options dialog.

---

### a. Data Display

1. **Report Title**
   
The Report Title may be changed to a title of your choice. To change the title, click on the Report Title text box. Press the Backspace key to delete the existing title and then enter your new title.

2. **Compliance Graph for Geophone 1**
   
   Blastware supports numerous Compliance Reports for each attached Geophone.
   
   To choose a report, click on the Compliance Report drop-down menu and scroll through the standards. Click on the required standard.

3. **Compliance Graph for Geophone 2**
   
   Blastware supports numerous Compliance Reports for each attached Geophone.
   
   To choose a report, click on the Compliance Report drop-down menu and scroll through the standards. Click on the required standard.
(4) **Language**
This drop-down menu selects the language used by the Blastware program. Contact Instantel for additional language options.

(5) **Print Custom Logo**
Blastware also enables you to print a logo of your choice, which appears in the top right-hand corner of your Event Summary Report. Any bitmap file (indicated by the extension .bmp) may be used, provided that it has dimensions in the ratio of 277 wide by 55 high. Blastware attempts to fit the graphic into an area of 277 by 55 pixels. If it cannot, a warning message appears when you print the report. You may wish to edit your logo in Microsoft Paint or another graphics program before you import it into Blastware.

To add a custom logo to your reports, move the mouse pointer to the checkbox and click to display a checkmark. Then click on **Change** to navigate through your directories and find the bitmap file you wish to use. When you have selected the file, it will appear in the text box to the left of the **Change** button.

Print a test report to ensure that the logo appears as expected.

(6) **Print in color**
This setting controls the printing of the Event summary report in either black and white or color. For black and white printing, leave the Print in color checkbox blank. For color printing, enter a checkmark in the checkbox. Color printing requires a color printer connected to your computer.

(7) **Display Waveforms in Color**
This setting toggles the display of the waveforms in the Event Report from black and white to color. To display the waveforms in color, click on the checkbox to display a checkmark.

(8) **Show Cursor on Print Screen**
This feature controls the printing of the cursor, and the associated cursor data, in the waveform graph. To include the cursor and cursor data, click on the checkbox to display a checkmark.

(9) **Show Grid Lines on Waveform**
This feature controls the printing of grid lines in the waveform graph.
To include grid lines, move the mouse pointer to the checkbox and click to display a checkmark. If you do not require the grid lines, click on the checkbox to remove the checkmark.

(10) **Show Waveform Compliance Graph**
To include the waveform compliance report, click on the checkbox to display a checkmark. If you do not require the waveform compliance report, click on the checkbox to remove the checkmark.

(11) **Show Histogram Compliance Graph**
To include the histogram compliance report, click on the checkbox to display a checkmark. If you do not require the histogram compliance report, click on the checkbox to remove the checkmark.

(12) **Show Ponderated Peaks**
Ponderation is a weighting of waveform frequencies, as defined in the French national compliance standard.

To print ponderated peaks in the Event Summary Report, move the mouse pointer to the checkbox and click to display a checkmark. If you do not require ponderated peaks, click on the checkbox to remove the checkmark.

(13) **Show Waveform**
This setting controls the printing of the Event waveforms. The waveforms are graphical representations of the activity recorded on each of the recording channels.

To print the waveforms, click on the checkbox to display a checkmark. If you do not require the waveforms, click on the checkbox to remove the checkmark.
(14) **Represent Histogram Using Lines**

To display the Histogram as lines instead of a filled bar chart graph, click on the checkbox to display a checkmark. If you would rather view the filled bar chart style, click on the checkbox to remove the checkmark.

(15) **Include PVS on Event Report**

To include the Peak Velocity Sum (PVS), click on the checkbox to display a checkmark. If you do not require the PVS results, click on the checkbox to remove the checkmark.

(16) **Flex Event Compliance Warning (Series III Only)**

If an Event has been recorded using the Flex mode, and this checkbox has been selected, the following dialog box will appear. Flex Events will only display compliance channels – advanced channels must be viewed within the Analysis screen. If you do not require this function, click on the checkbox to remove the checkmark. An option is provided to remove this dialog prompt.

(17) **Show Channel Test Waveform**

To include the Sensor Check at the end of the waveform, and the frequency and overswing ratio in the Geophone Summary, click on the checkbox to display a checkmark.

Waveform on Event Report with show **Channel Test Form** not selected:
Waveform on Event Report with show **Channel Test Form** selected:

(18) **Display Geo Peaks in dB**

To have geo peaks expressed in decibels (dB) on your Event Summary Report, move the mouse pointer to the checkbox and click to display a checkmark. If you do not require this function, click on the checkbox to remove the checkmark.

**i Reference to Value dB**

Input the dB reference level in accordance with your local regulations. If the local regulations express this reference value in PPV, then complete the following equation to obtain the value in dB:

\[
\text{Reference dB} = 20 \times \log\left(\frac{1}{\text{Reference PPV}}\right)
\]

*** WARNING ***

When performing this calculation, the Reference PPV units must be the same unit type (i.e. mm/s or inches/s) as that with which you are recording.

(19) **Event Manager Options**

These settings sort the Event List and choose whether to include Monitor Log entries within the list.

**i Sort events by start date/time**

This option displays the Event Lists Events sorted by date. The earliest recorded Event appears first within the list. If you do not choose this option, Events appear in the list in the order in which they were copied from a monitor.

To enable this option, click on the checkbox to display a checkmark.

**ii Show Monitor Log Entries**

This option displays monitor log entries within the Event List. Monitor Log files must be copied from a monitor to the Event List directory on your computer before they can appear within the list.
To ensure that monitor log entries and Events display in sequence, enable the Sort by date option explained in the previous section.

To enable this option, click on the checkbox to display a checkmark.

b. Units and Channel

1. **Show Mic in dB**
   The microphone units are either Metric, Pa (Pascal), or Imperial, pounds per square inch (psi).
   To choose dB units, click on the Show Mic in dB checkbox to display a checkmark. To disable dB units, click on the checkbox again to remove the checkmark.

2. **Show Mic in Linear Units**
   The microphone units are Metric, Pa (Pascal), or Imperial, pounds per square inch (psi).
   To choose Linear units, click on the Show Mic in Linear Units checkbox to display a checkmark. To disable Linear units, click on the checkbox again to remove the checkmark.

3. **Measurement Units**
   You can print an Events Event Summary Report using either Imperial or Metric measurement units. To select the measurement unit for the Event Report, click on the Measurement Units drop-down menu and click on either Imperial or Metric.

4. **Time Display Format**
   You have the choice between 24 and 12 hour time displays.
   To choose the 24 hour time display, click on the 24 Hour button. To use the 12 hour display, click on the 12 Hour (AM/PM) button.

5. **Select channels to show on compliance Event report**
   With this command, you can choose which channels to display on an Event report. You must choose at least one channel per report.
   **NOTE:** Some analysis results cannot be calculated if the required channel is not chosen. For example, a Peak Vector Sum calculation cannot occur if either channel 1, 2, or 3 was not chosen to appear within the Event report. To show all channels, click Show All.
NOTE: Ensure that you select only the channels associated with the type of unit that you are obtaining the Events from, Series II and III, Series IV or Micromate.

c. Compliance Scaling

(1) Waveform Compliance Event Reports Scaling
You can either use the default selection for viewing the amplitude of the Recorded Peak of the Geophone, Linear Mic, or “A” Weight Mic channel, or define the Maximum Amplitude by clicking on the radio button underneath the heading Entered Maximum Amplitude, and enter a value for each channel.

(2) Time Scale
View the complete Time Scale of the Event by selecting Entire Event, or view a portion of the Event by entering a specific Time Scale in seconds. The default Time Scale is -0.25 second to 1 second – this negative number accounts for the pre-trigger set for compliance monitoring. If Entire Event has not been selected, then it is noted on the Event Report.
d. FFT Report Options

(1) Scale the Geo Channels
Determine if you would like to view the geo channel scaled to its own peak, or scaled to the maximum peak of the three triaxial geo channels. To scale the channel to the peak of the three triaxial geo channels, select the first option, Scale each channel to peak of the three triaxial geo channels, by clicking on the radio button. Or, select Scale each geo channel to its own peak.

(2) Display Frequency Band in Hz
Determine the Frequency band that you would like to view on the FFT Report by inputting values in the From and To fields. The allowable frequency range is 0 – 250 Hz.

(3) Display Channel 4
To view the microphone Channel (Linear Microphone, or if you are using the optional Sound Level Microphone, Part No. 720A5101), click on the Display Channel 4 checkbox to display a checkmark. To disable Display Channel 4, click on the checkbox again to remove the checkmark.
e. Sound Monitoring

(1) **For a Compliance Event Report, Sound Monitoring Channels**

The Sound Level Microphone Event Reports can be setup to display Equivalence and Exceedance Levels in Compliance Mode, or Equivalence in Advanced Mode. An example Compliance plot appears as follows (Advanced, Unfiltered, does not have the L10 or L90 Exceedance option):

An example of viewing a Compliance Event Report with Sound Level Microphone results:
Opening a Waveform or Histogram event that was recorded in Advance mode will produce an event report that shows the Peak Sound Pressure Level (PSPL), when the peak occurred relative to the trigger time, the range the event was recorded in and the measurement units.

An example of viewing an Advanced Event Report with Sound Level Microphone results:

- **Microphone**  
  - ‘A’ Weight – Fast
  - Lmax: 86.7 dB(A) at 2.854 sec
  - Sound (dB): LMin 53, L90 51.2, L10 83, Leq 79.0
  - Channel Test: Passed (Amp = 587 mv)
i **Equivalence Level, Leq**
The true equivalent sound level measured over the time of the recording.

ii **L(N1) Exceedance Level, default L10**
Exceedance levels represent the percent of the recording that was at, or above, the default L10 level.
*Example:* If L10 = 51.2 dB then 10% of the time recording was above 51.2 dB

iii **L(N2) Exceedance Level, default L90**
Exceedance levels represent the percent of the recording that was at, or above, the default L90 level.
*Example:* If L90 = 42 dB then 90% of the time recording was above 42 dB

(2) **For Advanced Event Report, All Channels**

i **Equivalence Level, Leq**
The true equivalent sound level measured over the time of the recording.

### 4.1.3 Close

This command is only available when you have either an Event or FFT Report open. Each time you select **Close**, the current, active Report window will exit. Until you have exited all open Reports, the Close command will be available.

### 4.1.4 Print

This command is only available when you have either an Event or FFT Report open. Select the **Print** command from the File Menu to print the currently opened and active window of a Report.

To create Portable Document Format (PDF) files of the Reports, download and install the free **CutePDF™** program from [http://www.cutepdf.com/](http://www.cutepdf.com/). After you have followed the manufacturers installations instructions to install the printer driver, you will be able to select the **CutePDF™** printer as your default printer to create electronic PDF files for distribution.

### 4.1.5 Print Preview

This command is only available when you have either an Event or FFT Report open. Select **Print Preview** to see how your report will look once it is printed. There are several selections under the Print Preview command to help navigate and view the Report.

a. **Print**

Selecting the **Print** icon will access the Windows printer dialog setup for the default printer selected within the Windows operating system.

b. **Zoom In**

Select the **Zoom In** icon to increase the visible size and clarity of the Report – you are able to magnify the report by two hundred percent.

c. **Zoom Out**

Select the **Zoom Out** icon to reduce the visible size of the Report – you are able to reduce the visible size until the entire page appears in the Print Preview dialog.

d. **Close**

Select **Close** to exit the Report Print Preview without printing and return to the current active window.

### 4.1.6 Print Setup

This command is only available when you have either an Event or FFT Report open. Select **Print Setup** from the file menu to modify your default printer options, or to select another printer that is connected to your computer.
To create Portable Document Format (PDF) files of the Reports, download and install the free *CutePDF™* program from http://www.cutepdf.com/. After you have followed the manufacturers installations instructions to install the printer driver, you will be able to select the *CutePDF™* printer as your default printer to create electronic PDF files for distribution.

### 4.1.7 Copy Report to Clipboard

This command is only available when you have an Event, FFT, or Analysis FFT Report open. From the file menu, select **Copy Report to Clipboard**. A bitmap image of the open report is copied to your computers temporary memory. Open another Windows program that supports graphics and use the paste command, or simultaneously press *CTRL-V*, to place the bitmap image into the file.

### 4.1.8 Exit

Select **Exit** to close the Blastware program. A dialog will appear to confirm whether or not you would like to exit the program. Click on **Yes** to exit to Windows, or **No** to remain within the Blastware program.

### 4.2 Unit Menu

The Unit Menu contains several commands to program the Series III, Series IV, Minimate Blaster or Micromate. After you have changed the setups, Blastware transfers the changes to the monitor. In order for Blastware to complete this successfully, the unit must be connected to the computer using the supplied communication cable. Before you enter this menu and attempt to change the setups, connect a monitor to your computer.

#### 4.2.1 Communications Setup

The Communications Setup command establishes **Serial**, **TCP** or **UDP** communication parameters to allow a computer to talk to the monitor. Open the **Unit Menu** and choose **Communications**. The Communications Setup dialog box appears.
a. **Serial Communications**

(1) **Port**

Port refers to your computer’s serial port where you plugged in the communication cable with the USB adaptor. The serial port allows the monitor to communicate with your computer. Set the Port drop-down menu to match the number of the serial port. You have a choice between Ports 1 to 20. Identify the serial port on your computer and choose the same number in the Port box. See your computer’s manual for information on how to identify serial ports. Click on the **Port** drop-down menu and select a com port.

To test your selection, press the **Test** button. Blastware will indicate if your selection is correct – if the communication link is not successful, systematically select the next Communications Port from the **Port** drop down menu, and use the **Test** function until you have made a successful connection to the monitor. Click on the **Close** button to save your setting and exit the Communications Setup dialog box.

**NOTE:** Micromate monitors will be recognized by Windows® and the Port will be briefly displayed when the unit is attached to the PC, and automatically input into the Port dialog.

(2) **Baud (Series II, III, Micromate or IV)**

The Baud Rate determines the communication speed and the amount of information (bps, or bits per second) that is transferred to and from the unit. Ensure that the Baud Rate within Blastware and on the unit match, otherwise you will not be able to communicate between the two platforms.

For Series III units, set the communications Baud Rate to 38400 bps, using the Blastmate III PC connecting cable. This will provide you with the fastest communication speed with the Series III unit.

For Series IV units, the communication speed may be set as high as 115,200 bps, using the Series IV communication cable.

Click on the **Baud Rate** drop-down menu and select a setting for the unit that is attached to the computer.

(3) **Retries**

Set the number of retries the computer will attempt when connecting to the monitor. Retries range from zero to ten. A typical setting is two.

Click on the **Retries** drop-down menu and select a setting.

(4) **Timeout Factor**

Set the amount of time that you want the modem to automatically stop communicating with the unit if it is idle, or has stalled while communicating with the unit. A typical setting is two.

Click on the **Timeout Factor** drop-down menu and select the time factor.

(5) **Modem Type**

Remote communications can occur if a modem is selected. For direct communications between the computer and the monitor, set this to No Modem. For Series IV, a modem script file must be loaded on the unit.

Click on the **Modem Type** drop-down menu and select No Modem.

(6) **Disconnect modem after being connect for X minutes (1-9999)**

Indicate how much time the modem will remain connected.

(7) **Close**

Leave the Communications Setup dialog box and return to the Main Menu.
(8) **Test Communications**
This checks the communications between the computer and the monitor. After you have completed all connections and setups, press the Test button. The response “Communications OK” indicates proper communication between the computer and the monitor.

(9) **Dial**
For modem communications only. See **Chapter 7**.

(10) **Hang Up**
For modem communications only. See **Chapter 7**.

(11) **Initialize PC Modem**
For modem communications only. See **Chapter 7**.

(12) **Initialize Remote Modem**
For modem communications only. See **Chapter 7**.

(13) **Debug**
For modem communications only. See **Chapter 7**.

b. **Series IV Communication Setup**

![Series IV Communication Setup](image)

The **Ethernet Communication Cable, Minimate Pro to PC** (Part No. 720A4101) is the default cable supplied with the Minimate Pro. A router or **Ethernet** card hardware is supplied by the customer.

**Ethernet** communication feature includes downloading recorded events and uploading setup files to the unit at a much faster rate than serial or USB. And, with the optional **Blastware Advanced Module**, the ability to view **Histogram** data in real-time is available.
Below is a table describing the common terminology used for this communication protocol, followed by brief descriptions for each command within the **Series IV Ethernet** dialog. Below the table and the descriptions, in **Step 5**, are detailed instructions on how to successfully communicate with the unit using the **Automatic IP Address** or **Static IP Address** communication protocols. In some instances, you may require the assistance of your **Network Administrator** to achieve successful communications with your unit. Refer to the **Minimate Pro Operator Manual** for additional information about setting up the **Ethernet** communications feature.

<table>
<thead>
<tr>
<th>LAN – Local Area Network</th>
<th>A LAN is a communications system that links computers and/or devices (Printers, Monitors, Servers, etc.) within a confined geographic area, such as a home or office building.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAN – Wide Area Network</td>
<td>A WAN is a communications system that links computers and/or devices within a larger network, such as between cities or different building locations.</td>
</tr>
<tr>
<td>TCP/IP – Transmission Control Protocol/Internet Protocol</td>
<td>TCP/IP is the backbone communication language of the internet or intranet. This is the most reliable means of communication for the Series IV units.</td>
</tr>
<tr>
<td>UDP/IP – User Datagram Protocol/Internet Protocol</td>
<td>UDP/IP is communication protocol that utilizes one-way data transmission in a network. Files or blocks of information are divided and transferred during a communication session.</td>
</tr>
<tr>
<td>DNS – Domain Name Server</td>
<td>DNS hosts domain names and acts as the ‘phone book’ for the Internet by creating IP Addresses from domain names. DNS routes all queries for your domain to your server.</td>
</tr>
<tr>
<td>IP Address – Internet Protocol</td>
<td>The IP Address is a unique address assigned for devices to communicate with one another over a computer network.</td>
</tr>
<tr>
<td>DHCP (Dynamic Host Configuration Protocol) Server</td>
<td>DHCP is a communications protocol that lets devices on a network advertise and negotiate operations (for example, link speed, data flow control). A DHCP server assigns temporary IP addresses to connected devices.</td>
</tr>
<tr>
<td>Automatic IP (DHCP Client)</td>
<td>The configuration for the unit when a DHCP server is being used. The Automatic IP Address configuration uses DHCP to acquire its network configuration settings.</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>A set (non-dynamic) IP address. A Static IP Address remains unchanged, even when rebooting your PC or Router. Obtain your Static IP from your network administrator or local Internet Service Provider.</td>
</tr>
<tr>
<td>Static IP Mask</td>
<td>Static IP Masks are used to separate IP networks into subgroups. Obtain your Static IP Mask from your network administrator or local Internet Service Provider.</td>
</tr>
<tr>
<td>Router</td>
<td>A Router is a device that acts as a gateway, controlling messaging for communication and access to network resources, between a LAN and a WAN. The router is supplied by the customer.</td>
</tr>
</tbody>
</table>

(1) **Ethernet/Modem Communications**
Select **Ethernet/Modem Communications** to activate the dialog area to edit and/or establish communications with the unit using the **TCP/IP** or **UDP/IP** communication protocols.

(2) **Automatic IP Address (Series IV Only)**
Select **Automatic IP Address** to use this communication mode. See the table above for a description.

(3) **Static IP Address**
Select **Static IP Address** to use this communication mode. See the table above for a description.
(4) **Port**
Assign a port address if there are conflicts with other devices on the Ethernet network.

(5) **Disconnect**
Disconnect the unit from the Ethernet network.

(6) **Test Communications**
Select the Test button for either communication mode, **Automatic IP Address** or **Static IP Address**, to ensure that you have established a successful communication link with the unit.

(7) **Protocol**
Select **UDP/IP** if you are communicating with a modem that supports the **UDP Protocol**, otherwise select the **TCP/IP Protocol**. TCP/IP is the recommended communications protocol.

(8) **Ethernet Setup**
For communicating with **Series IV** monitors, you can connect to the PC directly or connect to a switch, router, or hub.

If you have purchased a router, follow the manufacturer’s installation instructions, and if required, contact your **Network Administrator** for troubleshooting. By direct or router connection using either the **Automatic** or **Static IP** protocol, **Ethernet** takes approximately one minute to negotiate an initial, successful communication.

For **Series IV**, there are two ways of obtaining IP addresses to establish communications,

a) **Automatic (Auto) IP Address**, and

b) **Static IP Address** (refer to the terminology table above) for **Series IV**.

**NOTE:** When connecting directly to a PC, it is recommended that the Static IP Address option be used since the Automatic IP Address option requires a DHCP server.

*For the setup of communications using **Automatic IP Address**, follow these directions:*

i **Set up the Automatic IP Address on the Minimate Pro**

**NOTE:** When using the Automatic IP Address option with a switch, router, or hub, the network is required to have a DHCP server. If it does not, the Automatic IP Address option will not be successful.

1. With the Minimate Pro connected to your computer, switch, router, or hub, start the Minimate Pro and click the Setup button. Press the Down Arrow key until View/Edit Preferences is highlighted and press the Enter key.

2. Press the Down Arrow key until Ethernet is highlighted and press the Right Arrow key.

3. Set the following options:
   - **Ethernet**: On
   - **Mode**: Automatic

4. Press the Enter key twice to exit.

5. If the mode was changed from Static to Automatic, reboot the Minimate Pro.

ii **Set up Blastware to Communicate with a Minimate Pro Configured to use an Automatic IP Address**

1. Start Blastware.

2. With the Series IV check box in the bottom menu checked, click the Unit menu, then click Communications.

3. Check the Ethernet/Modem Communications check box.

4. (Optional) If communicating with a modem that supports UDP/IP, check the UDP/IP check box.

5. Check the **Automatic IP Address** check box.
6. Click the **Test Communications** button.
   - If you have a single unit, the results of the communication will be displayed in a dialog box. Click the **OK** button.
   - If you have more than one unit, a list of units will be displayed. Click the name of the unit you will set up and click the **Test** button. Click **Exit**.

7. Click the **Close** button.

For the setup of communications using **Static IP Address**, please follow these directions:

**NOTE:** When setting up Ethernet communications for a Minimate Pro directly connected to a PC using a static IP address, you must have administration rights on your computer.

**i Set up the Static IP Address on the Computer**

1. Obtain an IP address and subnet mask from your Internet service provider or Network administrator.
2. On your computer, switch, router, or hub, set the IP address to the IP address you received from your Internet service provider or Network administrator. For information on how to set the IP address, see the documentation provided with your computer, switch, router, or hub.
3. Set the subnet mask of your computer, switch, router, or hub to the subnet mask you received from your Internet service provider or Network administrator. For information on how to set the IP address, see the documentation provided with your computer, switch, router, or hub.

**ii Set up the Static IP Address on the Minimate Pro**

1. With the Minimate Pro connected to your computer, switch, router, or hub, start the Minimate Pro and click the **Setup** button. Press the **Down Arrow** key until **View/Edit Preferences** is highlighted, then press the **Enter** key.
2. Press the **Down Arrow** key until **Ethernet** is highlighted, then press the **Right Arrow** key.
3. Set the following options:
   - **Ethernet**: On
   - **Mode**: Static IP
4. Set the **Static IP Address** to the IP address you received from your Internet service provider or Network administrator.
5. Set the **Static IP mask** to match the subnet mask being used on the computer you want to connect to.
6. Press **Enter** twice to exit.

**iii Set up Blastware to Communicate with a Minimate Pro Configured to use a Static IP Address**

1. Start Blastware.
2. With the **Series IV** check box in the bottom menu checked, click the **Unit** menu, then click **Communications**.
3. Check the **Ethernet/Modem Communications** check box.
4. (Optional) If communicating with a modem that supports UDP/IP, check the **UDP/IP** check box.
5. Check the **Static IP Address** check box and enter the IP address you set for the Minimate Pro.
6. In the **Port** box, enter **9034**.
7. Click the **Test Communications** button.
If you have a single unit, the results of the communication will be displayed in a dialog box. Click the OK button.

If you have more than one unit, a list of units will be displayed. Click the name of the unit you will set up and click the Test button. Click Exit.

8. Click the Close button.

4.2.2 Compliance Setup – Series II, Series III and Micromate

NOTE: The Series IV Compliance Setup is covered in the next section.

This section of the manual reviews the Compliance Setup for Series II, Series III and Micromate units. To display the Compliance Setup preferences window select the Unit Type and then the Unit Menu, Setup, and then Compliance Setup. The associated Compliance Setup dialog which appears has several tabbed dialogs: Recording Setup, Notes, Special Setups, Printer Setup (Series III monitors only), and Setup Files. In the lower, right hand corner of this window, there is a message that either states “PC is not attached to a unit.” or a comparison of the operating system version. Example: “Operating system version 4.33 on unit, 8.0 on disk.” For the best results while using the Compliance Setup window, ensure that the two versions match. To update the unit operating system, refer to the Reload Operating System section in this manual.

After making changes within any given tabbed Setup dialog, you have the choice to either reject the changes by clicking on Cancel, which exits the Compliance Setup, or accept any changes by clicking on Send to Unit, which will update the settings on the attached unit.

The dialog will initially contain the settings of the attached unit.

a. Micromate Recording Setup

Note: The Recording Setup for Series II and III is covered in the next step.
(1) **Recording Mode**

The record mode sets how the monitor records Events. To choose a recording mode, click on the **Recording Mode** drop-down menu and select one of the following recording modes:

i **Waveform**

Use Waveform Record Mode to record multiple Events automatically with no dead time between Events. The monitor records an Event, displays the results, and continues to monitor, ready to record following Events. The monitor records all Events whose activity exceeds the preset trigger level.

ii **Waveform Manual**

Use Waveform Manual Record Mode if automatic triggering is unreliable, due to excessive wind or nearby vehicle activity, or to record the background noise level in the vicinity of a site. Recording can be initiated from the Unit Monitor Status dialog.

iii **Histogram Record Mode (Strip Chart)**

Use the Histogram Record Mode for long-term recording periods such as monitoring of pile driving operations.

In Histogram Record Mode, the monitor stores summary information in intervals. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. This reduces the data recorded and greatly increases the monitors storage capacity. For each interval, the monitor calculates the maximum peaks, the frequency of the largest peak, and the peak vector sum. For each channel, the maximum peak and its frequency are calculated. Also the largest peak vector sum is calculated over the entire Event. Histogram Record Mode displays the peak of each interval in a bar chart, while tabular format represents the peaks as numbers.

iv **Histogram Combo Mode**

The Histogram Combo Mode creates a waveform recording during a Histogram recording if the signal exceeds the waveform trigger level. The waveform Event is saved as a separate file while
the Histogram Event file remains continuous, only limited by the amount of available memory. The auxiliary trigger is automatically disabled during Histogram Combo Mode.

The maximum sample rates in this mode are 1024, 2048, and 4096.

(2) **Record Stop Mode**

The Record Stop Mode sets how the monitor stops recording after being triggered. Select a Record Stop Mode if you are using Waveform or Histogram Combo Record Modes. You can choose between a **Fixed Record Time** setting or an **Auto Record** setting. **Fixed Record Time** sets the record time to a specified length. Once the record time has elapsed, the monitor stops recording. In **Auto Record**, unlike the **Fixed Record Time**, the monitor continues to record Event activity as long as that activity remains above the trigger level (sufficient memory and battery power must be available). Recording stops a specified period of time after the Event activity falls below the trigger level. Use the **Auto Record** mode if you are unsure of the actual Event duration.

To Select a Record Stop Mode, position the mouse pointer on the **Record Stop Mode** drop-down menu and click the mouse button. Choose **Fixed Record Time** or **Auto Record**.

(3) **Sample Rate**

The monitor has three sample rates; standard (1024 samples per second), fast (2048 samples per second), and faster (4096 samples per second on channels 1 to 4 only). The choice of a sample rate depends on the type of monitoring you are conducting. Increasing the sample rate increases the accuracy of the waveform recording. For this reason, set the sample rate according to the location of the standard transducer or the Micromate. For close-in or near field monitoring, set the sample rate to 4096 samples per second. For far-field monitoring, set the sample rate to 1024 samples per second. Increasing the sample rate also increases the amount of memory required to store Events and reduces the number of Events that can be stored on the monitor. It also reduces the battery life.

To choose a recording rate, click on the **Sample Rate** drop-down menu. Click the mouse pointer on the required sample rate. The maximum sample rates in this mode are 1024, 2048, and 4096.

(4) **Record Time**

This setting changes between record times depending on the Record Stop Mode chosen above. If you chose **Fixed Record Time**, enter a time in seconds in the Record Time box.

(5) **Histogram Interval**

Set the Histogram Interval if Histogram or Histogram Combo Record Mode was chosen. The Histogram Interval is the period of time the monitor records Event information before applying the data analysis techniques. For each interval, the monitor calculates the maximum positive or negative peaks, the frequency of the largest peak, and one peak vector sum. For each channel the maximum peak and its frequency are displayed in the summary data. The maximum peak vector sum is calculated over the entire Event is also displayed. Select the drop-down list to set the desired Histogram Interval time.

(6) **Enable Standard Geophone**

The Geophone channels record ground vibrations. In this section of the dialog box, you enable the geophone channels by selecting the **Enable Standard Geophone** option.

i **Enable Trigger**

Click on the **Enable Trigger** checkbox to use the geophone channels as a Trigger Source. For example, when selecting the geophone as a trigger source, Event recording begins on all these channels when Event activity exceeds the Trigger Level of the geophone. Refer to Trigger Level, below.

ii **Trigger Level**

The Trigger Level sets a threshold that must be exceeded by an Events activity before the monitor begins recording. Use your judgment when setting a Trigger Level. You must set the level high enough so the unit does not trigger on unwanted Events such as nearby vehicle traffic. At the same
time, you have to set the trigger level low enough so that an Events activity exceeds the trigger level and starts the unit recording.

To set a trigger level, click on the **Trigger Level** box. Enter the new level.

**Note:** In certain situations, the actual trigger level may be lower than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the geophone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest lower value.

The available Trigger Level range is 0.127 – 254.0 mm/s.

**7) Enable ISEE Microphone**

The microphone channel records air over pressure. In this section of the Micromate Recording Setup dialog, you enable the **Microphone ISEE Channel**, select the channel as a Trigger Source, and set a Trigger Level.

i **Enable Trigger**

Click on the Enable Trigger checkbox to use the microphone channel as a Trigger Source. For example, when selecting the microphone as a Trigger Source, Event recording begins on all enabled channels when Event activity exceeds the Trigger Level of the microphone. Refer to Trigger Level, below.

ii **Trigger Level**

Set a **Trigger Level** for the microphone. To set a Trigger Level, click on the **Trigger Level** text box. Enter the new level.

**Note:** In certain situations, the actual trigger level may be lower than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the microphone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest lower value.

The available Trigger Level range is 100 – 148 dB(L).

**8) Enable Sound Level Microphone**

The optional Sound Level Microphone (Part No. 720A5101) records acoustic noise. In this section of the Micromate Recording Setup dialog, you enable the **Sound Level Microphone Channel**, select the channel as a Trigger Source, set a Trigger Level, choose A- or C-weighting, choose fast or slow response time, and set statistical noise levels.

i **Enable Trigger**

Click on the Enable Trigger checkbox to use the microphone channel as a Trigger Source. For example, when selecting the microphone as a trigger source, Event recording begins on all enabled channels when Event activity exceeds the Trigger Level of the microphone. Refer to Trigger Level, below.

ii **Trigger Level**

Set a **Trigger Level** for the microphone. To set a Trigger Level, click on the **Trigger Level** text box. Enter the new level.

**Note:** In certain situations, the actual trigger level may be lower than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the microphone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest lower value.

The available Trigger Level range is 33 – 140 dB.
iii **A-Weighting**
Set the frequency weighting filter. A-weighting mimics the frequency sensitivity of the ear at low levels, filtering out most of the low-frequency noise. A-weighted measurements are expressed as dBA.

iv **C-Weighting**
Set the frequency weighting filter. C-weighting mimics the frequency sensitivity of the ear at high levels, including more of the low-frequency range of noise than A-weighting. C-weighted measurements are expressed as dBC.

v **Fast**
Set the response time weighting to 125mS.

vi **Slow**
Set the response time weighting to 1 second.

vii **L(N1)**
Set a statistical noise level, expressed as a percentage. L(N1) must be between 1-98 and must be less than L(N2).

viii **L(N2)**
Set a statistical noise level, expressed as a percentage. L(N2) must be between 2-99, and must also be greater than L(N1).

b. **Series II and III Recording Setup**

*Note:* The Recording Setup for Micromate is covered in the previous step.

The record mode sets how the monitor records Events. To choose a recording mode, click on the Recording Mode drop-down menu and select a record mode. Choose one of the following recording modes.

i **Single Shot Record Mode**
Use single shot record mode to record one Event automatically. The monitor records the Event, displays the results, and stops. No further recording occurs. Recording begins automatically when an Events vibration or overpressure channel exceeds the preset trigger level.
**Continuous Record Mode**

Use continuous record mode to record multiple Events automatically with no dead time between Events. The monitor records an Event, displays the results, and continues to monitor, ready to record following Events. The monitor records all Events whose activity exceeds the preset trigger level.

**Manual Record Mode**

Use manual record mode if automatic triggering is unreliable, due to excessive wind or nearby vehicle activity, or to record the background noise level in the vicinity of a site. Recording can be initiated from the Unit Monitor Status dialog.

**Histogram (Strip chart) Record Mode (Blastmate II and Series III only)**

Use the histogram record mode for long-term recording periods such as monitoring of pile driving operations. Histogram record mode operates with both four and eight channel monitors. Four channel histogram Events can be printed on the Blastmate III printer, eight channel Events cannot. Print eight channel Events using the Blastware software program.

In histogram mode, the monitor stores summary information in intervals. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. This reduces the data recorded and greatly increases the monitors storage capacity. For each interval, the monitor calculates the maximum peaks, the frequency of the largest peak, and the peak vector sum. For each channel, the maximum peak and its frequency are calculated. Also the largest peak vector sum is calculated over the entire Event. Events may be printed in histogram or tabular mode using the Blastmate III. Histogram mode displays the peak of each interval in a bar chart, while tabular format represents the peaks as numbers.
v 

**Histogram Combo Mode (Series III only)**

This mode creates a waveform during Histogram recording if the signal exceeds the waveform trigger level. The waveform Event is saved as a separate file while the Histogram Event file remains continuous. A maximum of 13, 1-second waveform Events can be recorded. The auxiliary trigger and printing are automatically disabled during histogram combo mode.

The maximum sample rates in this mode are as follows:

a. 4 channels or less: 2048 samples per second 
b. more than 4 channels: 1024 samples per second 

(2) **Record Stop Mode**

The Recording Stop Mode sets how the monitor stops recording after being triggered. Choose a record stop mode if you are using the single shot or continuous record modes. You can choose between a **Fixed Record Time** setting or an **Auto Record** setting. **Fixed Record Time** sets the record time to a specified length. Once the record time has elapsed, the monitor stops recording. In **Auto Record**, unlike the **Fixed Record Time**, the monitor continues to record Event activity as long as that activity remains above the trigger level (sufficient memory and battery power must be available). Recording stops a specified period of time after the Event activity falls below the trigger level. The specified period of time, called the **Auto Window**, can be adjusted. Use the **Auto Record** mode if you are unsure of the actual Event duration.

To choose a Recording Stop Mode, position the mouse pointer on the **Recording Stop Mode** drop-down menu and click the mouse button. Choose **Fixed Record Time** or **Auto Record**.

(3) **Sample Rate**

The monitor has three sample rates; standard (1024 samples per second), fast (2048 samples per second), and faster (4096 samples per second on channels 1 to 4 only). The choice of a sample rate depends on the type of monitoring you are conducting. Increasing the sample rate increases the accuracy of the waveform recording. For this reason, set the sample rate according to the location of the standard transducer or the Minimate Plus. For close-in or near field monitoring, set the sample rate to 4096 samples per second. For far-field monitoring, set the sample rate to 1024 samples per second. Increasing the sample rate also increases the amount of memory required to store Events and reduces the number of Events that can be stored on the monitor. It also reduces the battery life.

To choose a recording rate, click on the **Sample Rate** drop-down menu. Click the mouse pointer on the required sample rate.

(4) **Record Time/Auto Window**

This setting changes between record time and auto window depending on the record stop mode chosen above. If you chose **Fixed Record Time**, enter a time in seconds in the Record Time box. If you chose **Auto**, enter a value for the Auto Window ranging from one to nine seconds.

(5) **Histogram Interval**

Set the Histogram Interval if histogram or histogram combo record mode was chosen. The histogram interval is the period of time the monitor records Event information before applying the data analysis techniques. For each interval, the monitor calculates the maximum negative peaks, the frequency of the largest peak, and up to two peak vector sums (one for 4 channel monitors, two for 8 channel monitors). For each channel the maximum peak and its frequency are calculated. The peak vector sum is calculated over the entire Event. See the Blastmate III or the Minimate Plus manual for approximate histogram recording times.

(6) **Storage Mode**

The storage mode setting allows you to set the amount of data stored with each Event. In the Full Data setting, the monitor stores all Event data. When **Save Summary Only** is selected, only the peaks are stored in the Event – the individual sample rates are not stored.
To select a storage mode, click on the Storage Mode drop-down menu. Click the mouse pointer on either Save All Data or Save Summary Only.

(7) Geophone Type
Select the type of geophone that you are using.

(8) Geophone Channels
The Geophone channels record ground vibrations. In this section of the dialog box, you enable the Geophone channels, select the channels as a trigger source, set a trigger level and choose a range.

i Enable all geophones
Click on this checkbox to turn the Geophone channels on when monitoring. Click on the box again to clear the checkmark to turn the channels off and not record ground vibrations. Note that the other checkboxes in the section fade indicating they cannot be selected. On eight channel monitors, enabling all Geophones turns on all the Geophone channels, one to three and five to seven.

ii Trigger Source
Click on this checkbox to use the Geophone channels as a trigger source. The Trigger Level box brightens indicating it can be set. For eight channel monitors, choosing a trigger source applies to both sensor groups. For example, choosing Geo as a trigger source designates both Geophone transducers as trigger sources. Triggering occurs and Event recording begins on all channels when Event activity exceeds the trigger level of either Geophone transducer.

iii Trigger Level
The trigger level sets a threshold that must be exceeded by an Events activity before the monitor begins recording. Use your judgment when setting a trigger level. You must set the level high enough so the unit does not trigger on unwanted Events such as nearby vehicle traffic. At the same time, you have to set the trigger level low enough so that an Events activity exceeds the trigger level and starts the unit recording.

On eight channel monitors, set the trigger levels for the first standard transducer in the first text box then set the trigger level for the second standard transducer in the second text box.

To set a trigger level, double click on the Trigger Level box. Enter the new level.

Note: In certain situations, the actual trigger level may be lower than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the Geophone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest lower value.

iv Maximum Range
The Maximum Range specifies the measurement limits of the standard transducers Geophones. Two ranges are available; Normal 10.0 in/s (254 mm/s) and Sensitive 1.25 in/s (31.7 mm/s). Choosing a geo range depends on the proximity of the transducer to the Event and the expected particle velocities. On eight channel monitors, set the maximum range for the first standard transducer in the first text box. Set the maximum range for the second standard transducer in the second text box.

To choose a maximum range, click on the Maximum Range drop-down menu. Choose a range.

(9) Microphone Channel
The microphone channel records air over pressure. In this section of the Recording Setup dialog box, you enable the microphone channel, select the channel as a trigger source, and set a trigger level.

i Enable all microphones
Click on this checkbox to turn the microphone channel on when monitoring. Click on the box again to clear the checkmark to turn the channel off and not record sound pressure during
monitoring. Note the other checkboxes in the section fade indicating they cannot be selected. On eight channel monitors, enabling all microphones turns on the microphone channels four and eight.

ii **Trigger Source**
Click on this checkbox to use the microphone channel as a trigger source. The Trigger Level checkbox brightens indicating it can be set.

**Note:** You can set both the Geophone and Microphone Channels as trigger sources. An Events activity has to exceed only one of the trigger levels to start recording Event activity on all channels.

iii **Trigger Level**
Set a trigger level for the microphone. On eight channel monitors, set the trigger level for the first microphone in the first text box then set the trigger level for the second microphone in the second text box.

To set a trigger level, click on the Trigger Level text box. Enter the new level.

**Note:** In certain situations, the actual trigger level may be lower than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the microphone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest lower value.

c. **Edit Compliance Setup ‘More’ for Series II, III and IV**

![Image of Compliance Setup window]

**Note:** Edit Compliance Setup ‘More’ for Micromate is covered in the next step.

i **Geophone Alarm Level**
The alarm level controls the triggering of an optional Remote Alarm Controller, Part No. 721A0902 for Series III and Series IV).

The remote alarm can sound two alarms: warning and alarm. The warning alarm sounds when Event activity exceeds the Trigger Level for the Geophone. The alarm level can be set to a different level that is higher than the trigger level of the Geophone. This allows for the triggering of a second alarm at the higher level.

For example, in pile driving operations the remote alarm triggers a warning when activity exceeds the trigger level for the Geophone, notifying the operator that the pile driving activity has
exceeded that set level. The second alarm triggers when activity exceeds the alarm level, set to a higher level, notifying the operator to re-evaluate the piling operation.

To set an alarm level, double click on the **Alarm Level** box. Enter the new level that is within the stated range (Range: 0.508 – 254 mm/s).

ii **Microphone Alarm Level**

For a description of the optional remote alarm, see the Geophone channel in the previous section. To set an alarm level, click on the **Microphone Alarm Level** box. Enter the new level that is within the stated range (Range: 100.0 – 148 dB(L)).

iii **Microphone Type (Chan 4 or Chan 8)**

Select the microphone type being used; either Linear “L” or “A” Weight. Click on the **Type** drop-down menu and select the Linear or “A” Weight. On eight channel monitors, set the microphone type for the second microphone in the second text box.

iv **Enable Auxiliary Trigger**

This command turns on the Auxiliary Trigger feature and allows the monitor to be triggered by an external trigger. Instantel offers a variety of external triggers including the DS–20 Wire Break Trigger package (Part Number 677A9601).

To enable the **Auxiliary Trigger**, click on the checkbox to display checkmark.

v **Channels**

Select the number of **Channels** you would like to record data on by clicking on their associated radio button.

vi **Channel Names**

The channel names can be changed. These names appear throughout the software including in printed Event reports. The default names describe the compliance sensors connected to the monitor. The new names can be alphanumeric up to five characters in length. To change the **Channel Names**, double click on the existing name and enter the new name.

(2) **Command Buttons**

To choose one of the following command buttons, click the mouse pointer on the button.

i **Cancel**

Exit the dialog box and return to the previous Recording Setup dialog without accepting the changes.

ii **OK**

Approve the changes in this dialog box.
d. Edit Compliance Setup 'More' for Micromate

Note: Edit Compliance Setup 'More' for Series II and III is covered in previous step.

(1) The **More** dialog within the Micromate Recording Setup dialog allows you to configure the optional Auxiliary I/O for an optional external trigger or the optional Remote Alarm (Part No. 721A0901). Refer to the associated product specification sheet (Part No. 714U0901) that was shipped with the Remote Alarm for more information. The Remote Alarm must be attached to the optional Auxiliary Port (Part No. 721A0101) on the Micromate.

i Geophone Alarm Level

The alarm level controls the triggering of an optional Remote Alarm Controller, Part No. 721A0901 for Micromate.

The remote alarm can sound two alarms: Warning and Alarm. The Warning Alarm sounds when Event activity exceeds the **Geophone Alarm Level**. The alarm level can be set to a different level that is higher than the trigger level of the Geophone. This allows for the triggering of a second alarm at the higher level.

For example, in pile driving operations the remote alarm triggers a warning when activity exceeds the trigger level for the Geophone, notifying the operator that the pile driving activity has exceeded that set level. The second alarm triggers when activity exceeds the alarm level, set to a higher level, notifying the operator to re-evaluate the piling operation.

To set an alarm level, double click on the **Geophone Alarm Level** box. Enter the new level that is within the stated range (Range: 12.570 – 254.000 mm/s).

ii Microphone Alarm Level

For a description of the optional remote alarm, see the Geophone channel in the previous section.

To set an alarm level, click on the **Microphone Alarm Level** box. Enter the new level that is within the stated range (Range: 130 – 148 dB(L)).

iii Auxiliary I/O

This command turns on the optional **Auxiliary I/O** feature, factory installed at the time of purchase, and allows the monitor to be triggered by an **External Trigger** or a **Remote Alarm**. If you do not want to use this feature, set **Auxiliary I/O** to **Off**. To enable the **Auxiliary I/O**, click on the radio button next to the accessory that you will be using, **External Trigger**, such as a wire make/break, or **Remote Alarm**.
When the **Remote Alarm** option is selected, the **Warning Hold Time**, **Alarm Hold Time**, and **Alarm On** drop down boxes become available. The **Alarm On** option allows you to select which sensor setup and activity that you would like to initiate a **Remote Alarm**.

iv. **Warning Hold Time**
Set the duration of time for the warning. The default setting is **Manual Clear**, which requires pressing the **Enter** (Checkmark) key at the unit. Additional settings include 2, 5, 15, 30, 60, 180 and 300 seconds.

v. **Alarm Hold Time**
Set the duration of the alarm. The default setting is **Manual Clear**, which requires pressing the **Enter** (Checkmark) key at the unit. Additional settings include 2, 5, 15, 30, 60, 180 and 300 seconds.

i. **Pre Trigger**
The **Pre Trigger** feature captures up to one second of buffered event data that was recorded prior to the set **Trigger Level**, and includes it in the final recorded **Event Data**. Set a **Pre Trigger** range from 0.25 Sec to 1.00 Sec.

(2) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.

i. **Cancel**
Exit the dialog box and return to the previous Recording Setup dialog without accepting the changes.

ii. **OK**
Approve the changes in this dialog box.

e. **Notes**
To display the Notes dialog box, open the **Unit, Setup, Compliance Setup** menu and select the **Notes** tab. The Edit Notes dialog box appears.

The Notes dialog box lets you enter notes about an Event. These notes are then saved with the Event when it is recorded. The notes become part of the permanent record and cannot be changed after an Event has been recorded. The notes are very flexible, offering you the ability to change their titles and content.
To enter notes, click on a space and delete the existing note by pressing and holding the Backspace key. Enter the new notes for each User Notes field box.

1) **Enable User Notes**

When you enable user notes, the information contained in the User Notes dialog box is recorded with every Event. If you do not require this information, disable user notes by clicking on the **Enable User Notes** checkbox to clear the checkmark.

2) **User Notes**

Enter the notes you wish to include with the recorded Events. You can include user note headings like the ones in the figure above. You can use these headings or delete them and enter your own. You can also delete them entirely and use no headings. Headings can range up to 20 characters in length. In the right hand column, enter your user notes. User notes can range up to a maximum of 64 characters in length.

3) **Extended Notes**

Use this area to enter additional notes as required up to a maximum of 640 characters.

4) **Enable Extended Notes**

When you enable extended notes, the information contained in the Extended Notes dialog box is recorded with every Event. If you do not require this information, disable extended notes by clicking on the **Enable Extended Notes** checkbox to clear the checkmark.

5) **Extended Notes Title**

Enter a name for the extended notes section up to 20 characters in length.

6) **Enable Job Number**

You may include a job number to identify a series of recorded Events. This helps you keep track of Events in the monitor and on your computer. To enable the Job Number, click the mouse pointer on the **Enable Job Number** checkbox to enter a checkmark.
(7) **Job Number**
Enter a job number. Job numbers range from 1 to 9999. Double click on the **Job Number** box and enter a new job number.

(8) **Enable Scaled Distance**
Check this box to enable the recording of scaled distance information with each Event. Enter the Distance from blast and the Charge Weight. Blastware automatically calculates and displays the Scaled Distance value. The value appears both within this dialog box and on Event Summary Reports.

(9) **Distance from blast**
Enter the distance from the monitor to the blast in feet or meters.

(10) **Charge Weight**
Enter the charge weight of the blast in pounds or kilograms.

(11) **Scaled Distance**
The Scaled Distance result appears within this dialog box and on Event Summary Reports.

(12) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.
   
   i. **Cancel**
   
   Exit the dialog box and return to the Blastware Main Menu.
   
   ii. **Send To Unit**
   
   Transfer your settings to the monitor.

f. **Special Setups (Micromate)**
Refer to **Special Setups** within the **Compliance Setup** for **Series IV**, Section 4.2.3.

f. **Special Setups (Series II and III)**
To display the Special Setups dialog box, open the **Unit, Setup, Compliance Setup** menu and select the **Special Setups** tab.

The Special Setup dialog box includes setting the timer, self check mode and time, when Sensor Check operates, measurement units, microphone units, time format, Backlight on Time, Power Saving Timeout, and the Monitoring LCD Cycle. After you have entered your settings in each dialog box, choose **Send** to transfer your settings to the monitor.
(1) **Unit Timer**

The timer function sets the monitor to automatically turn on and start monitoring operations at a preset time in the future. The timer can be set for a one time monitoring session or it can be set to record at the same time every day. Using the timer extends the monitors battery life by turning on and monitoring only the time periods when Events occur and not the time periods between Events.

**Note:** When using a monitor in the Timer Mode, the monitor stops recording even if Event activity is present and exceeds the trigger levels. The monitor waits until after the present Event is recorded. If recording in the Histogram Record Mode, the monitor stops recording immediately and discards the last histogram interval if incomplete.

(2) **Timer Mode**

The timer can be set for a one time operation or repeated operations at the same time each day.

- **Off**
  Choose this setting if you do not require the unit timer.

- **Monitor Once Only**
  Choose this setting if you want the monitor to turn on monitor for a set period of time, then turn off. Open the **Timer Mode** drop-down menu and choose **Monitor Once**.

  - **Start Date**
    Enter the calendar date when you want the monitor to turn on.

  - **Start Time**
    Enter the time of day when you want the monitor to turn on and start monitoring.

  - **Stop Date**
    Enter the calendar date to turn the monitor off.

  - **Stop Time**
    Enter the time of day to turn the monitor off and stop monitoring.
After you have configured the timer, click on **Send** to send the settings to the monitor. Next, you must enter the monitor into the Monitor Mode. To do this, choose **Start Monitor** from the **Monitor** command located under the **Unit Menu**.

### iii Monitor Every Day

Choose this setting if you want the monitor to turn on and record at the same time every day beginning immediately. Open the **Timer Mode** drop-down menu and choose **Monitor Every Day**. Note the Start Date and Stop Date items dim indicating they do not require setting in this timer mode.

- **Start Time**
  Enter the time of day when you want the monitor to turn on and start monitoring.

- **Stop Time**
  Enter the time of day to turn the monitor off and stop monitoring.

After you have configured the timer, click on **Send** to send the settings to the monitor. Next, you must enter the monitor into the Monitor Mode. To do this, choose **Start Monitor** from the **Monitor** command located under the **Unit Menu**.

### (3) Self Check Mode

Use the Self Check Mode for remote monitoring where you require a record indicating the monitor was operating properly over a period of time. The self check mode only occurs when the monitor is in the monitor mode. The monitor temporarily exits the monitor mode, at the same time each day specified by you, performs the check, and returns to monitor mode. The results appear in a monitor log entry.

To set the self check mode, move the mouse pointer to the **Self Check Mode** drop-down menu and click. Choose **On** to turn the self check mode on. Choose **Off** if you do not require self check to operate.

### (4) Time

Enter a time for the Self Check Mode to run. Click on the **Time** boxes and enter a time.

### (5) Sensor Check

This setting chooses when to automatically run Sensor Check to test your monitor and its sensors. You can choose to run Sensor Check after recording each Event or only once before a monitoring session starts. You can also choose to disable Sensor Check. If you choose **After Each Event**, Sensor Check runs after recording each Event. Results are saved with each Event and appear on the monitor display. If you choose **Before Monitoring**, Sensor Check runs once before monitoring starts, immediately after you enter the monitor mode. The results of this single Sensor Check appear with each Event recorded during the monitoring session. This setting provides a zero recycle time and ensures you cannot miss an Event when using the continuous record mode (the Automatically Print Event After Recording function in the Printer Setup dialog box must also be turned off).

To select a Sensor Check position, click on the **Sensor Check** drop-down menu. Click on **After each Event** or **Before monitoring**. Select **Disabled** if you do not wish to use Sensor Check.

### (6) Measurement Units

The Blastmate III and Minimate Plus use either **Metric** or **Imperial** measurement units.

To choose the measurement units, position the mouse pointer on the **Measurement Units** drop-down menu and click. Click on either **Metric** or **Imperial**.

### (7) Time Format

This sets the time format for the monitors clock. You can choose between the 24 hour and the 12 hour AM/PM time formats.

To choose a time format, click on either button.
(8) **Backlight on Time**
This command sets the length of time the backlight remains on by setting an adjustable timer from 0 to 255 seconds. To disable the backlight and not have it turn on, set the timer delay to 0. This conserves battery power.
To set the Backlight on Time, click on the **Backlight on Time** box and enter a new time.

(9) **Power Saving Timeout**
The Power Saving Timeout is a timer that automatically turns the monitor off when it has remained in the ready to monitor mode while detecting no key presses for a specified period of time. This conserves battery power. The monitor will also turn off while connected to a computer but automatically turns on again when the computer communicates with the monitor.
To set the Power Saving Timeout, click on the **Power Saving Timeout** box and enter a new time.

(10) **Monitoring LCD Cycle**
The Monitoring LCD Cycle is a timer that automatically starts a power saving mode. While in this mode, the monitor minimizes power consumption while continuing its monitoring operations. The monitor turns the display off for the time period set in this command, turns on the display momentarily, then cycles the display off again. To turn this feature off, set the time to zero. To reactivate the monitor and see the display, press the **On/Off** key.
To set the Monitoring LCD Cycle, click on the **Monitoring LCD Cycle** box and enter a new time.

(11) **Set Unit Time with Setup**
To synchronize the Unit clock with the personal computer clock, place a checkmark in the box prior to selecting **Send to Unit**. Disable **Set Unit Time with Setup** by clicking on the checkbox to clear the checkmark.

(12) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.

   i. **Cancel**
Exit the dialog box and return to the Blastware Main Menu.

   ii. **Send To Unit**
Transfer your settings to the monitor.

h. **Printer Setup (Blastmate III Only)**
To display the Printer Setup dialog box, open the **Unit, Setup, Compliance Setup** menu and select the **Printer Setup** tab.
The Printer Setup dialog box configures the Event Summary Report printed by the Blastmate III printer. Settings include when the report is printed, how many copies will be printed, and the reports contents. After you have entered your settings in each dialog box, choose **Send To Unit** to transfer your settings to the monitor.
(1) **Automatically Print Event After Recording**  
Choose this to print the Event Summary Report immediately after recording an Event. To turn this on, position the mouse pointer on the checkbox and click the mouse button to display a checkmark.

(2) **Copies**  
Multiple copies of the Event Summary Report can be printed automatically. The number of copies ranges from one to ten. Click on the **Copies** text box and enter a new number.

(3) **Print Recording Setup**  
This prints the recording setup used by the monitor to record the Event. The setup information specifies the trigger source, trigger level, record time, sampling rate, and notes. Position the mouse pointer on the **Print Recording Setup** checkbox and click to display a checkmark.

(4) **Print Waveform**  
This prints a graphical waveform representing the Events activity recorded by each channel. To include this, click on the **Print Waveform** checkbox.

(5) **Print Compliance Report**  
Use this command to print the Compliance Report, also known as a National Frequency Standard, on each Event Summary Report. To include the compliance report, click on the **Print Compliance Report** checkbox to display a checkmark.

(6) **Sensor Check**  
This prints a graphical representation of the Sensor Check results for each Geophone and the microphone channel. The Pass/Fail status of the Sensor Check always appears on the Event Report, but the numerical results are only included when the graph is present. You can choose to include the Sensor Check graph in the Event Summary Report or not. Click on the checkbox to display a checkmark and include the Sensor Check graph.
(7) **Histogram Printout**

The setting configures how the Blastmate III printer prints histogram Events. Choose **Graphics** to print a histogram for each recorded interval. Choose **Tabular Data** to print numerical results of the data analysis for each interval. If you do not require printing of histogram record mode results, choose **None**.

(8) **Command Buttons**

To choose one of the command buttons, click the mouse pointer on the button.

i. **Cancel**

Exit the Printer Setup dialog box and return to the Blastware Main Menu. You are prompted to send your changes to the unit.

ii. **Send To Unit**

Transfer your settings to the monitor.

i. **Setup Files**

To display the Library Files dialog box, open the **Unit, Setup, Compliance Setup** menu and select the **Setup Files** tab.

The **Setup Files** dialog box allows you to load and save settings from your PC or the unit, and to specify any changes you have made to be the default settings. These files have a .set file extension.

(1) **Read Setup**

i. **From Disk**

Load a saved setup file from your PC. Locate previously saved setup files and load them to affect the unit currently connected to your PC by clicking on **Send to Unit**.

ii. **From Unit**

Load the setup library files that are currently being used on the unit connected to your PC.
iii Default
Select Default to load the previously saved file.

(2) Save Setup

i To Disk
Save your current setup settings to a file. Click on To Disk, and save the file into the default “Dbase” directory.

ii As Default
Use your current settings as the default every time you connect a unit and click on Default.

(3) Button Commands
To choose one of the command buttons, click the mouse pointer on the button.

i Cancel
Exit the Printer Setup dialog box and return to the Blastware Main Menu.

ii Send To Unit
Transfer your settings to the monitor.

4.2.3 Compliance Setup – Series IV
This section of the manual reviews the Compliance Setup for Series IV units; the Series II and III Compliance Setup is reviewed in the previous section. To display the Compliance Setup preferences window select the Unit menu item and choose Setup, then Compliance Setup. The Compliance Setup dialog which appears has several tabbed dialogs; Recording Setup, Notes, Special Setups, Printer Setup, and Library Files. In the lower, right hand corner of the subsequent tabs, there is a message that either states “PC is not attached to a unit.” or a comparison of the operating system version. Example: “Operating system version 4.33 on unit, 8.0 on disk.” For the best results while using the Compliance Setup window, ensure that the two versions match.

To update the unit operating system, refer to the Reload Operating System section in this manual.

After making changes within any given tabbed Setup dialog, you have the choice to either reject the changes by clicking on Cancel, which exits the Compliance Setup, or accept any changes by clicking on Send To Unit, which will update the settings on the attached unit.

IMPORTANT: After setting up the Monitor Scheduler, refer to the Unit Monitor Status feature, List Setup Files, and List Operator, for additional ways to activate and control the unit without entering the Compliance Setup dialog.
a. Recording Setup

To display the Series IV Recording Setup dialog box, open the Unit, Setup, Compliance Setup to view the setup tab. If a unit is communicating with Blastware then the current setup information will be displayed. If a unit is not attached, than the software will prompt to ensure that you still want to view the Compliance Setup.

The Recording Setup dialog box programs the selected sensors, source and triggers level, as well as the Record Mode and associated Record Mode settings. After you have entered your settings in each dialog box, choose Send to Unit to transfer your settings to the monitor, or under the Setup Files tab, you can save each setup file to your local hard drive for later use or inclusion in recording sessions using the Monitor Scheduler, located under the Special Setups tab. Refer to the Monitor Scheduler section for more information on this feature.

Note: VDV Record Mode is optional and available with the purchase of the Blastware Advanced Module.

(1) Vibration Channels

i Vibration Channels 1, 2, 3 Enable (Minimate Pro4 and Minimate Pro6)

To enable Channels 1, 2, 3, dedicated to vibration monitoring, select the check box next to Vibration Channels 1, 2, 3 Enable. Determine which geophone that you are going to use for monitoring, ISEE Geo or DIN Geo, attach it to the unit and select the appropriate box.

To select the Geophone channels as a Trigger Source, place a checkmark in the box. The Trigger Level box value is enabled for entering values. The trigger level sets a threshold that must be exceeded by an Events activity before the monitor begins recording. Use your judgment when setting a trigger level. You must set the level high enough so the unit does not trigger on unwanted Events such as nearby vehicle traffic. At the same time, you have to set the trigger level low enough so that an Events activity exceeds the trigger level and starts the unit recording.
To set a trigger level, click in the Trigger Level value field. A maximum range for the Trigger Level is indicated at the right once you place your cursor in the value field. The Maximum Range specifies the measurement limits of the ISEE or DIN Geophone transducers. Enter the new level in the value field.

**Note:** You can set both the Geophone and Microphone Channels as trigger sources. An Events activity has to exceed only one of the trigger levels to start recording Event activity on all channels.

**Note:** In certain situations, the actual trigger level may be marginally lower or higher than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the geophone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest value.

**ii Vibration Channels 4, 5, 6 Enable (Minimate Pro4 and Minimate Pro6)**

To enable Channels 4, 5, 6, dedicated to overpressure monitoring on the Minimate Pro4, select the check box next to Vibration Channels 4, 5, 6 Enable. Select the box next to the Linear Mic – this will enable Channel 4 on the unit (Channels 5 and 6 are reserved for the ISEE or DIN Geophone on the Minimate Pro6 for vibration monitoring).

If you have attached an ISEE Linear Microphone to the monitor and selected the ISEE Linear Microphone option, the channel records air over pressure. In this section of the Recording Setup dialog box, you can enable the microphone channel, select the channel as a Trigger Source, and set a Trigger Level.

If you have attached an optional Sound Level Microphone (Part No. 720A5101) to the monitor and selected the Sound Level Microphone option, the channel records acoustic noise. In this section of the Recording Setup dialog box, you can enable the microphone channel and select the channel as a Trigger Source. Afterwards, set the Trigger Level, A-Weighting or C-Weighting, and the response of Fast or Slow.

1. To set a trigger level, click in the Trigger Level value field. A maximum range for the Trigger Level is indicated at the right once you place your cursor in the value field. The Maximum Range specifies the measurement limit of the ISEE Linear Microphone or Sound Level Microphone, dependent on which microphone has been selected.
2. Enter the new level in the value field.
3. Select A-Weighting or C-Weighting, as required for your application.
4. Determine the Response time and select “Fast” or “Slow”
   a. In the next section of the dialog, Record Mode, you set the Sample Rate. If you are only recording with a Sound Level Microphone, this may be set to 512: However, if you are also recording with a Geophone, then set the Sample Rate for that sensor.

**Note:** You can set both the Geophone and Microphone Channels as trigger sources. An Events activity has to exceed only one of the trigger levels to start recording Event activity on all channels. **Note:** In certain situations, the actual trigger level may be marginally lower or higher than the trigger level that you entered. This is because the monitor converts the analog signal it receives from the geophone into digital data, which consists of a series of discrete values. If the trigger level that you entered does not match one of these values, Blastware automatically sets the trigger level to the nearest value.

**iii Vibration Channels 4, 5, 6 Enable (Minimate Pro6)**

For Minimate Pro 6, enable Channels 4, 5, 6, dedicated to over pressure (see description above, Vibration Channels 4, 5, 6 Enable) or vibration monitoring (refer to description under section above Vibration Channels 1, 2, 3 Enable), by selecting the check box next to Vibration Channels 4, 5, 6 Enable. Select the box next to the Linear Mic, the ISEE Geo, or the DIN Geo, dependent on what sensor you have chosen and attached to the unit.
(2) **Recording Mode**

The record mode sets how the monitor records Events. To choose a recording mode, click on the **Recording Mode** drop-down menu and select a record mode. Refer to the **Minimate Pro Operator Manual** for more information on the data displayed on the monitor during recording. Choose one of the following recording modes.

i **Waveform**

Use **Waveform** record mode to record multiple Events automatically with no dead time between Events. The monitor records an Event, displays the results, and continues to monitor, ready to record following Events. The monitor records all Events whose activity exceeds the preset trigger level.

ii **Waveform Manual**

Use **Waveform Manual** record mode if automatic triggering is unreliable, due to excessive wind or nearby vehicle activity, or to record the background noise level in the vicinity of a site. Recording can be initiated from the **Unit Monitor Status** dialog.

iii **Histogram (Strip chart)**

Use the **Histogram** record mode for long-term recording periods such as monitoring of pile driving operations. **Histogram** record mode operates with both four and six channel monitors. In **Histogram** record mode, the monitor stores summary information in intervals. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. This reduces the data recorded and greatly increases the monitor storage capacity. For each interval, the monitor calculates the maximum peaks, the frequency of the largest peak, and the peak vector sum. For each channel, the maximum peak and its frequency are calculated. Also the largest peak vector sum is calculated over the entire Event. **Histogram** record mode displays the peak of each interval in a bar chart, while tabular format represents the peaks as numbers. You are able to capture up to 800,000 intervals. Examples: 18.5 days at 2 second intervals, or 555 days at 1 minute.

iv **Histogram Combo**

**Histogram Combo** record mode creates a waveform during **Histogram** recording if the signal exceeds the waveform trigger level. The waveform Event is saved as a separate file while the **Histogram** Event file remains continuous. Depending on the amount of data collected and the sample rate, you are able to capture thousands of full waveform records while simultaneously recording in histogram mode. Example: 30 days of Histogram recording at 1 minute intervals, and over 7500 1 second waveform events.
v. **VDV (Optional – with Advanced Software Module)**

The optional Vibration Dose Value (VDV) Record Mode is available with the purchase of the Blastware Advanced Module software. If you have a licensed copy of the Blastware Advanced Module, follow the instructions in the Blastware Operator Manual for **Reloading the Operating System** of the Minimate Pro, which will load the VDV feature into the unit. To order your copy of the Blastware Advanced Module, please contact your Instantel Dealer Representative.

The VDV monitoring option is used to measure and determine whole-body vibration based on a Frequency Weighting file that is downloaded from Blastware. Your geographic location and the type of vibration that you are monitoring will determine which Frequency Weighting file that you choose to use during the monitoring session – the frequency range of the data collected is from 1 to 80 Hz. Two frequency weighting files may be downloaded to the monitor, which can then be assigned to daytime or nighttime monitoring sessions.

There are two primary standards for determining and evaluating whole-body vibration, as follows:

<table>
<thead>
<tr>
<th>BS-6841</th>
<th>Measurement and evaluation of human exposure to whole-body mechanical vibration and repeated shock.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO-2631</td>
<td>Evaluation of human exposure to whole body vibration.</td>
</tr>
</tbody>
</table>

While monitoring, the unit differentiates the velocity data into acceleration, applies the frequency weighting and then calculates the VDV and Root Mean Square (RMS) values. The unit displays the VDV and RMS values every ten seconds while recording, and stores the final calculations as part of the file and Event Report.

The unit is capable of continuously monitoring full waveform data for 24 hours; the daytime VDV monitoring is performed on the vertical channel (7:00 AM to 11:00 PM) while the nighttime VDV monitoring is performed on the horizontal channels (11:00 PM to 7:00 AM). The Monitor Scheduler feature must be used to specify the different settings required for daytime and nighttime monitoring setup files. Refer to the Monitor Scheduler section of this manual for more information.
NOTE: Due to the processing power and decimal accuracy of a PC, performing VDV calculations using the Blastware Human Exposure tool on a computer will typically produce a higher accuracy result when compared to the VDV recorded in the field by the Minimate Pro unit. These results will typically be within 5% of each other.

a. Frequency Weighting File

Select the Frequency Weighting File that is appropriate for the duration of time that you are recording data. The weighting file is defined in the standard; it is important to select the correct geophone channel (Tran, Vert, and/or Long) to monitor:

<table>
<thead>
<tr>
<th>Frequency Weighting Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>BW6841WB Vertical whole-body vibration, lying down, standing or sitting</td>
</tr>
<tr>
<td>BW6841WD Horizontal whole-body vibration, lying down, standing or sitting</td>
</tr>
<tr>
<td>BW6841WE Rotational whole-body vibration, lying down, standing or sitting</td>
</tr>
<tr>
<td>BW6841WF Vertical whole-body vibration, for motion sickness</td>
</tr>
<tr>
<td>BW6841WG Vertical whole-body vibration in buildings</td>
</tr>
<tr>
<td>ISO2631WM Whole-body vibration in buildings</td>
</tr>
</tbody>
</table>

b. Calculate (T, V, L)

Based on the VDV standards that you are using as a guideline, select the channels that you want to monitor, T (Tran), V (Vert), or L (Long), or any pair. The unit memory is capable of storing 24 hours of data using one geophone and two channels, at the default sample rate of 512 s/s.

(3) Interval

The Interval setting is reserved for Histogram and Histogram Combo record modes. The Histogram Interval is the period of time the monitor records Event information before applying the data analysis processing. For each interval, the monitor calculates the maximum negative peaks, the frequency of the largest peak, and up to two peak vector sums. For each channel the maximum peak and its frequency are calculated. The peak vector sum is calculated over the entire Event.

(4) Record Stop Mode

The Record Stop Mode sets how the monitor stops recording after being triggered. Choose a record stop mode if you are using the single shot or continuous record modes. You can choose between a Fixed Record Time setting or an Auto Stop Mode setting. Fixed Record Time sets the record time to a specified length. Once the record time has elapsed, the monitor stops recording. In Auto Record, unlike the Fixed Record Time, the monitor continues to record Event activity as long as that activity remains above the trigger level (sufficient memory and battery power must be available). Recording stops a specified period of time after the Event activity falls below the trigger level. The specified period of time, called the Auto Window, can be adjusted. Use the Auto Record mode if you are unsure of the actual Event duration.

To choose a Record Stop Mode, position the mouse pointer on the Recording Stop Mode drop-down menu and click the mouse button. Choose Fixed Record Time or Auto Stop Mode.

(5) Sample Rate

The monitor records using sample rates; 512 (typically for VDV), 1024, 2048 and 4096. The choice of a Sample Rate depends on the type of monitoring you are conducting. Increasing the Sample Rate increases the accuracy of the waveform recording. For this reason, set the Sample Rate according to the location of the standard transducer or the Minimate Pro. For close-in or near field monitoring, set the Sample Rate to 4096 samples per second. For far-field monitoring, set the Sample Rate to 1024 samples per second. Increasing the Sample Rate also increases the amount of memory required to store Events and reduces the number of Events that can be stored on the monitor. It also reduces the battery life.
To choose a recording rate, click on the **Sample Rate** drop-down menu. Click the mouse pointer on the required **Sample Rate**.

(6) **Auxiliary Trigger**

The **Auxiliary Trigger** is an external triggering feature used to start monitor recording.

An optional Wire Break/Make Trigger Cable is available (Part No. 720A3501) used to connect several monitors together for multiple point blast monitoring.

To use the **Auxiliary Trigger**, set the monitor in Waveform Manual, Waveform, Histogram, or Histogram Combo Record Modes. Set a fixed Record Time. The Auxiliary Trigger combined with the Auto Record Time setting is only available on Minimate Pro units. Click on the Auxiliary Trigger checkbox to display a check mark.

(7) **Edit Compliance Setup More**

![Image of More Recording Setups dialog box]

- **Geophone Alarm Level**
  
  The alarm level controls the triggering of an optional Remote Alarm (Part No. 720A3901). The remote alarm can sound two alarms: warning and alarm. The warning alarm sounds when Event activity exceeds the Trigger Level for the Geophone. The alarm level can be set to a different level that is higher than the trigger level of the Geophone. This allows for the triggering of a second alarm at the higher level.

  For example, in pile driving operations the remote alarm triggers a warning when activity exceeds the trigger level for the Geophone, notifying the operator that the pile driving activity has exceeded that set level. The second alarm triggers when activity exceeds the alarm level, set to a higher level, notifying the operator to re-evaluate the piling operation.

  To set an alarm level, double click on the **Alarm Level** box. Enter the new level that is within the stated range (Range: 0.508 – 254 mm/s).

- **Microphone Alarm Level**
  
  For a description of the optional remote alarm, see the Geophone channel in the previous section.

  To set an alarm level, click on the **Microphone Alarm Level** box. Enter the new level that is within the stated range (Range: 100.0 – 148 dB(L)).

- **Auxiliary I/O**
  
  The Auxiliary I/O section of the dialog controls the option for triggering of a Remote Alarm (Part No. 711A1401) based on levels set for Vibration or Pressure, or for an External Trigger, using the optional Wire Break/Make Trigger Cable (Part No. 720A3501). Select Off if you don’t want to use the Auxiliary I/O option.
When the **External Trigger** option is selected, the **Warning Hold Time**, 0 - 300 seconds, is available for input.

When the **Remote Alarm** option is selected, the **Warning Hold Time**, **Alarm Hold Time** (both 0 – 300 seconds) and the **Alarm On** inputs boxes become available. The **Alarm On** option allows you to select which sensor setup and activity that you would like to initiate a **Remote Alarm**.

iv **Channel Names**

The **Channel Names** can be changed. These names appear throughout the software including in printed Event reports. The default names describe the compliance sensors connected to the monitor. The new names can be alphanumeric up to five characters in length. To change the **Channel Names**, double click on the existing name and enter the new name.

v **Command Buttons**

To choose one of the following command buttons, click the mouse pointer on the button.

1. **Cancel**
   
   Exit the dialog box and return to the previous Recording Setup dialog without accepting the changes.

2. **OK**
   
   Approve the changes in this dialog box.

b. **Notes**

To display the Notes dialog box, open the **Unit, Setup, Compliance Setup** menu and select the **Notes** tab. The Edit Notes dialog box appears.

The **Notes** dialog box lets you enter notes about an Event. These notes are then saved with the Event when it is recorded. The notes become part of the permanent record and cannot be changed after an Event has been recorded. The notes are very flexible, offering you the ability to change their titles and content.

To enter notes, click on a space and delete the existing note by pressing and holding the **Backspace** key. Enter the new notes for each **User Notes** field box.

(1) **Enable User Notes**

When you enable user notes, the information contained in the User Notes dialog box is recorded with every Event. If you do not require this information, disable user notes by clicking on the **Enable User Notes** checkbox to clear the checkmark.
(2) **User Notes**
Enter the notes you wish to include with the recorded Events. You can include user note headings like the ones in the figure above. You can use these headings or delete them and enter your own. You can also delete them entirely and use no headings. Headings can range up to 20 characters in length. In the right hand column, enter your user notes. User notes can range up to a maximum of 40 characters in length.

(3) **Extended Notes**
Use this area to enter additional notes as required up to a maximum of 640 characters.

(4) **Enable Extended Notes**
When you enable extended notes, the information contained in the Extended Notes dialog box is recorded with every Event. If you do not require this information, disable extended notes by clicking on the Enable Extended Notes checkbox to clear the checkmark.

(5) **Extended Notes Title**
Enter a name for the extended notes section up to 20 characters in length.

(6) **Enable Job Number**
You may include a job number to identify a series of recorded Events. This helps you keep track of Events in the monitor and on your computer. To enable the Job Number, click the mouse pointer on the Enable Job Number checkbox to enter a checkmark.

(7) **Job Number**
Enter a job number. Job numbers range from 1 to 9999. Double click on the Job Number box and enter a new job number.

(8) **Enable GPS Notes**
Check this box to enable GPS Notes to be included on the Event Report. The GPS information is captured from the waypoints that are entered on the unit within the View/Edit Setup > GPS Location feature. Refer to the Minimate Pro Operator Manual for information on how to enter GPS Locations.

(9) **Enable Scaled Distance**
Check this box to enable the recording of scaled distance information with each Event. Enter the Distance from blast and the Charge Weight. Blastware automatically calculates and displays the Scaled Distance value. The value appears both within this dialog box and on Event Summary Reports.

(10) **Distance from blast**
Enter the distance from the monitor to the blast in feet or meters.

(11) **Charge Weight**
Enter the charge weight of the blast in pounds or kilograms.

(12) **Scaled Distance**
The Scaled Distance result appears within this dialog box and on Event Summary Reports.

(13) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.
   i. **Cancel**
   Exit the dialog box and return to the Blastware Main Menu.
   ii. **Send To Unit**
   Transfer your settings to the monitor.
c. Special Setups

To display the Special Setups dialog box, open the Unit, Setup, Compliance Setup menu and select the Special Setups tab.

The Special Setup dialog box includes access to the Monitor Scheduler feature, when Sensor Check operates, Measurement Units, Time Format, and Send Unit Time with Setup. After you have entered your settings in each dialog box, choose Send to transfer your settings to the monitor, or proceed to the Setup Files tab and save the settings on the PC.

(1) Monitor Scheduler – Edit

The Monitor Scheduler feature sets the Minimate Pro unit to automatically start monitoring sessions at a preset time using a series of saved setup files and, if required, the Self Check feature can be activated. The scheduler can be set for a one time session, daily, or weekly. Using the Monitor Scheduler extends the battery life by only monitoring the time periods when Events are scheduled to occur and not the time periods between Events. It allows for different monitoring Record Modes to be selected, too, as long as the sensors remain the same within each setup file used.

Select Edit to enter the Monitor Scheduler window. The initial view has the Week selected, with the time window set as 5:30 a.m. to 6:00 p.m. Use the window scroll bar at the right to access earlier or later times. The calendar is divided into programmable half-hour Time Cells.

IMPORTANT: After setting up the Monitor Scheduler, refer to the Unit Monitor Status feature, List Setup Files, and List Operator, for additional ways to remotely activate and control the unit without entering the Compliance Setup dialog.

NOTE: The Monitor Scheduler can be used to define VDV Record Mode sessions. This feature can be used to specify the different settings required for daytime and nighttime monitoring (24 hours) setup files for VDV Record Mode: Daytime VDV monitoring is performed on the vertical channel (7:00 AM to 11:00 PM) while the nighttime VDV monitoring is performed on the horizontal channels (11:00 PM to 7:00 AM).

NOTE: To avoid a half hour delay between daytime and nighttime VDV monitoring, enter two sequential ‘Start Monitoring’ commands at 11:00 PM.

NOTE: The Monitor Scheduler uses Setup Files that have been created and saved. Refer to this section of the manual, Compliance Setup – Series IV, for information about creating and saving setup files.

Monitor Scheduler Example:

A populated Monitor Scheduler calendar is shown on the next page, based on a repeated week. Follow the descriptions and directions following this example to learn how to use this feature.
1. Select **Day** or **Week** and determine if you want to **Repeat** the monitoring schedule.

2. Double click on a **Time Cell** to access the **Monitor Scheduler Events** dialog.

3. Select “…” to access the **Select Series IV Compliance Setup File** dialog.
i **Repeat**
Select **Repeat** to have the recording sessions input to be repeated, every **Day** or **Week**, until a **Stop Monitor** command is sent to the unit from the **Unit > Monitor** menu, or a **Cancel** key press on the unit. Note that when you select **Repeat**, the column above the **Day** calendar will be renamed to **Repeat**, as shown below:

![Image](image1.png)

ii **Day**
Refer to the figure below. Select the **Day** setting to view and input recording sessions into the calendar that will be completed over the duration of the current day.

![Image](image2.png)

iii **Week**
Refer to the figure below. Select the **Week** setting to view and input recording sessions into the calendar that will be completed over the duration of a week. Select **Repeat** to have the recording sessions input to repeated, indefinitely, until a **Stop Monitor** command is sent to the unit from the **Unit > Monitor** menu, or a **Cancel** key press on the unit. Select **Repeat** to view the actual date as opposed to the day of the week.
iv **Clear All**
If you want to remove all entries from a Monitor Scheduler Calendar to start the population process over, select the **Clear All** button.

v **OK**
To save and exit the Monitor Scheduler, select the **OK** button. If you want to exit without saving, select the **OK** button, but then select **Cancel** in the **Save** dialog. Either selection will return you to the Compliance Setup > Special Setups tab.

vi **Cancel**
Press the **Cancel** button if you don’t want to proceed and exit without saving the Monitor Scheduler calendar.

vii **Send to Unit**
1. Press **Send to Unit** to download the Monitor Scheduler settings to the Series IV unit. If existing, duplicate named Setup Files exist on the unit, than the following dialog will appear:

   ![Duplicate Setup Dialog](image)

   a. Decide if you want to update the Setup File from the file saved on the PC by selecting User Setup from PC, or from the unit, select User Setup from Unit. This window will appear for each, first instance filename that is a Duplicate.
b. If you would like to redefine the Setup File, press Cancel to exit the Duplicate Setup dialog and return to the Monitor Scheduler. You will have to return to the Compliance Setup dialog to make any changes to the Setup File before returning to the Monitor Scheduler feature.

c. If you select User Setup from PC or User Setup from Unit, or if the file that you are transferring has a unique name, then the following Save Series IV Monitor Scheduler dialog will appear:

![Save Series IV Monitor Scheduler dialog]

Use descriptive filenames to help you identify these sessions for later use (e.g. VDV Schedule Day for daytime monitoring in the VDV Record Mode).

The file extension, (*.SCH) is automatically added to the files as they are saved. The default file location for saved .SCH is the /Blastware/System/Dbase directory.

d. At this time, you will be prompted with the following dialog:

![Monitor Schedule sent to unit: Enable now?]

Select Yes if you want the unit to start using the Monitor Scheduler settings the next time a recording session is initiated, either via Blastware or as a manual key press on the unit. Select No if you don’t want Monitor Scheduler to be enabled.

e. You are able to Enable or Disable the Monitor Scheduler feature on a connected unit, at any time, by using the Unit > Monitor dialog. The unit must be idle to access the Turn On or Turn Off button. In the example below, the initial Current Monitor Mode: “Unit is idle,” and it is not using a Monitor Scheduler session. The ability to Enable or Disable the Monitor Scheduler is available by selecting the Turn On or Turn Off button:
NOTE: Refer to the Unit Monitor Status section of this manual for more information on enabling or disabling the Monitor Scheduler.

If you have chosen to enable the Monitor Scheduler on the unit and have started a recording session, the display on the unit will appear as follows until the first Record Mode is activated and displayed (i.e. Waveform, Histogram, Histogram Combo, or the optional VDV Record Mode):

viii Input Monitoring Scheduler Events

Double-click on the Time Cell that you would like to enter a Monitoring Scheduler Event. The following menu will appear:

1. Start Monitor – Select Setup File
   a. Double-click to select a Time Cell. The Monitor Schedule Events dialog appears.
   b. Select Start Monitor to gain access to the Setup File discovery field.
   c. Click on the “… ” to access previously saved Setup Files. The following window will appear (the default directory location for Setup Files, unless saved in another location, is /Blastware/System/Dbase):
NOTE: The Setup File selected will remain the default file until a different setup file is loaded into a Time Cell.

NOTE: All Setup Files selected for use in a Monitor Scheduler session must have a sensor setup that matches what is currently attached to the unit. If any single Setup File, in a series of selected files, does not match the unit sensor setup, than the Monitor Scheduler recording session will not be completed.

d. Select the Setup File that you want to load into the Time Cell. Once the Monitor Scheduler is enabled on the unit, recording with this setup file will be started at the chosen time.

NOTE: Sequential Start Monitor sessions can be input without including a Stop Monitor command. This is particularly helpful for continuous 24 hour recording using the VDV Record Mode.

2. Stop Monitor
   a. Double click to select a Time Cell. The Monitor Schedule Events dialog appears.
   b. Select Stop Monitor to end a specified recording session that was previously input using the Start Monitor command.

3. Self Check
   Select the Self Check mode for where you require a record indicating the monitor was operating properly. An Instantel Service Technician may ask you to perform this Self Check. This is a diagnostic tool that displays the status of various hardware and software components. The results of the Self Check are displayed on three screens on the unit and any items that are tested that don’t pass, are listed in the Monitor Log as Failed. The Service Technician can assist you in determining how to repair or describe a workaround for returning the monitor to a working state.

   Press the Down Arrow key to scroll and highlight the Self Check menu option.
Blastware Compliance Module

4. Call Home (Must be enabled on unit)
   a. Select Call Home to use the Auto Call Home feature. Auto Call Home will use the most recent configuration settings. Refer to the Auto Call Home section of this manual for more information.

5. Clear Cell
   a. Within the calendar, select the Time Cell that you want to remove a scheduled event from, and double click on it.
   b. Select Clear Cell, from the Monitor Schedule Events dialog. Select OK.

File
The file menu contains common commands; Save As, Open and Send to Unit.

1. Save As
   a. After you have completed populating the Monitor Scheduler with setup files and commands, select Save As to save the session.
   b. Use descriptive filenames to help you identify these sessions for later use (e.g. VDVSchedule_Day for daytime monitoring in the VDV Record Mode).
   c. The file extension, (*.SCH) is automatically added to the files as they are saved. The default file location for saved .SCH is the /Blastware/System/Dbase directory.

2. Open
   After you have completed populating the Monitor Scheduler with setup files and commands, and saved the session, you can load them at a later date, and modify them, if necessary.

   a. Select the Open menu item and select the saved Monitor Scheduler session that you want to use or modify.
b. The calendar will automatically populate with the previously saved settings. Transfer the Monitor Scheduler settings to the unit. At this time, you will be prompted with the following dialog:

![Monitor Schedule Send to Unit: Enable Now](image)

Select Yes if you want the unit to start using the Monitor Scheduler settings the next time a recording session is initiated, either via Blastware or as a manual key press on the unit. Select No if you don’t want Monitor Scheduler to be enabled.

(2) Sensor Check

This setting chooses when to automatically run Sensor Check to test your monitor and its sensors. You can choose to run Sensor Check after recording each Event or only once before a monitoring session starts. You can also choose to disable Sensor Check. If you choose After Each Event, Sensor Check runs after recording each Event. Results are saved with each Event and appear on the monitor display. If you choose Before Monitoring, Sensor Check runs once before monitoring starts, immediately after you enter the monitor mode. The results of this single Sensor Check appear with each Event recorded during the monitoring session. This setting provides a zero recycle time and ensures you cannot miss an Event when using the continuous record mode (the Automatically Print Event After Recording function in the Printer Setup dialog box must also be turned off).

To select a Sensor Check position, click on the Sensor Check drop-down menu. Click on After each Event or Before monitoring. Select Disabled if you do not wish to use Sensor Check.

(3) Measurement Units

The Blastmate III and Minimate Plus use either Metric or Imperial measurement units.

To choose the measurement units, position the mouse pointer on the Measurement Units drop-down menu and click. Click on either Metric or Imperial.

(4) Show Mic units in dB

Select Show Mic Units in dB if you want to change from the default display units of Pa.

(5) Time Format

This sets the time format for the monitors clock. You can choose between the 24 hour and the 12 hour AM/PM time formats.

To choose a time format, click on either button.

(6) Set Unit Time with Setup

To synchronize the Unit clock with the personal computer clock, place a checkmark in the box prior to selecting Send to Unit. Disable Set Unit Time with Setup by clicking on the checkbox to clear the checkmark.

(7) Command Buttons

To choose one of the following command buttons, click the mouse pointer on the button.

i Cancel

Exit the dialog box and return to the Blastware Main Menu.

ii Send To Unit

Transfer your settings to the monitor.
d. Setup Files

To display the Setup Files dialog box, open the Unit, Setup, Compliance Setup menu and select the Setup Files tab. The Setup Files dialog box allows you to load and save settings from your PC or the unit, and to specify any changes you have made to be the default settings. These files have a .set file extension.

(1) Read Setup

i. From Disk
Load a saved setup file from your PC. Locate previously saved setup files and load them to affect the unit currently connected to your PC by clicking on Send to Unit.

ii. From Unit
Load the setup library files that are currently being used on the unit connected to your PC.

iii. Default
Select Default to load the previously saved file.

(2) Save Setup

i. To Disk
Save your current setup settings to a file. Click on To Disk, and save the file into the default “Dbase” directory.

ii. As Default
Use your current settings as the default every time you connect a unit and click on Default.
(3) **Button Commands**

To choose one of the command buttons, click the mouse pointer on the button.

i. **Cancel**

Exit the Printer Setup dialog box and return to the Blastware Main Menu.

ii. **Send To Unit**

Transfer your settings to the monitor.

e. **List Operator (Series IV and Micromate Only)**

With communications successfully setup between the PC and unit, you can view and select which **Operator** you want to appear on all current and subsequently recorded Events. You are also able to **Rename**, **Delete** and **Add** operators. To display the **List Operators** dialog box, open the **Unit, Setup**, and select **List Operators**:

![Operators dialog box](image)

**NOTE:** The **Active Operator** is shown at the top of the dialog. Operator names are limited to 15 characters.

1. Highlight the **Operator** that you would like to appear on the reports by using the **Select** button.
2. Click on the **Select** button to change the operator.
3. Click on **OK** to confirm the change, or **Cancel** to exit the menu without changing the **Operator**.
4. Repeat the Steps 1 and 3 above to **Rename**, or **Delete** an **Operator**.
5. To **Add** an **Operator**, place your cursor in the top box and type in a new **Operator** name. Click on **Add** and it will appear in the list below.
6. Click on **OK** to confirm the change, or **Cancel** to exit the menu without changing the **Operator**.

f. **List Setup Files (Series IV and Micromate Only)**

With communications successfully setup between the PC and unit, you can view and select which **Setup File** you want to use on all subsequently recorded Events. You are also able to **Rename**, **Delete** and **Select** the **Setup Files**.

To display the **List Setup Files** dialog box, open the **Unit, Setup**, and select **List Setup Files**:
NOTE: The Active Setup file is shown at the top of the dialog.

1. Highlight the Setup File that you would like to use.
2. Click on the Select button to change the Setup File.
3. Click on OK to confirm the change, or Cancel to exit the menu without changing the Operator.
4. Repeat the Steps 1 and 3 above to Rename, or Delete a Setup File.
   NOTE: Renaming a setup file which is part of a saved Monitor Scheduler session, will cancel that part of the scheduled recording session.
5. Click on OK to confirm the change, or Cancel to exit the menu without changing the Setup File.
   NOTE: In conjunction with the Start/Sop Monitor command under the Unit, Monitor dialog, this is a convenient tool to quickly change setup files as opposed to communicating through the Unit, Setup dialog. If you don’t have any changes that need to be made to an existing setup file, or you don’t need to send a new setup file to the unit, use the Setup Files dialog to interact with the unit.

h. Edit Owner Text (Micromate Only)
   With communications successfully setup between the PC and unit, you can edit the Owner Information displayed on the unit.

   To display the Edit Owner dialog box, open the Unit, Setup, and select Edit Owner Text:
6. Select each field and type the information that you would like displayed on the unit
Owner Info window.

7. Select the **Send to Unit** button to send the information to the attached unit.
8. Select the **Cancel** button to return to the Blastware Event Manager window.

### 4.2.4 Status

The Status command checks the monitor and displays the following information. To display the
Status dialog box, open the **Unit Menu** and choose **Status**. Press the **Refresh** button to update the
information. Press the **Close** button to return to the Main Menu. Below is an example of the **Unit
Status** for a **Minimate Pro6**:

```plaintext
<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release/Version</td>
<td>PB V8.0</td>
</tr>
<tr>
<td>Calibration Date</td>
<td>August 14, 2008 by instantInc.</td>
</tr>
<tr>
<td>Unit Enter/Time</td>
<td>November 5, 2008 11:42:51</td>
</tr>
<tr>
<td>Current Mode</td>
<td>The unit is idle.</td>
</tr>
<tr>
<td>Battery Level</td>
<td>6.7 Volts</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>4.9 MB Total, 4.7 MB (94%) Free</td>
</tr>
<tr>
<td>Event Count</td>
<td>15</td>
</tr>
</tbody>
</table>
```

### 4.2.5 Sensor Check

This command runs **Sensor Check** and checks the **Blastmate III**, **Minimate Plus** or **Minimate
Pro** Geophone and Microphone sensors. For **Series III**, if you have selected a 4.5 Hz Geophone in
the Channel Setup dialog box, the unit will perform a continuity test rather than the standard
Sensor Check test. To display the dialog box, open the **Unit Menu** and choose **Sensor Check**.

Test results of the last **Sensor Check** performed by the monitor appear in the box. If no results are
available, the word **None** appears in the Test Type column. Rows of dotted lines (**---------**) fill each
of the other columns. Below is an example of a **Sensor Check** on a geophone (Channels 1, 2, and
3, or Tran, Vert, Long) attached to a **Minimate Plus**.

```plaintext
<table>
<thead>
<tr>
<th>Channel</th>
<th>Test Type</th>
<th>Overswing Ratio</th>
<th>Frequency (Hz)</th>
<th>Amplitude (mv)</th>
<th>Pattern</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Geo</td>
<td>3.3</td>
<td>7.6</td>
<td>535</td>
<td>Ok</td>
<td>Passed</td>
</tr>
<tr>
<td>2</td>
<td>Geo</td>
<td>3.6</td>
<td>7.4</td>
<td>493</td>
<td>OK</td>
<td>Passed</td>
</tr>
<tr>
<td>3</td>
<td>Geo</td>
<td>3.6</td>
<td>7.4</td>
<td>560</td>
<td>OK</td>
<td>Passed</td>
</tr>
<tr>
<td>4</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**a. Close**

Choose this to return to the Main Menu.
b. **Perform Test**
   This runs Sensor Check and tests the sensors connected to the monitor. Click on the **Perform Test** button.

c. **Plot Waveform**
   This displays a graphic representation of the Sensor Check results. Move the cursor to the channel results you wish to see and press the **Plot Waveform** button. The plot appears on your computer display.

![Channel 5 Sensorcheck Waveform](image)

---

b. **Perform Test**
   This runs Sensor Check and tests the sensors connected to the monitor. Click on the **Perform Test** button.

c. **Plot Waveform**
   This displays a graphic representation of the Sensor Check results. Move the cursor to the channel results you wish to see and press the **Plot Waveform** button. The plot appears on your computer display.

![Channel 5 Sensorcheck Waveform](image)

---

d. **Fetch Results**
   This command obtains the most recent Sensor Check results stored in the monitor. Click on the **Fetch Results** button.

e. **Channel 1, 2, 3, 4, 5, 6, 7, and 8**
   You have a choice of which channels will be tested by **Sensor Check**. Click on the checkbox to display a checkmark for each channel to be tested. To exclude channels from the Sensor Check, click on the checkbox to remove the selection. Sensor Check results for excluded channels are indicated by the word **None** in the Test Type column. Rows of dotted lines (----------) fill each of the other columns. For eight channel monitors, channels 5, 6, 7, and 8 will also be displayed.

f. **Most Recent Test Results**
   This displays the Sensor Check test results for each channel tested. The results for the Linear “L” and the “A” Weight microphones differ. The Linear “L” results appear with a Test Type called Square Wave and are similar to the dialog box above. Series IV supports the Linear Microphone.

4.2.6 **Date/Time**

a. **Blastmate III, Minimate Plus or Series IV**
   Open the **Unit Menu** and choose **Date/Time**. The Set Unit Date/Time dialog box appears.
You may set the Date and Time in your monitor in two ways. The first method is to copy the settings from your PC, as displayed in the PC Date/Time area. Make sure the date and time are correct, and then click on the Send to Unit button. The date and time in the Unit Date/Time area will change to match the PC Date/Time. You can also set the date and time manually: enter the current date and time in the Unit Date/Time area then send the changes to the unit by clicking on the Set Date/Time button.

b. Adjust Speed (Series II, Series III and Minimate Blaster Only)

The Adjust Speed button is used to adjust the units clock if it is running too fast or too slow. The Set Clock Speed dialog box appears:

Select the appropriate radio button and enter the number of seconds in a 24-hour period that the clock is slow or fast. Use the Increase and Decrease buttons to change the number of seconds. Click OK to send the time correction to the unit and close the dialog box.

Note: The Self Check function must be activated for the unit in order for the time to be corrected. The time is adjusted as part of the Self Check. The Daily Self check is scheduled in hours and minutes and occurs at 30 seconds into the chosen minute. The amount of the correction is limited to 28 seconds so that the minute does not change. Example: 11:59:30 + 28 sec = 11:59:58 or 11:59:30 - 28 sec = 11:59:02

Note: This feature is not required for Series IV units.

c. Micromate

Open the Unit Menu and select Date/Time. The Set Unit Date/Time dialog box appears.
You may set the **Date/Time** in your monitor two ways. The first method is to **Synchronize Unit to PC**, as displayed in the PC Date/Time dialog area, which also includes the **UTC Time** and **UTC Offset**. Make sure the PC date and time are correct, and then click on the **Synchronize Unit to PC**. The date and time in the **Unit Date/Time** area will change to match the **PC Date/Time**. Within the **Unit Date/Time** dialog area, you can also manually adjust the **UTC Offset**. This feature allows for consideration of different time zones that the unit may be installed. Select the dropdown menu button and adjust the **UTC Offset** time accordingly.

### 4.2.7 Monitor

Use the **Monitor** command to start and stop your unit monitoring session. Establish communications between the unit and the PC, then open the **Unit Menu** and choose **Monitor**. To start monitoring, press the **Start Monitoring** button. If the monitor is already in the monitor mode, the **Start Monitoring** button will read **Stop Monitoring**. You may need to click on **Stop Monitoring** several times to communicate with the unit over the modem and end the monitoring session.

The **Unit Monitor Status** also displays the **Unit Date/Time**, **Battery Level**, **Memory Usage**, and whether or not the **Monitor Scheduler** is **Enabled** or **Disabled**. The unit must be idle to have access to the **Turn On** or **Turn Off** button that controls the status of **Monitor Scheduler**. Refer to the section in this manual about the **Monitor Scheduler** and within the **Minimate Pro Operator Manual** for more information about the feature.

**Examples:**

1. In the example below, the initial **Current Monitor Mode**: “Unit is idle,” and it is not using a **Monitor Scheduler** session. The ability to **Enable** or **Disable** the **Monitor Scheduler** is available by selecting the **Turn On** or **Turn Off** button:

   ![Unit Monitor Status](image)

2. Press **Start Monitoring** and the unit status displays the record mode that is being used. In the example below, the **Unit Monitor Status** is **Waveform Monitoring**, and it is not using a **Monitor Scheduler** session:
3. In the example below, **Monitor Scheduler** has been **Enabled**.

Press **Start Monitor**, and the **Unit Monitor Status** dialog will appear as follows:

**NOTE:** The **Current Monitor Mode** is the **Unit is in Monitor Scheduler** and that the ability to **Turn Off**, or **Disable**, the **Monitor Scheduler** can only be done by pressing **Stop Monitoring** and then selecting the **Turn Off** button. When you press **Start Monitoring** and the **Monitor Scheduler** has been **Enabled**, then the following will be displayed on the unit until the first recording session begins, than it will reflect the
scheduled record mode (i.e. Waveform, Histogram, Histogram Combo, or the optional VDV Record Mode):

4. The example below demonstrates how you can access the View Real Time Histogram Data feature, which requires a Series IV monitor, Minimate Pro4 or Minimate Pro6, and the Ethernet® Communication Cable option. Refer to the section in this manual, and your Minimate Pro Operator Manual, for more information about what is required for the Ethernet® communications setup and recording in Histogram Record Mode.

   a. The instruction below assumes that Ethernet communications has been established between the unit and the PC, and that you are already actively recording with Histogram Record Mode to successfully use this feature.

   b. Within Blastware, select the Unit menu.

   c. Select the Monitoring menu option.

   d. Select Start Monitoring.

   e. Select the View Real Time Histogram Data button.

   f. The number of channels that you are monitoring will determine how the display is represented. For instance, monitoring with a Minimate Pro6 with two geophones will display all six channels (Tran/Vert/Long for each geophone). Below is an example of one geophone being used during a Histogram Record Mode monitoring session:
g. The data will be displayed, as it occurs, based on the **Interval** setting for **Histogram Record Mode**.

h. Click on the **Scaling** icons to increase or decrease the scale of the data being viewed.

**NOTE:** The speed of the data transfer will be determined by the connection quality and supported rate. Initial data will take a few seconds before it becomes visible, and that time will be dependent on the **Interval Size** setting.

**NOTE:** Use the **Monitor** dialog in conjunction with the **List Operator** and **List Setup Files** to easily change recording setups.

### 4.2.8 Monitor Log

The monitor log lists monitoring periods including date, start time, and stop time. To display the monitor log, click on the **Unit Menu** and choose **Monitor Log**. The Monitor Log dialog box appears.

![Monitor Log dialog box]

**a. Display All**

Select **Display All** to view all the Events that are currently on the monitor.

**b. Search Now**

Enter dates into the **Between** and the **And** fields, by clicking on the small down arrow to the right of each box – this displays the calendar. By clicking on the left and right arrows, you can navigate through the calendar to select the inclusive dates you would like searched for Monitor Log entries.

**c. Close**

Select **Close** to return to the previous window.

**d. Print**

Select **Print** to enter the Output Dialog menu.
(1) **Use Report Header**
Click on the selection box next to **Use Report Header** to display a checkmark in the checkbox. This will include a title on the printed report. Clicking again will unselect the Use Report Header option. Input text in the three text boxes below the Use Report Header option – this will be the text that appears at the top of the report.

(2) **Destination**
To select the destination of the Output, you can either choose **Printer** or **File** by clicking on the radio button.

(3) **Entries to output**
The predefined default for this is **ALL**.

(4) **Format**
You have a choice between **Large**, **Medium**, and **None** for the margins.

<table>
<thead>
<tr>
<th></th>
<th>Top Margin</th>
<th>Left Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>1 ½ in. (3.8 cm)</td>
<td>¾ in. (1.9 cm)</td>
</tr>
<tr>
<td>Medium</td>
<td>1 in. (2.5 cm)</td>
<td>½ in. (1.3 cm)</td>
</tr>
<tr>
<td>No Margin</td>
<td>0 in. (0 cm)</td>
<td>0 in. (0 cm)</td>
</tr>
</tbody>
</table>

(5) **OK**
Click on **OK** to accept the current settings and proceed to the Printer Dialog box.

(6) **Cancel**
Click on **Cancel** to exit to the previous menu.

### 4.2.9 Reload Operating System

This command sends a new version of the operating system (OS) and library components to the monitor. To reload the operating system, click on the **Unit Menu** and choose the **Reload Operating System** command. The Reload Operating System dialog box appears.
a. **Unit Operating System**
This is the release number and version number of the operating system presently in the monitor.

b. **Disk Operating System**
This refers to the unit operating system stored in the Blastware program.

c. **Compliance Report Type**
This drop-down menu displays the current type of report loaded into the monitor. It also lists the available compliance reports in Blastware that you can choose to load into the monitor.

To choose a compliance report, click on the **Compliance Report Type** drop-down menu and select a report.

d. **Printer Driver Type (Minimate Plus, Minimate Blaster and Micromate Only)**
Three printer models are supported for the Minimate Plus and Minimate Blaster: the Kodak Diconix 180 SI, Hewlett Packard DeskJet 320, and the Canon BJ-30 in Epson LQ mode. Choose the driver corresponding to your printer.

If your printer type does not correspond to either of these printers, choose the Canon BJ-30 in Epson LQ mode driver for printers capable of emulating the Epson LQ mode. Set the printer scaling to two-thirds of a page. For printers using Hewlett Packard’s PCL printer language, choose the HP DeskJet 320 driver.

The Citizen CMP-30 Printer is compatible with the Micromate monitor.

To choose a driver, click on the **Printer Driver Type** drop-down menu and select a driver.

e. **Language**
Different languages can be loaded into the monitor and used. This drop-down list identifies the Language Library files available for use.

To choose a language, click on the arrow and select. The Language Library must be loaded into the monitor. To load the Language Library, choose either the **Reload OS and Library Components** command to reload the operating system along with the language library, or the **Reload Library Components Only** command to load only the language library.

**NOTE:** New language files may be created using the Language Editor available in the Blastware Advanced software (optional – Series III only).

f. **Modem (Minimate Pro Only)**
Instantel supports a variety of modems. Modems are controlled by script files.

To choose a Modem, click on the arrow and select. The Modem must be loaded into the monitor.

To load the Modem script file, choose either the **Reload OS and Library Components** command to reload the operating system along with the Modem script file, or the **Reload Library Components Only** command to load only the Modem script file.

g. **Vibration Dose Value (VDV) Frequency Weights (Series IV Only)**
This option is only available if you have purchased the Blastware Advanced Module. The VDV monitoring option is used to measure and determine whole-body vibration based on a Frequency Weighting file that is downloaded from Blastware. Your geographic location and the type of vibration that you are monitoring will determine which Frequency Weighting file that you choose to use during the monitoring session – the frequency range of the data collected is from 1 to 80 Hz. Two frequency weighting files may be downloaded to the monitor, which can then be assigned to daytime or nighttime monitoring sessions.

To choose a Frequency Weights file, click on the arrow and select. The Frequency Weights file must be loaded into the monitor. To load the Frequency Weights file, choose either the **Reload OS and Library Components** command to reload the operating system along with the Frequency Weights, or the **Reload Library Components Only** command to load only the Frequency Weights file.
h. **Reload OS and Library Components**

This command loads all the software required to operate the monitor including the disk operating system, the library components, and the compliance report into the monitor. This operation replaces all the software currently loaded into the unit. The disk operating system becomes the unit operating system. This feature is most commonly used to upgrade the monitor to the latest software.

**WARNING:** Make sure that you are replacing the unit operating system with the required disk operating system. This procedure cannot be reversed.

Select the required **Compliance Report** in the **Compliance Report Type** drop-down menu and press the **Reload OS and Library Components** button.

i. **Reload Library Components Only**

Select this command to send a new version of the Blastware library file to the monitor. The library file contains the complete **Language Library** for the entire monitor program. You can use this command to load a new language into the monitor.

You can also use this feature to load a new **Compliance Report** into the monitor. To do this, make sure the unit operating system release and version number match exactly the disk operating system release and version. If they do not match, the **Reload Library Components Only** button will be dimmed requiring you to use the **Reload OS and Library Components** button only.

Select the required **Compliance Report** in the **Compliance Report Type** drop-down menu and press the **Reload Library Components Only** button.

j. **Reset Unit**

This command resets the unit.

k. **Cancel**

Leave the **Reload Operating System** dialog box without changing the monitor's current software.

4.2.10 **Select Unit Type**

The Event Manager helps to organize your Event files. From this window you list, copy, delete, print, and view Events. The Event Manager can be accessed in two ways, 1) from the **Main Menu** bar, select **Unit, Select Unit Type**, or from the Event Manager window in the lower-left hand corner, select **Micromate, Series IV, Series III, Minimate Blaster**, or **Series II** in the lower left-hand corner of the Main Blastware window.
Note to Series II users: Blastware contains two Event Managers: the Series III Event Manager described in this section, and the Series II Event Manager. These menus are toggled by selecting the unit type at either the bottom left corner of the Event Manager window, or under the Unit, Select Unit Type menu selection. The Series II Event Manager displays the Events stored on your Series II monitor, and is used to copy Events to your PC. Once you have copied an Event over to your PC, you use the Event Manager to view and edit it. Previous and new Series II Events will be converted to Series III Events and the original files will be saved in the Series II directory:

```
DRIVE:/BLASTWARE/BW_SERIES2_BACKUP/"Unit Serial Number"
```
The Series II folder is automatically created prior to the conversion.

### 4.3 Tools Menu

The Tools Menu contains three commands in Compliance Mode, Scaled Distance, Post Event Notes, and ASCII Conversion.

#### 4.3.1 Scaled Distance

The Scaled Distance menu invokes the Scaled Distance window, which contains commands for performing Scaled Distance Analysis. Scaled distance analysis is a useful tool for quickly and confidently calculating the maximum charge weight per delay and the minimum safe structure distance for a specific blast site. The information is presented in a simple and easy-to-read regression line graph.

The analysis is based on blast data for a site. Scaled distances (SD) and the peak particle velocities (PPV) are used as coordinates to plot points on a graph with logarithmic axes. SD is plotted on the X axis, and PPV is plotted on the Y axis. Since there is a correlation between SD and PPV, a regression line is computed using the least squares method. This is a straight line which “predicts” with a specified confidence level whether a new data point will reside above or below the line. Both square root and cube root scaling can be used.

Event data from any Series III or Series IV monitor can be loaded automatically, while data from other Events can be entered manually. Blastware can also read files saved by the Series II DS-550 Scaled Distance Program.

To open the Scaled Distance window, click once on the Scaled Distance menu.

The Scaled Distance window displays summary information describing the Events, including the Peak Particle Velocity (PPV), the charge weight, and the distance.

#### a. File Menu

This menu contains the New, Load, Save, Print and Exit commands.

1. **New**

The New command is used to create a new scaled distance file (.sdf). Each scaled distance file contains data from a number of blast Events, which you enter manually in the Edit Scaled Distance Record dialog box. (You can also add Events using the Event Manager, as described below). Once you have made all the settings for one Event, click on OK. The Event appears in the
Scaled Distance window, and the Scaled Distance dialog box remains open. You can then add more Events to your scaled distance file.

When you first select the New command after starting Blastware, all the settings in the Edit Scaled Distance Record dialog box are blank, except for the date, which is copied from the settings on your PC. Once you have entered data for one Event and clicked OK, however, Blastware will use the data for that Event as the default values for your next Event. This feature makes it easier to rapidly enter a series of Events.

To create a new scaled distance file, select New from the File menu. The Edit Scaled Distance Record dialog box appears:

- **Serial Number**
Enter the serial number for the blast Event here. The serial number can be alphanumeric up to nine characters in length.

- **Date/Time**
This field is used to enter the date and time the Event was recorded. The default information is either the current date and time, or the date and time for the previously entered Event.

- **Description**
Enter a description of the Event here. Your description can be alphanumeric up to 31 characters in length.

- **Geophone Peaks**
Geophone Peaks is used to enter the Peak Particle Velocity information recorded by the Geophone for the blast Event. You can enter the PPV for transverse (Trans), vertical (Vert) and longitudinal (Long) vibrations. Click on the appropriate box, and enter the PPV.

- **Microphone**
You can also enter air blast data recorded by the microphone. Enter the Peak and Background data. Click on the appropriate box, and enter the value.

- **Weight**
Enter the weight of the charge used in the blast. Click on the box, and enter the value.

- **Distance**
Enter the distance between the monitor and blast when the Event data was recorded. Click on the box, and enter the value.

- **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.
• **OK**
  Press this to enter the Event into the scaled distance file. The Scaled Distance dialog box remains open.

• **Cancel**
  Press Cancel when you have finished entering Event data. The Scaled Distance dialog box will close, returning you to the Scaled Distance window.

**WARNING:** Do not forget to save your scaled distance file before exiting the Scaled Distance window. See below for details.

(2) **Load**
The Load command is used to load scaled distance files (.sdf) into the Scaled Distance window. The Load Scaled Distance file dialog box appears:

![Load Scaled Distance File dialog box](image)

Navigate through your directories to locate the file. Click on **Open** to load the file into the Scaled Distance window.

(3) **Save**
The Save command saves the scaled distance file currently within the Scaled Distance window. The Save Scaled Distance File dialog box appears:

![Save Scaled Distance File dialog box](image)

Enter a filename for the new scaled distance file. Then navigate through your directories to choose the folder where you want to store the file. Click on **Save** to save the file.

(4) **Print**
The Print command invokes the Output dialog box, where you can choose to print a list of the scaled distance Events currently within the Scaled Distance Window, or save it to file.
Use Report Header
Click this checkbox if you wish to add the existing Report Title as defined in the Report Options dialog box. You can also add up to three additional headers to the Event list printout by typing in the text boxes provided. The headers appear as bold, centered titles at the top of each printed page.

Destination
Choose where to print the Event list, either to a printer or to a file. If you choose a printer, the list prints on your printer. If you print to a file, the list is saved in standard text format. You can view and print the list using a text editing program like Microsoft WordPad.

Entries to output
You have a choice to output all Events appearing in the Event List or only selected Events. To select Events, click on the Event to highlight it.

Format
Under this command, you can choose the margin size and font size used in the printout.

Margins
You have a choice between large, medium, and no margins.

<table>
<thead>
<tr>
<th></th>
<th>Top Margin</th>
<th>Left Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>1 ½ in. (3.8 cm)</td>
<td>¾ in. (1.9 cm)</td>
</tr>
<tr>
<td>Medium</td>
<td>1 in. (2.5 cm)</td>
<td>½ in. (1.3 cm)</td>
</tr>
<tr>
<td>No Margin</td>
<td>0 in. (0 cm)</td>
<td>0 in. (0 cm)</td>
</tr>
</tbody>
</table>

Font
You can choose either large, medium, or small fonts.

(5) Command Buttons
Choose OK to output the Event List. Choose Cancel to close the dialog without printing or saving to file.

(6) Exit
Choose this command to close the Scaled Distance window and return to Blastware Main Window. The Save Scaled Distance File dialog box will automatically appear, prompting you to save your file. If you do not wish to save your file, click Cancel.

b. Edit Menu
The Edit menu contains commands for adding, deleting, changing and finding duplicates of Events within the currently displayed scaled distance file.
(1) Manual Append
The Manual Edit command opens the Edit Scaled Distance Record dialog box, where you can manually enter Event data. The dialog box uses data from the Event most recently added to the scaled distance file as the default settings. Once you have entered all the data for the Event, click on OK to add the Event to your scaled distance file.

(2) Delete
The Delete command deletes Events from the scaled distance file.
To delete one or more Events, first highlight them in the Scaled Distance window. Then select Delete from the Edit menu. The selected Events will automatically be deleted.
WARNING: If you delete Events on your computer by mistake, refer to your computer manual immediately for instructions on how to undelete files.

(3) Manual Edit
You use the Change command to make changes to Events in the scaled distance file. Select the Event in the Scaled Distance window, and then select Change from the Edit menu. The Edit Scaled Distance Record dialog box appears where you can alter the data for the Event.

(4) Find Duplicates
This command is used to find duplicate Events within your scaled distance file. If duplicates are not removed, the scaled distance analysis results may be distorted.
To remove duplicates, select Find Duplicates from the Edit menu. If any duplicates are found, the following dialog box appears:

![Dialog box for finding duplicates]

To delete all duplicate Events, click on Yes. If you do not wish to delete duplicate, select No.
If no duplicates are found, a message appears confirming this information.

(5) Zero Mic Background
Some Scaled Distance files may contain erroneous data in the background. Select Zero Mic Background to place these values at zero.

**c. Graph Menu**
The Graph menu contains commands for performing scaled distance analysis on the file currently open within the Scaled Distance window. The Graph menu contains the following commands: Square Root, Cube Root, and Air Blast.

(1) Square Root
The Square Root command generates a graph showing the regression line for square root scaled distance.
The Print menu contains commands for printing the scaled distance graph.

**Save to Metafile**
Save the Scaled Distance Graph as a metafile, which can be inserted into a Microsoft Word document.

**Copy to Clipboard**
From the file menu, select *Copy to Clipboard*. A bitmap image of the Scaled Distance plot is copied to your computer’s temporary memory. Open another Windows program that supports graphics and use the paste command, or simultaneously press *CTRL-V*, to place the bitmap image into the file.

**Printer Setup**
Setup the defaults of your current printer, or select a different printer.

**Print**
The Print command prints the scaled distance graph currently displayed.

**Edit**
The Edit Menu contains the Notes command

**Notes**
The notes command is used to append a header centered at the top of the Scaled Distance Data Plot window, and two notes that appear in the lower left-hand corner. This feature allows you to customize your graph for printing.

To open the Edit notes dialog box, select Notes from the Edit menu.
To enter notes or a header, click on the appropriate text box and type in the desired contents, to a maximum of 40 characters. Click on OK to save your notes. Click Cancel (Esc) to close the Edit notes dialog box without adding notes.

viii Tools
Under the Tools menu are various tools to calculate charge weight, safe distance and other factors, based on the scaled distance analysis.

ix Calculator
The Calculator command invokes the Scaled Distance Calculator, where you can make a range of calculations based on a confidence level graph. This enables you to obtain precise information for the blast site. Enter the values in the appropriate boxes, and the results are displayed automatically. Click Cancel to close the dialog box.

- Calculate Charge Weight from Peak and Distance
This area is used to calculate the charge weight based on values for PPV and Distance that you enter. Enter the PPV and the distance, and the charge weight is calculated automatically.

- Other Calculations
You can also calculate the Scaled Distance, Peak Particle Velocity, and the Distance. Enter the values; the results are calculated automatically.

x Scaled Distance Table
The Scaled Distance Table command invokes the Max Weight Table dialog box. This tool allows you to quickly calculate a range of charge weights at different distances, based on a PPV chosen by you. As with the Scaled Distance Calculator, results are based on the scaled distance graph, and have a specified confidence level.

To open the Max Weight Table dialog box, select Scaled Distance Table from the Tools menu.
• **Distance**
  Enter the first distance from the Event that you wish to begin calculating charge weight for. The distance you enter here will be the first entry in the table, as shown in the example above.

• **Increment**
  This value determines the increase in distance between each entry in the table. For example, if you enter an initial distance of 500 m and set the Increment to 100 m, the table will display the maximum charge weight at 500 m, 600 m, 700 m, etc.

To enter the Increment, click on the text box with the mouse and type in the value.

• **Peak**
  Enter the PPV for the charge weight calculation here. Click on the text box with the mouse and type in the value.

• **Table Size**
  Enter the size of the table. The table can have up to 2000 entries. Click on the text box with the mouse and type in the value.

• **Command Buttons**
  Click Calculate to display the weight results. Click Print to print the weight table. The Output dialog box appears, where you can choose setting to print the table, or save it to file.

  **View Data**
  This command displays all the numerical coordinates of the scaled distance graph.

• **Copy**
  Use this command to copy the coordinates to third party analysis program such as Microsoft® Excel®. Click Copy. The information transfers to the computers clipboard file. From within
the third party software such as Excel, choose paste. The coordinates appear within the program.

- **Format**
  
  This controls the View Data table. **Width** controls the size of the table columns. **Precision** controls the number of significant digits.

(2) **Cube Root**

The Cube Root command generates a graph showing the regression line for cube root scaled distance.

![Cube Root Graph](image1)

The menu commands contained in this window are the same as those for the square root graph window.

(3) **Air Blast**

The Air Blast command generates a graph showing the cube root regression line for scaled distance using air blast data.

![Air Blast Graph](image2)

The menu commands contained in this window are the same as those for the square root graph window.
d. **Add**

Click on the **Add** button to include Events from the current directory into the Scaled Distance Event list window. Events can also be added manually by highlighting them in the Event Manager and then clicking on the **Add** button within Scaled Distance.

e. **Also Plot 95% of Line**

Input the confidence level in this box. Refer to the technical and “rule of thumb” description in Section 3.3.2, Part b. Algorithms, subsection (2).

### 4.3.2 Scaled Distance - Technical Description

This section describes the formulas used by Blastware to calculate scaled distance.

a. **Scaled Distance**

(1) Dividing the distance from the blast by the square or cube root of the charge weight is familiar to the blasting industry and is known as the Scaled Distance. It arises from the fact that surface blast energy dissipates in all directions; i.e., it goes into a circular or spherical area surrounding the blast site.

(2) The actual value of the scaled distance depends on the units of measure used in the equation,

\[ SD = \frac{D}{W^r} \]

where the distance \( D \), and weight of charge \( W \), may be expressed in either Metric or Imperial units and \( r \) is either 1/2 or 1/3 depending on whether square or cube root is used. (Air pressure always uses cube root scaling.)

(3) There is a correlation between scaled distance and particle velocity. If enough PPV (or pressure) - SD sample pairs are available, statistical analysis can be used to derive an expression to show this dependence. It is of the form,

\[ P = H(SD)^{-\beta} \]

where

- \( P \) = PPV is peak particle velocity (or air pressure),
- \( H \) is the velocity (or air pressure) axis intercept i.e., \( P \) when \( SD = 1 \),
- \( SD \) is the scaled distance,
- \( \beta \) is the slope of the curve, i.e., the negative decay exponent

(4) This is an equation for a curve of the form \( y = ax^b \). (In the case of air pressure in dB, the equation is of the form \( P = a+b \log SD \) where \( P \) is pressure.) If the logarithm is taken of both sides we have \( \log y = \log a + b \log x \) which gives a linear xy relationship when plotted using log-log scales. Since the curve has been reduced to a straight line, we can perform linear regression analysis to find its equation. Linear regression is a statistical tool for determining a line of fit through a distribution of points on a graph.

b. **Algorithms**

(1) Linear regression is used to find the equation of a straight line of the form

\[ y = a + bx \]

where the slope \( b \) is computed from the expression,
\[ b = \left( \sum (x_i y_i - n \cdot x \cdot y) \right) / \left( \sum (x_i - n \cdot x^2) \right) \]

and the intercept \( a \) is computed from the expression,

\[ a = y - b \cdot x \]

The coefficient of correlation \( r \) is obtained by evaluating the expression,

\[ r = \left( \sum (x_i y_i - n \cdot x \cdot y) / \left[ \left( \sum (x_i^2 - n \cdot x^2) \right) \left( \sum (y_i^2 - n \cdot y^2) \right) \right] \right)^{1/2} \]

and the sample standard deviation is evaluated from

\[ s = \left( \left( \sum y_i^2 - n \cdot y^2 \right) - \left( \sum (x_i y_i - n \cdot x \cdot y)^2 / \sum (x_i^2 - n \cdot x^2) \right) / n \right)^{1/2} \]

In the equations above, \( n \) is the number of points (or Event PPV, SD pairs) \( x_i \) and \( y_i \) are the \( i \)th variable in the set \( i = 1 \) to \( n \), and \( x \) and \( y \) are means or each of the variables in the given set.

(2)

A confidence line is based on the "rule of thumb" as a special case of Tchebychev's Rule. It states that in a normally distributed large population approximately 68% of the members lie within one standard deviation of the mean, whereas 95% of the members lie within two standard deviations.

For further reading, please see the following references.


4.3.3 Post Event Notes

Select this command to view and change the Post Event Notes for an Event.

**Editing notes for one Event only**

To create or edit the note of a specific Event, select it in the Event List Box, and then select the **Edit Post Event Notes** command, or the **Notes** icon from the Event Manager toolbar. The following window appears:

![Post Event Notes window](image)

Type in your notes and click the **Apply to Event** button when you are finished. Then click **Exit** to close the dialog box.

**Editing notes for multiple Events**
You may also view and change notes for multiple Events. Select a series of Events in the Event List Box, and then select the **Edit Post Event Notes** command (or select the **Notes** icon from the Event Manager Toolbar) to open the **Post Event Notes** window. Enter your note and select **Apply to Selected**, and click the **Save Event Note** button when you are finished to save your notes and move to the next Event in your list.

You can also use the standard Windows cut and paste commands to copy notes from one Event to another. Highlight the note you wish to copy and then press the Control (Ctrl) and C key simultaneously. Access the destination Event by using the **Previous Event** and **Next Event** buttons, place your cursor in the text box, and then press the Control Key (Ctrl) and V key simultaneously.

The **Previous Event** and **Next Event** buttons can also be used to view existing notes by scrolling through Events selected in the List Box. Be sure to save notes for an Event by clicking the **Save Event Note** button before moving to another Event. If no Events are selected, the notes for the first Event in the list are displayed.

Use the **Exit** command to close the dialog box.

### 4.3.4 ASCII Conversion

The ASCII output formats Blastmate Events into ASCII format (American National Standard Code for Information Interchange). This lets you use other programs to analyze the Blastmate Events. The ASCII conversion leaves the original Blastmate Event unaltered and creates a copy in the ASCII format.

To create an ASCII copy of an Event, select an Event in the Event List box then click on the **ASCII** button. The ASCII Conversion dialog box appears.

#### a. **Save converted files to directory**

Enter the path where you want the ASCII converted files to be saved, or use the browse button to locate a directory that you have already created. The default, indicated in the dialog box, is created automatically when you convert an Event for the first time. If you want to change the directory, click on the text window and press the backspace to delete the existing directory path. Then enter your new path.

#### b. **Close**

This closes the ASCII Conversion dialog box and returns to the Event Manager. Click on **Close**.
c. **Convert All**

Select this button to automatically convert all the Event files listed in the Event List box. Before using this command, open the ASCII Conversion Settings dialog box, and make sure that the Output File Name is not set to Fixed File Name. Otherwise each ASCII output file will overwrite the last converted file. See Settings below for more information.

d. **Convert Selected**

This converts only the Events you have selected from the Event List box. To select Events, click on the required Events. Each chosen Event is highlighted. Press the **Convert Selected** button and the Events are converted into ASCII files.

e. **Settings**

This customizes how the Events are converted into ASCII files. Varying these settings changes how the Event information is organized within the ASCII file. Press the **Settings** button to display the ASCII Conversion Settings dialog box. To change the settings, click the mouse pointer in the box to be changed and enter the required information.

![ASCII Conversion Settings](image)

(1) **String Delimiter**

The character entered here separates the text information of an Event into separate single text lines in the ASCII file. This information includes the monitors setup information. The default setting is a double quotation mark.

(2) **String Separator**

The String Separator formats all strings into single lines within an ASCII file. The default setting is a line feed \(<10>\) and a carriage return \(<13>\).

(3) **Wave Sample Separator**

The Wave Sample Separator separates all samples from each other. The default setting is a comma.

(4) **Wave Channel Separator**

The Wave Channel Separator divides each waveform from the other waveforms present in the Event. The default setting is a line feed \(<10>\) and a carriage return \(<13>\) at the end of a waveform.
(5) **Histogram Column Separator**
This lets you define how much space appears between histogram columns of Event information.

(6) **Format Histograms Data into a Table**
The histogram data can be unformatted or formatted into a table. In unformatted data, each sample appears under its record channel. Formatted data appears by sample, listed by the time it was recorded. The samples PPV and Frequency appear in columns beside each sample.

(7) **Format Waveform Data into a Table**
Waveform data for the Event can also be formatted into a table. If unformatted, waveform data for each channel appears in sequence, starting with Channel 1. Formatted data appears in the form of a table.

(8) **Wave Data Column Width**
This setting determines the width of the columns in the waveform data table. The default setting is 10.

(9) **Output File Name**
You can change the name of the ASCII file to a name of your choice. The default name is ASCII.txt.

**WARNING:** Converting multiple files without changing the output file name results in each ASCII output file overwriting the last converted file. Add a prefix or append a letter to the files to avoid this, see below.

- **Fixed File Name**
Use this method when converting files one at a time. You can change the name by deleting the existing name and entering a new name.

- **Prefix a letter**
Use this method when converting multiple files.
Enter a letter in this text box. This letter is added to the beginning of each Blastmate Events filename and saved.

- **Append a letter**
Use this method when converting multiple files.
Enter a letter in this text box. This letter is added to the ending of each Blastmate Events filename and saved.

- **Unit Serial Number and Event Date**
Use this selection to save the ASCII conversion with the unit serial number and Event date as the name of the file. Below is an example of converted Event using this option:

```
BE6178_21_3_2003_18_51_39.txt
```

(10) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.

- **OK**
Press this to save your settings.

- **Cancel**
Leave the Printer Setup dialog box without changing the current settings.

- **Defaults**
Changes all the settings to the default settings.
f. Compliance Histogram and Sound Level Microphone ASCII Results

The Event Report summary of a histogram event with a sound recording channel, will display the Lmax, Lmin, LN1, LN2 and Leq for the entire time the unit was recording. If you highlight the event and convert it to an ASCII file you will be able to see the Lmax, Lmin, LN1, LN2 and Leq values for each of the individual intervals, as shown in the exported table below:

<table>
<thead>
<tr>
<th>Time</th>
<th>Tran PPV mm/s</th>
<th>Tran Freq Hz</th>
<th>Vert PPV mm/s</th>
<th>Vert Freq Hz</th>
<th>Long PPV mm/s</th>
<th>Long Freq Hz</th>
<th>Geo PVV mm/s</th>
<th>MicA Lmax dB(A)</th>
<th>MicA Lmin dB(A)</th>
<th>MicA L10 dB(A)</th>
<th>MicA L90 dB(A)</th>
<th>MicA Leq dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-Feb-13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:21:31</td>
<td>0.0315</td>
<td>47</td>
<td>0.0236</td>
<td>13</td>
<td>0</td>
<td>&lt;1.0</td>
<td>0.0885</td>
<td>83.8</td>
<td>63</td>
<td>81</td>
<td>65</td>
<td>75.8</td>
</tr>
<tr>
<td>9:21:33</td>
<td>0.0236</td>
<td>47</td>
<td>0.0236</td>
<td>17</td>
<td>0.00788</td>
<td>&lt;1.0</td>
<td>0.078</td>
<td>78.2</td>
<td>61.6</td>
<td>74</td>
<td>63</td>
<td>71</td>
</tr>
<tr>
<td>9:21:35</td>
<td>0.0315</td>
<td>23</td>
<td>0.0236</td>
<td>13</td>
<td>0.00788</td>
<td>N/A</td>
<td>0.0838</td>
<td>68.2</td>
<td>56.4</td>
<td>66</td>
<td>57</td>
<td>62.9</td>
</tr>
<tr>
<td>9:21:37</td>
<td>0.118</td>
<td>23</td>
<td>0.0631</td>
<td>22</td>
<td>0.0315</td>
<td>21</td>
<td>0.185</td>
<td>71</td>
<td>59.3</td>
<td>69</td>
<td>61</td>
<td>66.2</td>
</tr>
<tr>
<td>9:21:39</td>
<td>0.0315</td>
<td>9</td>
<td>0.0158</td>
<td>20</td>
<td>0.0158</td>
<td>N/A</td>
<td>0.0881</td>
<td>74.4</td>
<td>60.1</td>
<td>72</td>
<td>61</td>
<td>68.7</td>
</tr>
<tr>
<td>9:21:41</td>
<td>0.0236</td>
<td>&gt;100</td>
<td>0.0236</td>
<td>15</td>
<td>0.00788</td>
<td>&lt;1.0</td>
<td>0.0899</td>
<td>74.2</td>
<td>62.6</td>
<td>72</td>
<td>64</td>
<td>68.7</td>
</tr>
<tr>
<td>9:21:43</td>
<td>0.173</td>
<td>3.9</td>
<td>0.244</td>
<td>3.8</td>
<td>0.11</td>
<td>3</td>
<td>0.363</td>
<td>103</td>
<td>57.7</td>
<td>100</td>
<td>60</td>
<td>93.9</td>
</tr>
<tr>
<td>9:21:45</td>
<td>0.126</td>
<td>4.9</td>
<td>0.181</td>
<td>3.9</td>
<td>0.0631</td>
<td>4.7</td>
<td>0.264</td>
<td>68.5</td>
<td>56.5</td>
<td>65</td>
<td>58</td>
<td>62.5</td>
</tr>
<tr>
<td>9:21:47</td>
<td>0.102</td>
<td>8</td>
<td>0.126</td>
<td>4.5</td>
<td>0.0709</td>
<td>3.9</td>
<td>0.201</td>
<td>69.4</td>
<td>57</td>
<td>67</td>
<td>58</td>
<td>64.2</td>
</tr>
<tr>
<td>9:21:49</td>
<td>0.0631</td>
<td>5.8</td>
<td>0.0709</td>
<td>3.5</td>
<td>0.0236</td>
<td>4.1</td>
<td>0.174</td>
<td>66.6</td>
<td>59.1</td>
<td>64</td>
<td>60</td>
<td>62.9</td>
</tr>
<tr>
<td>9:21:51</td>
<td>0.221</td>
<td>N/A</td>
<td>0.307</td>
<td>N/A</td>
<td>0.15</td>
<td>N/A</td>
<td>0.442</td>
<td>66.1</td>
<td>56.3</td>
<td>64</td>
<td>57</td>
<td>61.5</td>
</tr>
<tr>
<td>9:21:53</td>
<td>0.615</td>
<td>4.1</td>
<td>0.969</td>
<td>4.2</td>
<td>0.473</td>
<td>3.5</td>
<td>1.24</td>
<td>70.1</td>
<td>56.1</td>
<td>65</td>
<td>57</td>
<td>63.1</td>
</tr>
<tr>
<td>9:21:55</td>
<td>16.9</td>
<td>5</td>
<td>2.36</td>
<td>64</td>
<td>1.12</td>
<td>43</td>
<td>18</td>
<td>72.2</td>
<td>57.5</td>
<td>69</td>
<td>58</td>
<td>65.3</td>
</tr>
</tbody>
</table>

g. Advanced Histogram and Sound Level Microphone ASCII Results

As with a Compliance Histogram event if you convert it to ASCII you will be able to see the peak information for each interval.

<table>
<thead>
<tr>
<th>Time</th>
<th>Mic A PPV pa.</th>
<th>Mic A Freq Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-Nov-12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:31:53</td>
<td>0.525</td>
<td>39.4</td>
</tr>
<tr>
<td>10:31:55</td>
<td>0.44</td>
<td>21.6</td>
</tr>
<tr>
<td>10:31:57</td>
<td>8.13</td>
<td>114</td>
</tr>
<tr>
<td>10:31:59</td>
<td>0.638</td>
<td>6.6</td>
</tr>
<tr>
<td>10:32:01</td>
<td>0.443</td>
<td>21.3</td>
</tr>
<tr>
<td>10:32:02</td>
<td>0.49</td>
<td>20.7</td>
</tr>
</tbody>
</table>
4.4 Remote Access

The Remote Access menu contains Auto Call Home and Start Blastware Mail. Blastware Mail is also accessible via the Windows Start, Programs menu. The Auto Call Home feature has three communication options, 1) Serial, or 2) UDP/IP and 3) TCP/IP.

4.4.1 Auto Call Home™ Overview

Use the Auto Call Home program for easy, remote access to your monitor and data, using Serial or IP communications. Whenever an event occurs, the monitor automatically places a call to your PC and downloads event data into a central location on your hard disk drive. When the monitor is ready to call in, it switches its modem on, and dials in to your PC. When communication has been established, the PC checks the serial number of the monitor, and then executes the instructions you have set for that specific monitor. Once data has been downloaded, the PC terminates communication.

To use this feature, you require a telephone or cellular modem connection to your Micromate, Series III Blastmate or Minimate Plus with a serial number of 6000 or more, or a Series IV unit, a PC equipped with a free serial port, and the Microsoft® Windows® operating system. If using the Auto Call Home Serial Communications option, each communications port used on the PC must also have a modem. The Auto Call Home program is not available for use with units that have a serial number less than 6000, the Minimate Blaster or any of the Series II units (DS477/677 and DS077).

NOTE: When connecting to a Series IV unit, TCP is the recommended communication protocol for reliability of messages being transferred between the unit and Blastware.

4.4.2 Steps for a Successful Auto Call Home Configuration

Review each step below, and proceed to the corresponding Subsection that is referenced to make the required configuration settings:

1. Ensure that you have a Micromate, Blastmate III or Minimate Plus with a serial number of 6000 or higher, or a Series IV unit.
2. Take a moment to review the entire Remote Access Section of this manual.
3. Review the protocol descriptions outlined in this Section for Auto Call Home IP and Serial communications. Determine what type of communications protocol you will be using, a) Serial, b) UDP/IP or c) TCP/IP. Proceed to the appropriate section within this chapter for more information on these communication setups.
4. Purchase the required software and modem(s). Purchase a communications package from your local service provider. Install the required software as per the manufacturer’s instructions. For a list of required software and communication requirements for IP communications, refer to Section Setting up an Airlink Raven Modem for Auto Call Home UDP/IP and TCP/IP.
5. Connect the instrument to your computer and start Blastware.
6. Proceed to the Setup Unit Section. Setup the unit dependent on the communications protocol, (i.e. cellular modem/telephone line or IP communications).
7. Proceed to the Setup PC Section and configure your PC. Configure the Communication Settings for Serial, UDP/IP or TCP/IP. For Serial Communications, refer to the Subsection Configure Auto Call Home Serial Communications, or for IP Communications, refer to the Subsections Configure Auto Call Home UDP/IP Communications, Setting up an Airlink Raven Modem for Auto Call Home UDP/IP, and Using Internet Protocol (IP) Communications. Or, if you prefer, refer to the TCP/IP section for those configurations.

Note: For setting up the UDP/IP or TCP/IP communications protocols it is suggested that you contact your System Administrator to handle Windows® Firewall adjustments and router configurations.
8. Refer to the **Reports** Section. Establish where your data output files will be located once they are downloaded, and their file format. Additionally, determine the download location of Event and FFT Report Metafiles and formats, along with the measurement system to be applied.

9. Proceed to the **Start Auto Call Home** Section.

10. Use the various testing features to determine that the modem and software configurations are working in the office prior to locating the system as a field installation.

### 4.4.3 Description of Commands

a. **Setup Unit**

Access this dialog by selecting **Remote Access Menu > Auto Call Home > Setup Unit**. The Setup Unit command opens the **Call Home Setup** dialog box. The settings made in the Call Home Setup dialog box are stored directly on the unit. If you are using **Auto Call Home** with more than one monitor, you must set up each monitor individually.

(1) **USR Modem or Radio Modem**

i. **Dial-up modem option**

   If you’re connecting your instrument to a cellular modem or a telephone line modem, then place a check mark on the **Enable Auto Call Home** and click on the **USR Modem** button.

   ![USR Modem dialog box](image)

   **USR Modem**

   - **Enable Auto Call Home**
   - **Phone Number**
   - **USR Modem**

ii. **IP modem option**

   If you’re using a Raven modem or any other type of Internet modem or Radio modem, then place a check mark on the **Enable Auto Call Home** and then press the **Radio Modem** button.

   ![Radio Modem dialog box](image)

   **Radio Modem**

   - **Enable Auto Call Home**
   - **USR Modem**
   - **Radio Modem**

   ![Call Home Setup dialog box](image)

   **Call Home Setup**

   - **Enable Auto Call Home**
   - **Phone Number**
   - **USR Modem**
   - **Radio Modem**

   ![Call Home Setup dialog box](image)
This will place the Radio Ring command in the dial string section and automatically transmit any data once it has been recorded. From here you will need to program the modem to redirect the information to their router or directly to your computer.

Depending on the situation, you need to select if you want the unit to call home after each event, at a specific time or both. Place the check mark(s) at the proper place(s).

Press the **Send** button to program the unit.

### iii When to Call Home

These settings determine when the monitor calls in to your PC to download data. If your unit is set to Histogram or Histogram Combo Recording Mode, you must schedule the unit to call home.

#### iv After Event Recorded

To have the monitor download data after every Event, click on this checkbox to display a checkmark. The monitor will call in after the wait time you specify, as set below.

#### v Wait ____ Minutes

Enter the length of time in minutes the monitor waits before calling in to your PC to download data. Click on the text box and enter the time. If you want the monitor to call in immediately after the Event, enter 0.

#### vi Monitor while calling home

Select this setting to ensure that the unit continues to record Events during downloading so that no Events are missed. If an Event is triggered during a download, the unit will stop the download, record the Event, and then restart downloading Events three minutes later to your PC. This function works only with downloads that occur right after the Event, or after the preset wait time. While in this mode, you are not able to set the time or delete Events. Downloads scheduled at a specific time (see the next item) cannot be interrupted to capture an Event.

#### vii At Specified Times

You can have the monitor call in at the same time every day, up to four times a day, to download data. This setting is preferable for long-term monitoring as it ensures that the monitors memory is regularly cleared while preserving battery power. It is more efficient to
have the unit call in only once or twice a day to download data rather than several times a day when an Event occurs.

Note: The “Monitor while calling home” function above does not work with scheduled downloads. Be sure to schedule your downloads for times when Events are unlikely to occur, to minimize the risk that an Event will be missed.

To enable downloads at specific times, click on the At Specified Times checkbox to display a checkmark. Then enter the time information in 24-hour format.

The unit will only call when it is in Monitor Mode. If the unit is set to call home when it is in Sleep Mode because the timer was set, it will not call home at that time.

(2) **Enable Auto Call Home**
Click on the checkbox to Enable **Auto Call Home** on the monitor currently connected to your PC. The unit must have the Auto Call Home settings configured.

(3) **Dial String**
Enter the dial string for the remote modem you intend to use with the monitor. The dial string must include the phone number for the telephone line to which your PC modem is connected. Your modem type may use a different dial string. Consult the documentation that came with your modem.

To change the string, click on the text box and enter the dial string. To insert a comma in the dial string without causing a 1 second pause, place the characters “\,” (backslash comma) into the string.

Note: The dial string for radio modems is RADIO RING.

(4) **Auto Answer: On**
Enter the text string the monitor sends to the modem to turn Auto Answer mode on when the modem is in data mode. The default text string has been tested on various modems from different manufacturers, and found to work adequately. However, you may wish to change the string to improve performance. Consult the documentation that came with your modem.

To change the string, click on the text box and enter the text string.

Note: The Auto Answer: On string for radio modems should be blank.

(5) **Auto Answer: Off**
Enter the text string the monitor sends to the modem to turn Auto Answer mode off. The default text string has been tested on various modems from different manufacturers, and found to work adequately. However, you may wish to change the string to improve performance. Consult the documentation that came with your modem.

To change the string, click on the text box and enter the text string.

Note: The Auto Answer: Off string for radio modems should be blank.

(6) **Modem Power Controlled by Relay or Remote Alarm**
This setting enables you to conserve modem power for longer operation. The Blastmate III, Minimate Plus and Series IV units automatically toggles a pin on the auxiliary port that can be used to power the modem on or off as needed. The Warm Up Time is to allow the modem to initialize. Please contact Instantel for advice on relay settings necessary to use this function.

Warning: The alarm cannot be used if this feature is enabled.

(7) **Communication Timeouts**
This area contains information on the modem communication setup. You cannot change any of these settings. Number of Retries indicates the number of retries the monitor will make to call in if the line is busy on the first attempt. Time Between Retries is the time in seconds between these attempts. Wait for Connection is the time the monitor waits for instructions from the PC after its call has been answered; if no instructions are received within this time, the monitor terminates the connection. Serial Idle Time is the amount of time the monitor allows without any exchange with the PC before terminating the connection.
(8) **Command Buttons**

To choose one of the following command buttons, click the mouse pointer on the button.

- **Send**
  Press this to send your settings to the unit.

- **Close**
  Leave the dialog box without changing the current settings.

**b. Setup PC**

You are able to access the Setup PC command from two locations;

1. Remote Access Menu > Auto Call Home > Setup PC, or
2. Remote Access Menu > Auto Call Home > Start, then Settings Menu > PC Setup.

Either command will store and access the settings you enter.

The Setup PC command opens the **Auto Call Home PC Setup** dialog box, where you setup your PC for communication with remote monitors. You must tell Blastware which monitors to expect modem communications from. When the monitor phones in, the software checks the monitors serial number against the settings contained in the **Auto Call Home** PC Setup dialog box. If it finds a match, it executes the instructions you have specified.

(1) **Remote Unit Serial No.**

Enter the serial numbers of the Blastmate III or Minimate Plus units that you wish to use with Auto Call Home. Click on the text box and enter the serial number.

You can also create a single set of actions to be performed when any remote monitor calls in to your PC. In the first Remote Unit Serial No. field, enter the * character as the serial number. Then click on the Edit button to set the actions (see below). Blastware applies these actions to any monitor that calls in.

**Note:** **Auto Call Home** is supported by Blastmate III or Minimate Plus units with a serial number of 6000 or greater, or any **Series IV** unit.

(2) **Description of Actions**

This area displays the description entered for the unit. The description cannot be edited here. Click on the Edit button (see below) to change your description.

(3) **Edit**

The Edit button invokes the **Auto Call Home Actions** dialog box. In this dialog box you tell Blastware what actions to perform when the monitor calls in.
Description
Enter the description you wish to associate with this monitor. The description allows you to identify the monitor in a way that is meaningful to you. For example, you may wish to describe the monitor according to its installed location or by the project that it is monitoring.
To enter a description, click on the text box and type in your description.

Copy Last and All Un-Copied Events From Unit
Check this checkbox to have Blastware download the most recent Event and all Events on the unit that have not yet been downloaded. The Events will be copied to the directory that you specify (see below). If this is not selected no Events will be downloaded.
To choose to download the most recent and all un-copied Events, click on the checkbox to display a checkmark.

Copy Monitor Log
Check this checkbox to have Blastware download the monitor log. The log will be copied to the directory that you specify (see below).
To choose to download the monitor log, click on the checkbox to display a checkmark.

Delete All Events on Unit
Note: This command will not work if Auto Call Home is set to run during monitoring.
You can have Blastware delete all Events stored on the unit. Click on the checkbox to display a checkmark.

 Warning: If you select Delete All Events on Unit without also selecting Copy Last And All Un-Copied Events From Unit, you may delete Events that you have not yet copied to your PC. Once deleted, these Events cannot be recovered.

Note: This option is not available if the unit is set to Histogram Combo Recording Mode.

Send the PC Time to the Unit (Series III, IV and Micromate)
You can have the PC Time and Date settings sent to the unit. One second is added to the PC Time to allow for transfer delays.
Note: This command will not work if Auto Call Home is set to run during monitoring.

Additional feature available for Micromate monitors only: If an Auto Call Home configuration, with the ‘Send the PC Time to the Unit’ command selected, has been set in the Monitor Scheduler, and the time difference between the PC and the Micromate is within 10 seconds, the time will be updated on the unit; the Micromate clock will gradually (100 ms/s) be updated to align with the new time. If the time difference is greater than 10 seconds, the unit will not be updated. A log will be added to the Service Log file indicating if the time update was applied or not.
(4) **Destination**

This displays the directory where the data from the monitor will be copied. To select a directory, click on the button to the right of the description field. The following dialog box appears:

Navigate through your directories to select the destination directory. Press Select to make that directory the destination for downloaded Events. To create a new directory, press Create and enter the name of the directory in the dialog box that appears.

i "**Disconnect after being connected for 'x' minutes (Range 1-9999)**"

Check this box to have the Call Home connection automatically terminated after a certain time (1-9999 minutes). The timer starts as soon as the PC is successfully connected to the remote unit. If a Call Home connection is terminated because of this timeout a "Session timeout" entry is made in the CALLHOME.LOG.

**NOTE:** Make sure that the timeout is long enough to allow all Events to download. For example, a 1-second 4-channel Event recorded at 1024 sps takes about 1 minute to transfer using a typical modem connection. For Series IV units, ensure that the range is set to handle extremely large Events or thousands of stored Events.

ii **Clear All**

Press this button to clear all settings in the **Auto Call Home** PC Setup dialog box.

If you wish to clear the settings for only one monitor, erase the serial number. The Description field and all settings within the Call Home Setup dialog box will clear automatically.

iii **Units in List**

This area lets you control how many monitor entries appear in the list (the minimum is five). The current number appears in the title. To add more entries, click on the More button. To remove entries, click on the Less button.

**Note:** Whenever you press the Less button, you will erase any settings you have made in the entry you are deleting. For example, if there are 7 monitors in the list, and you press Less once, you will erase all settings for Monitor 7.

iv **Command Buttons**

Select OK to save your settings and return to the Main Window, or Cancel to leave the dialog box without changing the current settings.

c. **Load Setup**

Use the **Load Setup** function to automatically send saved setup files to remote units. Access this dialog by selecting the Remote Access menu > Auto Call Home > Start > Settings > Load Setup.
Blastware Compliance Module

Remote Unit
Under the column Remote Unit, you are able to view the serial number of each unit that is being monitored.

Load
Clicking in this box will indicate that you want to load the specified setup file shown in the Setup Filename text box.

Browse
Use the Browse feature to search and select the Setup File that you want to be loaded into the specified unit.

Open
Select Open to accept the selection. This file and path will be added to the Setup Filename text box.

Cancel
Select Cancel to leave this dialog without applying the changes you have made.

OK
Select OK to approve the changes.

d. Reports
This option is only available when Auto Call Home is not actively connected. Select Settings from the main menu bar of the Auto Call Home dialog box, than click on Reports to display the Setup Text Report for Data Base dialog box:
(1) **Create Database Files**

If you would like to generate file copies of your reports or if you are using Blastware Mail, select **Create Database Files**. If it is an 8-channel Event that is being sent to a database file, two separate files, 4 channels each, is created. If it is a 6-channel Event that is being sent to a database file, two separate files, 4 and 2 channels each, are created.

**File Naming Convention Examples:**

- **Event Name**
  - H0029YO8_CC0.txt
- **Database File Name**
  - H0029YO8_CC0.txt or H0029YO8.xml
- **Event Report File**
  - H0029YO8_CC0_1_4.wmf (4-channel example)
  - H0029YO8_CC0_5_8.wmf (8-channel example)
  - H0029YO8_CC0_5_6.pdf (6-channel example)
- **FFT Report File**
  - H0029YO8_CC0_FFT1_4.wmf (4-channel example)
  - H0029YO8_CC0_FFT5_8.wmf (8-channel example)
- **ASCII Export**
  - H0029YO8_CC0_ASCII.txt or H0029YO8_CC0_XML.xml

**NOTE:** Series IV file naming is the same with the exception of the beginning of each file, which starts with "MPID#-".

(2) **Save to**

Use the **Save to** text box to indicate the directory and folder in which you want the files to be saved, or select the "..." tab to browse and select directories on your PC. If you want to add a new directory, it must be done within Windows® Explorer.

To automatically save files into a folder that is automatically created using the serial number of the unit, place a checkmark in the **Use Serial Number as a Subdirectory** box.
(3) **Sensor Configuration**  
Select your **Sensor Configuration** by either selecting the radio button next to **Uni-Axial** or **Tri-Axial**.

(4) **Database File Type**  
Indicate what file type you would like to have the database files saved as, by either selecting the radio button next to **Text** or **XML**.

(5) **Output Files**  
In this section of the dialog, you can select which file types you want to create, and also the directory path where you want to save each file type. Use the **Save to** text box and □ to indicate a directory path for the saved files.

i **Event Report Metafile**  
This feature is only available if the **Tri-Axial** format has been selected. Selecting **Event Report Metafile** will save the file in a graphic (.wmf) format.

ii **Event Report PDF**  
This feature is only available if the **Tri-Axial** format has been selected. Selecting **Event Report PDF** will save the file in the Adobe® Acrobat® (.pdf) format.  
**Note:** The associated Metafile used to create each .pdf file will be deleted.

iii **FFT Report Metafile**  
This feature is only available if the **Tri-Axial** format has been selected. Selecting **FFT Report Metafile** will save the file in a graphic (.wmf) format.

iv **Frequency Range**  
This feature is only available if the **Tri-Axial** format has been selected. Enter the **Frequency Range** you would like to include within your reports by inputting the range in the **To** and **From** boxes.

v **Convert Event to ASCII**  
This feature is only available if the **Tri-Axial** format has been selected.

vi **Convert Event to XML**  
This feature is only available if the **Tri-Axial** format has been selected.

(6) **Measurement System**  
Select the unit type that you would like to have the reports created in by either selecting **Metric** or **Imperial**. Select the unit which the microphone reading was created with, **dB** or **pa** (metric), or **psi** (imperial).

(7) **File extensions for database reports**  
Under **File extensions for database reports** you can alter the file extension for either the database or metafile. Place your cursor in the box related to the extension you would like to change under **For Waveform Events** or **For Histogram Events**, highlight the existing default text, and replace with an optional file extension name (i.e. JPG, TIF, BMP).

**Warning:** Use this with caution, as some programs will not be able to open the file if an improper extension is used.

(8) **Test**  
You can test the file extension, to ensure that Windows recognizes the file type and that you are able to open the file with either a word processing or graphics program, by clicking on the **Test** button. When you click on the Test button, the following dialog appears:
(9) **Open**  
Highlight an existing event and select Open. The files will be written to the specified directory with the file extensions that you have input. Use the Windows File Explorer program to locate the files, and ensure that you can open them.

(10) **Cancel**  
Click on Cancel to abort the test.

### 4.4.4 Communications Configuration Options

Communications configurations are based on the type of unit you have, Series III or Series IV. For Series III communication protocols, there are two possibilities, UDP/IP or TCP/IP. Series IV offers four communication configuration possibilities: UDP/IP or TCP/IP, with Automatic or Static IPs. All Series III and Series IV units support Serial Communications.

**NOTE:** When connecting to a Series IV device, TCP is the recommended communication protocol for reliability of messages being transferred between the unit and Blastware.

**Micromate Serial Communications**
Series III Communications: UDP/IP
Modem Communications

Series III Communications: TCP/IP
Modem Communications

Series IV Communications Setup: UDP/IP
Ethernet/Modem Communications
Automatic IP Address

Series IV Communications Setup: TCP/IP
Ethernet/Modem Communications
Automatic IP Address
Series IV Communications Setup: TCP/IP
Ethernet/Modem Communications
Static IP Address

Series IV Communications Setup: UDP/IP
Ethernet/Modem Communications
Static IP Address
4.4.5 **Configure TCP/IP Communications**

With **Auto Call Home** and the seismograph(s) configured, select **Auto Call Home > Start** and then the **TCP** radio button.

(1) **Communications**

i. Select the Settings option from the Communications menu.

ii. Enter the Host Computer IP address running the Blastware program.

iii. Enter the Port Number that will be receiving the call from the seismographs.

iv. Save these settings by clicking the **OK** button. Select Exit.
(2) **Raven Modem Setup**

i. The Raven X modem must also be configured for TCP communication. Start the Acemanager program and connect to the modem using the provided URL.

ii. Select the Serial tab.

iii. The settings should be as outlined below except where noted:

![Serial Port Configuration](image)

a. The Destination Port must be the same as what was entered in Auto Call Home.
b. The Destination Address is the IP address of the device receiving the call from the modem.
c. If the modem can reach the host computer running the Blastware program directly, the IP address would be the IP address of the host computer.
d. If the modem connects to a switch first which in turn forwards the messages to the host computer, then the IP address is the IP address of the switch.

iv Save these changes.
v Place the seismograph into monitor mode
vi Start the Auto Call Home program.

vii Trigger the seismograph and ensure the event file is transferred.
viii To add additional units repeat the above procedure.

NOTE: All modems MUST be configured to the same IP address and port number.

4.4.6 Configure Auto Call Home UDP/IP Communications

UDP/IP communications refers to a network and transport protocol used for exchanging data over the Internet. The Blastware feature Auto Call Home UDP/IP facilitates communications with remote packet data modems, such as the Airlink Raven, on a PC or server, through a conventional Internet connection. This feature of Blastware is used to transfer data from single or multiple Instantel Series III and Series IV units at faster rates within a more stable and less costly configuration than analog networks (Serial Communication). The analog data is converted for transfer over a data network and the Internet; in the most efficient configuration, the modems need to address a static IP address at the destination PC or server to facilitate transfer of this data over the Internet, through a standard Internet connection at the destination PC/server.

The Auto Call Home UDP/IP program allows you to connect with up to two hundred and fifty six remote units, and communicate with twenty five of those units simultaneously. Whenever an event occurs, each monitor automatically calls your PC and downloads the event data into a specified directory that is created using the unit serial number of the monitoring system. This information includes the unit serial number, communication port, and the date and time. This part of the Auto Call Home feature is useful when you are monitoring more than the four available communication ports on your PC. You can view activity and error logs of the monitoring and data acquisition as it occurs.

Auto Call Home UDP/IP saves the original setup file for future use, and automatically sends the stored setup file to a remote monitor through the standard Internet connection, once the monitor establishes communication with the PC or server.

Note: Contact your computer system administrator or trained technician to assist you in router configuration, communications and Windows Firewall settings for Auto Call Home UDP/IP and TCP/IP.

a. Setting up an Airlink Raven Modem for Auto Call Home UDP/IP

Instantel encourages the use of the Airlink Raven modem. The Airlink Raven has a high-speed data transfer rate that supports the Instantel® Series III monitors, serial number 6000 and higher. Since it uses Internet Protocol (IP) to transfer data from the monitor to a computer operating the Instantel® Blastware® Software, the communication link is always present, and long distance charges no longer apply. The service plans differ from analog plans in that billing is commonly done based on the quantity of data transferred in a given period.

These installation instructions describe the procedures for installing an AirLink Raven modem that will support communication with a remotely installed Instantel vibration monitor. For the purpose of these installation instructions, it is assumed that the office PC already has an Internet connection and that communications do not pass through an interoffice server or firewall. If
communications do pass through an interoffice server or firewall, please contact your IT person to make the proper adjustments.

Tools and Material Required:

1. Purchase and activate the telephone service package; this is a regular data call package from either Bell Mobility or with Verizon Wireless. Also, request a static IP address from the local telephone service provider that you have selected.
2. AirLink Raven modem.
3. Power source for the AirLink Raven modem (a 12 volt car or marine battery and/or a solar panel).
4. Null modem cable (Instantel® part number 718A3701).
5. Install the AirLink software. This software can be downloaded from AirLink’s web site, or from the modem manufacturer’s website at www.sierrawireless.com.
6. Download and install the ACEmanager™ software to program and troubleshoot the modem. This software can be downloaded from AirLink’s web site, or from the modem manufacturer’s website at www.sierrawireless.com. Below are screen captures of the Info, Status and Common screens from the ACEmanager to Raven Modem setup software. Question marks (?) are placed next to the fields that need information input, or represent areas that may particularly cause difficulties during setup. If you are required to call the Instantel Technical Service Team for assistance, please have this document, the ACEmanager software running with the modem attached.

ACEmanager Info Dialog (Phone Number is input in the Common dialog):

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MDSEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>AT</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>*NETPHONE</td>
<td>Phone Number</td>
</tr>
<tr>
<td></td>
<td>*DEVICEID</td>
<td>Device ID</td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td>Misc</td>
<td>Modern Name</td>
</tr>
<tr>
<td></td>
<td>Serial</td>
<td>Modern EID/IMEI</td>
</tr>
<tr>
<td></td>
<td>TCP</td>
<td>Modern Type</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DNS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dynamic IP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PPP/Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PassThru</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SMTP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firewall</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port Forwarding</td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td></td>
<td>Boot Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MSCI Version</td>
</tr>
</tbody>
</table>
ACEmanager Status Dialog (Phone Number is input in the Common dialog):

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPP/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PassThru</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMTP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Firewall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ACEmanager Misc Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPP/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PassThru</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMTP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Firewall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### ACEmanager Serial Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td><strong>AT</strong> Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configure Serial Port</td>
<td>36400,8N1</td>
<td>36400,8N1</td>
</tr>
<tr>
<td></td>
<td><strong>IQ</strong> Serial Port How Control</td>
<td>0</td>
<td>0-Mono</td>
</tr>
<tr>
<td>COMMON</td>
<td><strong>B20</strong> Data Forwarding Timeout</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td><strong>B51</strong> Data Forwarding Character</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td><strong>E</strong> DB9 Serial Echo</td>
<td>0</td>
<td>0-OFF</td>
</tr>
<tr>
<td></td>
<td><strong>E</strong> Telnet Echo</td>
<td>0</td>
<td>0-OFF</td>
</tr>
<tr>
<td></td>
<td><strong>IV</strong> AT Verbose Mode</td>
<td>1</td>
<td>1-Verbose</td>
</tr>
<tr>
<td></td>
<td><strong>BD</strong> DTR Mode</td>
<td>1</td>
<td>1-Ignore DTR</td>
</tr>
<tr>
<td></td>
<td><strong>B211</strong> DTR Mode</td>
<td>1</td>
<td>1-Ignore DTR</td>
</tr>
<tr>
<td>LOGGING</td>
<td><strong>AS</strong> Assert DSR</td>
<td>1</td>
<td>1-In Data Mode</td>
</tr>
<tr>
<td></td>
<td><strong>AG</strong> Assert DCD</td>
<td>1</td>
<td>1-In Data Mode</td>
</tr>
<tr>
<td>REPORT</td>
<td><strong>CTSE</strong> Enable CTS to Indicate Network Coverage</td>
<td>0</td>
<td>0-Disabled</td>
</tr>
<tr>
<td>Server 1</td>
<td><strong>IQ</strong> Quiet Mode</td>
<td>1</td>
<td>1-ON</td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td><strong>K</strong> Call Progress Result Mode</td>
<td>1</td>
<td>1-ON</td>
</tr>
<tr>
<td>TELEMETRY</td>
<td><strong>NUMTIDIP</strong> Convert 12 digit Number to IP</td>
<td>0</td>
<td>0-Use as Name</td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ACEmanager TCP Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td><strong>SG0</strong> TCP Auto Answer</td>
<td>2</td>
<td>2-Telnet Server</td>
</tr>
<tr>
<td></td>
<td><strong>S7</strong> TCP Connect Timout</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td><strong>TCPD</strong> TCP Idle timeout</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td><strong>TCPB</strong> TCP Idle Timeout Secs</td>
<td>0</td>
<td>0-Minutes</td>
</tr>
<tr>
<td></td>
<td><strong>B221</strong> TCP Connect Response Delay</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td><strong>SG60</strong> Telnet Echo</td>
<td>0</td>
<td>0-No Echo</td>
</tr>
<tr>
<td></td>
<td><strong>ENQ</strong> Enable ENQ on TCP Connect</td>
<td>0</td>
<td>0-Disable</td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ACEmanager UDP Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPP/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PassThru</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMIP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Firewall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AT</td>
<td>Name</td>
<td>Value</td>
</tr>
<tr>
<td>MD</td>
<td>Startup Mode Default D99 Serial</td>
<td>03</td>
</tr>
<tr>
<td>SB2</td>
<td>UDP Auto Answer</td>
<td>2</td>
</tr>
<tr>
<td>SB3</td>
<td>UDP Idle Timeout</td>
<td>0</td>
</tr>
<tr>
<td>HDR</td>
<td>UDP Auto Answer Response</td>
<td>0</td>
</tr>
<tr>
<td>*TUPLAST</td>
<td>UDP Connect Last</td>
<td>0</td>
</tr>
<tr>
<td>AIP</td>
<td>Allow Any IP</td>
<td>1</td>
</tr>
<tr>
<td>*TUALL</td>
<td>Allow All UDP</td>
<td>0</td>
</tr>
<tr>
<td>*FDU</td>
<td>Dial UDP Always</td>
<td>1</td>
</tr>
<tr>
<td>FUSD</td>
<td>UDP Serial Delay</td>
<td>0</td>
</tr>
</tbody>
</table>

ACEmanager DNS Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPP/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PassThru</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMIP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Firewall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AT</td>
<td>Name</td>
<td>Value</td>
</tr>
<tr>
<td>OPTIONS</td>
<td>DNS Updates</td>
<td>0</td>
</tr>
<tr>
<td>DNS1</td>
<td>Modern DNS Server 1</td>
<td></td>
</tr>
<tr>
<td>DNS2</td>
<td>Modern DNS Server 2</td>
<td></td>
</tr>
<tr>
<td>DNSUSER</td>
<td>Use Alternate DNS 1</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Use Alternate DNS 2</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>
### ACEmanager Dynamic IP Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>AT Name: MODEMNAME, Value: 6068646c</td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>AT Name: DOMAIN, Value:</td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td>AT Name: *IPMANAGER1, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: *IPGROUPDATE1, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: *IPMKERKEY1, Value:</td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td>AT Name: Dynamic-IP, Value:</td>
<td></td>
</tr>
<tr>
<td>Dynamic-IP</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Firewall</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>AT Name: Server 1, Value:</td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td>AT Name:</td>
<td></td>
</tr>
</tbody>
</table>

### ACEmanager PPP/Ethernet Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>AT Name: HOSTPRIVMODE, Value: 0</td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>AT Name: HOSTPRIVIP, Value:</td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td>AT Name: HOSTGROUPIP, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: HOSTGROUPERIP, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: HOSTNETMASK, Value: 0.0.0.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: *HOSTAUTH, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: HOSTUID, Value:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AT Name: *HOSTPW, Value:</td>
<td></td>
</tr>
<tr>
<td>Dynamic-IP</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Firewall</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>AT Name: Server 1, Value:</td>
<td></td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td>AT Name:</td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td>AT Name:</td>
<td></td>
</tr>
</tbody>
</table>
ACEmanager PPP/Ethernet Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>PrintableView</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ACEmanager SMTP Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>PrintableView</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### ACEmanager Other Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>UPPING</em></td>
<td>Keepalive Ping Time</td>
<td>0</td>
</tr>
<tr>
<td><em>UPPINGSADOR</em></td>
<td>Keepalive Ping Address</td>
<td></td>
</tr>
<tr>
<td><em>MSCURADDR</em></td>
<td>Status Update Address</td>
<td>0/0</td>
</tr>
<tr>
<td><em>MSCUPPERIOD</em></td>
<td>Status Update Period (Seconds)</td>
<td>0/0</td>
</tr>
<tr>
<td><em>TPORT</em></td>
<td>AT Telnet Port</td>
<td>2332/2332</td>
</tr>
<tr>
<td><em>TELNETTIMEOUT</em></td>
<td>AT Telnet Port Timeout (Minutes)</td>
<td>2/2</td>
</tr>
<tr>
<td>DAE</td>
<td>Disable AT Escape</td>
<td>0/0-FF</td>
</tr>
<tr>
<td><em>DATZ</em></td>
<td>Disable ATZ Reset</td>
<td>0/0-FF</td>
</tr>
<tr>
<td><em>SMTP</em></td>
<td>Enable time update</td>
<td>0/0-FF</td>
</tr>
<tr>
<td><em>SMTPADDR</em></td>
<td>SMTP Server Address</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>NETLOG</em></td>
<td>Network Connection Wait</td>
<td>120/120</td>
</tr>
<tr>
<td><em>SNMPPORT</em></td>
<td>SNMP Port</td>
<td>0/0</td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMTRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>SNMPSECLVL</em></td>
<td>SNMP Security Level</td>
<td>0/0</td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>SNMPTRAPDEST</em></td>
<td>SNMP Trap Destination IP</td>
<td>0/0</td>
</tr>
<tr>
<td><em>SNMPCOMMUNITY</em></td>
<td>SNMP Community String</td>
<td>public/public</td>
</tr>
<tr>
<td>IPSec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ACEmanager Firewall Dialog:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Modem Data</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM</td>
<td>Firewall Mode</td>
<td>0/0-FF</td>
</tr>
<tr>
<td>Non-Friend Port Forwarding</td>
<td>0/0-Disabled</td>
<td></td>
</tr>
<tr>
<td>F0</td>
<td>Friends List IP0</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F1</td>
<td>Friends List IP1</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F2</td>
<td>Friends List IP2</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F3</td>
<td>Friends List IP3</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F4</td>
<td>Friends List IP4</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F5</td>
<td>Friends List IP5</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F6</td>
<td>Friends List IP6</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F7</td>
<td>Friends List IP7</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F8</td>
<td>Friends List IP8</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>F9</td>
<td>Friends List IP9</td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>1X/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMTRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Range 1 Start</td>
<td></td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>Range 1 End</td>
<td></td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>Range 2 Start</td>
<td></td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
<tr>
<td>Range 2 End</td>
<td></td>
<td>0.0.0.0/0.0.0.0</td>
</tr>
</tbody>
</table>
ACEmanager Post Forwarding Dialog:

<table>
<thead>
<tr>
<th>GROUPS</th>
<th>MODEM DATA</th>
<th>PRINTABLE VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPP/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PassThru</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNTP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Firewall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Forwarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGGING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPORT Server 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1x/EV-DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TELEMETRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDR LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AT Name</th>
<th>Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of FF Entries</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Public Port 1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Host IF 1</td>
<td>4</td>
<td>4-Ethernet</td>
</tr>
<tr>
<td>Host IP 1</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Private Port 1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Public Port 2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Host IF 2</td>
<td>4</td>
<td>4-Ethernet</td>
</tr>
<tr>
<td>Host IP 2</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Private Port 2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Public Port 3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Host IF 3</td>
<td>4</td>
<td>4-Ethernet</td>
</tr>
<tr>
<td>Host IP 3</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Private Port 3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Public Port 4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Host IF 4</td>
<td>4</td>
<td>4-Ethernet</td>
</tr>
<tr>
<td>Host IP 4</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Private Port 4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Public Port 5</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Host IF 5</td>
<td>4</td>
<td>4-Ethernet</td>
</tr>
<tr>
<td>Host IP 5</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Private Port 5</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

7. Load and write the script file to the modem as per the manufacturer’s instructions. Reset the modem or disconnect/reconnect it the power to ensure that the script file is loaded properly.
8. The Airlink Raven modem script file supplied by Instantel® Technical Services.
9. Latest version of the Instantel® Blastware Software. Download the latest version from the Instantel website.
10. Instantel® Series III seismograph (to use the Call home feature, use a Series III unit with a serial number higher than 6000).

Monitor Setup:

1. Refer to the operator manual of your Instantel® vibration monitor to set the following communication options: Series III unit - the unit should be set to communicate at 38400 baud and the serial connection to DIRECT.

Installation:

2. Refer to the manufacturer’s instructions for setting up and attaching the AirLink Raven modem to the COM 1 port of your computer.
3. Install and run the AirLink software. This software will prompt for the following information obtained from your service provider (Refer to Material’s Required, Item 1):
a. Unit’s unlock code (also known as the master subsidy Lock Code),
b. the phone number,
c. the SID and NID (typically, the SID = 0, and the NID = 65535),
d. the NAI (the account e-mail address), and
e. the password.

4. Set the modem to “Home Preferred” and “Public Internet”. Next, update the PRL (Preferred Roaming List - This is a list of information that resides in the memory of a digital phone. It lists the frequency bands the phone can use in various parts of the country). If the modem returns an error, bypass this step. The Modem will now attempt a connection with the service provider.

5. After a successful connection, disconnect the modem (with the antenna installed) from the computer. Four lights on the modem should be either on or flashing, a) Chan, b) Link, c) Reg., and d) Pwr. The RSSI (Receive Signal Strength Indicator) may also be indicating the level of coverage.

6. Install AirLink Wireless ACE 3G software. This software will load the communication protocols into the modem.

7. Run the AirLink Wireless ACE 3G software. Click on CONNECT and then select the UPD (User Datagram Protocol) protocol. This protocol provides a procedure for application programs to send messages to other programs with a minimum of protocol mechanism.

8. Enter the IP (Internet Protocol) address and the password. Select OK. The software will attempt to communicate with the modem.

9. Select the “Load” icon and scroll to find the “Raven 1X modem” script file. Select the WRITE button. This will send the information to the modem.

10. Select menu item Blastware > Communications > Static IP. Enter the IP Port Address (example: 12345). Select the Test Communications button.

4.4.7 Configure Internet UDP/IP Communications

To access the Auto Call Home IP Communications Setup dialog, select the Remote Access Menu > Auto Call Home > Start menu item. Use your cursor to select UDP at the top of the dialog box before selecting the Settings Menu > Communications option.
(1) **First Port**  
Enter the starting port that you are going to be monitoring within the range specified (1024 – 65535).

(2) **Number of Ports**  
Enter the number of ports that you are going to be monitoring, that will have units calling in and downloading data onto the PC. The number of Ports is equivalent to the number of monitors using AutoCall Home.

(3) **Protocol UDP**  
User Datagram Protocol (UDP) is the only protocol supported for Auto Call Home IP. UDP is a high-level communication protocol that coordinates the one-way transmission of data in a packet data network. The UDP protocol coordinates the division of files or blocks of data information into packets and adds sequence information to the packets that are transmitted during a communication session using Internet Protocol (IP) addressing. This allows the receiving end to receive and re-sequence the packets to recreate the original data file or block of data that was transmitted. UDP adds a small amount of overhead (control data) to each packet relative to other high-level protocols such as TCP.

(4) **Computer Address (For Testing Only)**  
To obtain your computer **IP Address**, click on the Windows **Start** > **Programs** > **Run** and type **CMD** in upper or lower case, in the text block that appears. The **Command Prompt** window will appear. At the blinking horizontal cursor after `C:\>`, type **IPCONFIG** in upper or lower case and select **OK**. The **IP Address**, **Subnet Mask**, and **Default Gateway** are listed. Record the **IP Address** for later use – this address will be used to setup the Auto Call Home UDP/IP communications.
(5) **Computer Port**
Input a **Computer Port** number within the range specified (1024 – 65535) – this number must match the number entered into the **First Port** field.

(6) **Unit Address**
This is the address of the Modem attached to the unit.

(7) **Unit Port**
The **Auto Call Home UDP/IP** software is capable of detecting the port on which each packet data modem will communicate.

(8) **Loop Test**
To ensure that data is able to be sent to and from the PC to the Modem, and vice versa, perform a Loop Test. To do this, you must disconnect the modem serial communication connector and short the circuit of female connector pins 2 and 3, before selecting performing the Loop Test.
The Loop Test sends from 10 to 1400 bytes. It starts by sending 10 characters, or bytes, and increments the number of characters by 10 each iteration until 1400 characters has been reached. It then goes back to 10.
You can cancel the loop test at any time by clicking on the **Cancel Loop Test** button. Watch the **Message Window** for the software response to the Loop Test.

---

**Message from the Loop Test:**
Blastware is reading the response of the 10 Bytes that were sent:

![Diagram showing the Blastware Compliance Module interface]

The message window indicates that 10 Bytes were successfully sent and read – if you receive an error, check the modem connections, setup and status, and ensure that each piece of equipment is turned on:

![Diagram showing the Loop Test results]

If the Loop Test is not successful, the window will prompt you with a series of messages, similar to the following:

“Writing 100 bytes”
“Loop #10: Trying to read 100 Bytes”
“100 of 100 chars were read correctly”
“100 of 200 Error at char 101”

The last line indicates an Error, stating that character 101 does not match what was sent out. If a Loop Test is not able to be performed at all, the message “Connection failed” is displayed, indicating that the software could not open the communication socket. Review and check the status and setup of the modem.

(9) **Communications from a Unit**

Ensure that the modem is setup up and working properly. To test the communications from a unit, first turn the unit off, and then manually wake up the unit, wait 10 seconds and click on **OK**.
NOTE: Do not turn the Series IV monitors Off – the monitors will not communicate.

i When the unit is initially turned on, it will display that it is “Connecting” and sends the Operating System, as shown in the message box below:

![AutoCallHome dialog]

ii After the Operating System has been successfully read by Auto Call Home, you will be prompted with the message and a window dialog, as shown below – click on OK.

![AutoCallHome dialog]

iii If the unit is unable to successfully send the Operating System, the following dialog will appear. If you receive an error, check the modem connections, setup and status, and ensure that each piece of equipment is turned on:
(10) Communications to a Unit

Communications to a Unit tests the communication link from the PC to the unit. Turn off the unit for approximately 10 seconds then click on Communications to a Unit. A dialog will appear instructing you of the steps to follow. Click OK.

i Click OK on the new dialog that appears. The unit will turn on and display a “Connecting” message. If the unit does not wake up within 20 seconds, the follow the directions on this dialog:
4.4.8 Configure Auto Call Home™ Serial Communications

Serial communication refers to when data is transmitted bit-by-bit. If you wish to download events from several monitors, you can stagger the call times to ensure that there is no overlap or get a multiple ComPort box and have multiple modems at the computers end. This feature also allows you to connect with up to twenty communication ports on your PC and remotely gather data from multiple vibration monitors simultaneously. You can view activity and error logs of the monitoring and data acquisition as it occurs. Whenever an event occurs, each monitor automatically calls your PC and downloads the event data into a specified directory. This information includes the unit serial number, communication port, and the date and time. This part of the Auto Call Home program is useful when you are monitoring more than the four available communication ports on your PC.

(1) Auto Call Home using Serial Communications

To access the Auto Call Home Serial Communications Setup dialog, select the Remote Access Menu > Auto Call Home > Start. Use your cursor to select Serial at the top of the dialog box before selecting the Settings Menu > Communications option.

(2) COM Ports

Select Settings from the main menu bar of the Auto Call Home dialog box, then click on CommPorts to display the Communications Settings dialog box. Within this dialog you can indicate which CommPorts you would like to monitor for activity by placing a checkmark in the box beside each port, from 1 to 20.

(3) Baud Rate

Place a checkmark next to the proper Baud Rate setting – this setting must match the setting of the communications ports you are monitoring with the Auto Call Home program. The Baud Rate determines the speed that the data transfers, with 38400 (Series III) or 115200 (Series IV) being the highest, whereas a setting of 9600 is slower, but more stable.

(4) Modem Hang Up Method

You can instruct the modem to hang up after sending the data, which is the most common method, or you can choose to Close Serial Port after a specified number of seconds by entering a number in the text field next to Leave Port Closed For.

Select on of the two Modem Hang up Methods:

1) Send Commands to Modem – AT commands sent to the modem to hang up, or
2) **Close Serial Port** – Some modems will not respond to the AT hang up command and require the serial port be closed to trigger a hang up. The port is closed for the specified number of seconds before it is opened again. While the port is closed it is not being checked for units calling home.

Select **OK** to approve the changes, or **Cancel** to exit without making changes.

### b. Start Auto Call Home

Start the **Auto Call Home** program by selecting the **Remote Access Menu** in Blastware, and then **Auto Call Home > Start**. From here you are able to access important menu items for the configuration of **Auto Call Home**. Additionally, this is where you will set which type of communications protocol you will be using, **Serial** or **IP**. Prior to setting up **Auto Call Home**, determine which option you are going to be using by reading the overview and descriptions in the sections that follow.

**Note:** You must select **Connect** and have this window open any time that you want the software to monitor particular COM Ports for incoming calls.

The Start command opens the **Auto Call Home** dialog box and allows you to monitor your serial or IP ports. As long as the **Auto Call Home** dialog box remains open, your PC can receive messages. If you prefer, you may minimize the dialog box. To stop monitoring the serial ports click on **Disconnect**, or **Exit** to disconnect and return to the main Blastware window.

**Note:** Blastware Mail and **Auto Call Home** can not share the same communications serial port.

![Auto Call Home dialog box](image)

(1) **Communications Port**

i **Serial**

**Serial** communication refers to when data is transmitted bit-by-bit. For a complete description of the **Auto Call Home** Serial Communications protocol, refer to Subsection D of this Section.
ii IP (Internet Protocol)

IP communications refers to a network and transport protocol used for exchanging packets of data over the Internet. For a complete description of the Auto Call Home IP Communications protocol, refer to Subsection C of this Section.

(2) Serial No.
Displays the active unit that is calling the PC.

(3) Port
Indicates the port which the unit is calling in on.

(4) Time
Displays the time which the unit contacted the PC.

(5) Current Status
Indicates whether or not the unit has made a connection or is not connected.

(6) Connects
Displays the number of times the unit has successfully connected.

(7) Events
Displays the number of Events that have been successfully copied to the PC.

(8) Write to File
Use this command to save a text file of the Activity Log.

(9) Activity Log
The Activity Log displays a current log of activity including incoming calls, serial number(s), and the port(s), that the unit(s) is calling in on. Additionally, it indicates the files that are being transferred and emailed with their destination directory. The Activity Log returns to Monitoring for Call Home status once the download from a unit is completed.

(10) Error Log
The Error Log displays units that were not able to successfully call into the PC.

(11) Connect/Disconnect
Click on the Connect/Disconnect to start or stop communicating with the unit(s). When you select Connect, the units that are setup to call home will automatically be displayed in the Serial No. column.

(12) Print
After a unit has connected and sent the Events and connection information, you are able to print out the Activity and Error Log details by clicking on Print.
(13) **Exit**

Click on **Exit** to leave the **Auto Call Home** program.

There are three communication options within Auto Call Home to remotely access data from the monitor, 1) Serial (Communications), and 2) UDP/IP, and 3) TCP/IP.

i Once all setups for Auto Call Home are completed, it is strongly recommended that communications be checked before the unit is placed in the field. Some modem/phone combinations may require parameter changes to function properly. Refer to Chapter 6 for more information on setting up modems and communications settings.

ii Auto Call Home is supported by Blastmate III or Minimate Plus units with a serial number of 6000 or greater.

c. **Status**

Select the **Status** to access the Event Copy status function.

(1) **Event Copy**

Click on **Event Copy** to access the Event Copy Status dialog box. This window displays the status of each communications Port, the Serial Number of the unit associated with that Port, and the time and date of each connection.

![Event Copy Status Window]

**d. Test**

Use the **Test** feature of **Auto Call Home** to determine if any of the Events that have been copied were created due to a false trigger. You may also email the files, using the parameters set in Blastware Mail.

**Sample of a Valid Event** – the waveform signature is almost equivalent in the positive and negative baseline.
Sample of a False Trigger – the entirety of the Event response is positive.

(1) Test Auto Call Home Processing

Selecting Events to Test

Select Test from the Auto Call Home main menu, and then click on Processing. The Test Auto Call Home Processing dialog will appear. Click on the button labeled Select Events, and browse your computer for files that you wish to test for false triggers. Highlight the files with your cursor and select Open.
ii False Trigger Detection (Series III Only)

Once the files are loaded into the Processing window you will notice that the Result indicates that they have not been tested. Click on the button labeled False Trigger Detection – a software algorithm will test the opened Events. The Result window will indicate which Events are valid, and which ones were False Triggers.
e. Test Modem

This feature is provided to enable you to further test the modem you are using with the remote monitor. Enter a text string of modem commands, and Blastware writes it to the serial port. You can then evaluate the modem’s operation. If you require a more advanced testing tool, use a program such as HyperTerminal, supplied with the Windows operating system.

To access the Modem Test dialog box, select Remote Access > AutoCall Home > Test Modem.

Example test strings to send to the modem:

- ATDT5552368  Dial Jim Rockford’s home phone!
- ATS0=0       Auto answer off
- ATS0=1       Auto answer on first ring
- AT+RSSI?      Test the signal strength of a GSM phone

(1) Test text box
Enter the text string you wish to send to the serial port.
(2) **Send Buttons**
Click on Send to send the text string to the serial port.

(3) **On/Off**
This setting allows you to send a command repeatedly to the modem, and check the response. Enter the command in the upper text box, and click the On/Off button. The button will change to Stop. The response from the modem appears in the lower text box. Click Stop to end the procedure.

(4) **Cancel**
Click Cancel to close the Modem Test dialog box and return to the Main Window.

(5) **Call Home Log**
Every time you use **Auto Call Home** to receive data from a remote monitor, a log of the session is created. The log includes such information as a "Session Timeout" entry if a Call Home connection is terminated from exceeding your “Disconnect after being connected for 'x' minutes” setting. The log file, entitled CALLHOME.LOG, is stored in the directory containing the Blastware executable file (Blastware.exe), and can be printed or edited using a text editor such as Microsoft Notepad. When you select the **Connect** command in **Auto Call Home**, the following warning message appears asking you whether you wish to clear the data currently stored in the Call Home Log:

![AutoCallHome Dialog]

If you do not wish to save the current data, click Yes. The contents of the log will be deleted. If you would like to keep the information currently in the log, click No. The information for the current session will be added to the log.

**f. About**
If you call Instantel Technical Support, they may request information about the version of **Auto Call Home** that you are currently using. To access the **About** menu select Remote Access > AutoCall Home > Start > **About** to display the following dialog:

![About AutoCallHome Dialog]

**4.5 Blastware Mail**
Use **Blastware Mail** for automatic distribution of data to a wide variety of devices, such as cellular phones, pagers, PDAs and PCs. This is a separate application that works **together** with the Blastware software, **Auto Call Home**, and your internet connection. After events are automatically downloaded to your PC using the **Auto Call Home**, Blastware Mail automatically sends the results to the e-mail addresses and text-messaging-capable cellular/GSM phones you have specified. BW Mail allows you to create “accounts” in the Edit Mail Delivery dialog box that specify what information will be sent to which email addresses — the entire event file, or selected data for each channel. You can also send different information to different recipients, and choose to time-delay distribution. Cell phone users automatically receive peak information for each channel.
A Blastmate III, Minimate Plus or Series IV unit is placed in the field with a telephone and modem connection. Events are automatically downloaded to your PC using the Auto Call Home feature of Blastware. Then Blastware Mail automatically sends the results to the specified email addresses.

If a cellular network is being used to transmit data, the modems must be compatible with that network. For example, if you are using an analog (AMPS, or Advanced Mobile Phone System) cellular phone network, the modems must be MNP10EC compatible. The MNP10EC (Microcom Networking Protocol – Class 10 Enhanced Cellular) protocol means that the modem has the ability to adjust packet size, data rate, and transmission levels in response to an inadequate or fluctuating communication line. Both the sending and receiving modems on an analog network must have the MNP10EC protocol capability. Also, ensure that you have proper cellular coverage.

4.5.1 Starting Blastware Mail

Prior to using Blastware Mail, a SMTP (Mail) Server must be configured to allow the relay of emails from the computer that is running the program. Blastware Mail can be accessed from within Blastware, or from the Windows Start button.

**From Blastware**

Click on the Remote Access menu, and then select Start Blastware Mail.

The following dialog box appears, prompting you to check that your internet service is running. Click Yes to start Blastware Mail.
Note: This dialog box will also appear if you have started Auto Call Home without first opening Blastware Mail. If you do not intend to use Blastware Mail for the Auto Call Home session, just click No. If you would like to open Blastware Mail, click Yes.

From the Windows Start Button
When accessing Blastware Mail from the Windows Start button, click on Programs, then find the Blastware folder. Within this folder is the Blastware Mail icon; click on this icon to launch Blastware Mail.

a. Blastware Mail Main Window
The main window provides an overview of current settings in Blastware Mail. To create or change your Blastware Mail accounts, click on the Edit button for that account.

Warning: In order to e-mail Event data from a remote monitor, Blastware Mail, and your Internet connection, must be open. In addition, you must also have selected the Start command for Auto Call Home.

(1) File
This selection provides access to Configure, Test Email and Exit. See below for more information on these settings.

(2) Help
This selection provides access to About Blastware, which displays the software version number and copyright information.

(3) Email when notified by Blastware
Select this command to enable the sending of e-mail from within the Blastware Event Manager. The Mail button will appear directly under the Default Directory checkmark box in the Event Manager. See Sending E-Mail from the Event Manager below for more information on this feature.
(4) **Serial Number**

This field displays the monitor serial numbers for the Blastware Mail account. To enter or change a serial number, click on the Edit button (see Editing Mail Delivery below for details). The character “*” indicates that results from any monitor will be forwarded as e-mail. The dialog box can only display five entries at a time: use the scrollbar to move up or down the list.

(5) **Description**

This displays the description for the account, as entered in the Edit Mail Delivery dialog box. This entry cannot be edited here. Click on the Edit button to enter or change the description (see Editing Mail Delivery below for details).

(6) **Edit**

Within the dialog box accessed from this button, you can define which information will be sent to an e-mail address — the entire Event file, or selected data for each channel. You can send different information to different recipients, and choose to time-delay distribution. Cell phone users can automatically receive peak velocity or acceleration information for each channel (see Editing Mail Delivery below for details).

To create a new Blastware Mail account, click on the Edit button of a blank entry.

(7) **Time, Serial No., Address, and Action message window**

This shows the results of each Blastware Mail session based on the settings that you have made within the Edit Mail Delivery dialog box. This log is refreshed with each new Blastware Mail session.

(8) **Email Subject**

Define what will be in the subject area of the e-mail by selecting one of the following options:

i **Peaks**

The Peaks command displays the Unit Serial Number, Transverse (Tran), Vertical (Vert) and Longitudinal (Long) Peak information. The Mic, Date, and Time are also included. The following is an example of the information that would be shown in the subject line of an e-mail when Peaks is selected:

BE6412 T:5.59 mm/s V:13.2 mm/s L:2.79 mm/s Mic:4.25 pa.(L), Nov 24 /00 2:55:55 PM

ii **User Text**

Input your own text message, up to 85 characters, that you would like to appear in the subject line of the e-mail(s).

(9) **Exit**

Exit Blastware Mail.

(10) **Configure**

The information required to complete the configuration settings can be located within your Windows Internet connection and email program configuration settings, or by contacting your Internet service provider.
i **Sender**
Input your personal information and Internet connection requirements in this area

ii **From Name**
Insert the name of the person (or project) which you would like the recipient to see in the “From” field of the email message.

iii **From Address**
Enter your e-mail address.

iv **Authentication Method**
Use the drop down menu and select the proper **Authentication Method** required by your Internet service provider. SMTP authentication is a system where some sort of authentication, such as providing a user name and password, is carried out during the sending of an email message for security purposes.

Setting up SMTP authentication is something that you would typically do when initially configuring your e-mail software - most current e-mail client software is capable of authentication, and most Internet service providers require that you use this feature.

There are several different mechanisms available for authentication; many use plain text passwords, while more complex ones use security technology similar to encryption.

Blastware supports the AUTH LOGIN, LOGIN PLAIN, and CRAM-MD5, authentication protocols.

v **Blind Carbon Copy**
A copy of the message that you send will not be kept in your Sent folder; for a record, use Blind Carbon Copy to ensure that a message is sent to you, and to other individuals.

vi **Bcc Address**
Place your cursor in the text box next to **Address**, and type the email address of the recipients you would like to receive a copy of the Event information; addresses input into this text field will not be visible to the recipients that you specify in the Edit Email Delivery dialog. Use a semi-colon with a space to separate each e-mail address

Example: consultant@consultant.com; customer@customer.com
iii  **Server**
This is the Domain Name System (DNS) server number of your Internet Service Provider.

iv  **SMTP Host Address**
This is the IP Address of the computer running *Blastware Mail* (the Mail Server).

v  **False Trigger**
Click on the False Trigger button and the following window appears:

![False Trigger Configuration Window]

If you would like recorded events created by a False Trigger to be emailed to a different address, select **E-Mail False Triggered Events to FT Address**, and input an email address in the FT to Address text box. Select the **OK** button to accept the change, or the **Cancel** button to return to the previous screen without saving the changes.

vi  **OK**
Click on **OK** to accept the information that you have input in the Configuration dialog box.

vii  **Cancel**
Click on **Cancel** to exit the Configuration dialog without accepting the information you have input.

(11) **Test Email**
You are able to test your e-mail system by selecting the Test Email button. Enter the e-mail address of the recipient in the Address field – you are able to send e-mail to yourself. If desired, you can also enter a Subject and a brief Message. Click the Send button to send the e-mail. If you have sent the e-mail to your own address, you will receive the message in your in box.

![Test Email Window]

If *Blastware Mail* is not able to establish a connection and send the e-mail, an error will appear – double check all entries in the **Configure** dialog box to ensure a proper connection.
4.5.2 Editing Mail Delivery

The Edit Mail Delivery dialog box is used to create Blastware Mail accounts that specify what information from which monitors will be sent to which e-mail addresses. Click on the Edit button located in the main Blastware Mail window, and the following dialog will appear:

a. Remote Unit Serial Numbers
Type in the monitor serial number(s), or enter "*" to include all units.

b. Description
Enter a description for the Blastware Mail account. This entry will be displayed in the main Blastware Mail window.

c. Email Address
Click on the checkbox to activate the e-mail field, and then enter the e-mail address of the recipient. Enter only one address per field.

d. Peak Filter
Select this option to filter unwanted Events; specified Event information will only be sent if the Peak Particle Velocity of any of the three Geophone channels exceeds the number in this Peak Filter field. Example: by entering a value of 2, Blastware Mail will only send Events with a Peak Particle Velocity that exceeds 2 mm/s or 2 in/s, depending on the units of measure selected on the monitor.

e. Peak
Select this option to have the Peak Particle Velocity for the Transverse, Vertical and Longitudinal channels sent to the specified e-mail address.

f. Accel (Acceleration)
Select this field to send the peak acceleration value of each channel.

g. Disp (Displacement)
This sends the Peak Displacement of each channel.

h. Mic (Microphone)
Sends the Microphone channels peak sound pressure. The units of measure displayed will be those selected on the unit: decibels (dB), Pascal [pa. (L)], or pounds per square inch (psi).

i. Freq (Frequency)
This selection provides the Frequency of each Peak in the waveform.
j. **PVS (Peak Vector Sum)**
   This selection provides the Peak Vector Sum of ground, amplitude and frequency.

k. **VDV (Vibration Dose Value)**
   This selection provides the Vibration Dose Value (VDV) daytime (vertical channel) or nighttime (horizontal channels) VDV and RMS monitoring calculation results.
   
   **NOTE:** For Series IV units only

l. **PPV Cell Phone Page**
   Cell phone users can automatically receive the subject of the Event (e.g. BE6412 Nov 24 /00 2:55:55 PM), and the Transverse (Tran), Vertical (Vert) and Longitudinal (Long) Peak information for each channel. The Microphone channels peak sound pressure is also included.

m. **Accel Cell Phone Page**
   Cell phone users can automatically receive the subject of the Event (e.g. BE6412 Nov 24 /00 2:55:55 PM), and the Peak Acceleration of each channel. The Transverse (Tran), Vertical (Vert) and Longitudinal (Long) Peak information for each channel, and the Microphone channels peak sound pressure is also included.

n. **VDV Cell Phone Page (Vibration Dose Value)**
   This selection provides the Vibration Dose Value (VDV) daytime (vertical channel) or nighttime (horizontal channels) VDV and RMS monitoring calculation results.
   
   **NOTE:** For Series IV units only

o. **PVS Cell Phone Page**
   Cell phone users can automatically receive the subject of the Event (e.g. BE6412 Nov 24 /00 2:55:55 PM), and the Peak Vector Sum (PVS) of each channel. The Transverse (Tran), Vertical (Vert) and Longitudinal (Long) Peak information for each channel, and the Microphone channels peak sound pressure is also included.

p. **Attach Event**
   Attach the entire Event to an email.

q. **Attach Reports**
   Attach the Reports to the email. Select which Reports you would like to attach to an email by selecting each box, **Event, Meta, PDF, ASCII, or XML.**

r. **Delay (minutes)**
   Select this setting if you wish to have e-mail sent from the unit a specified period after each Event. Enter a delay time in minutes.

s. **Time**
   Use this setting to specify a specific time for the unit to send e-mail. Make sure that Blastware, your and Internet connection is open, at the time specified.

t. **Cancel**
   Returns you to the Blastware Mail main window, without retaining any of the changes that you have made.

u. **Delete All**
   Clears all addresses and settings.

4.5.3 **Blastware Mail Example Setup**
   Below is an example of how to setup your computer to download Events from a remote monitor and distribute them as e-mail. There are three steps to complete.
Step 1: Create an account in Blastware mail.
Click on the Edit button, and enter the monitor serial number, recipient e-mail addresses and other information in the Edit Mail Delivery dialog box. Your settings should appear similar to the following:

Step 2: Open your Internet connection and email software
Make sure that your e-mail software is open and that you are connected to the Internet.

Step 3: Start Auto Call Home
From the Tools Menu in Blastware, go to Auto Call Home and select Start. In order to download Events, you must have setup the remote monitor along with its modem.

Your PC is now setup to distribute Event data as e-mail. Remember, Blastware Mail, Auto Call Home, the e-mail program, and your Internet connection must remain open. Below is a sample e-mail file of what Consultant@site1.com would receive, including the Event attached as a file (this file can be copied to the hard drive and opened in Blastware and analyzed). “Peaks” was selected for the “Email Subject.”

4.5.4 Sending E-mail from the Event Manager
Once you have launched Blastware Mail, you can also e-mail Events directly from the Event Manager, provided that you have setup an account that includes the units serial number (please see Editing Mail Delivery above for details). As the example below shows, a Mail button appears directly below the Default Directory check box in the Event Manager. Select to send an Event.
4.6 Windows Menu

Control the layout of opened windows, or control which types of reports you want to view, from within the Blastware program by using the commands under the Windows menu.

a. Cascade
   Click on the Cascade command to align your windows in a layered, overlapping arrangement, with the most current window residing on top.

b. Tile
   Click on the Tile command to align your windows from top to bottom, but not overlapping, with the most current window at the top.

c. Auto Open
   Use Auto Open to indicate which reports you want displayed when you double click on an event in the Event Manager. Blastware will open the associated Event and/or FFT Reports that were pre-selected under the Main Menu, Window, Auto Open list.

   Double click on the Event for which you would like to view the associated Event and FFT Reports. Each Report is generated in a new window.

   From the bottom of the Windows menu, you can toggle between opened reports and the Event Manager by highlighting and clicking on the desired item.
4.7 Help Menu

The Help Menu provides on–line help information, System Information about your computer, information about the Blastware program, and the latest Readme file. The Readme file contains important information about changes or enhancements that were made to the software since the previous version.

4.7.1 Help

Blastware offers an extensive on-line help information system. You can access the system by choosing this menu item or by pressing the F1 key when the Event Manager or any dialog box or window is open. The Blastware Help Window appears.

4.7.2 System Info

The System Info dialog provides specific information about your computer and the software it is using. This information is used by Instantel Service Technicians when diagnosing computer problems.

To help in diagnosing your software or unit, an Instantel Service Technician may ask you to select a specific category from the drop down menu:

After selecting the appropriate category, print the information by clicking on the Print button. Click on the Save button to save the information, click on the Save button. The information is saved to a text file called BMINFO0.TXT located in a default directory, as shown below:

4.8 Blastware Main Menu Icon Toolbar

The command buttons on the Blastware Main Menu Icon Toolbar are used to execute the most often used operations.
4.8.1 Event Manager

If you have an Event or FFT Report open, you can access the Event Manager by clicking on the Event Manager command in the Blastware Main Menu Icon Toolbar. This will bring the Event Manager to the forefront. Or, if you have closed the Event Manager, clicking on this menu selection will reopen the Event Manager window.

4.8.2 Event Report

You can view an Event Report by selecting the event and clicking on the Event Report icon located in the toolbar. These reports can also be accessed by pre-selecting them under the Window menu, then Auto Open – select the reports you would like to view automatically by highlighting them with a check mark. The default is both reports. To automatically view reports using the Auto Open selections, double click your left mouse button on the desired event, and the reports will be created in a new window based on the settings you have defined within File menu, Report Options dialog.

4.8.3 FFT Report

You can view an FFT Report by selecting the event and clicking on the FFT Report icon located in the toolbar. These reports can also be accessed by pre-selecting them under the Window menu, then Auto Open – select the reports you would like to view automatically by highlighting them with a check mark. The default is both reports. To automatically view reports using the Auto Open selections, double click your left mouse button on the desired event, and the reports will be created in a new window based on the settings you have defined within File menu, Report Options dialog.

The FFT Report includes a frequency range of 2 – 250 Hz. The parameters for this report are set in Report Options.

4.8.4 Print

Print the currently opened report by clicking on the Print icon located in the toolbar.

To create Portable Document Format (PDF) files of the Reports, download and install the free CutePDF™ program from http://www.cutepdf.com/. After you have followed the manufacturers installations instructions to install the printer driver, you will be able to select the CutePDF™ printer as your default printer to create electronic PDF files for distribution.

4.8.5 Report Options

Refer to Section 4.1.2 for a full description of the Report Options command.
4.8.6 Compliance Setup

Refer to Section 4.2.2 for a full description of the Compliance Setup command.

4.9 Event Manager Icon Toolbar

The command buttons on the Event Manager window are used to execute the most often used operations. First you select the Events. To select a single Event, simply click on it with the left mouse button once. To select multiple Events, click on the first Event in a group. Hold the Shift key down, and click on the last Event in the group. The entire group is highlighted. To select multiple Events that do not appear in order within the Event List, click on the first Event. Press and hold the Control (Ctrl) key down while clicking on the remaining Events. To de-select the Events, click anywhere on the Event List.

4.9.1 Copy/Print

This copies or prints all the Events on the unit. Right-clicking on the Copy/Print icon displays the following dialog box:

In this example, all Events and the Monitor Log will be copied to the default C:\BLASTWARE\EVENTS folder and then show the Windows Printer Dialog box.

Additional information about viewing the Monitor Log is provided under Report Options and the Monitor Log command. Refer to the Index.

To create Portable Document Format (PDF) files of the Reports, download and install the free CutePDF™ program from http://www.cutepdf.com/. After you have followed the manufacturers installations instructions to install the printer driver, you will be able to select the CutePDF™ printer as your default printer to create electronic PDF files for distribution.

4.9.2 Print

Use this command to print the Event Reports. To print all Events, press the Print button. To print selected Events, select the Events and then press the Print button. The Print dialog box appears.

To print an Event on the monitor, you must first copy it to the computer hard disk, or display the Event Summary Report by double-clicking on the Event (this automatically copies the Event to your default destination directory on your hard disk).
Under **Print Range**, select **All** to print all Events or click on **Selection** to print highlighted Events. The printer can be setup by using the **Properties** button. Press the **OK** for the following dialog.

Select which report types that you would like to print for the series of Events that you have selected. You may also print the Monitor Log. Select **OK** to proceed with printing.

To create Portable Document Format (PDF) files of the Reports, download and install the free **CutePDF™** program from [http://www.cutepdf.com/](http://www.cutepdf.com/). After you have followed the manufacturers installations instructions to install the printer driver, you will be able to select the **CutePDF™** printer as your default printer to create electronic PDF files for distribution.

### 4.9.3 Open

Select an Event and click on the **Open** icon – Blastware will open the associate Event and/or FFT Reports that were pre-selected under the Main Menu, Window, Auto Open list.

**Example:**

Select the Event you would like to view and right-click once to highlight it – reports for only one Event can be opened at a time. Select the types of Reports you would like to view for an Event. The selections are toggled on and off by clicking on the menu item. If a check mark is present, then the selected Report will be generated in a new window.

Double click on the Event for which you would like to view the associated Event and FFT Reports. Each Report is generated in a new window.
4.9.4 **Copy**

The Copy button copies Events. Press the copy button to display the Copy Destination dialog box. Click on the Default checkbox to designate a default directory to copy Events to.

**a. Copy All**

To copy all the Events in the Event List box, press the **Copy All** button. The Events, along with the monitor log (for Blastmate III and Minimate Plus) are copied to the destination directory indicated in the title bar of the Copy Destination dialog box.

**b. Copy Selected**

This copies only the Events you have selected from the Event List box. To select Events, click on the required Events. Each chosen Event is highlighted. Press the **Copy Selected** button.

**c. Move All**

To move all the Events in the Event List box, press the **Move All** button. The Events, along with the monitor log (for Blastmate III and Minimate Plus) are moved to the destination directory indicated in the title bar of the Move Destination dialog box.

**d. Copy Selected**

This moves only the Events you have selected from the Event List box. To select Events, click on the required Events. Each chosen Event is highlighted. Press the **Move Selected** button.

**e. Create**

Choose this to create a new directory in the Event subdirectory. Press the **Create** button. The following dialog box appears.

Enter the name of the directory you want created and press **OK**.

**f. Cancel**

Returns to the Event Manager without changing the current settings.
4.9.5 Delete

The Delete button deletes Events from either your computer or a monitor. On the computer, you can delete all Events or select some Events to delete. On the monitor, you can delete all Events only.

To delete Events, go to the directory containing the Events you wish to delete. If you wish to delete only certain Events, first highlight them in the Event List window. Press the Delete button to invoke the Delete Events dialog box. To delete only the Events you have selected, press the Delete Selected button. Press the Delete All button to delete all Events in the directory.

WARNING: Events deleted from the monitor cannot be recovered. Be sure to protect your Events by either printing them first to obtain a paper record or uploading the Events to a computer. If you delete Events on your computer by mistake, go to your Recycle Bin, located on the Windows® Desktop, and Restore the deleted Events.

To view restored files, you must click on a different folder within the Directory List window, then return to the folder from which the files were deleted, and then restored. This will refresh the folder so that you can view the restored files.

4.9.6 New Folder

When the New Folder icon is selected, a dialog box appears, Create Directory. Select an existing folder or hard drive letter that you would like to create the new folder under, then click on Create.
Input a file name of up to 119 characters. Special characters, \/:*?"<>|, are not allowed as part of a file name. If any of these special characters are input, or if the file name exceeds 119 characters, you will not be able to click on OK to create the directory and exit the dialog—a warning message for the file name length will be shown.

Use the Windows Explorer to edit, delete, copy, or rename folders created within Blastware.

### 4.9.7 Notes

Select this command to view and change the Post Event Notes for an Event.

**Editing notes for one Event only**

To create or edit the note of a specific Event, select it in the Event List Box, and then select the Edit Post Event Notes command, or the Notes icon from the Event Manager toolbar.

Type in your notes and click the **Apply to Event** button when you are finished. Then click Cancel to close the dialog box.

**Editing notes for multiple Events**

View and change notes for multiple Events. Select a series of Events in the Event List Box, and then select the Edit Post Event Notes command (or select the Notes icon from the Event Manager Toolbar) to open the Post Event Notes window. Enter your note and select **Apply to Selected**, and click the **Save Event Note** button when you are finished to save your notes to a file and move to the next Event in your list.
You can also use the standard Windows cut and paste commands to copy notes from one Event to another. Highlight the note you wish to copy and then press the Control (Ctrl) and C key simultaneously. Access the destination Event by using the Previous Event and Next Event buttons, place your cursor in the text box, and then press the Control Key (Ctrl) and V key simultaneously.

The Previous Event and Next Event buttons can also be used to view existing notes by scrolling through Events selected in the List Box. Be sure to save notes for an Event by clicking the Save Event Note button before moving to another Event. If no Events are selected, the notes for the first Event in the list are displayed.

Using the Exit command closes the dialog box.

4.9.8 ASCII Conversion

The ASCII output formats Blastmate Events into ASCII format (American National Standard Code for Information Interchange). This lets you use other programs to analyze the Blastmate Events. The ASCII conversion leaves the original Blastmate Event unaltered and creates a copy in the ASCII format. Refer to Section 4.3.4 for a complete description of this command.

4.9.9 Print List

This prints a list of all the Events presently displayed in the Event List box. Click on Print List. The following dialog box appears.

a. Use Report Header

You can add up to three additional headers to the Event list printout by typing in the text boxes provided. The headers appear as bold, centered titles at the top of each printed page.

b. Destination

Choose where to print the Event list, either to a printer or to a file. If you choose a printer, the list prints on your printer. If you print to a file, the list is saved in standard text format. You can view and print the list using a text editing program like Microsoft WordPad.

c. Entries to output

You have a choice to output all Events appearing in the Event List or only selected Events. To select Events, click on the Event to highlight it.
d. Format

Under this command, you can choose the margin size and font size used in the printout.

(1) Margins

You have a choice between large, medium, and no margins.

<table>
<thead>
<tr>
<th></th>
<th>Top Margin</th>
<th>Left Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>1 ½ in. (3.8 cm)</td>
<td>¾ in. (1.9 cm)</td>
</tr>
<tr>
<td>Medium</td>
<td>1 in. (2.5 cm)</td>
<td>½ in. (1.3 cm)</td>
</tr>
<tr>
<td>No Margin</td>
<td>0 in. (0 cm)</td>
<td>0 in. (0 cm)</td>
</tr>
</tbody>
</table>

(2) Font

You can choose either large, medium, or small fonts.

e. Command Buttons

Choose **OK** to output the Event List. Choose **Cancel** to close the dialog without printing or saving to file.

4.9.10 Filter

This filter selects Events to display within the Event List based on chosen criteria. For example, if using several Series III monitors, filter the Event List to display a single monitors Events using its serial number as a filter criteria.

To filter the Event List, click on the **Select Events** button. The Event Selection Criteria dialog box appears. The dialog box presents several selection criteria used to filter Events. Enter the selection criteria and click on the **Apply** button. Enter criteria combination to display very specific Events within the Event List.

a. Serial Number

Use this to display all the Events recorded with a specific monitor. Click on the checkbox to activate this search filter, and then enter the monitors serial number. Monitor serial numbers appear within the Event Lists Serial No. column. Each Event identifies the recording monitors serial number.

**Note:** The Event List can be customized to display or remove Event information. If the Serial No. column does not appear, move the mouse pointer over the column names and double click...
the right mouse button. Choose the **Use Default Columns** command. This displays the default Event Manager including the Serial No. column.

**b. Date**

This command displays only those Events recorded during a specified time period.

(1) **From**

This setting displays all Events recorded since a specified date and time up to and including the present date and time. All Events recorded after the specified time appear while all Events recorded before this time do not.

Click on the **From** checkbox to display a checkmark. Enter the date and time. Click the **Apply** button to display the specified Events.

(2) **To**

This setting displays all Events recorded up to and including the date and time specified. All Events recorded before this time appear while all Events recorded after this time do not.

Click on the **To** checkbox to display a checkmark. Enter a date and time. Click the **Apply** button to display the specified Events.

(3) **Choosing Both From and To**

Use both the From and To settings to display Events during a specified time period. For example, enter a From date and time as Nov 15/98. Enter a To date and time of Nov 16/98. This combination displays all Events recorded from November 15, 1998 at 00:00 (midnight) to November 16, 1998 at 00:00 (midnight). Unless specified, the time defaults to or 00:00 a.m. (midnight).

To display Events within a specified time period, click on the **From** checkbox to display a checkmark. Enter a time to indicate the beginning of the period. Click on the **To** checkbox to display a checkmark. Click the **Apply** button to display the Events.

**c. Include Events with values greater than**

This section filters Events based on recorded values. Events with values greater than the specified value appear while Events with values less than the specified value do not. For example, enter a value within the Geo #1 box. Only those Events with values greater than the specified value appear in the Event List.

To filter Events based on recorded values, click on one or all of the **Geo #1**, **Mic**, or **PVS1** checkboxes. Enter a value for each and click the **Apply** button.

**Note:** The **Options** button displays a dialog box offering other Event values to choose from.

**d. Description**

Events can be filtered based on the Location information saved with an Event as part of the User Notes. Events containing any part of the entered text appear in the Event List.

Click on the checkbox to display a checkmark. Enter the text and click on the **Apply** button.

**e. Display All**

This command removes all filters and displays all the Events within the Event List.

**f. Apply**

This command applies the selected criteria to the Event List and displays the new filtered list.

**g. Exit**

This command saves the most recent changes and closes the dialog box.

**h. Cancel**

This command discards the most recent changes and closes the dialog box.

**i. Options**

This displays options to customize the Event Selection Criteria dialog box.
This section displays the Tran, Vert, and Long channels as either a single Geo group or as individual channels within the Event Selection Criteria dialog box.

Click on the **Triaxial, same peak used for all geo channels** option to display the channels as a group. **Click on the Individual, specify peak for each channel** option to display the channels individually.

### 4 Channels or 8 Channels
This settings lets you choose whether to display either four or eight channel Events. Click on either selection to display a checkmark in the checkbox.

### Hide/Keep Buttons
These options select Events manually from within the Event List using the conventional Windows Shift and Control keys.

- **Keep Selection**
  This command displays the currently highlighted Events while hiding all other Events.

- **Hide Selection**
  This hides all selected Events within the Event List.

- **Keep Log**
  This command displays all the Log files currently appearing within the Event List.

- **Hide Log**
  This command hides all the Log files currently appearing within the Event List.

### OK
Applies the selections and closes the dialog box.

### Cancel
Closes the dialog box without applying the settings.

### Archive
This command adds all the Events displayed within an Event List to a single archive file. This helps with file management by grouping related Event files together for storage purposes. Archive files appear within the Event List indicated as type ARC. The files extension is BWA. The files within an archive must be extracted before they can be viewed or printed.

To create an archive, display the required Event List and click the mouse pointer on the **Archive** button. The Create Archive dialog box appears.
a. Archive
The field shows the name of the archive location and the directory to which it will be saved. To change the name and location, click on the Change button; see the following section.

b. Change
Click on the Change button to enter a new name or location for the archive. The following dialog box appears.

Under File name, enter the name of the archive. Choose the location to place the new archive: search through your directories in the Folders window. If you want to choose a different drive, select it under Drives.

c. Delete files after archiving
Choose to delete the original files after they have been added to the archive. Click on this option to display a checkmark.

d. Description of archive
Enter a description of the archive for future reference. Descriptions can be alphanumeric up to 1024 characters in length. Archive descriptions appear when you click the Quick View button with the archive highlighted within the Event List.

e. OK
Click on this button to create the archive.

f. Cancel
Close the dialog box without creating an archive.
4.9.12 **Extract**

This command extracts Event files from an archive. To extract files, click on an archive file to highlight it within the Event List. Click on the **Extract** button. The Extract dialog box appears. This button can be activated only after selecting an archive from within the Event List.

![](image)

**a. Extract to**

This field displays the location to which the files will be extracted. To change the location, click on the Change button; see the following section.

**b. Change**

Click on the **Change** button to enter a new location for the archived files. The following dialog box appears.

![](image)

Click the mouse pointer on the required directory to highlight and select it. To create a new directory, click the **Create** button, then enter the path and name of the new directory. Follow the example at the top of the dialog box. Click the **OK** button.

**c. Description of archive**

The archives description appears within this window. The description was added to the archive when it was created.
d. **OK**
   Extract the files from the archive and close the dialog box.

e. **Cancel**
   Close the dialog box without extracting the files.

### 4.10 Directories List Box

This box displays a directory tree of all directories located on the hard drive containing the Blastware program. All Event files appear in the Blastware directory under the Event subdirectory. This is the default directory indicated by the Default Directory checkbox located in the lower left hand corner of the window. To access directories, place the mouse pointer on the directory icon and double click the left mouse button. The Events appear in the Event List box.

### 4.11 Event List Box

The Event List box displays Events in the selected directory along with summary information describing the Events. If you choose the unit icon (Series III only), the Events stored on the monitor appear in the list. You can select one or more Events to copy, delete, print, or view. If you display the unit directory which lists the files on the monitor, you must first copy the files to the computer before you can view or print them. If you click on the **Event Report** icon, a copy of the Event will be created before opening it.

Position your mouse in the title bar (i.e. the area with the bold titles, including Type, Serial No., Date/Time, etc.) of the **Event List Box**, and double-right or double-left click; a menu of shortcuts to commonly used features appears:

```plaintext
Load
Save
Rename Column
Delete Column
Insert Column
Use Default Columns
Use Default Column Names
Edit The Event List Filter
Edit Post Event Notes
Cancel
```

To select an Event, move the mouse pointer on top of the Event and click the left mouse button. The cursor highlights the Event. To select multiple Events, click on the first Event in a group. Hold the **Shift** key down, and click on the last Event in the group. The entire group is highlighted. To select multiple Events that do not appear in order within the Event List, click on the first Event. Press and hold the **Control (Ctrl)** key down while clicking on the remaining Events. To de-select the Events, click anywhere on the Event List.

With the Event selected, you can now press one of the command buttons located at the top of the screen. The message above the Event List indicates the number of Events in the current directory, and the Event currently selected. The information within the Event List can also be manipulated in various ways. You can insert or remove columns, change the column names, or filter Events to display only those Events of interest. To customize the Event List, move the mouse pointer over the column names and double click to display the following popup menu.

a. **Load**
   With this command, you can display a saved Event List setup. Event lists can be customized to display different columns of data.

   To load an Event List setup, position the mouse pointer over a column name and double click the left or right mouse button. Choose the **Load** command. The following dialog box appears.
Select a setup file. All setup files have an .evm extension and appear in Blastware’s dbase subdirectory. Click OK to load the file. To exit without loading a setup file, click Cancel.

b. **Save**

This command saves a customized Event List. Save the setup after you have customized the Event List by changing columns and column names. The next time you require this Event List, all you have to do is load it.

To save an Event List setup, position the mouse pointer over a column name in the Event List and double click the left or right mouse button. Choose the **Save** command.

Enter a name for the setup file. All setup files have an .evm extension and appear in Blastware’s dbase subdirectory.

c. **Rename Column**

The column names appearing in the Event List can be changed to the name of your choice. These can be returned to their default names by choosing the **Use Default Column Names** command, see below.

To rename a column name, position the mouse pointer over the column name to be changed and double click the left or right mouse button. Select the **Rename Column** command. The following dialog box appears.

The dialog box presents two sections. The first section, **Default data name**, displays the default Instantel column name. The second section, **Name used in Event manager**, displays the names currently used. These names can be changed. Names can be entered on Lines 1, 2, 3, or all. Names may include alphanumeric characters. You can specify the width of the column by entering the
number of point character size value in the Col Width field. Click the Copy button to enter the default names from the first section into the second section. Click OK to save the new names. The names appear immediately in the Event List box. Click Cancel to close the dialog box without changing the names.

d. **Delete Column**

This command removes an entire column from the Event List box. The remaining columns shift to the left.

To delete a column and remove it from the Event List display, position the mouse pointer on the column name to be removed. Double click the left or right mouse button and choose the **Delete Column** command.

**Note:** Deleting a column does not delete the supporting data. It just removes the column from the Event List box. The column can be displayed again using the Insert Column command described below.

e. **Insert Column**

This command inserts a column into the Event List box. The remaining columns shift to the right.

To insert a column, position the mouse pointer over an existing column name. The new column appears to the left of this column. Double click the left or right mouse button. Choose the **Insert Column** command. The following dialog box appears.

This dialog box lists all the columns that can be used in the Event List. Please see the following table for a description of each column. To insert a column, select a name then click the OK button. Click Cancel to close the dialog box without inserting a column.

<table>
<thead>
<tr>
<th>Event Column Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>List all Event types.</td>
</tr>
<tr>
<td>Serial / No</td>
<td>Identifies the recording monitors serial number.</td>
</tr>
<tr>
<td>Date / Time</td>
<td>Date and time of the Event.</td>
</tr>
<tr>
<td>Tran / Peak (mm/s)</td>
<td>Transverse channels peak particle velocity.</td>
</tr>
<tr>
<td>Vert / Peak (mm/s)</td>
<td>Vertical channels peak particle velocity.</td>
</tr>
<tr>
<td>Long / Peak (mm/s)</td>
<td>Longitudinal channels peak particle velocity.</td>
</tr>
<tr>
<td>Mic / Peak (pa.)</td>
<td>Microphone channels peak sound pressure.</td>
</tr>
<tr>
<td>Tran2 / Peak (mm/s)</td>
<td>Second transverse channels peak particle velocity (eight channel monitors).</td>
</tr>
<tr>
<td>Vert2 / Peak (mm/s)</td>
<td>Second vertical channels peak particle velocity (eight channel monitors).</td>
</tr>
<tr>
<td>Blastware Compliance Module</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td>Long2 / Peak (mm/s)</td>
<td>Second longitudinal channels peak particle velocity (eight channel monitors).</td>
</tr>
<tr>
<td>Mic2 / Peak (pa.)</td>
<td>Second microphone channels peak sound pressure (eight channel monitors).</td>
</tr>
<tr>
<td>PVS1 / (mm/s)</td>
<td>Peak Vector Sum for the first Transverse, Vertical, and Longitudinal channels.</td>
</tr>
<tr>
<td>PVS2 / (mm/s)</td>
<td>Peak Vector Sum for the second Transverse, Vertical, and Longitudinal channels (eight channel monitors).</td>
</tr>
<tr>
<td>Description</td>
<td>This displays the first line of the User Notes. By default this is the Location note.</td>
</tr>
<tr>
<td>Trigger</td>
<td>This identifies the trigger source for the Event.</td>
</tr>
<tr>
<td>Record / Length</td>
<td>This is the overall length of the Event.</td>
</tr>
<tr>
<td>Sample / Rate</td>
<td>This is the sample rate for the Event.</td>
</tr>
<tr>
<td>No. / Chan</td>
<td>This identifies the number of channels recorded in the Event.</td>
</tr>
<tr>
<td>File Name</td>
<td>This lists the Events file name.</td>
</tr>
<tr>
<td>Chan1 / Name</td>
<td>Channel 1 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan2 / Name</td>
<td>Channel 2 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan3 / Name</td>
<td>Channel 3 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan4 / Name</td>
<td>Channel 4 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan5 / Name</td>
<td>Channel 5 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan6 / Name</td>
<td>Channel 6 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan7 / Name</td>
<td>Channel 7 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan8 / Name</td>
<td>Channel 8 name entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan1 / Units</td>
<td>Channel 1 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan2 / Units</td>
<td>Channel 2 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan3 / Units</td>
<td>Channel 3 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan4 / Units</td>
<td>Channel 4 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan5 / Units</td>
<td>Channel 5 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan6 / Units</td>
<td>Channel 6 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan7 / Units</td>
<td>Channel 7 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan8 / Units</td>
<td>Channel 8 units entered in the Advanced Setup dialog box.</td>
</tr>
<tr>
<td>Chan1 / Peak</td>
<td>The peak particle velocity calculated for channel 1.</td>
</tr>
<tr>
<td>Chan2 / Peak</td>
<td>The peak particle velocity calculated for channel 2.</td>
</tr>
<tr>
<td>Chan3 / Peak</td>
<td>The peak particle velocity calculated for channel 3.</td>
</tr>
<tr>
<td>Chan4 / Peak</td>
<td>The peak particle velocity calculated for channel 4.</td>
</tr>
<tr>
<td>Chan5 / Peak</td>
<td>The peak particle velocity calculated for channel 5.</td>
</tr>
<tr>
<td>Chan6 / Peak</td>
<td>The peak particle velocity calculated for channel 6.</td>
</tr>
<tr>
<td>Chan7 / Peak</td>
<td>The peak particle velocity calculated for channel 7.</td>
</tr>
<tr>
<td>Chan8 / Peak</td>
<td>The peak particle velocity calculated for channel 8.</td>
</tr>
<tr>
<td>Chan1 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 1.</td>
</tr>
<tr>
<td>Chan2 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 2.</td>
</tr>
<tr>
<td>Chan3 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 3.</td>
</tr>
<tr>
<td>Chan4 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 4.</td>
</tr>
<tr>
<td>Chan5 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 5.</td>
</tr>
<tr>
<td>Chan6 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 6.</td>
</tr>
<tr>
<td>Chan7 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 7.</td>
</tr>
<tr>
<td>Chan8 / Peak / Time</td>
<td>The time of the peak particle velocity for channel 8.</td>
</tr>
<tr>
<td>Tran / Freq. / Hz</td>
<td>Transverse channels Zero Crossing Frequency.</td>
</tr>
<tr>
<td>Vert / Freq. Hz</td>
<td>Vertical channels Zero Crossing Frequency.</td>
</tr>
<tr>
<td>Long / Freq. Hz</td>
<td>Longitudinal channels Zero Crossing Frequency.</td>
</tr>
<tr>
<td>Tran2 / Freq. / Hz</td>
<td>Second transverse channels Zero Crossing Frequency (eight channel monitors).</td>
</tr>
<tr>
<td>Vert2 / Freq. Hz</td>
<td>Second vertical channels Zero Crossing Frequency (eight channel monitors).</td>
</tr>
<tr>
<td>Long2 / Freq. Hz</td>
<td>Second longitudinal channels Zero Crossing Frequency (eight channel monitors).</td>
</tr>
<tr>
<td>Tran / Displ / mm</td>
<td>Transverse channels peak displacement.</td>
</tr>
<tr>
<td>Vert / Displ / mm</td>
<td>Vertical channels peak displacement.</td>
</tr>
<tr>
<td>Long / Displ / mm</td>
<td>Longitudinal channels peak displacement.</td>
</tr>
<tr>
<td>Tran2 / Displ / mm</td>
<td>Second transverse channels peak displacement (eight channel monitors).</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vert2 / Displ / mm</td>
<td>Second vertical channels peak displacement (eight channel monitors).</td>
</tr>
<tr>
<td>Long2 / Displ / mm</td>
<td>Second longitudinal channels peak displacement (eight channel monitors).</td>
</tr>
<tr>
<td>Tran / Accel / g</td>
<td>Transverse channels peak acceleration.</td>
</tr>
<tr>
<td>Vert / Accel / g</td>
<td>Vertical channels peak acceleration.</td>
</tr>
<tr>
<td>Long / Accel / g</td>
<td>Longitudinal channels peak acceleration.</td>
</tr>
<tr>
<td>Tran2 / Accel / g</td>
<td>Second transverse channels peak acceleration (eight channel monitors).</td>
</tr>
<tr>
<td>Vert2 / Accel / g</td>
<td>Second vertical channels peak acceleration (eight channel monitors).</td>
</tr>
<tr>
<td>Long2 / Accel / g</td>
<td>Second longitudinal channels peak acceleration (eight channel monitors).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start / Date</th>
<th>This displays the date the Event started recording.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start / Time</td>
<td>This displays the time the Event started recording.</td>
</tr>
<tr>
<td>Post Event Note / first line</td>
<td>This displays the first line of the post Event notes.</td>
</tr>
<tr>
<td>End / Date</td>
<td>This displays the date the Event stopped recording.</td>
</tr>
<tr>
<td>End / Time</td>
<td>This displays the time the Event stopped recording.</td>
</tr>
<tr>
<td>Job</td>
<td>Title or brief description of the job.</td>
</tr>
</tbody>
</table>

f. **Use Default Columns**

This command changes the Event List box columns back to the original columns first used by the Blastware software. Notice the names of the default columns do not automatically revert to the original names. If you want the default column names, use the Use Default Column Names command described below.

**WARNING:** This command overwrites your custom Event List. If you want to display and use your custom Event List again, choose the Save command (see above) to save your setup before selecting the Use Default Columns command.

g. **Use Default Column Names**

This command changes the column names to the Blastware default column names.

**WARNING:** This command overwrites the displayed column names. If you want to use these names again, choose the Save command (see above) to save your setup before selecting the Use Default Column Names command.

h. **Edit the Event List Filter**

This command filters Events from within the Event List according to criteria you assign. Each Event List column can be filtered once. Filtering removes all the Events that do not meet your criteria. To help you keep track of the number of Events within an Event List and the number of Events that have been filtered, a message appears in the top right hand corner of the Event List box.

**Note:** The Select Events command also filters Events.

To filter the Event List, position the mouse pointer on the required column and double click the left or right mouse button. Select the **Edit the Event List Filter** command. The following dialog box appears.
(1) **Column Title**
This is the column you chose to filter.

(2) **Data for comparison**
In the Data For Comparison text box, enter a value to be used by the filter. For example if you choose to filter the Date/Time column, enter a date using the same format as the date appearing in the Event List.

(3) **Comparison**
Use the following criteria to filter the Event List.

   i. **Greater than**
   This includes all Events having a value greater than the data for comparison value entered above.

   ii. **Less than**
   This includes all Events having a value less than the data for comparison value entered above.

   iii. **Equal to**
   This includes all Events having a value equal to the data for comparison value entered above. This command can be used with the Greater than and Less than commands.

(4) **Remove Current Filter**
This removes the filter applied to the selected column.

(5) **Remove All Filters**
This removes all the filters applied to the columns appearing in this Event List.

(6) **Command Buttons**
The OK button applies the filter. Click Cancel to close the dialog box without changing the settings.

   i. **Edit Post Event Notes**
Select this command to view and change the Post Event Notes for an Event.

   **Editing notes for one Event only**
To create or edit the note of a specific Event, select it in the Event List Box, and then select the Edit Post Event Notes command, or the Notes icon from the Event Manager toolbar. The following window appears:
Type in your notes and click the **Apply to Event** button when you are finished. Then click Cancel to close the dialog box.

**Editing notes for multiple Events**

To view and change notes for multiple Events, select a series of Events in the Event List Box, and then select the **Edit Post Event Notes** command (or select the **Notes** icon from the Event Manager Toolbar) to open the **Post Event Notes** window. Enter your note and select **Apply to Selected**, and click the **Save Event Note** button when you are finished to save your notes to a file and move to the next Event in your list.

You can also use the standard Windows cut and paste commands to copy notes from one Event to another. Highlight the note you wish to copy and then press the Control (Ctrl) and C key simultaneously. Access the destination Event by using the **Previous Event** and **Next Event** buttons, place your cursor in the text box, and then press the Control Key (Ctrl) and V key simultaneously.

The **Previous Event** and **Next Event** buttons can also be used to view existing notes by scrolling through Events selected in the List Box. Be sure to save notes for an Event by clicking the **Save Event Note** button before moving to another Event. If no Events are selected, the notes for the first Event in the list are displayed.

**Editing Location, Client, User Name and General titles and content**

You may also view and change **Location**, **Client**, **User Name** and **General** titles and content for multiple or individual Events.

Using the **Exit** command closes the dialog box.
5. SERIES II MENUS

Blastware is fully compatible with all Series II monitors. The Series II commands communicate directly with Series II monitors—including the Blastmate II 677, 477, and DS-077 Minimate—allowing you to change setups, check your sensors and download data. The Blastware software copies Series II Events directly from a Series II monitor without having to use the Series II DOS software. Blastware then makes a copy of the Event, leaving the Series II Event in its original form. Once completed, all of the extensive commands and features of the Blastware software can be applied to the new Event.

5.1 Connecting Series II Monitors to Your Computer

Connect the Blastmate II 677, 477, or Minimate to your computer using the Blastmate III PC Connecting Cable provided (part number 712A2301). (This cable is also sometimes referred to as the Blastmate II serial or connecting cable.) Turn the power Off on the monitor and the computer. Attach the Blastmate PC connecting cable to a serial port on your computer. Use a 9 pin to 25 pin adapter if required. Connect the other end of the cable to the AUX connector located on the front of the Blastmate II 677 or 477. For the Minimate, first connect the Minimate Adapter Cable (part number 715A1501) to the monitor, and then connect the Blastmate PC connecting cable. Do not force the connectors or possible damage may result.

WARNING: Use the Blastmate III PC connecting cable only (part number 712A2301). (Series II users may recognize this cable as the Blastmate II serial or connecting cable.)
5.2 Selecting a Serial Port

Before your computer can communicate with your Series II monitor, you must tell Blastware what serial port you are using to connect to your monitor with the Blastmate III PC connecting cable. This is done in the Communications Setup dialog box. Select the Communications Setup command in the Unit Menu.

Set the Port drop-down menu to match the number of the serial port. You have a choice between Ports 1 - 20. Identify the serial port on your computer and choose the same number in the Port box. See your computer's manual for information on how to identify serial ports.

The other settings within this dialog box, including the Test button, do not apply to Series II monitors. Click on Close to save your settings and quit the Communications Setup dialog box. Your computer and monitor can now communicate.

NOTE: Refer to Section 4.2, Series IV Communications Setup the steps to setup the Ethernet Communications protocol.

5.3 Series II Event Manager

The Series II Event Manager displays the Events stored on your Series II monitor, and is used to copy Events to your PC, and delete them from the monitor. The Series II Event Manager is not used to display or edit your Event data.

Access the Series II menus by clicking and placing a checkmark in the Series II box located at the lower right hand corner of the Event Manager. The menus may also be accessed by selecting Unit, Select Unit Type, and then clicking on Series II. Once you have copied Events over to your PC, you use the main Event Manager, accessed from the File Menu, to view and edit them.

After connecting the monitor to the computer and selecting a serial port, open the Series II Event Manager by clicking on the Series II Unit icon in the Directories List Box:
Blastware automatically reads the Events stored on the monitor and displays them within the Series II Event Manager list:

a. **Refresh**
   This command reads and displays the Events stored in the monitor again. The monitor can be the same one initially connected or a different monitor just connected to the computer.
   To update the Event List, open the **Series II Event Manager** and click on the **Refresh** button.

b. **Copy**
   This command copies Events from the monitor to the computer.
   To copy Events, place a checkmark in the Series II box and then choose the **Event Manager** command. Click on the **Copy** button. The following dialog box appears.
(1) **Directory**
This window displays the directory where the files will be copied to. To select a directory, position the mouse pointer on the directory and click the left mouse button.

(2) **Default**
This option sets the Event Manager to automatically copy Events to the same directory currently selected. Click on this checkbox to display a checkmark.

(3) **Copy All**
The Copy All command copies all the Events on the monitor to the computer.

(4) **Copy Selected**
This command copies only those Events selected within the Event List.
To select an Event, click on it to highlight it. To select multiple Events, click the first Event in the Event List, hold the Shift key, then select the last Event. To select multiple Events not appearing in order within the Event List, click on the first Event, hold the Control key, then click on the remaining Events. Click on the Copy Selected button to copy the Events to the computer.

**Note:** If a communications error occurs while copying Events, a dialog box appears with the following commands. **Abort** - stops copying Events and deletes the last incomplete Event. **Retry** - copies the current Event again and continues copying the remaining Events. **Ignore** - skips the current Event and continues copying the remaining Events.

(5) **Create**
Click the Create button to create a new directory to copy the Event files to. Click on the window and enter a directory path and a name for the new directory. Click on the OK button.

(6) **Cancel**
This command closes the dialog box.

c. **Delete All**
The Delete All command erases all the Events stored on the monitor. All the Events must be deleted as a group.

**WARNING:** Events deleted from the monitor cannot be recovered.

d. **Cancel**
Closes the Series II Event Manager dialog box.
5.4 Series II Unit Menu

The Unit Menu contains several commands to program the Blastmate II or Minimate. After you have changed the setups, Blastware transfers the changes to the monitor. In order for Blastware to complete this successfully, a Blastmate II or Minimate must be connected to the computer using the Blastmate II PC connecting cable. Before you enter this menu and attempt to change the setups, connect a monitor to your computer. See Chapter 4, Section 4.1, for information on how to connect a monitor to a computer.

5.4.1 Compliance Setup

The Compliance Setup dialog box programs the monitor’s Recording Mode, Storage Mode, Record Time, Record Interval, Trigger Source, and the Geophone and Microphone setups. After choosing the settings, click on the Send button to transfer the settings to the monitor.

To display the Recording Setup dialog box, ensure that the Series II menus have been enabled; click on Unit, Setup, and Compliance Setup.

Note: The availability of the following settings differ between the Blastmate II and Minimate monitors due to the different features offered by each model.

a. Record Mode

The Record Mode determines how the monitor records Events.

To choose a recording mode, click on the Record Mode drop-down menu and select a record mode. Choose one of the following record modes.

(1) Single Shot Record Mode

Use Single Shot record mode to record one Event automatically. The monitor records the Event, displays the results, and stops. No further recording occurs. Recording begins automatically when an Events particle velocity or overpressure exceeds a preset trigger level.

(2) Continuous Record Mode

Use Continuous record mode to record multiple Events automatically. The monitor records an Event, displays the results, and continues to monitor, ready to record following Events. The monitor records all Event activity that exceeds a preset trigger level.
(3) **Manual Override Record Mode**
Use Manual Override record mode if automatic triggering is unreliable, due to excessive wind or nearby vehicle activity, or to record the background noise level in the vicinity of a site. The monitor begins recording when you choose **Enter Monitor Mode** from the **Series II Menu**.

(4) **Strip Chart Record Mode (Blastmate II Only)**
Use the Strip Chart record mode for long-term recording periods such as monitoring pile driving operations. Strip Chart record mode operates with Blastmate II 677 and 477 monitors.
In this mode, the monitor stores summary Event information in intervals rather than in the real time continuous method used in the other record modes. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. This reduces the data recorded to specific criteria only and greatly increases the monitors recording time. For each interval, the monitor calculates the maximum positive and negative peaks, the frequency of the largest peak, and the peak vector sum over the entire Event. Histogram mode prints all peaks over the entire Event along with the numerical results of the data analysis. In tabular mode, only the numerical results print.

(5) **Storage Mode (Blastmate II Only)**
The Storage Mode setting determines the amount of data recorded with each Event. In the Full Data setting, the monitor records all Event data. In Summary Only mode, the monitor records all Event data except each channels graphical waveforms and the Compliance Report.
To select a storage mode, click on the **Storage Mode** drop-down menu. Click the mouse pointer on either **Full Data** or **Summary Only**.

(6) **Record Time**
The Record Time setting chooses between a fixed record time and an auto record time.
To select a Record Time, click on the **Record Time** drop-down menu. Click the mouse pointer on **Auto** for auto record time or on one of the one to ten seconds options.

(7) **Record Interval (Strip-Chart Only)**
Set the record interval for the Strip-Chart record mode. The record interval is the period of time the monitor records Event information before applying the data analysis techniques. For each interval, the monitor calculates the maximum positive and negative peaks, the frequency of the largest peak, and the peak vector sum over the entire Event.
To choose a Record Interval, click on the **Record Interval** drop-down menu and choose an interval.

(8) **Trigger Source**
This setting determines whether the Geophone, microphone, or both start the monitor recording if an Events activity exceeds a preset trigger level.
To choose a Trigger Source, click on the **Trigger Source** drop-down menu. Choose **Geophone** to start recording when an Events seismic activity exceeds a preset trigger level. Choose **Microphone** to start recording when an Events air pressure exceeds a preset trigger level. Choose **Geo/Mic** to start Event recording when either an Events seismic activity or air pressure exceeds the preset trigger levels.

(9) **Geophone**
The following options setup the Geophone channel for recording.
**Note:** The Geophone must be enabled as a trigger source before these settings can be changed.

  i  **Trigger Level**
The trigger level sets a threshold that must be exceeded by an Events activity before the monitor begins recording. Use your judgment when setting a trigger level. You must set the level high
enough so the monitor does not trigger on unwanted Events such as nearby vehicle traffic. At the same time, you have to set the trigger level low enough so that an Events activity exceeds the trigger level and starts the monitor recording.

To set a trigger level, click on the Trigger Level box. Enter the new level.

ii Alarm Level (Blastmate II Only)

The alarm level controls the triggering of an optional remote alarm (711A1401). The remote alarm sounds two alarms: warning and alarm. The warning alarm sounds when Event activity exceeds the set Geophone trigger level. The alarm level can be set to a different level that is higher than the trigger level of the Geophone. This allows for the triggering of a second alarm at the higher level.

For example, in pile driving operations the remote alarm triggers a warning when activity exceeds the trigger level for the Geophone, notifying the operator that the pile driving activity has exceeded that set level. The second alarm triggers when activity exceeds the alarm level, set to a higher level, notifying the operator to re-evaluate the piling operation.

To set an alarm level, click on the Alarm Level box. Enter the new level.

(10) Microphone

The following options setup the microphone channel for recording.

Note: The microphone must be enabled as a trigger source before these settings can be changed.

i Weighting (Blastmate II Only)

Choose the microphone type connected to the monitor. Choose either Linear, A Weight, or C Weight.

To choose a microphone type, click on the Weighting drop-down menu. Choose a type.

ii Trigger Level

The trigger level sets a threshold that must be exceeded by an Events activity before the monitor begins recording. Use your judgment when setting a trigger level. You must set the level high enough so the monitor does not trigger on unwanted Events such as nearby vehicle traffic. At the same time, you have to set the trigger level low enough so that an Events activity exceeds the trigger level and starts the monitor recording.

To set a trigger level, click on the Trigger Level text box. Enter the new level.

iii Alarm Level (Blastmate II Only)

For a description of the optional remote alarm, see to the Geophone channel in the previous section.

To set an alarm level, click on the Alarm Level box. Enter the new level.

iv Range (Blastmate II Only)

Set the range for Strip-Chart record mode only. The Range controls the plotter (printer) output on the monitor. The range also controls the sensitivity of the monitor.

To choose a range, click on the Range drop-down menu. Choose a range.

b. Command Buttons

To choose one of the following command buttons, click the mouse pointer on the button.

i OK

Accept the changes and do not exit the dialog box.

ii Cancel

Cancel the changes and return to the previous window.
5.4.2 Notes

The Notes dialog box lets you enter notes about Events. These notes are then saved with every Event when it is recorded. Notes become part of the permanent record and cannot be changed after an Event has been recorded. After you have entered your settings in each dialog box, choose Send to transfer your settings to the monitor.

To display the Notes dialog box, open the Series II Menu and select Notes. The Series II Unit Notes dialog box appears.

To enter notes, click on a space and delete the existing notes by pressing and holding the Backspace key. Enter the new notes.

a. **Location**
   Enter the location where monitoring is to take place.

b. **Client**
   Enter the client for whom the monitoring is being performed.

c. **User**
   Enter the name of the person performing the monitoring.

d. **Extended Notes**
   Use this area to enter additional notes as required up to a maximum of 640 characters.

e. **Distance from blast (Blastmate II Only)**
   Enter the distance from the monitor to the blast in feet or meters.
f. **Charge Weight (Blastmate II Only)**
   Enter the charge weight of the blast in pounds or kilograms.

g. **Scaled Distance (Blastmate II Only)**
   The Scaled Distance is calculated automatically, and appears within this dialog box and on Event Summary Reports.

h. **Command Buttons**
   To choose one of the following command buttons, click the mouse pointer on the button.
   
   i. **OK**
      Accept the changes and do not exit the dialog box.
   
   ii. **Cancel**
      Cancel the changes and return to the previous window.
   
   iii. **Apply**
      Apply the changes and exit the dialog box.
   
   iv. **Help**
      Select Help to launch the menu to access help on the Series II dialogs.

5.4.3 **Timer Mode Setup**

The timer function sets a Blastmate II or a Minimate to automatically turn on and start monitoring operations at a preset time in the future. The timer can be set for a one time monitoring session or to record at the same time every day. Using the timer extends the monitors battery life by turning on and monitoring only the time periods when Events occur and not the time periods between Events.

To display the **Timer Mode Setup** dialog box, select Unit, Setup, and then click on Compliance Setup.

**Note:** When using a monitor in the Timer Mode, the monitor stops recording even if Event activity is present and exceeds the trigger levels. The monitor records the current Event then stops.
a. **Timer Mode**

The timer can be set for a one-time operation or repeated operations at the same time each day. To select a timer mode, click on the **Timer Mode** drop-down menu and select the required option. Choose **Off** to disable the timer. Choose **Monitor Once Only** if you want the monitor to turn on and record a single session, then turn off. Choose **Monitor Every Day** if you want the monitor to turn on and record at the same time every day beginning immediately.

(1) **Start Date**  
Enter the calendar date for the monitor to turn on.

(2) **Start Time**  
Enter the time of day for the monitor to turn on and start monitoring. Change the time format between the twenty-four-hour clock and the twelve-hour clock in the **Report Options** dialog box located within the **Options Menu**.

(3) **Stop Date**  
Enter the calendar date to turn the monitor off.

(4) **Stop Time**  
Enter the time of day to turn the monitor off and stop monitoring.

b. **Daily Self Check (Blastmate II only)**

Use the self check mode for remote monitoring where you require a record indicating the monitor was operating properly over a period of time. The self check mode program operates when the monitor is in the monitor mode. The monitor temporarily exits the monitor mode, at the same time each day specified by you, performs the check, and returns to monitor mode. The results appear in a monitor log entry.

To set the self check mode, move the mouse pointer to the **Self Check Mode** drop-down menu and choose **On** to turn the self check mode on. Choose **Off** if you do not require self check to operate.

(1) **Time**  
Enter a time for the Self Check Mode to run. Click on the **Time** boxes and enter a time.

To choose one of the following command buttons, click the mouse pointer on the button.

c. **Command Buttons**

To choose one of the following command buttons, click the mouse pointer on the button.

   i. **OK**  
   Accept the changes and do not exit the dialog box.

   ii. **Cancel**  
   Cancel the changes and return to the previous window.

   iii. **Apply**  
   Apply the changes and exit the dialog box.

5.4.4 **Status**

The Status command checks the monitor and displays the following information.

To display the Status dialog box, select **Unit** menu, then click on **Status**. Press the **Refresh** button to update the information. Press the **Cancel** button to return to the Blastware Main Menu, and the **Print** button to print out a copy of the Status settings.
5.4.5 Sensor Check

This command runs Sensor Check, which checks the Blastmate II or the Minimate Geophone and microphone sensors. To display the dialog box, open the Unit Menu and choose Sensor Check.

a. Test Results

This area displays the results of the Sensor Check. In addition to indicating the Pass/Fail status, the display offers basic information on the sensor. For the microphone, the frequency (FR) and ampere rating (AMP) are given. For the Geophone, the frequency (FR) and overswing ratio (OSR) are shown for each of the transverse, vertical and longitudinal sensors.

(1) Mic Test
This displays the results of testing on the microphone.

(2) Tran Test
This displays the results of testing on the Geophones transverse sensor.

(3) Vert Test
This displays the results of testing on the Geophones vertical sensor.

(4) Long Test
This displays the results of testing on the Geophones longitudinal sensor.

(5) Test button
This runs Sensor Check and tests the sensors connected to the monitor. Click on the Test button.

b. Sensor Check Mode

You can choose to have the unit run Sensor Check regularly, either before or after Events are recorded. The results are stored with the Event file, and are displayed in the Quick View window in the Event Manager.
(1) **Before Monitoring**
To have the unit run Sensor Check before monitoring, click on this setting.

(2) **After Event**
To have the unit run Sensor Check after monitoring, click on this setting.

(3) **Send**
Click on this button to save your settings to the unit run.

(4) **Cancel**
Click on this button to exit the Sensor Check dialog box.

### 5.4.6 Date/Time

To display the date and time, select **Unit** menu, then click on **Date/Time**. The Unit Date/Time dialog box appears.

You may set the Date and Time in your monitor in two ways. The first method is to copy the settings from your PC, as displayed in the PC Date/Time area. Make sure the date and time are correct, and then click on the **Send to Unit** button. The date and time in the Unit Date/Time area will change to match the PC Date/Time. You can also set the date and time manually: enter the current date and time in the Unit Date/Time area then send the changes to the unit by clicking on the **Set Date/Time** button.

**Micromate Date/Time with UTC Offset:**

![Micromate Date/Time with UTC Offset](image)
5.4.7 **Monitor Mode**

This command starts a Blastmate II or a Minimate monitoring. Choosing one of the other commands within Unit Menu also stops monitoring.

**WARNING:** Choosing a command within the Series II Menu automatically sends a signal telling the monitor to exit the monitor mode.

5.4.8 **Monitor Log**

The monitor log lists monitoring periods for the Blastmate II, including date, start time, and stop time. To display the Monitor Log, select Unit menu, then click on Monitor Log. The Series II Monitor Log dialog box appears. Choose Print to print a copy of the Monitor Log. The Output dialog box will appear. Click Cancel to close the Monitor Log dialog box.

5.4.9 **Reload Operating System**

This command sends a new version of the operating system to your Blastmate II or Minimate. To reload or view the operating system, select Unit menu, then click on the Reload Unit OS command. The Series II Reload OS dialog box appears.

**Note:** Series II users are strongly recommended to download the latest version of the Series II operating system to the monitor (version 2.6 for the Minimate and ver 5.5 for the Blastmate). The new version ensures year 2000 compatibility. Note, however, that once you have downloaded the OS from Blastware, you will no longer be able to download the OS from the Series II DS-467 or DS-567 software.
a. **Freq. Analysis Method**
   This drop-down menu lists the available frequency analysis methods for compliance monitoring. To choose a frequency analysis method, click on the **Freq. Analysis Method** drop-down menu and select a method.

b. **Unit Type**
   This indicates what kind of monitor is connected to your PC: a Blastmate II or Minimate. Blastware will automatically reload the appropriate operating system.

c. **Unit Version**
   This is the version number of the operating system presently in the monitor.

d. **Version Date**
   This is the release date of the operating system version presently in the monitor.

e. **Reload OS**
   This command loads the most recent version of the operating system to your monitor.
   **WARNING:** If you have Events stored on the unit, they will be erased when you reload the operating system. Download all Event files to your PC before reloading the OS.

f. **Cancel**
   Exit the Series II Reload OS dialog box without reloading the operating system. You will return to the Blastware Main Window.
6. **BLASTWARE ADVANCED MODULE (OPTIONAL)**

This chapter describes the optional Advanced Module for the Blastware software. This module offers additional features and capabilities to the Blastware program. Features include advanced setup procedures to use sample rates ranging from 512 sps to 65,536 sps, and the ability to configure virtually any type of sensor to be used by the Series III or the Series IV monitors. The module also includes analysis software to offer you unparalleled ability to analyze waveforms. You can perform FFT calculations and determine the frequency of a waveform at any point with the easy to use Windows® interface.

The Advanced Module is designed to easily integrate with the compliance module. It adds features to the Compliance Module without changing the look and operation of the Blastware software, allowing you to easily begin using the software. It builds on the Compliance Module.

This section of the manual explains the new advanced module features without repeating the Compliance Module information. The operations you perform using the Compliance Module are still available to you from the Blastware menus. If you have to refer to these operations when using the advanced module, flip back to the appropriate compliance module section or press F1 at any time to access the on-line help system.

The Main Window contains the Blastware Main Menu, an Icon Toolbar, and other standard Windows controls. You access all Blastware commands from the main window.

6.1 **Event Manager – Advanced Module**

The Event Manager operates exactly the same in the advanced module as it does in the compliance module. You can use it to copy Events from the monitor, delete Events both from the monitor and from your computer, print, view, and perform advanced analyses.

The titles under the “Type” column of the Event List Box change for each type of Event. This is due to the wide variety of possible Event types you can record using the advanced software. If you have advanced Events, the Event List automatically changes.
If you have Events stored from several different Instanet monitors, you may find it useful to create sub-directories in your Blast directory located on your computer's hard disk. Name the two directories differently and store your compliance and advanced Events separately in each of the two directories.

### 6.2 Analysis Window

This analysis window displays all Blastmate Event waveforms including Series III and Series IV compliance and advanced Events and Series II Events. Within this window, you can zoom in on the waveforms to examine them, add post Event notes, convert the files to ASCII format, view a report of the Event, calculate frequency at any two points on the waveforms, perform a Fast Fourier Transform (FFT) on the waveforms, and display timelines.

To display the window, display the Event Manager and click on the Analysis icon found on the Blastware Main Menu Icon Toolbar. The analysis window appears.

![Analysis Window Diagram](image)

#### 6.2.1 Waveform Window

This window displays the Events waveforms. One to eight waveforms may be displayed at the same time, depending on the number of channels recorded in the Event.

**a. Analysis Cursors**

Use the analysis cursors to analyze any part of a selected waveform. The cursors indicate Event time and amplitude.

1. **Moving the Cursors**

   The analysis cursors can be moved across the waveforms using either the mouse or the keyboard. Using the mouse, click on the cursor to select it (it will flash) and then double-click at the new position. You can also simply click and drag it.
Using the keyboard, press the Tab key repeatedly until the required analysis cursor begins to flash indicating it is selected. Press the Left or Right Arrow key to move the cursor one position in either direction. To move the cursor in increments of ten, hold the Ctrl key while pressing the Left or Right Arrow key. The analysis cursor jumps ten positions with each key press.

(2) Analysis Pointers

The analysis pointers indicate Event time, waveform amplitude, and the absolute difference in waveform amplitudes between the two points presently indicated by the analysis cursors. The analysis pointers appear on both the left and right analysis cursors. On the left cursor, the top pointer indicates the time for the current position of the cursor. The pointers inside each waveform window display the amplitude of the waveform at the analysis cursors current position.

For the right analysis cursor, the top pointer indicates the time for the current position of the analysis cursor. The pointers inside each waveform window indicate the amplitude of the waveform at the cursors current position. The pointers also indicate the difference in amplitude between the amplitude at the first cursors position and the amplitude at the second cursors position.

The data displayed by the Analysis Pointers can be configured using the Cursor command, located in the View menu.

(3) Calculations

Time and frequency calculations appear above the waveform windows. The time, indicated by dx, is the time period between the two analysis cursors. The frequency calculations indicate the frequency of the waveform located between the two analysis cursors. Frequency calculations include full, half, and quarter calculations depending on the portion of a waveform being analyzed.

b. Timelines

The timelines indicate the timing of sequences throughout an Event. The timelines indicate delays according to the manufacturer’s specifications. By overlaying the timelines on the Events waveforms, it is possible to compare stated performance to actual performance.

To view timelines, click on the View Menu and choose Timelines. You have to configure your timelines before they can appear on the Events waveforms.

To aid in analysis, the timelines can be moved as a group. To move the timelines, position the mouse pointer over any timeline and double click the left mouse button. The analysis cursor moves directly over top of the timeline. Press the right mouse button to select the timelines. The selected timeline reappears as a dashed line indicating it is selected. To move the timelines, position the mouse pointer on a timeline and click the left mouse button. Drag the timeline to the required position. You can also use the keyboard, press the Left or Right Arrow keys to move the timelines one position. Hold down the Ctrl key while pressing the Left or Right Arrow keys to move the timelines ten positions with each key press.

6.2.2 Waveform Scale Control

Waveform Scale Control changes the scale of the waveform displayed in the waveform window. The waveforms channel name along with the units of measurement appears above the window. Within the scale window itself, a large shaded section reflects the current view of the waveform window. To change the current view, position the mouse pointer on any timeline and double click the left mouse button. The analysis cursor moves directly over top of the timeline. Press the right mouse button to select the timelines. The selected timeline reappears as a dashed line indicating it is selected. To move the timelines, position the mouse pointer on a timeline and click the left mouse button. Drag the timeline to the required position. Notice this changes the amplitude scale located on the left hand side of the waveform window.

To increase the scale (enlarge) or decrease the scale (shrink) the displayed waveform, click the top button repeatedly or the bottom button repeatedly until the desired view appears. Notice this changes the amplitude scale located on the left hand side of the waveform window.

6.2.3 Time Scale Control

This changes the time axis scale for all displayed waveforms.
To increase the time axis, click on the right button. To decrease the time axis, click on the left button. Notice the shaded area in each of the waveform scale windows changes size indicating the change in the amount of a waveform that can appear within the waveform window.

### 6.2.4 Waveform Checkboxes

These checkboxes display or hide an Events waveforms. All available waveforms appear indicated by their channel name. Channel names vary depending on the type of Event. For compliance Events, the channel names are Tran, Vert, Long, and Mic. For advanced Events, the channel names correspond to the names chosen by you in the advanced setup dialog box. For eight channel monitors, the channel names are Tran1, Vert1, Long1, and Mic1 for the first four channels and Tran2, Vert2, Long2, and Mic2 for channels five to eight.

To display a waveform, click on the checkbox to display a checkmark. The waveform appears within a waveform window. To hide a waveform, click on the checkbox to clear the X. The waveform disappears from the waveform window. You can choose one waveform to view and automatically turning off all the others by holding down the CTRL key and clicking the left mouse button with the mouse pointer on the desired waveform.

### 6.2.5 Zoom Data Plot Command

The Zoom Data Plot command provides a detailed window for a selected region of a waveform channel. The portion of the waveform that is between the Analysis Cursors is the area that will be shown in the Zoom Data Plot window.

To select a specific region of a waveform channel, click on the cursor with the mouse to select it (the cursor will flash) and then double-click at the new position. You can also simply click and drag the cursor. Once the Analysis Cursors are positioned, double-click with the right mouse button within a channel to view the Zoom Data Plot window for that channel.

In the Zoom Data Plot window you are able to zoom in again using the same process, or by right clicking and dragging a box across the desired area as shown below; releasing the mouse button will instantly produce an enlarged view of the area of interest.

You can also move the Analysis Cursors within the Zoom Data Window by clicking once at the location you wish to move the Cursor. The Analysis Cursor that is closest to the position you have indicated will move.
a. File

Save Zoom Data Plot images to file for future reference, print them, and modify the printer setup.

(1) **Save as Metafile**
Saves the selected Zoom Data Plot view as a color image with the .wmf (Windows Metafile Format) file extension, a popular bitmap file format. The image saved includes the graph bars, waveform, inserted Notes, and Left/Right Cursor Calculations. This file may then be used in reports, or sent as an e-mail attachment.

(2) **Copy to Clipboard**
From the file menu, select **Copy to Clipboard**. A bitmap image of the Scaled Distance plot is copied to your computer’s temporary memory. Open another Windows program that supports graphics and use the paste command, or simultaneously press `CTRL-V`, to place the bitmap image into the file.

(3) **Print**
Prints the Zoom Data Plot.

(4) **Printer Setup**
This command specifies the type of printer connected to the computer and configures the printer settings.

b. Edit

(1) **Notes**
This command is used to add notes to the Zoom Plot. You can add up to three notes, which appear in the lower left-hand corner of the window. These notes will also appear on your print outs.

Enter the desired notes, and then click on OK. The notes will appear in the Zoom Data Plot window.

c. View

(1) **Cursor Data**
Toggles on/off the Cursor Data displayed on the right hand side of the Zoom Data Plot window. Cursor Data includes the following information:

- **Left Cursor**
  - Sec – time at the left cursor
  - mm/s – waveform amplitude at the left cursor

- **Right Cursor**
  - Sec – time at the right cursor
  - mm/s – waveform amplitude at the right cursor

- **Dx**
  - X value difference between the first cursor and the second cursor

- **Dy**
  - Y value difference between the first cursor and the second cursor
Average
Displays the average value between the two cursors

Slope
Indicates the point to point slope of the waveform between the two cursors

Regression
Displays the slope as calculated by a linear regression between the two cursors

d. Plot
Return the Zoom Data Plot window to its original zoom window, or perform multiple zooms.

(1) Restore
Restores the Zoom Data Plot window to the initial zoom settings selected in the Waveform Analysis window, while maintaining the position of the Analysis Cursors of the last selected zoom.

(2) Zoom
The Zoom command increases the size of the waveform located between the cursors. You can also zoom in on a waveform using the mouse. Click and hold down the right mouse button and drag to create a box over the area to be enlarged; then release the button.

e. Draw
The Draw menu contains various commands to insert annotations on the Zoom Data Plot window. You can add Slope Lines, Notes, Arrows, and Time Delays.

(1) Slope Line
Add Slope Lines within the Zoom Data Plot window to assist in annotating multiple slopes. Lines may also be added using the Line button in the upper right hand corner of the Zoom Data Plot window. Once the line is created, it may be moved by the click-and-drag method. Place the cursor cross-hairs over the light gray ball at either end of the line, and move to the desired location.

i. New
Select this command and then click and hold down the left mouse button at the beginning of the line. Drag the line to the desired location, and release the button. The annotation updates as the line is moved until the mouse button is released, allowing for accurate placement.

ii. Delete
Delete Slope Lines and related annotations by selecting the Delete command, then clicking on either gray ball at the end of a Slope Line.

(2) Paste Note
Paste Note allows you to create, edit, and move notes of up to 120 characters within the Zoom Data Plot window. The Paste Note command is also available by using the Note button in the upper right hand corner of the Zoom Data Plot window. Once the text is created, it may be moved by the click-and-drag method. Place the cursor over the text and move to the desired location.

i. New
Places a note in the Zoom Data Plot window. After selecting this command, place the cursor in the desired location and click the left mouse button once. The Text Parameters dialog box appears:
Input the text and select the font style, color, and size. After completing the text field box, press OK to finish the command.

ii Delete
The cursor will change to cross-hairs after selecting this command; place the cursor over the Note to be deleted and click once. Once Notes are deleted they cannot be restored.

iii Edit
To edit an existing Note, place the cursor over the Note and double-click the left mouse button. The Text Parameters dialog box will appear allowing you to edit the text content and attributes.

(3) Arrow
Use arrows to associate Notes with specific data.
Arrows may be moved by using the click-and-drag method. Place the cursor over either the arrow, or the end of the leader line, until the cursor changes to the four-way arrow style; then click-and-drag to the desired location.

i New
Arrows are created using the click-and-drag method. Select New, and then place the cursor where you would like the line to start; drag the arrow to the desired position.

ii Delete
Select the Delete command and move the cursor to either end of the arrow or leader line until the cursor changes to the four-way arrow style. Click once with the left mouse button to delete the arrow.

(4) Time Delay
A Time Delay is drawn parallel to the time axis and annotated with the duration of time between the two arrowheads. Time Delays may be moved by using the click-and-drag method. Place the cursor over either arrow until the cursor changes to the four-way arrow style, and drag to the desired location.

i New
Insert Time Delays in a Zoom Data Plot by using the click-and-drag method. Select New, and place the cursor where you would like to start the Time Delay; then drag the arrow to the desired position and release the mouse button. While positioning the line, the annotation for the delay automatically updates as the line is used. The line may also be positioned horizontally by sliding the cursor up or down while performing the click-and-drag motion.

ii Delete
Select the Delete command and move the cursor to either arrow until the cursor changes to the four-way arrow style. Click once with the left mouse button to delete the Time Delay.

f. Tools
(1) View ASCII Data
This command displays the numerical coordinates of the entire waveform appearing within the Zoom Data Plot window.
i **Copy**

Use this command to copy the coordinates to third party analysis program such as Microsoft Excel. Click **Copy**. The information transfers to the computer's clipboard file. From within the third party software such as Excel, choose paste. The coordinates appear within the program.

ii **Format**

This controls the View Data table. **Width** controls the size of the table columns. **Precision** controls the number of significant digits.

### 6.3 Advanced Setup (Series III and Series IV)

Advanced Setup configures Blastmate III and the Minimate Plus monitors for advanced operation. The Series III monitors must be configured using the Blastware software before they can be used in the advanced mode. Advanced Setup can be accessed by either clicking on the **Advanced Setup** icon in the Blastware Main Menu Icon Toolbar, or by clicking on **Unit, Setup, Advanced Setup**.

To configure the monitor, select the appropriate settings within the Advanced Setup tabbed dialogs of Recording Setup, Notes, Special Setups, and Library Files. After you have chosen the required settings, select **Send To Unit** to send the settings to the monitor. If you do not wish to accept the changes, or send them to your unit, then select **Cancel**.
Series III Advanced Setup Dialog:

**Advanced Setup**

**Channels:**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Name</th>
<th>Units</th>
<th>Sensitivity (Volts/Unit)</th>
<th>Gain 1X</th>
<th>Gain 8X</th>
<th>Trigger Level</th>
<th>Enable</th>
<th>Δ/± Resolution (Units)</th>
<th>Δ/± Range (Units)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tran1</td>
<td>in/s</td>
<td>0.16113302</td>
<td></td>
<td></td>
<td>0.500</td>
<td></td>
<td>0.00500</td>
<td>10.00</td>
</tr>
<tr>
<td>2</td>
<td>Vent1</td>
<td>in/s</td>
<td>0.16113302</td>
<td></td>
<td></td>
<td>0.500</td>
<td></td>
<td>0.00500</td>
<td>10.00</td>
</tr>
<tr>
<td>3</td>
<td>Long1</td>
<td>in/s</td>
<td>0.16113302</td>
<td></td>
<td></td>
<td>0.500</td>
<td></td>
<td>0.00500</td>
<td>10.00</td>
</tr>
<tr>
<td>4</td>
<td>Mic1</td>
<td>psi</td>
<td>22.22024757</td>
<td></td>
<td></td>
<td>0.01000</td>
<td></td>
<td>0.00004</td>
<td>0.0725</td>
</tr>
<tr>
<td>5</td>
<td>Tran2</td>
<td>m/s</td>
<td>0.00034382</td>
<td></td>
<td></td>
<td>20.0</td>
<td></td>
<td>0.127</td>
<td>254</td>
</tr>
<tr>
<td>6</td>
<td>Vent2</td>
<td>m/s</td>
<td>0.00030383</td>
<td></td>
<td></td>
<td>20.0</td>
<td></td>
<td>0.129</td>
<td>256</td>
</tr>
<tr>
<td>7</td>
<td>Long2</td>
<td>m/s</td>
<td>0.00034382</td>
<td></td>
<td></td>
<td>20.0</td>
<td></td>
<td>0.127</td>
<td>254</td>
</tr>
<tr>
<td>8</td>
<td>Mic2</td>
<td>pa</td>
<td>0.00022252</td>
<td></td>
<td></td>
<td>10.0</td>
<td></td>
<td>0.250</td>
<td>500</td>
</tr>
</tbody>
</table>

**Instrument:**

- **Record Mode**: Single Shot
- **Sample Rate**: 4036
- **Storage Mode**: Full
- **Record Time**: 1

PC is not attached to a unit.
Series IV Advanced Setup Dialog:

![Advanced Setup Dialog](image)

**a. Recording Setup**

(1) **Channels**

Configure the monitor channels using the following settings. These items can only be changed using the Blastware software (Advanced Module).

i **Select**

Choose the channels to be used during advanced operations. Click on the checkbox to display a checkmark to enable the channel. Channels must be enabled or disabled according to the following restrictions; Channel 1 only, Channels 1 and 2, Channels 1 through 4, or Channels 1 through 8 (eight channel monitor required), Channels 1 through 6 (six channel monitor required).

ii **Name (5 char max)**

Enter a name to refer to the channel name. The name can be a maximum of five characters long.

iii **Units (6 char max)**

Enter a name to refer to the measurement units for each channel. The following table summarizes Instantel sensor units. Refer to the manufacturers specifications for non Instantel sensors.
<table>
<thead>
<tr>
<th>Series III Instantel Sensor</th>
<th>Units</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series III L Microphone (714A9801)</td>
<td>pounds/square inch [psi (L)]</td>
<td>Pascal [Pa(L)]</td>
</tr>
<tr>
<td>Series III A Weight Microphone (714A2001)</td>
<td>decibels (dBA)</td>
<td>decibels (dBA)</td>
</tr>
<tr>
<td>Series III Standard Triaxial Geophone (ISEE, 2-250 Hz) (714A9701)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series III Standard Triaxial Geophone (DIN, 1-315 Hz) (718A3301)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series III Uniaxial 4.5 Hz Geophone (Vertical – 714A4601, Horizontal – 714A4602)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series III Bore Hole Transducer (714A3301)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series III Hydrophone Sensor (718A0801)</td>
<td>pounds per square inch (V/psi)</td>
<td>kilopascal (V/kPa)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Series IV Instantel Sensor</th>
<th>Units</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series IV L Microphone (720A1801)</td>
<td>pounds/square inch [psi (L)]</td>
<td>Pascal [Pa(L)]</td>
</tr>
<tr>
<td>Series IV A and C Weight Microphone (720A5101)</td>
<td>decibels (dBA)</td>
<td>decibels (dBA)</td>
</tr>
<tr>
<td>Series IV Standard Triaxial Geophone (ISEE, 2-250 Hz) (720A2001)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series IV Standard Triaxial Geophone (DIN, 1-315 Hz) (720A2002)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series IV Standard Triaxial Geophone (DIN, 1-80 Hz) (720A2003)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series IV HF Triaxial Geophone (20 Hz-1 KHz Hz) (720A4701)</td>
<td>inches/second (in/s)</td>
<td>millimeters/second (mm/s)</td>
</tr>
<tr>
<td>Series IV HP Microphone (720A4801)</td>
<td>pounds/square inch [psi (L)]</td>
<td>Pascal [Pa(L)]</td>
</tr>
<tr>
<td>Series IV Accelerometers .5, 50, 500 g (720A4901, 720A2401, 338B34)</td>
<td>m/s^2</td>
<td>m/s^2</td>
</tr>
<tr>
<td>Hydrophone Sensor (720A0801)</td>
<td>pounds per square inch (V/psi)</td>
<td>kilopascal (V/kPa)</td>
</tr>
</tbody>
</table>

**Sensitivity (Volts/Unit)**

Enter the sensors sensitivity. The following table summarizes Instantel sensor settings. Refer to the manufacturer’s specifications for non Instantel sensors.
Blastware Advanced Module

<table>
<thead>
<tr>
<th>Uniaxial 4.5 Hz Geophone (Vertical – 714A4601, Horizontal – 714A4602)</th>
<th>0.16113 V/in/s</th>
<th>0.006344 V/mm/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bore Hole Transducer (714A3301)</td>
<td>0.16113 V/in/s</td>
<td>0.006344V/mm/s</td>
</tr>
<tr>
<td>Hydrophone Sensor (714A0801)</td>
<td>0.034 V/psi</td>
<td>0.0049 V/kPa</td>
</tr>
<tr>
<td>Hydrophone with 100 psi adapter (714A8201)</td>
<td>0.017 V/psi</td>
<td>0.00244 V/kPa</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Series IV Instantel Sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>Imperial</td>
</tr>
<tr>
<td>Metric</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
</tbody>
</table>

| Series IV L Microphone (720A1801) | 44.496552 V/psi (0.0444496 v/mpsi) | 0.0646452 V/Pa |
| Series IV A and C Weight Microphone (720A5101) | 26.2 or 827.40 V/psi | 0.0038 or 0.12 V/pa |
| Series IV Standard Triaxial Geophone (ISEE, 2-250 Hz) (720A2001) | 0.3222605 V/in/s | 0.0126774 V/mm/s |
| Series IV Standard Triaxial Geophone (DIN, 1-315 Hz) (720A2002) | 0.3222605 V/in/s | 0.0126774 V/mm/s |
| Series IV Standard Triaxial Geophone (DIN, 1-80 Hz) (720A2003) | 0.3222605 V/in/s | 0.0126774 V/mm/s |
| Series IV HF Triaxial Geophone (28 Hz-1 KHz Hz) (720A4701) | 0.032226 V/in/s | 0.00126774 V/mm/s |
| Series IV HP Microphone (720A4801) | 0.06451998 V/psi | 0.00.09340870 kPa |
| Series IV Accelerometers, .5 g (720A4901) | 6.4451998 V/g | 0.6576735 V/m/s2 |
| Series IV Accelerometers, 50 g (720A2401) | 0.064451998 V/g | 0.006576735 V/m/s2 |
| Series IV Accelerometers, 500 g (720A0801) | 0.0064452 V/g | 0.000657673 V/m/s2 |
| Hydrophone (720A0801) | 0.06856596 V/psi | 0.00994630 V/kPa |

v  
**Gain**

Choose the required range and resolution. Click on either button.

vi  
**+/– Trigger**

Enter a trigger level if using single shot or continuous record modes.

vii  
**Level**

Enter the trigger level.

viii  
**Enable**

These checkboxes enable the trigger on a particular channel. You can enable the triggers on any combination of channels. Recording begins when Event activity exceeds any single set trigger level.

ix  
**+/– Resolution**

The Blastware software automatically calculates the resolution based on the entered sensitivity and chosen gain.

x  
**+/– Range**

The Blastware software automatically calculates the range based on the entered sensitivity and chosen gain. Refer to this value when setting a trigger level.
(2) **Instrument**

i **Record Mode**
Choose single shot, continuous, manual record mode, or histogram. Advanced histograms calculates only the peak particle velocity for each interval.

ii **Storage Mode (Series III Only)**
Choose between full and summary storage modes. Full storage mode stores an Events waveforms and compliance report, summary storage mode does not.

iii **Sample Rate**
Advanced operations offer a range of sample rates. The following table summarizes the sample rates and the channels that may be used. Note that some sample rates operate on specific channels only, or with specific recording modes.

**Note:** Eight channel monitors have been optimized for sample rates up to 65536 S/s. Four channel monitors may exhibit noise at sample rates greater than 16384 S/s.

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>Series III</th>
<th>Series IV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1 Only</td>
<td>Channels 1 – 8</td>
<td>Channels 1 – 2</td>
</tr>
<tr>
<td>65536</td>
<td>available</td>
<td>–</td>
</tr>
<tr>
<td>32768</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>16384</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>8192</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>4096</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>2048</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>1024</td>
<td>available</td>
<td>available</td>
</tr>
<tr>
<td>512</td>
<td>available</td>
<td>available</td>
</tr>
</tbody>
</table>

“_“ indicates not available

iv **Interval**
In histogram mode, the monitor stores summary information in intervals. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. Click on the **Interval** dropdown menu to select the duration of the interval.

v **Record Time**

1. **Series III Units**
Enter a fixed record time. The advanced module does not offer the auto record mode. Blastware calculates the maximum available record time based on the amount of installed memory in the monitor and chosen sample rate.
### Approximate Monitor Recording Times

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>Channels</th>
<th>Channel 1 Only</th>
<th>Channels 1 – 2</th>
<th>Channels 1 – 4</th>
<th>Channels 1 – 8</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 Megabyte</strong></td>
<td>(300 Event)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65536</td>
<td>3 sec*</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>32768</td>
<td>13 sec</td>
<td>3 sec*</td>
<td>–</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>16384</td>
<td>26 sec</td>
<td>13 sec</td>
<td>3 sec*</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>8192</td>
<td>52 sec</td>
<td>26 sec</td>
<td>13 sec</td>
<td>3 sec*</td>
<td></td>
</tr>
<tr>
<td>4096</td>
<td>104 sec</td>
<td>52 sec</td>
<td>26 sec</td>
<td>13 sec</td>
<td></td>
</tr>
<tr>
<td>2048</td>
<td>208 sec</td>
<td>104 sec</td>
<td>52 sec</td>
<td>26 sec</td>
<td></td>
</tr>
<tr>
<td>1024</td>
<td>416 sec</td>
<td>208 sec</td>
<td>104 sec</td>
<td>52 sec</td>
<td></td>
</tr>
<tr>
<td>512</td>
<td>500 sec</td>
<td>416 sec</td>
<td>208 sec</td>
<td>104 sec</td>
<td></td>
</tr>
</tbody>
</table>

| **5 Megabyte** | (300 Event) | | | | |
| 65536 | 20 sec | – | – | – | |
| 32768 | 60 sec | 20 sec | – | – | |
| 16384 | 120 sec | 60 sec | 20 sec | – | |
| 8192 | 240 sec | 120 sec | 60 sec | 20 sec | |
| 4096 | 480 sec | 240 sec | 120 sec | 60 sec | |
| 2048 | 500 sec | 480 sec | 240 sec | 120 sec | |
| 1024 | 500 sec | 500 sec | 480 sec | 240 sec | |
| 512 | 500 sec | 500 sec | 500 sec | 480 sec | |

“...” indicates not available  * may only record 2.9 seconds

### 2. Series IV Units

Enter a fixed record time. Blastware calculates the maximum available record time based on the amount of installed memory in the monitor and chosen sample rate.

### Approximate Monitor Recording Times Displayed in Seconds

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>Channel 1</th>
<th>Channel 1-2</th>
<th>Channel 1-3</th>
<th>Channel 1-4</th>
<th>Channel 1-6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>64 Megabyte</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65536</td>
<td>404</td>
<td>204</td>
<td>138</td>
<td>104</td>
<td>62</td>
</tr>
<tr>
<td>32768</td>
<td>2260</td>
<td>1357</td>
<td>914</td>
<td>726</td>
<td>479</td>
</tr>
<tr>
<td>16384</td>
<td>4275</td>
<td>2210</td>
<td>1684</td>
<td>1243</td>
<td>899</td>
</tr>
<tr>
<td>8192</td>
<td>5515</td>
<td>3491</td>
<td>2753</td>
<td>2261</td>
<td>1530</td>
</tr>
<tr>
<td>4096</td>
<td>26412</td>
<td>13206</td>
<td>8804</td>
<td>6603</td>
<td>4402</td>
</tr>
<tr>
<td>2048</td>
<td>52824</td>
<td>26412</td>
<td>17608</td>
<td>13206</td>
<td>8804</td>
</tr>
<tr>
<td>1024</td>
<td>105648</td>
<td>52824</td>
<td>35216</td>
<td>26412</td>
<td>17608</td>
</tr>
<tr>
<td>512</td>
<td>211296</td>
<td>105648</td>
<td>70432</td>
<td>52824</td>
<td>35216</td>
</tr>
</tbody>
</table>

### Approximate Monitor Recording Times Displayed in Hours

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>Channel 1</th>
<th>Channel 1-2</th>
<th>Channel 1-3</th>
<th>Channel 1-4</th>
<th>Channel 1-6</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>64 Megabyte</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65536</td>
<td>0.1</td>
<td>0.1</td>
<td>0.04</td>
<td>0.03</td>
<td>0.02</td>
</tr>
</tbody>
</table>
### Auxiliary Trigger

The auxiliary trigger is an external triggering mechanism used to start monitor recording.

A variety of optional auxiliary triggers are available including the DS 20 Wire Trigger (Part No. 677A3901), and the Blastmate Trigger Cable (Part No. 712A3901) used to connect several Series III monitors together for multiple point blast monitoring, or for Series IV, use the Wire Trigger Cable (Part No. 720A3501).

To use the auxiliary trigger, set the monitor in the single shot, continuous, histogram, or histogram combo record mode. Set a fixed record time. The auxiliary trigger does not operate in the auto record time setting. Click on the Auxiliary checkbox to display a check mark.

### Settling Time (Series IV Only)

The Settling Time represents the time required for the sensor vibrations to dampen out caused by the sensor being powered on or when monitoring starts.

#### Command Buttons

To choose one of the following command buttons, click the mouse pointer on the button.

- **Send To Unit**
  
  Send the settings to the monitor and close the Advanced Setup dialog box.

- **Cancel**

### Notes

Refer to Section 4.2.2b for information about the Notes dialog tab.

### Special Setups

Refer to Section 4.2.2c for information about the Printer Setup dialog tab.

### Printer Setup

Refer to Section 4.2.2d for information about the Special Setups dialog tab.

### Library Files

Refer to Section 4.2.2e for information about the Library Files dialog tab.

### 6.4 Sound Level Microphone Setup (Series IV only) [Optional]

The optional Series IV, Class 1, Sound Level Microphone can also be used in the Advanced mode. The data will not be weighted or filtered and it will be recorded in either Pascals (Pa) or PSI units. To configure the Series IV unit connect it to a PC running Blastware and select the Advance setup icon.
**NOTE:** The units are set to \( Pa \) if the Report Options are Metric, or \( psi \) if the Report Options are set to Imperial.

1. Select the **Normal** (+/- 100Pa) or **Sensitive** (+/- 25 Pa) range on **Channel 1** and/or **4**.

**NOTE:** Make sure the proper range is selected as the unit cannot dynamically change this while it is monitoring. After selecting the range the sensitivity will automatically be filled in.

2. Select **Trigger Level**. Enable or disable any channel including the sound channel as a trigger source. Assuming it is set as a trigger source the **Trigger Level** is the level at which the unit would trigger and start recording data.

Selecting the **Trigger Level** menu will also allow you to change the recording range between **Sensitive** and **Normal** on the monitor.

3. Edit the values, as required, for the **Record Mode**, **Sample Rate** and **Record Time**. To ensure the best possible reproduction of the recorded event, a **65536 sps** is recommended. Lower sample rates will trade off between the resolutions and longer record times.

4. If only **Channel 1** is to be monitored, turning off all other channels will also allow for longer recording times.

5. Send the **Setup File** to the unit.
6.5 Flex™ Setup (Series III only)

Flex Setup is a feature for Series III monitors providing pre-defined setups for channels to operate with a combination of standard sensors and alternative sensors such as accelerometers, crack extensometers, temperature sensors, or humidity sensors.

Each set of four channels can be setup with one of the following predefined channel combinations:

- Triaxial Bee + MciL
- Triaxial Bee + McA
- Triaxial Bee + Flex
- 4 Flex

Flex Setup can be accessed by either clicking on the Flex Setup icon in the Blastware Main Menu Icon Toolbar, or by clicking on Unit, Setup, Flex Setup.

To configure the monitor, select the appropriate settings within the Flex Setup tabbed dialogs of Recording Setup, Notes, Special Setups, and Library Files. After you have chosen the required settings, select Send To Unit to send the settings to the monitor. If you do not wish to accept the changes, or send them to your unit, then select Cancel.

a. Recording Setup

(1) Set Channels 1-4 (5-8)

Use the Set Channels drop down menus to select a predefined flex configuration. Click on Set to apply the channel settings to the 4 channels listed below the Set Channels dropdown menu.

(2) Channels

Configure the monitors channels using the following settings. These items can only be changed using the Blastware software (advanced module).
i Select
Choose the channels to be used during flex operations. Click on the checkbox to display a checkmark to enable the channel. Channels must be enabled or disabled according to the following restrictions; Channel 1 only, Channels 1 and 2, Channels 1 through 4, or Channels 1 through 8 (eight channel monitor required). The flex feature requires that the channels be selected in a sequential order; for example, you are not able to select channels 1-4, and then 6-8.

ii Name (5 char max)
Enter a name to refer to the channel name. The name can be a maximum of five characters long.

iii Units (6 char max)
Enter a name to refer to the measurement units for each channel. A summary table of the Instantel sensor units is available in Section 5.3, Advanced Setup. Refer to the manufacturers specifications for non-Instantel sensors.

iv Sensitivity (Volts/Unit)
A summary table of the Instantel sensor units is available in Section 5.3, Advanced Setup. Refer to the manufacturer’s specifications for non Instantel sensors.

v Gain
Choose the required range and resolution. Click on either button.

vi +/- Trigger
Enter a trigger level if using single shot or continuous record modes.

vii Level
Enter the trigger level.

viii Enable
These checkboxes enable the trigger on a particular channel. You can enable the triggers on any combination of channels. Recording begins when Event activity exceeds any single set trigger level.

ix +/- Resolution
The Blastware software automatically calculates the resolution based on the entered sensitivity and chosen gain.

x +/- Range
The Blastware software automatically calculates the range based on the entered sensitivity and chosen gain. Refer to this value when setting a trigger level.

(3) Instrument

i Record Mode
Choose single shot, continuous, manual record mode, histogram, or histogram combo. Advanced histograms calculate only the peak particle velocity for each interval. Dependent on which Record Mode you select, subtle changes will occur in the Instrument area of the dialog box. See below for a description of these changes:
Single Shot and Continuous

Manual

Histogram

Histogram Combo
Note: The **Histogram, Histogram Combo Record Mode** consumes more battery power than other record modes. We recommend connecting a monitor to the AC adapter or an external 12 VDC power supply.

**ii Sample Rate**

Advanced operations offer a range of sample rates. Refer to Section 5.5, Advanced Setup for a table summarizing the sample rates and channels that may be used. Note that some sample rates operate on specific channels only, or with specific recording modes.

**Note:** Eight channel monitors have been optimized for sample rates up to 65536 samples per second. Four channel monitors may exhibit noise at sample rates greater than 16384 samples per second. Please contact the manufacturer for further information.

**iii Interval**

In histogram and Histogram Combo modes, the monitor stores summary information in intervals. The monitor continues to sample data continuously at the chosen sample rate but only stores the relevant peaks for the interval. Click on the **Interval** dropdown menu to select the duration of the interval.

**iv Record Time**

Enter a fixed record time. The advanced module does not offer the auto record mode. Blastware calculates the maximum available record time based on the amount of installed memory in the monitor and chosen sample rate. Refer to Section 5.5, Advanced Setup, for more information on monitor recording times.

**v Auxiliary Trigger**

The auxiliary trigger is an external triggering mechanism used to start monitor recording.

A variety of optional auxiliary triggers are available including the DS 20 Wire Trigger (677A3901), and the Blastmate Trigger Cable (712A3901) used to connect several monitors together for multiple point blast monitoring.

To use the auxiliary trigger, set the monitor in the single shot, continuous, histogram, or histogram combo record mode. Set a fixed record time. The auxiliary trigger does not operate in the auto record time setting. Click on the Auxiliary checkbox to display a check mark.

**vi Storage Mode**

Choose between full and summary storage modes. Full storage mode stores an Events waveforms and compliance report, summary storage mode does not.

(4) **Command Buttons**

To choose one of the following command buttons, click the mouse pointer on the button.

**i Send to Unit**

Send the settings to the monitor.

**ii Cancel**

Cancel any changes you have made and exit the Recording Setup of Flex Mode.

**b. Notes**

Refer to Section 4.2.2 for information about the **Notes** dialog tab.

**c. Printer Setup**

Refer to Section 4.2.2c for information about the **Printer Setup** dialog tab.

**d. Special Setups**

Refer to Section 4.2.2d for information about the **Special Setups** dialog tab.

**e. Library Files**

Refer to Section 4.2.2e for information about the **Library Files** dialog tab.
6.6 File Menu

The File Menu contains several commands: Event Manager, Report Options, Close, Print, Print Preview, Print Setup, and Exit. The commands, Close, Print, Print Preview, and Print Setup are only available if you have either an Event or FFT Report open. These commands are described in the Compliance Module section of this manual. An additional command, Save Process File, is only available when the Analysis feature is used.

6.6.1 File

a. Print

The following print dialog appears if the Analysis or FFT Analysis window is the current, active window:

(1) Report Content

This section determines items to be included in the advanced Event report.

i. Print Text Summary

This command prints the text summary in the advanced Event report. The text summary includes the information displayed by choosing Quick View Text from the Analysis menu including the Events date and time, record time, sample rate, monitor serial number, channel name, peak, time, trigger level, and gain.

To include the text summary, click on the Print Text Summary to display a checkmark.

ii. Print Extended Notes on a Separate Page

Considering the possible size of extended notes, this command lets you print the notes on a separate page as part of the advanced Event report.

To print the extended notes on separate page, click on the Print Extended Notes On A Separate Page checkbox to display a checkmark.

(2) Time Domain Waveform Printing

This section includes or excludes an advanced Events graphic waveforms and determines how the advanced Events graphic waveforms will be printed.
i  Print Channel Waveforms
This command includes or excludes an Events graphic waveforms in the advanced Event report. Click on this checkbox to display a checkmark to print an Events graphic waveforms. Click on the checkbox to remove the checkmark and not print an Events waveforms.

ii  Wave Setup
This command configures how an Events graphic waveforms will be printed. Click on Wave Setup. The Waveform Printing Setup dialog box appears.

- Range
This section determines the part of a waveform to be printed. You can choose to print the entire waveform or a section of the waveform.

  Print Entire Waveform – choose this option to print the complete waveform.
  Select Time (1/1000th Sec) – this command prints a section of the waveform. Enter a point of the waveform to start printing in the Start box. Enter a point of the waveform to finish printing in the End box.

- Time Scale
This section determines the time scale of the waveform.

  Fixed Number Of Pages – this command changes the waveforms time scale to fit on a specific number of pages.
  Data Per Page – this command changes the Events time scale to a specific value you require. Values range from 0.01 seconds to 5.00 seconds of Event data per page.

- OK – save the current settings and return to the Print dialog box.
- Cancel – return to the Print dialog box without changing the current settings.

(3) Frequency Domain Waveform Printing
This section includes or excludes an advanced Events FFT analysis and configures how the FFT analysis will be printed.

i  Print FFT Waveforms
This command includes or excludes an Events FFT analysis in the advanced Event report. Click on this checkbox to display a checkmark to print an Events FFT analysis. Click on the checkbox to remove the checkmark and not print an Events FFT analysis.

ii  FFT Setup
This command configures how an Events FFT analysis will be printed. Click on FFT Setup. The FFT Waveform Printing Setup dialog box appears.
• **Range**
This section determines the part of an FFT analysis to be printed. You can choose to print the entire analysis or a section of the analysis.

**Print Entire Spectrum** – choose this option to print the complete FFT analysis.

**Select Frequency (Hz)** – this command prints a frequency range of the FFT analysis. Enter a frequency to start printing in the Start box. Enter a frequency to finish printing in the End box.

• **Frequency Scale**
This section determines the frequency scale of the FFT analysis.

**Fixed Number Of Pages** – this command changes the FFT analysis scale, measured in hertz, to fit on a specific number of pages.

**Hertz Per Page** – this command changes the FFT analysis hertz scale to a specific value you require. Values range from 1 hertz to 500 hertz of Event data per page.

• **OK** – save the current settings and return to the Print dialog box.

• **Cancel** – return to the Print dialog box without changing the current settings.

(4) **Print Table**
This section controls the appearance of tables when printing histogram Events.

i **Print Table**
Choose this to print a table of the numerical coordinates of the graphical waveform. Click on the checkbox to display a checkmark.

ii **Print All Data**
Choose this to have all data appear in the table. Click on the button.

iii **Select**
Choose this to select which data will appear in the table. Click on the button, then enter the Start and End time.

(5) **Command Buttons**
To choose one of the following command buttons, click the mouse pointer on the button.

• **Start Printing**
Print the advanced Event report.

• **Cancel**
Return to the Analysis Window without changing the current print settings.

• **Save Settings**
This command saves the current settings as defaults and will be displayed automatically the next time you display the Print dialog box.
b. **Save Process File**

The Save Process File command saves the current Event file being processed using the Analysis command. The Event file is saved as a new and separate Event file.

To save a process file, open the **File Menu** and select the **Save Process File** command. The Select Directory dialog box appears.

Enter a filename for the new Event file and click **Exit (Save file)**. To create a new folder, click on the **New Folder** button. Enter the name of your new directory and click **Exit (Save file)**.

**Note:** Event Reports that are generated from processed Events will contain the original date of the Event and the date it was processed and saved.

6.7 **Unit Menu**

In addition to the Compliance menu options, the Advanced Setup menu is available in the Advanced Module. The Unit Menu is not available if you are using the Analysis command.

6.8 **Analysis Menu**

The Analysis Menu is only available when an Waveform Analysis Window is open. The Analysis Menu contains two commands, **Post Event Notes** and **Edit Timeline**.

6.8.1 **Post Event Notes**

Refer to Section about **Post Event Notes**.

6.8.2 **Edit Timeline**

Refer to Section about **Edit Timeline**.

6.9 **Process Menu**

The Process Menu only becomes available in the Blastware Main Menu when you are viewing the Analysis window. This menu lists commands to manipulate Events. As a safety measure, Blastware makes a copy of the original Event before performing process procedures. It is this file copy that is changed using the process commands.

The Process Menu contains the following commands:

**WARNING:** Displaying the new waveform in an existing waveform window overwrites the waveform. This waveform will be lost for this process Event. To redisplay the original waveform, close this file, return to the Event Manager, and re–open the original Event file. The waveform reappears.
6.9.1 **View History**

All Event files changed using the processing commands contain a history of these changes. Using this history, you can retrace the waveform to its original form.

To view a file's history of changes, open the **Process Menu** and choose the **View History** command.

![Process history dialog box](image)

6.9.2 **Add**

This command adds two waveforms together in one Event.

To add waveforms, open the **Process Menu** and select the **Add** command. The following dialog box appears.

![Select channels to add dialog box](image)

Select the two waveforms to add together in the first two drop-down menus. Choose where to display the newly created waveform in the Display result in drop-down menu. By default, Blastware creates a new waveform window to display the waveform. If you wish to choose another window, click on the Display result in drop-down menu.

Enter the name of the new waveform in the Name result drop-down menu. Click **OK** to display the new waveform.

6.9.3 **Subtract**

This command subtracts two waveforms.

To subtract waveforms, open the **Process Menu** and select the **Subtract** command. The following dialog box appears.

![Select channels to subtract dialog box](image)
Select the two waveforms to subtract in the first two drop-down menus. Choose where to display the newly created waveform in the Display result in drop-down menu. By default, Blastware creates a new waveform window to display the waveform. If you wish to choose another window, click on the Display result in drop-down menu.
Enter the name of the new waveform in the Name result drop-down menu. Click OK to display the new waveform.

6.9.4 **Shift**

This command shifts the currently selected waveform forward or backward on the time axis. The waveforms absolute time does not change. This changes the waveforms trigger offset.

To shift waveforms, open the Process Menu and choose the **Shift** command. The Select channel to shift dialog box appears.

Select the waveform you wish to shift in the first drop-down menu. Enter the time to shift in seconds. To shift the waveform to the left, enter a minus sign (-) in front of the seconds input.

**Note:** You can shift waveforms within the Events recorded time frame. You cannot shift the Event outside this time frame.
Enter the waveform window to display the result and name the result. Press OK to display the new waveform.

6.9.5 **Truncate**

This command truncates a waveform by removing unwanted sections.

To truncate a waveform, click on the Process Menu and select **Truncate**. The Select channel to truncate dialog box appears.

Select a waveform in the Truncate waveform drop-down menu. Choose a channel to display the new waveform in and enter the name of the new waveform. Enter a time in the first seconds box. Waveform information before this time will be removed. Enter a time in the next seconds box. Waveform information after this time will be removed. Press OK to display the new waveform.

6.9.6 **Vector Sum**

The Vector Sum command performs a point by point vector addition of selected waveforms. Vector sums can be calculated for two or three waveforms.

To perform a vector sum, open the Process Menu and choose the **Vector Sum** command. The following dialog box appears.
Choose the waveforms to sum in the first three drop-down menus. Click on 2 Channels or 3 Channels, to correspond to the number of waveforms chosen. Choose a waveform window to display the result and name the result. Press OK to display the new waveform.

6.9.7 Integrate

This function integrates a velocity waveform to obtain displacement values along the entire waveform.

To integrate a waveform, open the Process Menu, and choose the Integrate command. The Select channel to integrate dialog box appears.

Choose the waveform to integrate in the first drop-down menu. Select the waveform window to display the result and name the result. Press OK to complete the calculation.

Note: Blastware automatically enters the units for the result channel. A maximum of six characters can appear. Process waveforms with units exceeding this number display an asterisk (*).

6.9.8 Differentiate

This function differentiates a velocity waveform to obtain the acceleration values along the entire waveform.

To differentiate a waveform, open the Process Menu, and choose the Differentiate command. The following dialog box appears.

Choose the waveform to be differentiated in the first drop-down menu. Select the waveform window to display the resulting waveform. Enter a name for the new waveform. Press OK.

a. Point to point

This option does a point to point differentiation of a waveform. Click in the radio button to enable this option.
b. Central difference (5 points)

This option differentiates a waveform to determine the velocity along the entire waveform. The five point central difference method uses a fourth degree polynomial to fit the waveform over five points then calculates the slope. This method proves less sensitive to high frequency noise and produces a smoother waveform. Click in the checkbox to display a checkmark to enable this option.

Note: Blastware automatically enters the units for the result channel. A maximum of six characters can appear. Process waveforms with units exceeding this number display an asterisk (*).

6.9.9 Filter

WARNING: It is important to remember that applying Windows and Filters distorts the original waveform.

The Filter command presents a series of functions to condition waveforms, including Filters and Windows. The Low Pass, High Pass, and Bandwidth Pass Filters perform filtering on waveform data in the frequency domain. The Low Pass Filter removes frequencies above the corner frequency, while the High Pass Filter removes frequencies below the corner frequency.

To access the Filter command, an event must be opened using the Analysis tool. Use the analysis cursors to analyze any part of a selected waveform. The cursors indicate Event time and amplitude. After opening and Analysis window, display the filter dialog box opening the Process Menu and selecting Filter.
a. **Process Waveform**

Define the area you want to filter by using the analysis cursors within the *Analysis* window. Within the *Analysis* window, select *Filter* from the *Process* menu. Select the waveform, or channel, to filter from the drop down menu, *Process Waveform*.

b. **Display Result In**

Within the *Filter Channel* dialog window, select the location which you want the results of the filtering to appear. The resulting filter can be shown in an existing waveform location or in a new channel.

c. **Name Result**

Enter a *Name* for the filtered results. The new name is limited to 5 characters in length.

d. **Window**

The *Window* functions, reviewed in detail below, are used to reduce spectral leakage and apply smoothing to assist in the analysis of recorded waveforms. Spectral leakage is where small amounts of the signal energy are seen in frequencies that do not exist in the original waveform, and have moved out of the original signal spectrum.

Each *Window* function within *Blastware* performs like a predefined narrowband, low pass filter, and multiplies the time record by a length window that results in a smooth and gradual end at zero of the defined window edges. The defined window edges are created by moving the cursors within the Analysis window of Blastware.

*Blastware* offers the following windowing functions: *Hanning Window* at cursors, *Hamming Window* at cursors, *Blackman Window* at cursors, *Triangular Window* at cursors, *Welch Window* at cursors, and *Bartlett Window* at cursors.

**Note:** It is important to remember that Windowing distorts the original signal. Applying a *Window* function narrows the frequency spectrum by suppressing distortion and signal to noise ratio, avoiding the broadening of the signal. Selecting a *Window* function depends on the knowledge of the original signal and the desired outcome.

A brief description of each *Window* function:
Hanning Window – This is one of the more popular Window functions. The Hanning window has a shape similar to that of a cosine wave, and along with general analysis purposes, it is useful for analyzing transients that extend past the time duration of the window.

Hamming Window – The Hamming window is a modified function of the Hanning window; it also has the shape similar to a cosine wave. Within the time domain, the Hamming window does not get as close to zero near the edges as does the Hanning window, and though it provides an excellent spectral peak, the reduction in spectral leakage is nominal.

Blackman Window – The Blackman window has a weighting function similar to the Hanning and Hamming window functions and has a narrower shape, still reflecting that of a cosine wave. The spectral peak sharpness is only fair, but it is ideal for reducing spectral leakage.

Triangular and Bartlett Window – The Triangular and Bartlett windows offer an identical triangular shaped weighting function (both names are included as either/or are used in the industry), which will bring the signal to zero at the edges of the window. This window produces a sharp spectral peak while concurrently reducing spectral leakage.

Welch Window – The result of the Welch window function is a parabolic curve. The Welch window is used to smoothly bring the signal down to zero at the edges of the sampled region. Due to the averaging of the function it substantially decreases the low frequency resolution.

e. Filter

Frequencies may be filtered out or removed from waveforms using the filter command. Review the image below for the area that each of the filters effects:
The available filters:

- **Low Pass Filter** – This filter passes low frequencies but attenuates (reduces amplitude and intensity of the signal) frequencies higher than the Cutoff Frequency – refer to Bandwidth Pass Filter, below). This filter provides a smoother form of a signal which removes the short-term oscillations, leaving only the long-term trend.

- **High Pass Filter** – This filter passes high frequencies but attenuates (reduces amplitude and intensity of the signal) frequencies lower than the Cutoff Frequency – refer to Bandwidth Pass Filter, below).

- **Bandwidth Pass Filter** – This filter is a combination of High Pass and Low Pass Filtering; it is the Cutoff Frequency that rejects both low and high frequencies and keeps all frequencies located in between. The Cutoff Frequency is the reject value; The **Low Pass Filter** removes frequencies above this value. The **High Pass Filter** removes frequencies below this value. The **Bandwidth Pass Filter** removes frequencies indicated by both the Low and High Pass Filters. The **Bandwidth Pass Filter** levels are entered in the lower text box, as indicated in the figure above.

- **Ponderation (France)** – The Ponderation Filter is only used for compliance monitoring to French National Standards. It is a frequency filter similar to the perception of the human ear.

- **Filter Weights from File** – Performs filtering of Frequency weighting from a file containing a weights table.

(1) **Taper**

The type of taper selected determines the overall characteristics of the filtering which takes place. For **Linear Taper**, a fixed amount of attenuation per change in frequency occurs. For **Cosine Taper**, a given percentage change in frequency does not produce a fixed amount of attenuation. It is determined by the frequency.

**f. Frequency Weight File**

This function performs frequency weighting of an Event based on a frequency weights table file (a .fwt file). To select an existing .fwt file, click on the Browse button and navigating through your directories. You can also edit an existing file by clicking the Edit button, or create a new file by clicking on New. The Edit dialog box appears:
Blastware includes a number of built-in weight tables, which you may use as-is or customize. To save new weight tables, enter the desired Frequency and Weight values and click on Save and Exit. A dialog box will appear where you can enter the name for the .fwt file and select the destination directory.

6.9.10 **Scale**

This command changes the measurement units and offset value for a waveform. To scale a waveform, choose **Scale** from the **Process Menu**. The following dialog box appears.

Choose a waveform to scale in the first drop-down menu. Enter a scale factor to be applied to the waveform. Select a waveform window to display the new waveform. Enter an offset value, if required. Enter a name for the new waveform in the Name result box. Finally, enter the abbreviation to represent the measurement units of the resulting waveform.

**WARNING:** The Result units text box names units only. This text box does not check to ensure the actual waveform result units match the units named in this box.

6.9.11 **Remove Offset**

Some recorded waveforms may contain a DC offset. Visually, a waveform containing an offset appears to be shifted a constant value above or below the X axis. The system does not automatically remove all offsets because a user may want to include them purposely. Using this command, you can remove the offset from a waveform. The Blastware program removes an offset by subtracting the average.

**Note:** You can manually adjust the offset using the scale command, see above.

To display the Remove Offset dialog box, open the **Process Menu** and choose the **Remove Offset** command.
Choose a waveform to remove the offset in the first drop-down menu. In the second drop-down menu, choose a waveform window to display the new waveform. Lastly, name the new waveform. Press OK to create the new waveform. If you would like to remove the offset from all of the channels, click on the All Channels button.

6.9.12 FFT Analysis

The FFT Analysis command selects a portion of a waveform to perform an FFT calculation upon, or if desired, the complete waveform. For a partial FFT Analysis, select a waveform section by either specifying the time or the sample number. Select start and end points at zero crossings to reduce the high frequency component that may be introduced by truncating the waveform. When the FFT dialog box appears, the default start and end time correspond to the present cursor positions.

To perform an FFT, open the Process Menu and select the FFT Analysis command. For a Partial Waveform FFT Analysis, click on the second radio button (as shown below), and enter a Start and End time, or a sample number. You do not have to enter both. Click OK. The FFT appears within the Analysis Window. For a full analysis, click on the FFT Analysis on Entire Waveform radio button.

Note: FFT calculations may require a period of time to complete. The time required depends upon the size of the waveform and the speed of the computer.

a. FFT Analysis Limitations - Description

In simple waveforms, not composed of many different frequencies, the dominant frequency may be at the peak particle velocity of the waveform. In more complex waveforms, the dominant frequency is not necessarily the frequency at the peak particle velocity but at the frequency with the greatest amplitude. Whether or not this frequency actually contributed to the peak particle
velocity value and by how much must be extrapolated by examining the original signal closely. The frequency at the peak of a complex wave is usually not a single frequency rather it is a series of waves of different frequencies superimposed. It is intended that the frequency spectrum data be used as a tool in conjunction with the velocity versus time waveform.

Due to the digital nature of the FFT process, some smearing or broadening of the spectrum may occur. The algorithm used to represent the original waveform with a series of weighted sine and cosine curves does so with discrete frequency increments. A 25.5 hertz signal, for example, may not be represented by one frequency category alone and may therefore be represented by the next closest frequencies, 25 and 26 hertz, with possibly some small residual leakage into neighboring frequency categories. This is referred to as the "Picket Fence Effect".

For further reading, please see the following references.


6.9.13 Test Wave

This command creates a sine wave based on entered amplitude and frequency parameters. To display the Test Wave dialog box, open the Process Menu and choose the Test Wave command.

![Test Wave dialog box](image)

Enter up to three amplitude and frequency components for the test wave. Select a waveform window to display the new waveform. Name the new waveform in the last box. Press OK to accept your settings.

6.9.14 Peak Hold

The Peak Hold command allows you to remove negative excursions from waveforms. To display the Peak Hold dialog box, open the Process Menu and choose the Peak Hold command.
Choose the waveform to apply the peak hold to within the first drop—down menu. Select the waveform window to display the result in and name the result. Press OK to perform the calculation.

6.9.15 Smooth

The Smooth process command is used to average consecutive data points of a waveform. To display the Smooth dialog box, open the Process Menu and choose the Smooth command.

Choose the waveform to smooth within the first drop—down menu. Enter a range of points to average within the Number of points window. Choose a waveform window to display the result in and name the result. Press OK to smooth the waveform.

6.9.16 Third Octave

The Third Octave is a frequency band tool that has a width that is only 1/3 of the width of an octave, displayed in Hz. Thirty one, one-third octave bands are required to encompass the entire range of human hearing. One-third octave frequency bands are used when analysis does not provide the required resolution in the frequency domain. Preferred centre frequencies and pass bands are defined in ISO R 266 and ANSI S1.6-1984.

In the Analysis window, select the channel(s) that you want to view using the Third Octave tool and then select the Tools menu. Scroll down and select Third Octave. Below is an example:

Microphone Channel from Event:
Results using the Third Octave tool:

6.9.17 Sound Monitoring

Perform additional Calculations and Octave Data Conversion to recalculate the data relative to different criterion. For example, if you wanted to calculate an L75 value, change the Ln number from 50 to 75 and select Calculate. The criterion that is used to calculate the Dose%, TWA and Projected Dose% can also be changed and the values recalculated to the new criterion. All of these calculations can be performed on the entire event or any portion of it. This is done by changing the Use data from (Start Time) Sec and To: (End Time) Sec.
This data is unfiltered and therefore it is possible to Play it back through the PC speaker to help determine the exact source of the noise. This is accomplished by selecting the Process Menu > Sound Monitoring > Calculations and pressing the Play button for the desired channel:

To determine the frequency weighted values from an unfiltered event select the Process Menu > Sound Monitoring > Octave Data Conversion.

Convert the unfiltered data to either A-Weighted or C-Weighted data with a Fast or Slow response. Also, edit the reference used in the dB Calculations.
The resulting waveform will look similar to the following example:

![Waveform Example](image)

After converting the octave data to dB the event can be processed in the same fashion as a Compliance event.

### 6.10 Tools Menu

The tools available under the **Tools Menu** will vary; dependent on what type of window you have open, Analysis, Event Manager or a Report.

#### 6.10.1 Scaled Distance

This tool is only available when the Event Manager is active, or when there are no windows open. The Scale Distance tool is available when the Blastware Event Manager is the only opened, active window. It also appears if there are no windows open within the Blastware program.
6.10.2 Post Event Notes
This tool is only available when the Event Manager is active. The Post Event Notes tool is available when the Blastware Event Manager and/or a Report window are open. Refer to Section 3.3.3 for more information about Post Event Notes.

6.10.3 ASCII Conversion
This tool is only available when the Event Manager is active. The ASCII Conversion tool is available when the Blastware Event Manager and/or a Report window are open. Refer to Section 4.3.4 for more information about ASCII Conversion.

6.10.4 Human Exposure Report
The Human Exposure Report option enables you to calculate frequency-weighted Vibration Dosage Value (VDV) and Root Mean Square (RMS) on a series of Events selected in the Event Manager. Once you have selected or created a frequency weighting, click on the Calculate button. Results are shown in the Calculations area.

If the channel data is in Velocity, the data is differentiated to acceleration prior to the calculation. The acceleration data is then weighted as specified in the selected Frequency Weighting file. The available list of weightings includes the ISO 2631-2:2003 Wm weighting. The microphone channels (4 and 8) are not available if a compliance event has been loaded.

To display the Human Exposure Report dialog, click on the Tools menu and select Human Exposure Report. The following dialog appears:

(1) **Frequency Weighting File**
Press the Browse button to navigate through your directories and load an existing frequency weight table (.fwt) file.

(2) **New**
Select New to create a frequency weight file. The following dialog appears:
Blastware includes a number of built-in weight tables, which you may use as-is or customize. To save new weight tables, enter the desired Frequency and Weight values and click on Save and Exit. A dialog box will appear where you can enter the name for the .fwt file and select the destination directory.

(3) **Edit**
Select **Edit** to modify an existing frequency weight file. The following dialog appears:

![Edit Frequency Weights dialog](image)

Blastware includes a number of built-in weight tables, which you may use as-is or customize. To save new weight tables, enter the desired Frequency and Weight values and click on Save and Exit. A dialog box will appear where you can enter the name for the .fwt file and select the destination directory.

(4) **Calculate**
Click on **Calculate** to update or generate a new VDV and RMS calculation. Refer to the results in the image below:
(5) **Save to Disk**

Save to Disk the resulting Human Exposure Report in a delimited text format.

You can then import and edit the file in a spreadsheet program, such as Microsoft Excel – refer to the image below:
(6) Exit
This command exits the Human Exposure Report tool.

6.10.5 Frequency Filter Report
This tool is only available when the Event Manager is active, or when there are no windows open. Use this tool to determine the Peak for each channel of an Event based on the selected frequencies.

(1) Select the Events and Access the Frequency Filter Report Tool
Highlight the Events that you want to perform a Frequency Filter Report on. Select the Tools Menu and scroll down to access the Frequency Report Filter Tool.
(2) **Frequency Report Filter Tool**

Below is the initial screen of the **Frequency Report Filter** tool.

---

**Browse, New, or Edit**

Browse and open, create a New, or Edit an existing set of Filter Frequencies. Open an existing Filter Frequencies table by selecting the Browse button. Select New to create a new set of Frequency Filters, or select Edit to open and alter an existing Frequency Filter. The default directory for opening and saving Frequency Filter files is the Blastware /Data directory.
ii **Calculate**

After determining the frequency ranges for the filter report, select **Calculate** to obtain the results. The Blastware program will briefly display the following dialog:

![Filter Report Dialog](image)

The results will be displayed in the **Frequency Filter** window, as per the example below:

![Frequency Filter Table](image)

**Continued...**
iii **Save to Disk**

The results may be saved as a delimited database file for future use in Microsoft® Excel® by selecting the **Save to Disk** button. The default directory is the Blastware /Data folder.

iv **Exit**

Select the **Exit** button to return to the Blastware Event Manager.

### 6.10.6 Compliance Graph Editor

This tool is only available when the Event Manager is active, or when there are no windows open. The Compliance Graph Editor tool is available when the Blastware Event Manager is the only opened, active window. It also appears if there are no windows open within the Blastware program. The compliance graph editor customizes compliance graphs to your requirements.

To open the compliance graph editor, click on the **Tools Menu** and choose the **Compliance Graph Editor** command. The following dialog box appears.
Blastware displays a generic compliance graph. To create a new compliance graph, change the generic graph accordingly then save it. Instantel does not recommend changing the compliance graphs included with the Blastware program. If you change a graph inadvertently, you can replace the graph with the original by installing Blastware again. After editing a compliance graph, transfer it to the monitor and check its printout.

a. File Menu
The file menu contains the following commands.

(1) Load
This command loads an existing compliance graph into the compliance graph editor. You could load an existing graph and change some aspects without having to create the entire graph.

(2) Save
After changing a compliance graph, choose this command to save the new graph. Remember to enter a new name for the graph to avoid overwriting the graph supplied with Blastware.

(3) Exit
This command closes the dialog box and returns to the Blastware main menu. You may be prompted to save the existing file. Enter a new name and click on OK. If you do not want to save the changes, click on Cancel.

b. Edit Menu
The following commands appear in the Edit Menu.

(1) Lines
Use this command to draw lines on the graph. For example, the USBM R18507 and OSMRE compliance graph displays OSMRE, USBM drywall or plaster, and USBM plaster lines.
To draw lines on the graph, open the Edit Menu and choose the Lines command. The Compliance Graph Lines dialog box appears.
To draw a line, enter the lines start (X,Y) and end (X1,Y1) points using X and Y coordinates. Choose a line type. Lines can be solid, dotted, dashed, or dot dashed. Up to forty lines can be drawn on a compliance graph. Click OK when done. To view the lines, click the Display button. The compliance graph appears. To make additional changes, close the displayed graph, make the changes, then click on the Display button again to see your changes.

(2) **Labels**
You can add text labels to the graph using the this command. Labels can appear anywhere on the graph. Each label can be up to twenty five characters in length including spaces. You can enter up to ten labels onto a graph. To position a label, enter the X and Y coordinates of the first character in the label. The entire label positions itself in a straight line to the right of this coordinate.

(3) **Footnotes**
You can add comments to a graph using the footnotes command. These footnotes appear at the bottom of the graph under the X – axis title. Up to four footnotes of forty characters in length can be added to a compliance graph.
Note: An asterisk (*) appears to the left of the last footnote indicating the graph was not created by Instantel Inc. The asterisk cannot be edited or removed.

(4) **Plot Symbols**

This command chooses the plot symbols that appear on the compliance graph. You have a choice for channels one and five, two and six, three and seven. If you wish to use the same symbols used in other Instantel Inc. compliance graphs, click on the Default button.

(5) **Lower Limit Message**

This command displays a message if no velocities were recorded. The value appearing in the message changes according to the minimum value of the Y axis. The message can be up to thirty characters in length including spaces. Choose a number of significant digits to appear after the decimal point. If you do not require this value to appear, enter zero for the number of significant digits.

c. **Main Title**

Enter the title of the compliance graph to appear in this dialog box. Titles can be up to forty characters in length including spaces.

d. **Subtitle**

A subtitle can appear under the main title. Subtitles can be up to forty characters in length including spaces.

e. **Velocity Axis and Frequency Axis**

The following commands configure the graphs velocity and frequency axes.

f. **Format**

This command defines the scale for the velocity and frequency axes. You can choose either Log 10 or Linear scales.

g. **Axis range**

These text boxes define the axes range. Enter the minimum value in the left hand text box followed by the maximum value in the right hand text box. For Log10 axes, the minimum value must be greater than zero. Also, for all ranges, the maximum value must be greater than the minimum value.
h. Grid line Format
Graphs can be displayed with axes tick marks and without grid lines, with grid lines appearing as solid lines, or dotted grid lines. The velocity and frequency grid lines can be different, as required.

i. Grid line Position
To position the grid lines on your graph, enter the numerical X or Y values in these text boxes. Separate each coordinate with a space. A maximum of fifteen gridlines can appear for each axis.

j. Position gridlines automatically
Click on this checkbox to have Blastware position the grid lines automatically.

k. Axis title
This command displays a title for each axis. Titles can be up to twenty five characters in length including spaces. The measurement units for the velocity and frequency appear automatically.

l. Command Buttons
The following command buttons appear at the bottom of the dialog box.

(1) Display
This command opens a window and displays the compliance graph you are editing. You can press this button at anytime to display the compliance graph and check your settings. To continue with your changes, close the window to display the compliance graph editor.

(2) Save and Exit
This command saves the compliance graphs changes and closes the compliance graph editor. You are prompted to enter a name for the new compliance graph. Enter a name and click the OK button.

(3) Cancel
Click on this command to close the compliance graph editor without changing the compliance graph.

6.10.7 Edit Timeline
This tool is available when the Event Manager is active (Tools Menu), or when the Waveform Analysis Window is open (Analysis Menu). The Edit Timeline command configures timelines to appear in the Wave Analysis Window or for use within the Linear Superposition tool. Timelines indicate the timing of sequences throughout an event. The timelines indicate delays according to the manufacturer's specifications. By overlaying the timelines on the event's waveforms, it is possible to compare stated performance to actual performance. To apply a timeline, open an Event in the Waveform Analysis Window. Display the Edit Timeline dialog box by clicking on the Analysis Menu and select the Edit Timeline command. The Edit Timeline dialog box appears, as shown below:
Below is a description of each column.

**Charge Number:**
This column is automatically generated.

**Initiation Time**
This column is user-defined information created from input located in the **Automatic Timeline Generation** section of the **Edit Timeline** dialog window:

\[
\text{Initiation Time} = (\text{Charge Num} - 1) \times \text{Inter-deck Delay} + \\
(\text{Hole Num} - 1) \times \text{Inter-hole Delay} + \\
(\text{Row Num} - 1) \times \text{Inter-row Delay}
\]

**Travel Time:**
User defined column representing the time in milliseconds that a vibration takes from the hole to the sensor.

**Arrival Time:**
This column represents the arrival time in ms at the sensor relative to the first arrival.
Initiation Time + Travel Time

**Scale Factor:**
This column represents the range, from .1 to 2, and is used to scale the amplitude of the signature waveform, if necessary.

If you need to view the resultant data that is not shown in the window, use the **Page Down** key on your keyboard to scroll through the entire timeline. After you have configured the timelines, choose **Exit** and the following message is displayed:

By selecting **OK**, the Timeline will be applied to the event. An example is shown below:
a. **Automatic Timeline Generation**

For each charge in the right hand column, enter the parameters for the timeline you want to create.

1. **Number of Decks per Hole**
   Enter the number of decks per hole.

2. **Inter-deck Delay**
   Enter the delay between decks.

3. **Number of Holes per Row**
   Enter the number of holes per row.

4. **Inter-hole Delay**
   Enter the delay between holes.

5. **Number of Rows**
   Enter the number of rows.

6. **Inter-row Delay**
   Enter the delay between rows.

b. **Generate**

This selection creates the timelines that will appear in the Analysis Window.

c. **Append**

This command adds a timeline to a timeline already appearing in the dialog box. Edit the current timeline by changing the Automatic Timeline Generation parameters, or repeat the current timeline and select **Append**.

d. **Save Timeline**

This command saves the currently displayed timeline to a file. This is useful if you have several recorded Events based on the same timeline. Simply load the saved timeline for each Event and continue with your analysis.

e. **Load Timeline**

This command loads a saved timeline. Timelines created in versions previous to Blastware 8.0 can not be loaded.
f. Exit  
Finish editing timelines and return to the Analysis Window, and Save Time to Event.

g. Cancel  
Close the Edit Timeline dialog box and return to the Analysis Window without changing the current settings.

h. Import 2DBench Text File  
If you have a 2DBench blast design file (*.mic file extension) created with JKTech Pty. Ltd., JKSimBlast software, you can import the file and edit or apply the resulting timeline to an analysis event or Superposition synthetic waveform.

6.10.8 Scale Graphs (Available with Advanced Event Open)  
This tool is only available when an Analysis window is open. This command is used to manually scale plots for waveform and histogram graphs. You can enter both the maximum and minimum peak for each channel, or use the Normalize and Symmetric buttons to impose a pattern. The customized scale will also be used when you print using the Print Button in the Analysis window.

To display the Scale Graphs dialog, click on the Tools menu and select Scale Graph.

To change the maximum and minimum peak for a channel, click on the box and enter the new value. Click OK to save your changes.

The Scale Analysis Graph for the Histogram Analysis window appears as follows:
6.10.9 Remove Channel

This tool is only available when an Analysis window is open. Use this command to remove a channel from an Event.

To display the Remove Channel dialog, click on the Tools menu and select Remove Channel.

Select the channel you wish to remove from the drop-down list, and click OK. The channel will be removed from the Event.

6.10.10 Ponderation

This tool is only available when an Analysis window is open, and is specifically used for the French National Compliance standard. Ponderation is a weighting of waveform frequencies. This tool is used to ponderate waveforms.

To display the Ponderation dialog, click on the Tools menu and select Ponderation (France).

6.10.11 Human Exposure

This tool is only available when an Analysis window is open. The Human Exposure option enables you to calculate frequency-weighted Vibration Dosage Value (VDV) and Root Mean Square (RMS) on the entire or partially selected waveform. Once you have selected a frequency weighting, click on the Calculate button. Results are shown in the Calculations area.

To display the Human Exposure dialog, click on the Tools menu and select Human Exposure.
If the channel data is in Velocity, the data is differentiated to acceleration prior to the calculation. The acceleration data is then weighted as specified in the selected Frequency Weighting file. The available list of weightings includes the ISO 2631-2:2003 Wm weighting. The microphone channels (4 and 8) are not available if a compliance event has been loaded.

Refer to the following for more information on Human Exposure:


Abstract:
ISO 2631-2:2003 concerns human exposure to whole-body vibration and shock in buildings with respect to the comfort and annoyance of the occupants. It specifies a method for measurement and evaluation, comprising the determination of the measurement direction and measurement location. It defines the frequency weighting Wm which is applicable in the frequency range 1 Hz to 80 Hz where the posture of an occupant does not need to be defined.

Whilst it is often the case that a building will be available for experimental investigation, many of the concepts contained within ISO 2631-2 would apply equally to a building in the design process or where it will not be possible to gain access to an existing building. In these cases, reliance will have to be placed on the prediction of the building response by some means.

ISO 2631-2 does not provide guidance on the likelihood of structural damage, which is discussed in ISO 4866. Further, it is not applicable to the evaluation of effects on human health and safety. Acceptable magnitudes of vibration are not stated in ISO 2631-2.

The mathematical definition of the frequency weighting Wm is given in Annex A. Guidelines for collecting data concerning complaints about building vibration are given in Annex B.

British Standard BS-6841
“Measurement and Evaluation of Human Exposure to Whole-Body Vibration.”

Abstract:
The BS-6841 standard reviews methods of quantifying vibration and shock in relation to human health, interference with activities, discomfort, the probability of vibration perception and the incidence of motion sickness. Tentative guidance is given on the possible effects of vibration.

Note: Due to the processing power and decimal accuracy of a PC, performing VDV calculations using the Blastware Human Exposure tool on a computer will typically produce a higher accuracy result when compared to the VDV recorded in the field by the Series IV unit. These results will typically be within 5% of each other.
a. **Frequency Weighting File**

Press the Browse button to navigate through your directories and load an existing frequency weight table (.fwt) file. You can also **Edit** an existing file by clicking the Edit button, or create a new file by clicking on **New**.

b. **Data Selection**

To generate VDV for the entire waveform select All Waveform. You may also specify only a part of the waveform. Click on Partial Waveform, and then enter the From and To time values.

c. **Calculate**

Click on **Calculate** to update or generate a new VDV and RMS calculation.

d. **Exit**

This command **Exits** the Human Exposure tool.

### 6.10.12 Transfer Function

This tool is only available when an Analysis window is open. Use the Transfer Function tool to determine structural response. The Transfer Function is the result of calculating the ratio of two frequency spectras. One spectrum, the driving function, is computed from a waveform recorded with a transducer located outside a building or structure; the second spectrum, the response spectrum, is recorded with a transducer mounted inside the building or structure. The ratio of the response function to the driving function is the resultant Transfer Function. The Transfer Function can also be used to help determine the Natural Frequency of a building or structure.

You can only use the Transfer Function within one Event and it must be a Compliance Event. **Example:** With a 4 channel Event, you will need two channels in the same orientation; if you are using a triaxial sensor, you will need an 8 channel unit. To access the Transfer Function, click once on the natural frequency event within the Event Manager, and then select the **Analysis** icon. From the Tools menu, select the **Transfer Function** feature. The Transfer Function menu will appear.

![Transfer Function Menu](image)

a. **Ground Channel**

Select the appropriate **Ground Channel** from the drop down list. The Ground channel represents the driving function.

b. **Structure Channel**

Select the appropriate **Structure Channel** from the drop down list. The Structure Channel represents the response to the Ground Channel vibration.

c. **Lower Frequency Limit**

Use the up and down arrow keys to define the **Lower Frequency Limit** you want to process. The allowable limit is 2 – 300.
d. **Upper Frequency Limit**

Use the up and down arrow keys to define the **Upper Frequency Limit** you want to process. The allowable limit is 2 – 300.

e. **Broad Band Noise Added to Signal**

(1) **Percentage of Peak**

Define the **Percentage of Peak** (from 0 to 100) to be added to the signal to prevent low level noise from creating false peaks – the default five percent is a nominal number. Increasing this number will lower the sharp peaks, especially if they are produced by the division of two small numbers, which is how the final Transfer Function frequency is calculated.

A report will appear containing the standard event information, the two time-based recordings, the Spectral Density of the recordings, the Transfer Function, and the Peak Frequency:

---

For more information, refer to the following publications for a complete explanation of natural frequencies and related calculations.


6.10.13 Export Data

Access this tool by selecting Export Channel Data from the Tools menu. Use the Export Channel Data tool to copy data from each channel of the Event to another program, such as Microsoft Excel (refer to the sample below for more information). The information copied includes a column header name for each channel. This Tool works on Waveform and FFT plots.

a. Copy All

Open an Event within the Waveform Analysis window, open the Export Channel Data tool, and click on the Copy All button. A message will appear briefly afterwards indicating that the data has been saved to your computer’s temporary memory, the clipboard. You can now open another program, such as Microsoft Excel, and paste the copied information into that program.

b. Copy Between Cursors

Open an Event within the Waveform Analysis window. Slide the perpendicular cursors within the Waveform Analysis window to select the data that you are interested in viewing within a different program, and then select the Export Channel Data tool from the Tools Menu. Click on the Copy Between Cursors button – a message will appear briefly afterwards indicating that the data has been saved to your computer’s temporary memory, the clipboard. You can now open another program, such as Microsoft Excel, and paste the copied information into that program.

c. Exit

Closes the Export Data dialog box.
6.11 Blast Design Simulation

Within the Tools menu, Waveform Simulation offers three ways to model the influence of initiation timing on blast-induced vibration, 1) Interval Analysis, 2) Linear Superposition, and 3) Signature Hole Analysis. These are modeling tools to assist you in developing blast design, and should be used with caution, as actual results will vary depending upon site particularities including geology, and explosives type, among other factors.

6.11.1 Interval Analysis

This tool is only available when a Waveform Analysis window is open. The tool produces a color plot with the frequency displayed on the x-axis, delay interval on the y-axis, and a measure of the energy content (y-axis value of a standard FFT plot) represented using different color bands. The recorded signals must be the same length as the desired resultant signal or larger.

The contour plot outputs to a separate window that can be printed or saved to disk as a metafile. WARNING: This is a modeling tool only. Actual results will vary depending upon site particularities including geology, and explosives type, among other factors.

NOTE: If the result of the entries for the **Number of Delays** × **Delay Range** (ms) is greater than 40, the following dialog will appear:

Click on the Tools menu in the Event Manager and select Synthetic Waveform – select the **Interval Analysis** tool from the fly-out menu. A dialog box is displayed:
a. **Waveform**
   Select the waveform channel that you would like to process with the Interval Analysis tool.

b. **Number of Delays**
   Enter the number of delays by inputting a number between 1 and 1000. This setting delimits the number of times the waveform will be linearly offset by the delay interval and superpositioned.

c. **Frequency Range (Hz)**
   Input a frequency range, from 1 to 1024 Hz, that you would like to plot.

d. **Delay Range (ms)**
   Input the delay range. This range can be from 1 to 500 milliseconds. The delay range that was previously calculated is shown to the right of each entry. If you input a new delay range that is within the previously calculated range, the Interval Analysis will not need to be recalculated.

e. **Calculate**
   Click on the **Calculate** button to perform the Interval Analysis. A brief message dialog will appear, as shown below:

   ![Interval Analysis dialog box](image)

   ![Interval Analysis progress bar](image)

f. **Exit**
   Exit the program without performing an Interval Analysis or saving any changes that you have made in each input box.

g. **Interval Analysis Data Plot Window**
   View the results from the Interval Analysis settings within the Interval Analysis Data Plot Window. You can save this view as a metafile, copy it to the clipboard for use in a graphics program, print, or add notes.
(1) File

i  Save to Metafile
Save the Interval Analysis as a metafile, which can than be inserted into a Microsoft Word document.

ii  Copy Graph to Clipboard
A bitmap image of the Interval Analysis Data Plot window is copied to your computers temporary memory. Open another Windows program that supports graphics and use the paste command, or simultaneously press CTRL-V, to place the bitmap image into the file.

iii Printer Setup
This command specifies the type of printer connected to the computer and configures the printer settings.

iv Print
Use this command to prints the Interval Analysis Data Plot window to your personal computers default printer.

(2) Edit

i Notes
The Edit Menu contains the Notes command. The notes command is used to append a header centered at the top of the Scaled Distance Data Plot window, and two notes that appear in the lower left-hand corner. This feature allows you to customize your graph for printing. To open the Edit notes dialog box, select Notes from the Edit menu.
To enter notes or a header, click on the appropriate text box and type in the desired contents, to a maximum of 40 characters. Click on OK to save your notes. Click Cancel (Esc) to close the Edit notes dialog box without adding notes.

6.11.2 Linear Superposition
This feature will linearly shift and superimpose a source waveform event according to the arrival times present in a timeline file. A synthetic waveform is produced.

WARNING: This is a modeling tool only. Actual results will vary depending upon site particularities including geology, and explosives type, among other factors.

![Linear Superposition Analysis dialog box]

a. **Use 3 channels**
   To use three waveforms in your calculation, click on this checkbox to display a checkmark.

b. **Source Waveform**
   Choose the waveform to be used in the analysis.

c. **Display result in**
   Choose a waveform window to display the analysis result in. You can replace the source waveform with the resulting waveform.

d. **Name result**
   Enter a name for the new waveform. By default, Blastware names the Linear Superposition Analysis waveforms beginning with SSM1. The number changes incrementally for additional waveforms.

e. **Timeline Handling**
   (1) **Load New File**
   You must choose and load a timeline file before calculating the Linear Superposition Analysis waveform. The timelines represent the number of shots and the delays.

   (2) **Edit/Create**
   Refer to section 5.9.7 for more information about the Edit Timeline feature.

f. **Command Buttons**
   (1) **Process**
   Click on this command to generate the Linear Superposition Analysis waveform.
(2) Exit

Close the Linear Superposition Analysis waveform dialog box without generating a waveform.

6.11.3 Signature Hole Analysis

Signature Hole Analysis is a tool available with the optional Blastware Advanced Module that requires a USB dongle for access. This tool is used to create and analyze theoretical blast vibration data based on your input range of blast timing parameters and a Signature Hole Waveform. The signature hole waveform can also be Band Pass Filtered to remove any unwanted frequencies it might contain. The theoretical waveform produced by this tool can then be sorted with a wide range of options and stored in a user defined Project Directory. This tool first creates all the blast Timeline file combinations, based on your input parameters for the range of different time delays you want to simulate. Then for each channel in the signature hole waveform it shifts the waveform in time according to these timeline files and adds them together to produce a simulated waveform. These simulated waveforms are conveniently listed in a Signature Hole Analysis Table with the delays used to create them, the resulting Peak Particle Velocities (PPV), Peak Vector Sum (PVS), Dominant FFT frequency and the Upper to Lower frequency ratio for each channel. This table along with all the timeline files and simulations are then saved in your project directory.

NOTES:
1. This is a simulation tool and can not replace standard blasting practices and experience.
2. Signature Hole Analysis is another tool to help you optimize and improve your blast performance.

a. Common Terms

1. Signature Hole Waveform

Signature Hole Waveform can be:
   1. a single hole of explosives that is the same as a single deck used in the production blast.
   2. a single hole of explosives that is the same as will be used in a production shot and contains inter-deck delays.
   3. a single row of holes that is the same as will be used in a production shot.

2. Timeline Files

A timeline file contains all of the time delays, relative to time zero (the actual initiation time) for the entire blast. These delays are derived from the Inter-Deck delays, Inter-Hole delays and Inter-Row delays.

3. Inter-Hole Delay, Inter-Deck Delay, Inter-Row Delay

Shown in the diagram below representing a Production Shot:
These are the typical delays used in the design of a blast. They will be used during the signature hole analysis process.

(4) **Band Pass Filter**

Specifies the range of frequencies to retain. Frequencies outside this range will be filtered out.

(5) **Frequency Ratio**

This is a ratio of the content of the lower frequency range to the content of the upper frequency range.

b. **Signature Hole Waveform Parameters**

The **Signature Hole Waveform** as defined in section “a (1)” MUST be representative of the actual production blast. The hole(s) must be:

1. Fully burdened, free-face, and a corner blast
2. A Single-Deck, Multi-Deck, Entire-Row
3. Must have the same diameter and depth as the **Production Blast**
4. Completed with the same type of explosive
5. For consistent results, ensure that the **Signature Hole** and **Production Blast** are monitored from the same location.

Basic assumptions for the use of the **Signature Hole Analysis** tool are that the geology across the **Signature Hole** and the **Production Blast** will remain constant, that each hole will produce identical vibration results, and that the seismograph was consistently positioned and correctly installed.

Below is an example of a **Signature Hole**:

![Signature Hole Waveform Example](image)

c. **Access the Signature Hole Analysis Tool**

To access the **Signature Hole Analysis** tool:

1. Select a **Signature Hole Waveform** in the Event Manager.
2. Click on the Analysis icon. The **Waveform Analysis** window opens.
3. From Event Manager menu, select Tools > Blast Design Simulations > Signature Hole Analysis.
4. The **Signature Hole Analysis** dialog appears:

This dialog box contains all the information to allow you to simulate your different delay patterns. Determine the timing to be used under the **Timeline Generation** section. The number of simulation files that will be generated will be equal to (number of Deck delays) X (number of Hole delays) X (number of Row delays). To reduce the number of simulations and quickly eliminate undesirable delays you can increase the increment number. The settings under the **Sorting Options** section will establish the sort criteria, displaying only relevant entries and arranging the priority of the listing based on your input. The **Frequency Ratio** section of the dialog indicates the concentration of the Upper and Lower ranges in Hz. To remove any unwanted frequencies in your signature hole waveform you can apply the band pass filter.

**NOTE:** removing any frequency from the signature hole waveform will also remove them from the simulation results. It is always a good idea to look at the results before filtering to fully understand the potential impact of filtering. Setting up a Project Directory allows you to keep all your projects organized for future reference.

d. **Signature Hole Analysis Dialog Overview**

(1) **Timeline Generation (assumes a corner blast)**

This section of the **Signature Hole Analysis** dialog is for entering the values for the **Number of Decks per Hole, Holes per Row, and Rows.**
(2) **Number of Decks per Hole**

Enter the proposed number of **Decks per Hole** in your production blast. This assumes your signature hole waveform was a single hole without any inter-deck delays. If your signature hole waveform had inter-decks delays then enter 1 for the number of decks and skip step #3.

(3) **Inter-Deck Delay**

Enter the **Start**, **End**, and **Increment** values in **msec** for the number of **Decks per Hole**. ie 2 decks and a range from 10 to 20 msec. The increment number allows you to reduce the number of simulations and quickly narrow in on the desired delays.

(4) **Number of Holes per Row**

Enter the proposed number of **Holes per Row** for your production blast. This assumes your signature hole waveform was a single hole. If your signature hole waveform was an entire row of holes then enter 1 for the number of holes per row and skip step #5.

(5) **Inter-Hole Delay**

Enter the **Start**, **End**, and **Increment** values in **msec** for the number of **Holes per Hole**. ie 10 holes per row and a range from 10 to 30 msec. Again, the increment number allows you to reduce the number of simulations and quickly narrow in on the desired delays.

(6) **Number of Rows**

Enter the proposed number of **Number of Rows** in your production blast.

(7) **Inter-Row Delay**

Enter the **Start**, **End**, and **Increment** values in **msec** for the **Number of Rows**. ie 5 rows of holes and a range from 120 to 150 msec. Again, the increment number allows you to reduce the number of simulations and quickly narrow in on the desired delays.

(8) **Sorting Options**

The sorting options act like a filter and allow you to quickly sort the simulated waveform and only view the results you want. The results that do not meet your criteria are not deleted they are just not displayed. To view the entire list of results simple remove the check mark in the **Apply Sort Options** box. The sort options allow you to customize your sort and redisplay your results narrowing your search until you find the results that best meet your requirements. For each of the sort criteria, **PPV**, **PVS**, **FFT Frequency**, or **Frequency Ratio**, you can choose to view the results that are **Greater Than**, **Less than or Equal to**, the value you enter. The **Priority** box then allows you to sort the results based on your own order of priority.
(9) **Frequency Ratio**

The **Frequency Ratio** indicates the concentration of **Upper** to **Lower** ranges in **Hz**. The upper and lower ranges can be adjusted to suite your requirements.

(10) **Apply Sort Options**

Indicate whether to apply or ignore the **Sort Options** that you have selected. If you choose not to use this option, than all the results will be listed in the table based on the blast timing simulation. This starts with the Deck delay followed by the Hole delay and finally by the row delay.

(11) **Clear All**

Click on the **Clear All** button to reset all **Sort Options** to a null or zero-value state.

(12) **Apply Band Pass Filter**

Input a frequency range in the **From** and **To** fields. Any signals that fall outside the specific range will be filtered out of the signature hole waveform and not used in the simulation waveforms.

(13) **Project Directory**

Create or use existing **Project Directory** by selecting the ‘…’ command.
NOTE: Ensure that you create a new directory for each project; otherwise, the existing directory will be cleared when you process a new simulation.

(14) **Process**

This command will **Process** and create all associated **Timeline Files** and **Simulated Waveforms**, placing them in the subdirectories under your Project Name directory, with the names “timeline” and “waveform”. When you click on the **Process** button, a brief message appears stating that these two subdirectories were created in the designated **Project Directory** (in this instance, C:\Blastware\Design) that you created or specified using the ‘…’ command:

```
Blastware
  \MAIL
  \DESIGN
    \Timeline
    \Waveform
```

An ASCII delimited file used to create the **Signature Hole Analysis Table** for each project will be placed directly in the **Project Directory** folder.

(15) **Display Table**

Display the most recent table or display the most recent **Sorting Options**, or when used in conjunction with the **Project Directory** command, view a **Signature Hole Analysis Table** that was previously created.

(16) **Exit**

Click the **Exit** button to return to the previous window.

e. **Signature Hole Analysis Example**

(1) **Input the Values**

Here is an example of the **Signature Hole Analysis** dialog populated based upon the previously shown **Signature Hole Waveform** sample:
Determine the values for the **Timeline Generation**, select the **Sorting Options**, and create a **Project Directory**.

(2) **Process the Simulation**

Once you have selected **Process**, a brief message appears stating that the following two subdirectories were created in the designated **Project Directory** (in this instance, C:\Blastware\Design) that you create using the “...”.

These directories will store the generated timeline and waveform files that will be created based on the input values. The top level folder, in this example, /DESIGN, is where the **Signature Hole Analysis Table** is stored. An ASCII delimited file used to create the **Signature Hole Analysis Table** for each project will be placed directly in the **Project Directory** folder.

1. **Signature Hole Analysis Simulation** than begins **Generating Timeline Files**, as shown below:

   ![Generating Timeline Files](image)

2. After creating the necessary **Timeline Files**, the tool will begin **Generating Simulated Event Files**, as shown below:

   ![Generating Simulated Event Files](image)

   The number of **Simulated Event Files** that are created, and the subsequent amount of time it takes to create these files, is in direct proportion to the values that are input under the **Timeline Generation** section.

3. Next, the **Signature Hole Analysis Simulation** tool begins **Generating Data Table**:
Based on the **Signature Hole Waveform** previously shown, and the values input into the **Signature Hole Analysis Simulation** dialog a **Signature Hole Analysis Table** is displayed.

(3) **Review the Signature Hole Analysis Table**

The table will be displayed using the sort parameters selected in the **Signature Hole Analysis Simulation** dialog. Additional sorts may be selected by clicking on any column header. A sort arrow will appear – click on the arrow to sort from ascending to descending.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Peak Particle Velocity</th>
<th>PVS Peak</th>
<th>Dominant FFT Frequency</th>
<th>Upper/Lower Frequency Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1H12R7D0H15R100.BWP</td>
<td>2.0 2.3 60.0 60.0</td>
<td>0.241 0.232 0.407 0.407</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1H12R7D0H15R100.BWP</td>
<td>2.0 2.3 60.0 60.0</td>
<td>0.259 0.239 0.524 0.524</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D1H12R7D0H15R100.BWP</td>
<td>2.0 2.3 60.0 60.0</td>
<td>0.203 0.244 0.533 0.533</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Under **Filename**, you can double-click to view the associated **Event Report** that the **Signature Hole Analysis Simulation** tool has generated based on your input values. The file name corresponds with the values input into the **Timeline Generation** section of the **Signature Hole Analysis Simulation** tool.

Refer to the first file named **1H12R7D0H15R100.BWP**, which translates to 1 Deck per Hole, 12 Number of Holes per Row, 7 Number of Rows, 0 Start for Inter-Deck, 15 Start for Inter-Hole Delay, and 100 Start for Inter-Row Delay. File names will change based on the increment value for each delay. Refer to the image below for more information on the file naming convention:
f. **Print**

Within the **Signature Hole Analysis Table** select **File** and then **Print** to send the displayed table to the printer.

g. **Review the individual Event Reports**

Double click on any **File Name** within the displayed table to view the associated **Event Report**. Below is an overview of an Event report created with the **Signature Hole Analysis Simulation** tool:
h. View the Processed Waveform

Once the Simulated Waveform have been generated and saved, you can also view the results which are shown as channels SimT (Simulation Transverse), SimV (Simulation Vertical), SimL (Simulation Longitude), and VSTVL (Vector Sum for Transverse, Vertical and Long). The example Processed Waveform Analysis window is shown below:
i. Timeline Editor

The Timeline files may be loaded into the Timeline Editor, as shown in the example below:

Refer to the Edit Timeline feature within this manual for additional information on adding travel and arrival times, scale factors, analysis, and manual generation of a Timeline file.

NOTES:

1. It is recommended that if your actual timeline file is different from the simulation that you edit the timeline file manually and re-run the simulation.
2. It is recommended that you do not make any radical changes to your blast timing patterns.
6.12 View Menu

The View Menu contains the grid lines, colors, and timelines commands.

a. Grid Lines
Choose this command to display grid lines behind each waveform appearing in the Analysis Window. Open the View Menu and choose Grid Lines to display a check mark.

b. Colors
Choose this command to display an Events waveforms in different colors. Open the View Menu and choose Colors to display a check mark.

c. Timelines
This command displays timelines on an Events waveforms. Open the View Menu and choose Timelines to display a check mark.

Note: Timelines must first be configured before they can appear.

d. Cursor Data
The following commands appear at the right Analysis Cursor within the Analysis Window, with the exception of Y value, which is displayed at both cursors.

(1) DY
The DY calculation indicates the Y value difference between the position of the first cursor and the position of the second cursor.

To display the DY calculation, open the View Menu and select the Cursor Data command. Select DY to display a check mark. Move the Analysis cursors to the point of interest on the waveform. The DY value appears at the right Analysis Cursor.

(2) RMS
The RMS (Root Mean Square) value provides an easy spot calculation of RMS values, especially useful for environmental monitoring. The RMS calculation formula is Square Root of [(Sum of all N*N between the cursors / (number of samples between cursors)] where N is a data value.

To display the RMS calculation, open the View Menu and select the Cursor Data command. Select RMS to display a check mark. Move the Analysis Cursors to the points of interest on the waveform. The RMS value appears at the right Analysis Cursor.

(3) Average
The Average value calculates and displays the average value between the two Analysis Cursors.

To display the Average calculation, open the View Menu and select the Cursor Data command. Select Average to display a check mark. Move the Analysis Cursors to the points of interest on the waveform. The Average value appears at the right Analysis Cursor.

(4) Slope
The slope between two cursor points within the Analysis Window can be selected to appear automatically. The slope is the difference between the two Y-axis cursor point values divided by the difference between the two X-axis cursor point values.

To display the slope calculation, open the View Menu and select the Cursor Data command. Select Slope to display a check mark. Move the Analysis Cursors to the points of interest on a waveform. The slope value appears at the right Analysis Cursor.

(5) Y Value
This command displays the Y value at both cursors.

To display the Y value, open the View Menu and select the Cursor Data command. Select Y Value to display a check mark. Move the Analysis Cursors to the points of interest on a waveform. The Y values appear at both cursors.
(6) Linear Regression
This command displays the slope and intercept results of a linear regression between the two cursors.

(7) Sound Monitoring
To view the **Leq**, **L10** and **L90** values of the waveform, select **View Menu > Cursor Data > Sound Monitoring** select the desired values by clicking on them.

These values are calculated on the data that is between the vertical left and right cursors. These values will be updated as each cursor is moved.
6.13 Window

6.13.1 Auto Open

Use Auto Open to indicate which reports you want displayed when you double click on an event. Blastware will open the associated Event and/or FFT Reports that were pre-selected under the Main Menu, Window, Auto Open list. Within the Blastware Advanced Module, two additional options are available – Analysis Plot and FFT Analysis.

Double click on the Event for which you would like to view the associated windows. Each selection is generated in a new window.

6.14 Help

Blastware offers an extensive on-line help information system. You can access the system by choosing this menu item or by pressing the F1 key when the Event Manager or any dialog box or window is open. The Blastware Help Window appears.

6.14.1 System Info

The System Info dialog provides specific information about your computer and the software it is using. This information is used by Instantel Service Technicians when diagnosing computer problems.

To help in diagnosing your software or unit, an Instantel Service Technician may ask you to select a specific category from the drop down menu:
After selecting the appropriate category, print the information by clicking on the **Print** button. Click on the **Save** button to save the information, click on the **Save** button. The information is saved to a text file called BMWINFO0.TXT located in a default directory, as shown below:
7. **MODEM OPERATION**

The following instructions outline how to connect to a Series II, III, or IV monitor located in the field using either a telephone and modem or a cellular telephone and modem.

### 7.1 Using a Telephone and Modem

This section discusses the procedures required to configure modems, connect a modem to your computer, connect a modem to your monitor, and use the Blastware software to connect to a remote monitor.

Before attempting to use a Micromate, Series IV, Blastmate III or Minimate Plus with a modem, change the **Serial Communications** within the monitor to operate with the modems. These steps are covered below for each unit type:

1. **Micromate**
   - For the Micromate unit, press the **Setup** key. Press the **Down Arrow** key to highlight **View/Edit Preferences**. Press the **Enter** key to enter the menu. Press the **Down Arrow** key to highlight **Auto Call Home**. Press the **Enter** key to access the **Auto Call Home** setup menu.
     
     a. **Enable Auto Call Home:**
        - i. On the display, press the **Disable** button to **Enable Auto Call Home**. **Enable** will appear. If it is already displayed as **Enabled** do not press the button.
     
     b. **Select the Modem:**
        - i. For **Modem**, select between **USB to PC** or **Generic**.
     
     c. **Select the Modem Baud Rate:**
        - i. Set the communications speed by selecting the number next to **Modem Baud Rate**. The rates that are available include, **9600**, **19200**, **38400**, **57600**, **115200**, and **230400**.
     
     d. **Select the Session Time Out:**
        - i. Set the **Session Time Out** in minutes. A range of **1-99** is available.
     
     e. Press the **Cancel** key to exit the menu.
     
     f. Press the **Enter** key to **Save Changes**.

2. **Series IV**
   - For the Series IV unit, press the **Setup** key. Press the **Down Arrow** key to highlight **View/Edit Preferences**. Press the **Right Arrow** key to enter the menu. Press the **Down Arrow** key to highlight **Auto Call Home**.
     
     a. **Select Modem:**
        - i. Press the **Right Arrow** key to toggle through the downloaded supported **Modem Script** files. Select the script file that matches your modem. Press **Enter** to **Save**.
     
     b. **Auto Call Home:**
        - i. Press the **Right Arrow** key to toggle between **On** or **Off**. Press the **Enter** key to **Save** the setting.

     ii. **Call Home Session Timeout:**
        - c. Press the **Right Arrow** key to enter the value field in minutes. Press the **Right** and **Left Arrow** keys to access each value field. Edit the value fields by pressing the **Up** or **Down Arrow** keys. Press **Enter** to **Save** the setting.
d. Turn the **Auto Call Home** feature **Off** when you are no longer using telecommunications.

3. **Blastmate III**
   a. In the **Blastmate III**, press the **Setups Special** key.
   b. Press the **Enter** key repeatedly to display the **Serial Connection** window.
   c. Press the **Up** or **Down Arrow** key to display the **Via Modem** option.
   d. Press the **Enter** key to select this option.
   e. When you have finished using the modems, change the **Serial Communications Setup** setting within the monitors to the **Direct** option. This allows the monitors to communicate with a computer.

4. **Minimate Plus**
   a. If using a **Minimate Plus**, press the **Right Arrow** key and the **Setups** key together.
   b. Press the **Enter** key to scroll through the windows until the **Serial Connection** window appears.
   c. Press the **Right Arrow** key to display the **Via Modem** option.
   d. Press the **Enter** key to select this choice when it appears on the display.
   e. When you have finished using the modems, change the **Serial Communications Setup** setting within the monitors to the **Direct** option. This allows the monitors to communicate with a computer.

**Blastmate II 677, 477 or Minimate**
The above procedures are not required for users of the **Blastmate II 677, 477 or Minimate**.

### 7.1.1 Materials Required

1. **External Modem to Connect to the Remote Monitor**
   a) US Robotics® Sportster® Modem, or
   b) Airlink® Raven Modem

2. **External or Internal Modem to Connect to the Computer**

3. Telephone line (not required for RF modems)

4. Standard RS–232 Cable, and

5. Depending on which unit you are using:

<table>
<thead>
<tr>
<th>Unit</th>
<th>Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series IV</td>
<td>1. Null Modem Cable (720A3401) for Airlink Raven modem, or</td>
</tr>
<tr>
<td></td>
<td>2. Null Modem Cable (720A3601) for U.S. Robotics Modem, and</td>
</tr>
<tr>
<td></td>
<td>3. RS-232 Cable with USB adaptor for connecting a Series IV unit to a</td>
</tr>
<tr>
<td></td>
<td>PC.</td>
</tr>
<tr>
<td></td>
<td>1. Blastmate PC Connecting Cable (712A2301): RS-232 cable for</td>
</tr>
<tr>
<td></td>
<td>connecting an Instantel monitor to a PC.</td>
</tr>
<tr>
<td></td>
<td>2. Null Modem Cable (714A7501): For use when connecting a US</td>
</tr>
<tr>
<td></td>
<td>Robotics modem to an Instantel monitor. (25 pin connector) One null</td>
</tr>
<tr>
<td></td>
<td>modem cable required for each monitor.</td>
</tr>
</tbody>
</table>
### Series II

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Minimate Adapter Cable (715A1501) (Minimate users only) Used with Blastmate - PC cable (p/n 712A2301)</td>
</tr>
<tr>
<td>2.</td>
<td>Null Modem Cable (714A7501): For use when connecting a US Robotics modem to an Instantel monitor. (25 pin connector) One null modem cable required for each monitor.</td>
</tr>
</tbody>
</table>

### 7.1.2 Configuring the Modems

Your modems may require the configuring of dip switches or software commands to operate with the Blastware software. Refer to your modem manufacturers operating instructions.

A wide variety of modems can be used to connect between your monitor and the computer running modem software. Script files allow you to use command sets other than the AT command set (e.g., RF modems have their own). In general, compression should be turned off since it interferes with our handshaking protocol. Table 1 lists some common script file commands.

### 7.1.3 Modem Settings

Configure your modems to the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>PC Modem</th>
<th>Remote Modem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Terminal Ready (DTR) Override</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>Result Codes</td>
<td>VERBAL</td>
<td>VERBAL OR NUMERIC</td>
</tr>
<tr>
<td>Result Code Display</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Command Mode Local Echo Suppression</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Auto Answer Suppression</td>
<td>ON or OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Carrier Detect Override (CD)</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Power on and ATZ Reset Software Defaults – Load user defined defaults at power up.</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>AT Command Set Recognition</td>
<td>ON</td>
<td>ON</td>
</tr>
</tbody>
</table>

### 7.1.4 Connecting a Modem to a Computer

This section applies to external modems. We assume internal modems have already been installed in your computer. Connect the modem to your computer using the serial cable supplied with your modem. Connect the telephone modular-to-modular cable into the modem "line" outlet located on your modem. Plug the other end into a telephone outlet. RF modems do not require telephone lines. Supply power to the modem.

**WARNING:** Radio Frequency (RF) modems are transmitters. Do not use radio frequency modems near blasting operations susceptible to transmitter interference.

### 7.1.5 Connecting a Modem to a Remote Monitor

Connect the modem to your monitor according to the figure below. Connect the telephone modular-to-modular cable into the modem "line" outlet located on your modem. Plug the other end into a telephone outlet. RF modems do not require telephone lines. Connect the Blastmate Null Modem Cable (714A7501) to the unit. DS-077 Minimate users must first connect the Minimate Adapter Cable (715A1501). Connect the other end to the modem and turn on the monitor. Supply power to the modem.
7.1.6 **How to Connect to a Remote Monitor Using Modems**

To connect to a remote monitor using modems, first configure your modems to operate on your computer. See the instructions that came with the modems. Before you connect the remote modem to a remote monitor, initialize the modem by connecting it to the computer running the Blastware program. Press the **Initialize Remote Modem** button in the Communications Setup dialog box. Remove the remote modem. Connect the PC Modem and initialize it. Press the **Initialize PC Modem** button. Connect the modems to a telephone line. From the Communications Setup dialog box, choose **Dial**. Select the telephone number of the remote modem from the dialing list. Connect to the remote modem. Change the settings on the remote monitor. Re-enter the monitor mode, if required. Choose **Hangup**. Your modem session is complete.

7.1.7 **Communications Setup**

Open the Communications Setup dialog box. From the Blastware Main Menu, click on the Unit Menu and select **Communications**.
a. Port

Port refers to your computer’s serial port where you plug in the communication cable. The serial port allows the monitor to communicate with your computer. Set the Port drop-down menu to match the number of the serial port. You have a choice between Com 1 to Com 20: Identify the serial port on your computer and choose the same number in the Port box. See your computer’s manual for information on how to identify serial ports. To test your selection, press the Test button. Blastware will indicate if your selection is correct – if the communication link is not successful, systematically select the next Communications Port from the drop-down menu, and use the Test function until you have made a successful connection to the monitor.

Note: The Test button does not apply to Blastmate II or Minimate units.

b. Baud Rate

The baud rate refers to the rate at which both the PC Modem and the Remote Modem will communicate. Check that each modem supports the designated baud rate. Modems have maximum baud rates at which they can communicate. Modems can communicate with other modems of lower baud rates but cannot communicate with modems with baud rates higher than their maximum rate. The baud rate you choose will depend on your modem and the quality of your telephone line. A lower baud rate results in slower but more reliable communication.

Note: This setting does not apply to Blastmate II or Minimate units. Blastware sets the baud rate automatically for communication with Series II units.

c. Retries

Set the number of retries the computer will attempt when connecting to the Blastmate III or Minimate Plus, or Series IV unit. Retries range from zero to ten. A typical setting is three.

d. Modem Type

Choose a modem type for both the PC Modem and the Remote Modem. Choose a modem type from the list of supported modems. If your modem type does not appear then select the Generic modem type.
e. **Test**

This checks the communications between the computer and the monitor. The communications can be either direct, over the Blastmate PC connecting cable, or over modems. If testing communications when using modems, press the **Test** button after you have established a connection. The message “Communications OK” confirms a proper connection.

**Note:** The Test button does not apply to Blastmate II or Minimate units.

f. **Dial**

Press the **Dial** button to display the Modem Dial List dialog box. With this box you can store up to 100 names, telephone numbers, and baud rate settings for your remote monitors.

![Modem Dial List](image)

(1) **Dial**

To dial a number and connect to a remote modem, double click on top of the number. The Modem Dialing Status Window appears to inform you of the progress of your call.

![Modem Dialing Status](image)

When a connection is made between the PC Modem and the Remote Modem, the following message appears on your computer display. Click on **OK**. The message “modem” appears on the side of your computer screen. This message remains until you end the modem session.

**Note:** When you connect to a remote monitor, the Blastware program causes the remote monitor to exit the monitor mode. Plan your remote access so it does not interfere with monitoring operations. Always remember to enter the remote monitor into the monitor mode before you end the monitor session.

At this point, you can control the monitor as if it was connected directly to your computer.

(2) **Edit**

This command adds additional dialing entries or changes existing entries. To add an entry or change an existing entry click on an available position or move to the entry to be changed. Press the **Edit** button. The Edit Dial Entry Window appears.
Click on a text box and enter the new information. If you are changing an existing entry, double click on the text box to highlight the existing information. Enter the new information. Enter a name for the remote modem and a telephone number. You can include dashes or spaces between the dialing codes to make the number easier to read. The Blastware program ignores these dashes and spaces.

**Hint:** You can add the number 9 if your office telephone system requires you to dial 9 before accessing an external line. Add commas between the dialing codes. The commas pause the modem connection allowing time for the telephone switching to occur.

Set the baud rate to the rate at which both the PC Modem and the Remote Modem will communicate. Check that each modem supports the designated baud rate. Modems have maximum baud rates at which they can communicate. Modems can communicate with other modems of lower baud rates but cannot communicate with modems with baud rates higher than their maximum rate. The baud rate you choose will depend on your modem and the quality of your telephone line. A lower baud rate results in slower but more reliable communication. The default rate is 9600 baud.

(3) **Print List**

This prints the dialing list and serves as a useful reference.

(4) **Close**

This closes the dialing window and returns to the Communications Setup dialog box.

g. **Hangup**

When you have completed your session with the remote monitor and want to end the modem session, press the **Hangup** button. The Modem Disconnect Status Window appears informing you that you have disconnected the communications link and ended the modem session. The status bar indicates the disconnect progress.

h. **Initialize PC Modem**

The Blastware requires two modems, one connected to the computer and one connected to the remote monitor. Before the two modems can connect and “talk” to each other, they must be initialized. Initializing the modems programs each one to speak the same language. You must initialize the modems before you use the Blastware modem feature for the first time and always after a modem has been used with any other type of modem communications software. We assume you have connected either the PC Modem or the Remote Modem to your computer and it is operating properly.

To initialize the modem to be used by your computer, connect the modem to your computer. Press the **PC Modem Initialization** button.
i. Initialize Remote Modem

Initializing the Remote Modem programs it to communicate with the PC Modem. You must always initialize the Remote Modem BEFORE you bring it out in the field and connect it to the remote monitor.

To initialize the Remote Modem to be used by your remote monitor, connect the modem to your computer. Press the Initialize Remote Modem button. After the modem has been initialized, disconnect it from the computer. It can now be transported to the field and connected to the remote monitor.

j. Debug

This command creates or modifies a modem script file. Modems require script files to operate with the Blastware software. Blastware includes modem script files for various modems. If the list does not include the modem you use or if you need to modify a script file, use this command.

To create or modify a modem script file, open the Unit Menu and select the Communications Setup command. Select a modem within the Modem Type Window. Click on the Debug button. The Modem Debugging Mode dialog box appears. Before editing an existing script file, make a copy of it to maintain a complete set of unaltered script files.

(1) File

The file menu contains the following commands.

i. Load

This command selects a script file for editing. Select the script file corresponding to the modem type being used. Choose the Generic Modem script file if adding a new type of modem for use with Blastware.

ii. Save

This command saves the script file currently being changed.

iii. Save As

This command saves the current script file to a different name than the name displayed within the Type: window. Use this command to create a new script file for a new type of modem.
iv **Close**
This closes the dialog box.

(2) **Modem File Section**
This section displays the location and filename of the modem script file currently being changed.

i **Type**
Enter the modems name. Be specific if creating a script file for a new type of modem.

ii **Note:**
Use this box to add a further description about the modem.

(3) **Debugging for**
Each of the following commands corresponds to a different section within a modem script file.

i **Dial**
This command enters a telephone number and baud rate for the debugging mode. The debugging mode requires a second modem to connect to and test the script file during its development. Click on the **Dial** command to display the following dialog box.

![Dial Dialog Box](image)

Enter the telephone number for the second modem. Enter a baud rate to use when communicating with this modem.

**Note:** Ensure both your PC and Remote modems were properly initialized and connected.

ii **Hang Up**
The Hang Up section contains the commands to hang up a modem and end a modem session.

iii **Initialize PC Modem**
The Initialize PC Modem section initializes a modem to act as the modem connected to your PC.

iv **Initialize Remote Modem**
The Initialize Remote Modem section initializes a modem to act as the remote modem connected to a remote monitor in the field.

(4) **Hangup, Initialize PC and Initialize Remote Sections**
A script file contains a section for each of these commands. To edit these sections, click on the appropriate button. A dialog box appears for the section. The commands, within these each dialog box perform the same function.
Modem Operation

7–10

Blastware Operator Manual

$i$ **All, Current to End, Current Only**
These commands determine which part of the script file to execute. **All** executes all the commands within the displayed section of the script file. **Current to End** executes the commands from the line displaying the cursor to the end of the displayed section of the script file. **Current Only** executes the line with the cursor displayed.

If the command is followed by the CHECKRESPONSE, SHOWRESPONSE or PAUSE command, then that command will also be executed. The cursor advances automatically to the next line after the execution. The execution ends by clicking the **Cancel** button. The execution also ends if it encounters an error or when it reaches the end of the displayed section of the script file.

$ii$ **Commands**
This window displays the commands within the specified section. Lines beginning with a "*" will be ignored during execution. Commands can be added, modified, or deleted. For a complete command set and a detailed description of each command, please refer to the Modem Script File section appearing at the end of this chapter.

$iii$ **Execution Output**
The Execution Output window displays the results for each executed command including the command line number, the command itself, time spent executing the command, and the response string received from the modem. To save the output, click the **Save Output** button. To print the output, click the **Print Output** button. To clear the window, click the **Clear Output** button.

$iv$ **Close**
This command closes the dialog box.

### 7.2 Setting Up a Cellular Telephone and Modem
Cellular modem phone support connects a computer to a remote monitor without the requirement of a telephone land line. Consult your local cellular telephone service provider for information on compatible equipment and services in your area.

#### 7.2.1 Modem Script File
A script file contains commands to control and identify a programmable modem. The commands are grouped into 5 procedure blocks and one file terminator. Each procedure block name is
enclosed in square brackets [ ]. When a procedure is run, all commands between the procedure block title and the next procedure block title are run. The procedures are:

- **Identification**: Modem identification that helps you choose a driver.
- **Connect**: Commands to make a connection with a remote modem.
- **Disconnect**: Commands to break a connection or hang–up the line.
- **Initialize_PC**: Contains commands to initialize the modem that will be attached to the PC at the time of making a connection.
- **Initialize_Remote**: Contains commands to initialize the modem that will be attached to the monitor.
- **End**: This procedure block has no body and is used to identify the end of the script file.

Each procedure block can consist of one or more commands. The commands are in the form "Command= %d" or "Command= %s" where %d is an integer number and %s is an alphanumeric text string. There must be a space <space> after the equal sign. All unrecognized commands are ignored so you can easily add documentation to your file by starting the line with a "#" as we have done in our drivers. Commands are recognized as part of the programming language used to set up modems and are described in the table below. An example of each command as it would appear in a typical script file is also shown.

Typical procedures used to program a Generic Modem as found in Gen_AT.MDM follow the table below.

### COMMAND | DESCRIPTION | EXAMPLE
--- | --- | ---
Title= %s | Placed in the Initialization procedure to provide the PC user with some additional information with which to identify the modem driver. The text is truncated to 25 characters. | Title= Generic Modem
UserNotes= %s | Placed in the initialization procedure to provide additional help information to the PC user. This text string can be up to 78 characters long. It is shown at the bottom of the screen when selecting a new modem driver from a list. | UserNotes= The Generic AT Command Set Modem Driver
Dial= %s | This command does the actual dialing. The telephone number or remote modem ID number is appended to the command string specified by the %s parameter. | Dial= ATD
CheckResponse= %d %s | This command instructs the program to look for the text response specified by the %s parameter for up to the number of seconds specified by the %d parameter. | Checkresponse= 40 CONNECT
Byte= %d | Sends the byte specified by the %d parameter to the modem. This is required to send special control characters that cannot be embedded in a text string. | Byte= 13
Pause= %d | Causes the modem program to pause the number of seconds specified by the %d parameter before executing the next command. | Pause= 1
ShowResponse= %d | Shows the modem response over the number of seconds specified by the %d parameter. | ShowResponse= 1
String_CR= %s
Same as the String command, but it also sends a carriage return (13) to the modem after the text string. Many modems use the CR as a delimiter.

Modem_ID_Number= %s
This command causes the program to prompt the user for an ID text string and sends the text string specified by the %s parameter followed by the ID text to the modem.

7.2.2 Example Modem Script File

This file contains commands to control and identify a modem. The commands are grouped into 5 procedure blocks and one file terminator. Each procedure block name is enclosed in square [] brackets. When a procedure is run, all commands between the procedure block title and the next procedure block title are run. The possible procedures are:

* Identification – Modem identification that helps you choose a driver.
* Connect – Commands to make a connection with a remote modem.
* Disconnect – Commands to break a connection or hangup the line.
* Initialize_PC – Contains commands to initialize the modem that will be attached to the PC at the time of making a connection.
* Initialize_Remote – Contains commands to initialize the modem that will be attached to the monitor.
* End – This procedure block has no body and is used to identify the end of the script file.

Each procedure block can consist of one or more commands. The commands are in the form "Command= %d" or "Command= %s" where %d is an integer number and %s is an alphanumeric text string. All unrecognized commands are ignored so you can easily add documentation to your file by starting the line with a "*" as we have done here. The following commands are recognized:

* Title= %s – Placed in the Initialization procedure to provide the PC user with some additional information with which to identify the modem driver. The text is truncated to 25 characters.
* UserNotes= %s – Placed in the initialization procedure to provide additional help information to the PC user. This text string can be up to 78 characters long. It is shown at the bottom of the screen when selecting a new modem driver from a list.
* Dial= %s – This command does the actual dialing. The telephone number or remote modem ID number is appended to the command string specified by the %s parameter.
* CheckResponse= %d %s – This command instructs the program to look for the text response specified by the %s parameter for up to the number of seconds specified by the %d parameter.
* Byte= %d – Sends the byte specified by the %d parameter to the modem. This is required to send special control characters that cannot be embedded in a text string.
* Pause= %d – Causes the modem program to pause the number of seconds specified by the %d parameter before executing the next command.
* ShowResponse= %d – Shows the modem response over the number of seconds specified by the %d parameter.
* String= %s – Sends the text string specified by %s to the modem.
* String_CR= %s – Same as the String command, but it also sends a carriage return (13) to the modem after the text string. Many modems use the CR as a delimiter.
* Modem_ID_Number= %s – This command causes the program to prompt the user for an ID text string and sends the text string specified by the %s parameter followed by the ID text to the modem.
* for an ID text string and sends the text string
* specified by the %s parameter followed by the ID
* text to the modem.
*
********************************************************************

[Identification]
****** The Title will be displayed with the file list
Title= Generic Modem
*********This is user note. This note will be displayed with the modem name
Usernotes= The Generic AT Command Set Modem Driver
****** The following commands are required to connect to modem
[Connect]
Dial= ATDT
******* Wait for the "CONNECT" response for up to 40 seconds ************
CheckResponse= 40 CONNECT

[Disconnect]
Pause= 1
String= +++
Pause= 1
String_CR= ATH0
CheckResponse= 3 OK

**INITIALIZE LOCAL PC MODEM (The one attached to your PC at the office) **
*Note:
* The main problems encountered, have to do with Flow Control and
* compression. The existing serial protocol will only work properly if
* compression is turned off. Modem connection to the monitor is with a
* simple 3 wire connection and therefore the hardware flow control must be
* disabled.
* In addition, the monitor will echo characters and therefore it is
* important that the modem connected at the monitor does not also echo
* (ATE0) and does not try to send result codes to the monitor(ATQ1).
*
* Some settings are set via Dip Switches on the Modem. Some modems do not
* allow you to save some of the parameters that are normally controlled
* with the Dip Switches. Always try to set the Dip Switches to the desired
* operation since they may not be fully controllable via software.

[Initialize_PC]
******************* Initialize to Factory Defaults **************
* This should disable flow control, compression and error control.
* Enable the default result codes so that 'OK' is returned.
String_CR= AT&F
Pause= 2
************** Display Result Codes ***********************+
String_CR= ATQ0
CheckResponse= 3 OK
************* Turn local echo on **********************
String_CR= ATE1
CheckResponse= 3 OK
** Write these settings to memory. These settings will be recalled when the
** Modem is powered up in the future.
String_CR= AT&W
CheckResponse= 3 OK

**INITIALIZE REMOTE MODEM (the one that is attached to the monitor) **

[Initialize_Remote]
Modem Operation

******************* Initialize to Factory Defaults ***********
* This should disable flow control, compression and error control.
* Enable the default result codes so that 'OK' is returned.
String_CR= AT&F
Pause= 2

******************* Display Result Codes ********************
String_CR= ATQ0
CheckResponse= 3 OK

****************** Auto answer after 1 ring **********************
String_CR= ATS0=1
CheckResponse= 3 OK

****************** Disable Display of Result Codes **************
String_CR= ATQ1
Pause= 3

***************** Turn local echo off ***************************
String_CR= ATE0
Pause= 2

** Write these settings to memory. These settings will be recalled when the
** Modem is powered up in the future.
String_CR= AT&W
[End]
Index

A
A - Weighted, 6–37
A Weight
  Measurement Units, PC Report, 4–6
  Sensorcheck, 4–62
A Weight microphone
  Series II, 5–7
  Series III, 4–30
Accel, 4–128
Add, 6–25
Add Post Event Notes, 3–4
Adjust Speed, 4–63
Advanced FFT, 6–33
Advanced Module (optional), 6–1
Air Blast Graph, Scaled Distance, 4–79
Alarm Level
  Geophone Channels, 4–30, 4–31, 4–46
  Geophone Channels (Series II), 5–7
  Microphone Channel, 4–30, 4–31, 4–46
  Microphone Channel (Series II), 5–7
All Enabled, Geophone Channels, 4–28
Analysis Cursors, Analysis Window, 6–2
Analysis Pointers, Analysis Window, 6–3
Analysis Window, Advanced Module, 6–2
Annotations, adding to Zoom Data Plot, 6–6
Archive button, Event Manager, 4–142
Archiving events, 4–142
  extracting, 4–144
ASCII Conversion
  settings, 4–83, 4–85
ASCII Data, Zoom Data Plot, 6–7
Auto Call Home
  Call Home Log, 4–122
  Setup Unit, 4–87
  Test Modem, 4–121
Auto IP, 4–15
Auto Window, 4–24, 4–27, 4–45
Automatic IP Address, 4–15, 4–16, 4–17
Automatically Print Event After Recording, 4–38
Auxiliary Trigger, 4–30
  Advanced Module, 6–15, 6–20
Average, displaying on cursor, 6–73
A-Weight, 4–42
Axis range, Compliance Graph Editor, 6–48
Axis title, Compliance Graph Editor, 6–49

B
Backlight on Time, 4–37
Basic Tutorial, 3–1
Baud Rate
  Edit Dial List Entry, 7–6
  Monitor to Computer, 4–13
  Monitor to Modem, 7–5
BlastWare III
  Features and Benefits, 2–1
  Software Modules, 2–1

C
C Weight microphone (Series II), 5–7
Calculations, 6–36
Calculations, Analysis Window, 6–3
Calculator, Scaled Distance, 4–77
Call Home Log, Auto Call Home, 4–122
Canon BJ–30 printer, 4–69
Channel 1, 2, 3, 4, Sensorcheck (Series III), 4–62
Channel name, Advanced Module, 6–10, 6–18
Channel Names, 4–30, 4–32, 4–47
Channel Setup, Advanced Module, 6–10, 6–17
Channel Setup, Compliance Module
  Geophone Channels, 4–25, 4–28
  Microphone Channel, 4–25, 4–29
Charge Weight, 4–34, 4–48
Check channels to show on compliance event report, 4–6
Clipboard, 4–12
Color Printing, 4–3
Colors, Displaying - Advanced Module, 6–73
Column Title, Event List Filter, 4–150
Communications Setup
  Monitor to Computer, 4–12
  Monitor to Modem, 7–4
Comparison, Event List Filter, 4–150
Compliance Graph Editor, 6–45
Compliance Module, 4–1
Compliance Report
  Check channels to show on compliance event report, 4–6
  choosing for Series II monitor, 5–14
  choosing for Series III monitor, 4–69
  Choosing for the PC Report, 4–2
  loading into the monitor (Series III), 4–70
  Printing on the Monitor, 4–38
  Configuring modems, 7–3
  Connecting a Modem to a Computer, 7–3
  Connecting a Modem to a Remote Monitor, 7–3
  Continuous Record Mode
    Series II, 5–5
    Series III, 4–26, 4–42, 4–43
Copy All/Print All button, Event Manager, 4–134
Copy button, Event Manager, 4–135
Copy Report to Clipboard, 4–12
Copying events, 4–134
Cube Root Graph, Scaled Distance, 4–79
Cursor Data, 6–73
Cursor Data, Zoom Data Plot Window, 6–5
Cursors, moving – Analysis Window, 6–2
Custom Logo, printing, 4–3
Customer Support, See the title page, 2
C-Weight, 4–42
C-Weighted, 6–37

D
Daily Self Check
Series II, 5–10
Series III, 4–36
Daily Timer Mode
Series III, 4–35
Data for comparison, Event List Filter, 4–150
Date
setting for Series II, 5–12
setting for Series III, 4–62
Date/Time
Series II, 5–12
Series III, 4–62
dB Calculations, 6–37
Debug, modem script files, 7–8
Delete button, Event Manager, 4–137
Delete Column, Events List Box, 4–147
Delete event from Scaled Distance File, 4–75
DHCP, 4–15
Dial
Monitor to Modem, 7–6
Dial String
Auto Call Home, 4–89
Dial, modem, 7–6
Diconix 180 SI, 4–69
Differentiate, 6–27
Directory List Box, Event Manager, 4–145
Disk Operating System (Series III), 4–69
Disp, 4–128
Display Channel 4, 4–8
Display Geo Peaks in dB, 4–5
Display result in, Linear Superposition, 6–61
Distance from blast, 4–34, 4–48
DNS, 4–15
Dose%, 6–36
Draw Menu, Zoom Data Plot window, 6–6
DY, displaying on cursor, 6–73

E
Edit Mail Delivery, BlastWare Mail, 4–128
Edit Menu
Compliance Graph Editor, 6–46
Scaled Distance, 4–74
Zoom Data Plot window, 6–5
Edit Post Event Notes, Events List Box, 4–150
Edit The Event List Filter, Events List Box, 4–149
Edit Timeline, Advanced Module, 6–49
Edit, modem dial list, 7–6
E-mail
BlastWare Mail, 4–123
sending from the Event Manager, 4–130
Enable Auxiliary Trigger, 4–30
Enable Extended Notes (Series III), 4–33, 4–48
Enable Job Number (Series III), 4–33, 4–48
Enable Scaled Distance
Series III, 4–34, 4–48
Enable User Notes (Series III), 4–33, 4–47
Enable, Triggers—Advanced Module, 6–12, 6–18
Enabled, Geophone Channels, 4–28
Enabled, Microphone Channel, 4–29
Equal to, Event List Filter, 4–150
Equivalence, 4–9, 4–11
Ethernet, 2–2, 4–14, 4–15, 4–16, 4–17, 4–19, 4–20, 4–22, 4–66
Event Manager
Advanced Module, 6–1
Archive button, 4–142
Copy button, 4–135
Copy/Print All button, 4–134
Delete button, 4–137
difference between main and Series 2, 4–71
Directory List Box, 4–145
Extract button, 4–144
Options in PC Report, 4–5
Print button, 4–137
Series II, 5–2
Event Manager Options, PC Report Options, 4–5
Events
archiving, 4–142
copying, 4–134
copying to the computer, 4–135
deleting, 4–137
extracting from archive, 4–144
printing, 4–137
Exceedance, 4–9
Exceedance, 4–9
Extended Notes
Series II, 5–8
Series III, 4–33, 4–48
External Trigger, 4–46
Extract button, Event Manager, 4–144
Extracting archived events, 4–144

F
Fast, 4–42, 6–37
Fetch Results, Sensorcheck (Series III), 4–62
File Menu
Compliance Graph Editor, 6–46
Scaled Distance window, 6–1
Zoom Data Plot window, 6–5
Filter, 6–28
Find Duplicates, Scaled Distance, 4–75
Flex Setup, 6–17
Flex™ Setup, 6–17
Footnotes, Compliance Graph Editor, 6–47
Format, Compliance Graph Editor, 6–48
Freq. Analysis Method, 5–14
Frequency Domain Waveform Printing, 6–22
Frequency Filter Report, 6–42
Frequency Weight File, 6–31, 6–39
Frequency Weighting, 4–44, 4–45, 4–69, 6–39, 6–54, 6–55
Frequency Weights, 4–69

G
Gain, Advanced Module, 6–12, 6–18
Geo Peaks in dB, show in the PC Report, 4–5
Geophone Channels, 4–25, 4–28
Alarm Level, 4–30, 4–31, 4–46
Enabling, 4–28
Index

**H**
- Hangup
  - Monitor to Modem, 7–7
- Hard Lock Key Connection, 1–2
- Help Menu, 4–132
- Hewlett Packard Deskjet 320, 4–69
- Histogram (Strip chart) Record Mode
  - Series II, 5–6
  - Series III, 4–24, 4–27, 4–43
- Histogram Combo, 2, 2–2, 4–24, 4–27, 4–43, 4–45, 4–46, 4–54, 4–88, 4–91, 6–19, 6–20
- Histogram Combo Record Mode, 4–24, 4–27, 4–43
- Histogram Interval, 4–24, 4–28
- Histogram Printout, 4–39
- Human Exposure, 6–39, 6–53

**I**
- Imperial Measurement Units
  - Monitor, 4–36, 4–57
  - PC Report Options, 4–6
- Initialize PC Modem
  - Monitor to Modem, 7–7
- Initialize Remote Modem
  - Monitor to Modem, 7–8
- Insert Column, Events List Box, 4–147
- Instantel Sensor
  - Units, 6–11, 6–12
- Instrument, Advanced Module, 6–13, 6–18
- Integrate, 6–27
- Interval Analysis, 6–58, 6–59, 6–60
- Introduction, 2–1
- IP Address, 4–15

**J**
- Job Number (Series III), 4–34, 4–48

**K**
- Kodak Diconix 180 SI, 4–69

**L**
- L10, 4–9, 4–11, 6–74
- L90, 4–9, 4–11, 6–74
- Labels, Compliance Graph Editor, 6–47
- LAN, 4–15
- Language
- choosing for Series III monitor, 4–69
- choosing for the PC software, 4–3
- Leq, 4–11, 4–85, 6–74
- Less than, Event List Filter, 4–150
- Library Components, Reload, 4–70
- Linear microphone
  - Series II, 5–7
  - Series III, 4–30
- Show Mic in dB in PC report, 4–6
- Linear Regression, displaying on cursor, 6–74
- Linear Superposition, 2–2, 6–58, 6–61, 6–62
- Linear t
  - Sensorcheck, 4–62
- Lines, Compliance Graph Editor, 6–46
- Lmax, 4–85
- Linin, 4–85
- Load Scaled Distance File, 4–73
- Load, Compliance Graph Editor, 6–46
- Load, Events List Box, 4–145
- Lower Limit Message, Compliance Graph Editor, 6–48

**M**
- Main Title, Compliance Graph Editor, 6–48
- Manual Override Record Mode (Series II), 5–6
- Manual Record Mode (Series III), 4–26, 4–43
- Maximum Range, Geophone Channels, 4–28
- Measurement Units
  - in PC Report, 4–6
  - Series III monitor, 4–36, 4–57
- Metafile, saving Zoom Date Plot to, 6–5
- Metric Measurement Units
  - Monitor, 4–36, 4–57
  - PC Report Options, 4–6
- Mic A, 4–85
- MicA, 4–85
- Micromate, 2, i, 3–1, 3–2, 3–4, 4–1, 4–7, 4–12, 4–13, 4–22, 4–23, 4–24, 4–25, 4–26, 4–30, 4–31, 4–34, 4–34, 4–59, 4–60, 4–63, 4–69, 4–70, 4–86, 4–96, 5–12, 7–1
- Microphone Channel, 4–25, 4–29
  - Alarm Level, 4–30, 4–31, 4–46
  - Enabled, 4–29
  - Trigger Level, 4–25, 4–29
  - Trigger Source, 4–29
  - Type, 4–30
- Microphone setup (Series II), 5–7
- MiniMate Plus, Printer Driver, 4–69
- Modem, 4–69
  - Cellular, 7–10
  - telephone, 7–1
  - testing for Auto Call Home, 4–121
- Modem Operation
  - Baud Rate, 7–5
  - Communications Setup, 7–4
  - Configuring the Modems, 7–3
  - Connecting a Modem to a Computer, 7–3
  - Connecting a Modem to a Remote Monitor, 7–3
  - Dial, 7–6
  - Hangup, 7–7
- Initialize PC Modem, 7–7
- Initialize Remote Modem, 7–8
- Modem Script File, 7–10
Index

Modem Type, 7–5
  Port, 7–5
  Retries, 7–5
  Settings, 7–3
  Test, 7–6
Modem Script File, 7–10
Modem Settings, 7–3
Modem Type
  Monitor to Computer, 4–13
  Monitor to Modem, 7–5
Module
  Advanced, 6–1
  Compliance, 4–1
Modules, BlastWare III, 2–1
Monitor command
  Series II, 5–13
  Series III, 4–64
Monitor Log
  Series II, 5–13
  Series III, 4–67
Monitor Mode (Series II), 5–13
Monitor Status
  Series II, 5–10
  Series III, 4–61
Monitor, Start Monitoring, 4–64
Monitoring LCD Cycle, 4–37
Most Recent Test Results, Sensorcheck (Series III), 4–62

N
Name result, Linear Superposition, 6–61
New Scaled Distance File, 4–71
Notes
  Series II, 5–8
  Series III, 4–32, 4–47
Notes, adding to Zoom Data Plot, 6–5

O
Octave Data Conversion, 6–36, 6–37
Operating system
  reloading, Series III, 4–68
OS
  reloading, Series III, 4–68

P
PC Report Options, 4–2
PCL Compatible, 4–69
Peak, 4–128
Peak Filter, 4–128
Peak Hold, 6–34
Peak Sound Pressure Level, 4–10
Perform Test, Sensorcheck (Series III), 4–62
Play, 6–37
Plot Menu, Zoom Data Plot window, 6–6
Plot Symbols, Compliance Graph Editor, 6–48
Plot Waveform, Sensorcheck (Series III), 4–62
Port
  Monitor to Computer, 4–13
  Monitor to Modem, 7–5
Series II, 5–2
Position gridlines automatically, Compliance Graph Editor, 6–49
Power Saving Timeout, 4–37
PPV, 4–129
Print button, Event Manager, 4–137
Print Compliance Report, 4–38
Print Custom Logo, show in the PC Report, 4–3
Print List, modem dial list, 7–7
Print Recording Setup, 4–38
Print Scaled Distance File, 4–73
Print Setup
  Advanced Module, 6–21
Print Table, 6–23
Print the Event, 3–5
Print Waveform, 4–38
Printer
  PCL Compatible, 4–69
  Printer Driver Type
    MiniMate Plus, 4–69
Printer Setup, monitor, 4–37
Printing Zoom Data Plot, 6–5
Process Menu, Analysis Window, 6–24
PSPL, 4–10
PVS, 4–129

Q
Quick Zoom, 6–4

R
Range, Advanced Module, 6–12, 6–18
Range, Geophone Channels (Series III), 4–28
Range, Mic Channels (Series II), 5–7
Record Interval, 5–6
Record Mode
  Advanced Module, 6–13, 6–18
  Advanced Module, 6–24, 4–27, 4–45
Record Stop Mode, 4–24, 4–27
Record Time
  Advanced Module, 6–20
  Series II, 5–6
  Series III, 4–24, 4–27
Recording Mode
  Compliance Module, 4–23, 4–26, 4–43
  Series II, 5–5
Recording Setup
  Compliance Module, 4–41
  Series II, 5–5
Recording times available on monitor, 6–14
Registration Card, 1–1
Reload Library Components Only, 4–70
Reload Operating System
  Series III, 4–68
Remote Alarm
  geo alarm level, 4–46
Remove All Filters, Event List Filter, 4–150
Remove Current Filter, Event List Filter, 4–150
Remove Offset, 6–32
Rename Column, Events List Box, 4–146
Report Content, Advanced Report, 6–21

1–4
Blastware Operator Manual
Index

Report Title, changing in the PC Report, 4–2
Reset Unit (Series III), 4–70
Resolution, Advanced Module, 6–12, 6–18
Retries
  Monitor to Computer, 4–13
  Monitor to Modem, 7–5
RMS, displaying on cursor, 6–73
Router, 4–15

S
Sample Rate
  Advanced Module, 6–13, 6–20
  Compliance Module, 4–24, 4–27, 4–45, 4–46
Sample rates available on monitor, 6–13
Save Process File, Advanced Report, 6–24
Save Scaled Distance File
  Advanced Module, 6–46
Save, Compliance Graph Editor, 6–46
Save, Events List Box, 4–146
Scale, 6–32
Scaled Distance, 4–71
  air blast graph, 4–79
  create new file, 4–71
  cube root graph, 4–79
  delete events from file, 4–75
  displaying graphs, 4–75
  find duplicate events, 4–75
  load file from disk, 4–73
  print file, 4–73
  save file, 4–73
  square root graph, 4–75
  technical description, 4–80
Scaled Distance Calculator, 4–77
Scaled Distance Table, 4–77
Scaled Distance, Enable
  Series II, 5–9
  Series III, 4–34, 4–48
Select Channels, Advanced Module, 6–10, 6–18
Selecting a Serial Port, Series II, 5–2
Self Check Mode
  Series II, 5–10
  Series III, 4–36
Sensitive, 6–16
Sensitivity (Units/Volt), Advanced Module, 6–11, 6–18
Sensorcheck
  choosing when to run (Series II), 5–11
  choosing when to run (Series III), 4–36, 4–57
  Printing with the Monitor, 4–38
  Series II, 5–11
  Series III, 4–61
  speed up recording, 4–36, 4–57
Serial Numbers, 4–128
Series II, 5–1
  Connecting monitor to PC, 5–1
  Selecting a Serial Port, 5–2
  Series II Event Manager, 5–2
Settling Time, 6–15
Setup Unit, Auto Call Home, 4–87
Shift, 6–26
Show Mic in dB
  PC Report, 4–6
Show Waveform Grid Lines, 4–3

Signature Hole Analysis, 2–2, 6–58, 6–62, 6–63, 6–64, 6–67, 6–68, 6–69, 6–70
Single Shot Record Mode
  Series II, 5–5
  Series III, 4–26, 4–41
Slope, displaying on cursor, 6–73
Slow, 4–42, 6–37
Smooth, 6–35
Software Modules, 2–1
Sound Level Microphone, 4–8, 4–9, 4–10, 4–42, 4–85, 6–15
Sound Monitoring, 4–9, 6–37, 6–74
Source Waveform, Linear Superposition, 6–61
Special Setup, 4–34, 4–49
Square Root Graph, Scaled Distance, 4–75
Starting BlastWare III, 1–6
Starting monitoring
  Series II, 5–13
  Series III, 4–64
Static IP, 4–15
Static IP Address, 4–15, 4–16, 4–19, 4–20, 4–21, 4–22
Static IP Mask, 4–15
Status of monitor
  Series II, 5–10
  Series III, 4–61
Storage Mode
  Advanced Module, 6–13, 6–20
  Compliance Module, 4–28
  Series II, 5–6
Subtitle, Compliance Graph Editor, 6–48
Subtract, 6–25
Synthetic Waveform, 6–58
System Info, 4–132, 6–75
System Requirements, 1–1

T
Taper, 6–31
TCP/IP, 4–15, 4–96, 4–97, 4–98
TCP/IP Communications, 4–98
Test
  Monitor to Computer, 4–14
  Monitor to Modem, 7–6
Test Modem, Auto Call Home, 4–121
Test Wave, 6–34
  the Use data from, 6–36
Third Octave, 6–35, 6–36
Time
  adjusting for Series III, 4–63
  setting for Series II, 5–12
  setting for Series III, 4–62
Time Delay, adding to Zoom Data Plot, 6–7
Time Display Format, choosing for the PC Report, 4–6
Time Domain Waveform Printing, 6–21
Time Format, Monitor (Series III), 4–36, 4–57
Time Scale Control, Analysis Window, 6–3
Timeline Handling, Linear Superposition, 6–61
Timelines, Analysis Window, 6–3
Timer Mode
  Series II, 5–9
  Series III, 4–35
Tools Menu
  Compliance Module, 4–71

Blastware Operator Manual
I–5
Index

Zoom Data Plot window, 6–7
Transfer Function, 2–2, 6–55, 6–56
Trigger Cable, 4–46, 6–15, 6–20
Trigger Level, 6–16
  Advanced Module, 6–12, 6–18
  Geophone Channels, 4–25, 4–28
  Geophone Channels (Series II), 5–6
  Microphone Channel, 4–25, 4–29
Trigger Source
  Advanced Module, 6–12, 6–18
  Geophone Channels, 4–28
  Microphone Channel, 4–29
  Microphone Channel (Series II), 5–7
  Series II, 5–6
Truncate, 6–26
Tutorial, 3–1
TWA, 6–36
Type of microphone
  Series II, 5–7
  Series III, 4–30

U

UDP/IP, 4–96, 4–97, 4–98
UDP/IP Communications, 4–100, 4–109
Unit Monitor Status, 4–23, 4–26, 4–43, 4–54, 4–64, 4–65
Unit Operating System (Series III), 4–69
Unit Status, Series II, 5–10
Unit Timer, 4–35
Unit Timer, Extending Battery Life, 4–35
Units, Advanced Module, 6–10, 6–12, 6–18
Use 3 channels, Linear Superposition, 6–61
Use Default Column Names, Events List Box, 4–149
Use Default Columns, Events List Box, 4–149
User Notes
  Series II, 5–8
  Series III, 4–33, 4–48

V

Vector Sum, 6–26
Velocity Axis and Frequency Axis, Compliance Graph Editor, 6–48
Vibration Dose Value, 4–44, 4–69, 4–129
View History, 6–25
View Menu
  Advanced Module, 6–73
  Zoom Data Plot window, 6–5

W

WAN, 4–15
Warning Alarm
  Series II, geophone channel, 5–7
  Series II, microphone channel, 5–7
  Series III, geophone channel, 4–30, 4–31, 4–46
  Series III, microphone channel, 4–30, 4–31, 4–46
Warranty, See the title page, 2
Waveform Checkboxes, Analysis Window, 6–4
Waveform Manual, 4–43, 4–46
Waveform Scale Control, Analysis Window, 6–3
Waveform Window, Analysis Window, 6–2
Waveform, including in the PC Report, 4–3
Waveform, Printing with the Monitor, 4–38
Waveforms, print in colour in the PC Report, 4–3
Weighting of microphone (Series II), 5–7
Window, 6–29
Wire Break/Make Trigger Cable, 4–46

Y

Y value, displaying on cursor, 6–73

Z

Zoom Data Plot Command, 6–4
Notes: